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INTRODUCTION

This Data Acquisition and Processing Report outlines the acquisition and processing procedures used for
Hydrographic projects surveyed in 2009 by the NOAA Ship Fairweather.

Survey specific details will be listed in Descriptive Reports as needed. Unless otherwise noted, the acquisition
and processing procedures used and deliverables produced are in accordance with the NOAA Hydrographic
Survey Specifications and Deliverables Manual (HSSD) April 2009, the Field Procedures Manual (FPM), May
2009, and all active Hydrographic Surveys Technical Directives (HTD).

Any additions and changes to the following will be included with the individual Descriptive Reports.

A  EQUIPMENT

Detailed descriptions of the equipment and systems, including hardware and software, used for bathymetric data
acquisition, horizontal and vertical control operations, shoreline acquisition, and processing are listed below.

1.0 Hardware
The hardware listed in this section was used throughout the 2009 field season.

11 Hardware Systems Inventory

Detailed hardware information, including installation dates and serial numbers, is included in Appendix | of this
report. Manufacturer’s product specifications are included in Appendix II.

1.2 Echo Sounding Equipment

1.2.1 RESON 8111ER Multibeam Echosounder (MBES)

Fairweather is equipped with a RESON SeaBat 8111 MBES with the Extended Range (ER) and snippet options.
The 8111ER is a 100 kHz multibeam system with swath coverage of 150°. The swath is made up of 101 discrete
beams with an along-track and across-track beamwidth of 1.5°. It has a specified depth range of 3 to 1200 meters,
though the typical operational depth range of the 8111ER on the Fairweather is 20 to 300 meters. No calibration
information was provided by the manufacturer for the system.

The 8111ER is hull-mounted within a reinforced projection that extends 27 inches below the keel. It is located
39.5” starboard of the centerline at approximately frame 29 (see Figures 1 & 2).

1.2.2 RESON 8160 Multibeam Echosounder (MBES)

Fairweather is equipped with a RESON SeaBat 8160 MBES with the snippet option. The 8160 is a 50 kHz
multibeam system with a swath coverage of greater than 4x water depth. Each swath is made up of 126 discrete
beams with an along-track and across-track beamwidth of 1.5°. It has a specified depth range of 10 to 3000
meters, though the typical operational depth range of the RESON 8160 on Fairweather is 300 to 1000 meters. No
calibration information was provided by the manufacturer of the system.

Page A-1 of 22
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The 8160 is hull-mounted within a reinforced projection that extends 13.6 inches below the keel. It is located 54
inches port of the centerline at approximately frame 29 (see Figures 3 & 4).

FigureERESON SeaBat 8111ER MBES Flgure 2: RESON SeaBat 8111ER MBES on
Fairweather

FAIRWEATHER 10/1/2003

i

Figure 3: RESON SeaBat 8160 Figure 4: RESON SeaBat 8160 on Falrweather

1.2.3 RESON 8101ER Multibeam Echosounder (MBES)

Survey Launches 1010 and 1018 are each equipped with a RESON SeaBat 8101 MBES with the Extended Range
and snippet option. The 8101ER is a 240 kHz multibeam system with a swath coverage of 150°. The swath is
made up of 101 discrete beams with an along-track and across-track beamwidth of 1.5°. It has a specified depth
range of up to 500 meters. The typical operational depth range of the RESON 8101 on launches 1010 and 1018 is
3 to 100 meters. Under optimal conditions with a hard bottom, high power and high gain, the depth range of the
8101 ER was observed to be as deep as 350 m producing a swath of £45° from nadir. No calibration information
was provided by the manufacturer for the system.

Each system is attached to a launch using a swing mount which is starboard of the keel and approximately
centered fore and aft (see Figures 5 & 6).

A2 -



2009 DAPR NOAA Ship Fairweather

Figure 6: Launch 1010 with 8101 retracted

Y | g

| Figure 5: Laun 1010ith 81extend

1.2.4 RESON 8125 Multibeam Echosounder (MBES)

Survey Launch 1018 can be equipped with a RESON SeaBat 8125 MBES with snippet option. The 8125 is a 455
kHz multibeam system with swath coverage of 120°. The swath is made up of 240 discrete beams with an along-
track beamwidth of 1° and an across-track beam spacing of 0.5°. It has a maximum range scale of 120 meters for
surveying depths less than 60 meters with a complete swath. The typical operational depth range of the 8125 on
launch 1018 is 3 to 50 meters. No calibration information was provided by the manufacturer for the system.

The system is attached to the launch using a bolted-on sled mount which is on the port side of the keel and
approximately centered fore and aft (see Figure 7).

Launch 1018 with 8125

Figure 7:

1.25 Odom Echotrac CVM (VBES)

The Odom Echotrac CVM Vertical Beam Echo Sounder (VBES) is portable (Figure 8), and is intended for use
during shoreline acquisition or as necessary with vessels 2302 and 1706. The CVM vertical beam system can
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utilize either a 4 degree or a smaller 9 degree 200 kHz side mounted transducer and has a depth range up to 180
meters (Figure 9). The CVM links directly into one Trimble Pathfinder® Pro XRS unit for positioning and
provides a real-time bottom profile. Files are logged in Hypack as BIN files to obtain accurate depth records for
the Shoreline NALL Buffer, VBES mainscheme, and/or VBES crosslines.

o

Figure 8: Odom Echotrac CVM Figure 9: Four degree (left) & nine degree transducers

1.2.6 Klein Series 5000 Side Scan Sonar

The Klein Series 5000 Sonar System consists of a side scan sonar instrument-mounted towfish (Figure 10), a
Transceiver and Processing Unit (TPU), and Windows-based computer for display and control, along with a tow
cable and various interconnect cables. The 5000 series operates at a nominal frequency of 500 kHz (455 kHz
actual) and has a depth rating to 200 meters. It is software driven on a PC platform employing Klein's SonarPro™
software. Files are logged in SDF format and converted into Caris HIPS and SIPS using the Conversion Wizard.

Preliminary testing of the Klein 5000 occurred in May 2009. Full testing and documentation will be conducted
prior to data collection and system utilization.

The towfish can be used in one of two configurations, hull-mounted on launch 1018 or towed from Fairweather.
In the hull-mounted configuration the towfish is bolted to a sled on the bottom of the launch. The sled is situated
to port of the keel and is approximately centered fore and aft. In the towed configuration the towfish is fitted with
a K-wing depressor and affixed to armored coaxial cable for deployment from Fairweather’s A-frame. The
amount of tow cable being used is manually entered into SonarPro™ for towfish layback calculation.
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o 2

Figure 10: Klein 5000 Side Scan Sonar

13 Manual Sounding Equipment

131 Diver’s Least Depth Gauge

The diver’s least depth gauge (DLDG) is a hand-held device that uses pressure to determine depth of water over a
discrete point (e.g. mast of a shipwreck). A raw sounding obtained during a dive is corrected with verified tides
and Conductivity/Temperature/Depth (CTD) information acquired in the vicinity of the object.

The divers least depth gauge (see Figure 11) was calibrated by PTC Electronics Incorporated on April 2, 2008,
documentation is included in Appendix V. Prior to field season use on April 22, 2009, raw DLDG sounding with
simultaneous lead line readings allowed for comparison measurements for check purposes to ensure appropriate
readings, the associated Divers Least Depth Gauge Report is include in Appendix V. Depths acquired with the
DLDG are processed using the same procedures as other shoreline features that require tide correction as
described in section B.2.2 of this report.

During projects that required DLDG use, periodic quality assurance checks are conducted as outlined in section
1.5.6 of the FPM. Daily DQA checks and pre and post dive DQAs are performed. Documentation and DQA files
are included with the individual descriptive reports with the Sound Speed DQA data for the particular surveys that
required the use of the DLDG.

Figure 11: Diver's least depth gauge
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1.3.2 Lead Lines

Vessels 1010, 1018, 1706, and 2302 are each equipped with a lead line. Lead lines are used for depth
measurements near shore over submerged shoals and for echosounder depth comparisons.

Leadlines were created, measured and calibrated according to Section 1.5.3 of the FPM with the exception that the
lines were calibrated to the meter instead of decimeter. Calibration was performed during April 2009. Calibration
reports for the leadlines are included in Appendix V.

1.4 Positioning, Heading, and Attitude Equipment

1.4.1 TSS Positioning and Orientation System for Marine Vehicles (POS/MV)

Fairweather and her launches are each equipped with a TSS POS/MV 320 V4, configured with TrueHeave™.
The POS/MV calculates position, heading, attitude, and vertical displacement (heave) of a vessel. It consists of a
rack mountedPOS Computer System (PCS) (Hardware Version 2.9-7 on Fairweather and version 2.6-7 on both
Launches), a strap down IMU-200 Inertial Measurement Unit (IMU), and two GPS antennas corresponding to
GPS receivers in the PCS. The port side antenna is designated as the primary receiver, and the starboard side
antenna is the secondary receiver (see Figures 12 & 13). Differential correctors are supplied to the POS MV by a
CSI wireless MBX-3S Automatic Differential GPS receiver. The POS MV firmware version 3.42 and the
controller software version 4.0.2.0 are currently the installed versions utilized.

For all multibeam systems aboard Fairweather and her launches, timing between the sonar swath, position,
heading and attitude information was synchronized by utilizing the proprietary UTC string from POS/MV 320
v.4’s. A timing string is sent from the POS/MV to the RESON topside unit via serial connection and to the
Hypack acquisition computer via ethernet. Vessel wiring diagrams are included in Appendix I11.

POS/MV controller software was used to monitor position accuracy and quality during data acquisition. This
ensured that positioning accuracy requirements are met, as outlined in section 3.2.1 of the HSSD. The POS/MV
controller software provides clear visual indications whenever accuracy thresholds are exceeded.

1.4.2 POS/MV GAMS Calibration

GAMS (GPS Azimuth Measurement Sub-system) calibrations were performed on each of the three POS/MV
units. The GAMS calibration procedure was conducted in accordance with instructions in chapter 4 of the
POSMV V4 Installation and Operation Guide, 2005. Results are included in the individual vessel reports and
spreadsheets, with calibration details located in Appendix I11.
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Figure 12: POS/MV antennas on 1018 Figure 13: POS/MV antennas on 1010

143 CSI1 Wireless MBX-3S DGPS Receiver

Fairweather is equipped with commercial grade CSI Wireless MBX-3S DGPS Receivers that are used in
conjunction with TSS POS/MV to provide vessel positioning during data acquisition. The DGPS receivers are
configured in manual mode to allow reception of only one U.S. Coast Guard (USCG) differential GPS beacon
station. Vessel wiring diagrams are in Appendix I11-vssl-5.

Differential GPS (DGPS) is the primary method of real-time positioning. The individual descriptive reports list
the U.S. Coast Guard beacon sites and frequencies used for differential corrections utilized during hydrographic
surveying.

1.4.4 Trimble Backpack

Fairweather uses two GPS Pathfinder® Pro XRS receivers in conjunction with a field computer to acquire
detached positions during shoreline verification in the field. Data can also be collected with a handheld TSCe
data collector. Fairweather’s field computers are Panasonic Toughbooks. Currently in use are two CF-30’s, one
CF-29, one CF-19, and one CF-18. The receivers have integrated beacon/satellite differential antennas which
allow access to digital real-time sub-meter accuracy solutions. Data quality assurance testing was conducted by
Fairweather personnel in April 2009. Trimble units were tested over a published benchmark. Trimble positions
matched the published benchmark position within 0.6m. Test results are located in Appendix V.
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;

Figue 14: Trimble Backpack Unit

1.45 Impulse LR Hand-held Laser

The Impulse Laser Rangefinder and TruPulse 200 Laser Rangefinder are used in conjunction with the Trimble
Backpack GPS unit to acquire distances and heights during shoreline verification. These data are entered directly
into the shoreline acquisition software and annotated on the detached position forms. The Impulse LR and
TruPulse 200 Laser Rangefinder do not function properly in low light or in choppy seas when a feature is not
distinguishable from surroundings.

o

Pulse 200 Laser Rangefinder

Figure 15: IMPULSE LR laser Figure 16:
Data quality assurance testing was conducted in April 2009 by Fairweather personnel. Vertical and horizontal
readings were taken with the laser rangefinders and compared to measurements taken with a steel tape. The laser
rangefinder was set up on a tripod and a staff of known height was measured at distances of 10, 20, 50, and 100
meters. Three horizontal and three vertical readings were taken at each interval. The results of the laser
rangefinder accuracy testing are located in Appendix V.

15 Sound Velocity Equipment

151 SBE 19plus SEACAT Profiler

Fairweather is equipped with three SBE 19plus and two SBE 19plusV2 SEACAT sound velocity profilers used to
acquire conductivity, temperature, and depth (CTD) data in the water column to determine the speed of sound
through water. Two of the SBE 19plus profilers have pressure sensors rated to 1000 meters. The third SBE
19plus profiler has a pressure sensor rated to 3,500 meters. The two SBE 19plusV2 profilers have pressure
sensors and units rated to 600 meters.
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The SBE 19plus and SBE 19plusV2 SEACAT sound velocity profilers were calibrated by the manufacturer and
current calibration files were returned with the units. Calibration files are located in Appendix V.

Periodic quality assurance checks include comparison casts between CTD instruments. Data quality assurance
(DQA) checks include comparison casts between two instruments as per section 1.5.2.2.2 of the FPM for each
survey. Records of the DQA tests performed are kept aboard the ship and are included with the digital Separates
Il — Sound Speed Data for each survey.

To ensure that the CTDs continue to function properly a stringent maintenance schedule is followed using
guidelines from the manufacturer's recommendations. This includes a thorough rinsing of the instrument with
distilled water after each cast and periodically each CTD is flushed with a Triton X-100 solution.

152 Moving Vessel Profiler 200

A Brooke Ocean Technology, Ltd. (BOT) Moving Vessel Profiler 200 (MVP200) is mounted in the aft starboard
corner of the fantail (see Figure 15). The MVP200 system is a self contained sound velocity profiling system
capable of sampling water column profiles to 200m depth from a vessel moving up to 12 knots. The system is
configured with a Single Sensor Free Fall Fish (SSFFF) outfitted with an Applied Microsystems Ltd. Sound
Velocity and Pressure Smart Sensor. Deeper profiles can be obtained by reducing the vessel speed. When the
vessel is holding station, the system is capable of recording casts over 400m in depth.

The MVP system consists of a winch, cable, fish (the towed unit with the sound velocity sensor), support
assembly, and controlling hardware and software. During ship acquisition, the fish is deployed using the on-deck
controller and towed with enough cable out to keep the fish 3-5 m below the water surface. A “messenger” (a
short cable-thickening sleeve) is set to allow the system to keep the appropriate amount of cable out and is reset as
needed when the ship acquisition speed is altered.

During SVP acquisition, the controlling computer application, BOT MVP version 2.4 is used to control the MVP
system and to acquire SVP data. MVP allows for three acquisition modes: 1) automatic continuous multiple cast
freefall casting while at speed, 2) single cast freefall casting while at speed, and 3) single cast winch speed casting
while stationary. The user limits the depth to which the fish will fall by setting 1) the depth-off-bottom and 2) the
maximum depth. Either single, individually initiated casts can be performed at the discretion of the Hydrographer
or the auto deploy function can be enabled and set with varying intervals (every 10 minutes, for example) for
deployment.

On 19 August 2009 the MVP Controller software was updated to version 2.401.

Fairweather has three Applied Microsystems Ltd. Sound Velocity and Pressure Smart Sensors. All of the sensors
were calibrated by the manufacturer and current calibration files were returned with the units. Calibration files are
located in Appendix V.

Periodic quality assurance checks include comparison casts between the MVP and one of the SBE 19plus or SBE
19plusV2 SEACATS. Data quality assurance (DQA) checks include comparison casts among the instruments as
per section 1.5.2.2.2 of the FPM for each survey. Records of the DQA tests performed are kept aboard the ship
and are included with the digital Separates Il — Sound Speed Data for each survey.
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Figure 17: Fairweather’s MVVP200 sound velocity system

153 RESON Sound Velocity Probe (SVP 70)

Fairweather is equipped with one RESON SVP 70. The SVP 70 measures the speed of sound near the ship’s hull
mounted transducers to provide real time surface sound speed values. The unit is mounted adjacent to the
RESON 8160 as shown in Figure 18.

— l - e rfi? -I!
Figure 18: Fairweather’s SVP 70 sound speed unit (left) and the 8160

The sound speed is output to the RESON 8160’s processing unit. The 8160 - a flat faced transducer - requires
sound velocity information for beam forming. The 8160 cannot be used to acquire data without real time sound
velocity information.

The unit was installed during the winter drydock period in Seattle at Lake Union Drydock Company. The current
calibration report is included in Appendix V.
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154 Odom Digibar Pro

Fairweather is equipped with one Odom Digibar Pro. The Digibar measures the speed of sound near the RESON
8125 on the sled attached to Launch 1018 to provide real-time surface sound speed values. The unit is mounted
vertically just aft of the RESON 8125 on the sled as shown in Figure 19.

Figure 19: Fairweather’s Odom Digibar Pro mounted on Launch 1018.

The sound speed is output to the RESON 8125 processing unit. The 8125 requires surface sound speed
information for beam forming due to the flat faced transducer.

The unit was calibrated on April 16, 2009 and the current calibration report is included in Appendix V.
1.6 Vertical Control Equipment

16.1 Water Level Gauges

Five Sutron 8210 tide gauges were provided to Fairweather by the Center for Operational Oceanographic
Products and Services (CO-OPS) at the start of the 2009 field season. These gauges are equipped with Paros
Scientific Sensors for pressure measurements. The tide gauges are checked annually by CO-OPS Field
Operations Division personnel to ensure that their accuracy standards are being met.

CO-OPS does not provide calibration or quality assurance documentation to the Fairweather. Installation and
removal of the water level gauges is the responsibility of Fairweather personnel. To ensure full functionality of
the vertical control equipment prior to deployment for field operations, new gauges undergo testing by
Fairweather personnel. Five gauges underwent testing in April 2009 and results are included in Appendix V.

1.6.2 Leveling Equipment

-A-11-



2009 DAPR NOAA Ship Fairweather

Fairweather is equipped with four universal automatic levels (two Zeiss NI2 333 and two Leica NA2 100) and
graduated metric staffs to assist in leveling tide gauges.

A Kukkamaki procedure is performed prior to leveling in order to verify the collimation error. Procedures used
followed those described in the User’s Guide for the Installation of Bench Marks and Leveling Requirements for
Water Level Stations, October 1987. Kukkamaki results for 2009 are located in the Tides section of Appendix V.

1.7 Horizontal Control Equipment

Fairweather is equipped with two Trimble NetR5 receivers and one Ashtech Z-Xtreme dual-frequency GPS base
stations used for the positioning of horizontal control marks, tidal benchmarks and aids to navigation. These base
stations can be configured for use as a portable DGPS or RTK reference station, or as a static receiver to record
observations for use with PPK.

When deployed for PPK the base stations log data locally, either to internal memory or external memory, and the
data is downloaded periodically. The data is downloaded either by visiting the site or remotely via Freewave 900
MHz spread spectrum Ethernet radios. Station power needs are supported by batteries and solar panels.

The Ashtech antenna can be equipped with an optional ground plane and all receiver antennas are used with a
Seco fixed height GPS tripod.

Data quality assurance (DQA) testing of the Ashtech receiver was performed April 30", 2009 by Fairweather
personnel. The receiver was installed over control mark “VIXEN HBR 2009” (NGS PID: BBBK46) in Ernest
Sound, AK using a Seco fixed height tripod. The receiver acquired data for 8 hours. The recorded observations
were submitted to OPUS. The OPUS position of the receiver was half a centimeter from the published position.
The OPUS solution is included in Appendix V.

Data quality assurance testing of all three GPS units was performed May 1%, 2009 by Fairweather personnel. The
receivers were set up over Benchmark No. 37 (NGS PID: Al4914) in Ketchikan, AK using a Seco fixed height
tripod. Each receiver acquired data for 2 hours. The recorded observations were submitted to OPUS. The OPUS
position of each of the two Trimble receivers was within three centimeters of the published position for the mark.
The Ashtech receiver had a position over a decimeter from the published position; this is likely due to fewer
satellites observed during the recording period as compared with the two Trimble receivers and the significantly
shorter observation period as compared to the previous DQA testing. The OPUS solutions are included in
Appendix V.

Horizontal control equipment serial numbers and installation dates are located in the hardware section of
Appendix I, System Tracking.
2.0  Software

2.1 Software Systems Inventory

An extensive software inventory with documentation, of the software systems used by NOAA ship Fairweather,
is maintained as a Survey Software spreadsheet and is included with the Supplemental Survey Records for the
individual Descriptive Reports. This spreadsheet includes specifics such as software applications, versions, and
hot fixes, in addition to dates loaded on specific computers within the survey department.

2.2 Data Acquisition Software

221 HYPACK® HYSWEEP
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Fairweather uses the Hypack® software package to acquire multibeam echo sounder and backscatter data on all
of its multibeam platforms. Hypack is used to log VBES data, which is acquired in two formats: .BIN and .RAW
(used for processing).

Hysweep is a module of the Hypack software suite that allows for real-time data planning and acquisition.
Hysweep combines geo-referenced bathymetric digital terrain models and reference files such as raster charts and
vector shoreline files to display real-time bathymetric bottom coverage. Data is acquired in three formats: .RAW,
.HSX (containing bathymetry), and .81X (containing snippets data). All three file types are logged but only the
\HSX and .81X files are utilized, stored, and submitted.

2.2.2 CARIS Notebook

CARIS Notebook™ can be used to directly collect detached shoreline positions and verify shoreline. The
software is run on a field computer and receives the Trimble GPS data output from the GPS Pathfinder® Pro XRS
receivers.

GPS settings in CARIS Notebook are as follows:

Maximum Horizontal Dilution of Precision (HDOP) = 3
Maximum Positional Dilution of Precision (PDOP) = 6
Minimum Signal-to-Noise Ratio (SNR) = 12

Minimum Elevation Mask = 8°

Minimum # of Satellites = 4

Real-Time settings in CARIS Notebook are as follows:
« Source Type: Integrated Beacon — Manual Mode
o Position Mode: Corrected Only
o Age Limit: 20 seconds

Differential GPS correction is applied in real-time, using the unit’s integrated beacon as the primary corrector.
The unit can be setup to run without using DGPS with position mode set to “Autonomous Only” or with values
different than those listed above. These special circumstances of acquisition with altered parameters are recorded
and documented in the individual Descriptive Report as appropriate.

2.3 Data Processing Software

2.3.1 NOAA Hydrographic Systems and Technology Programs (HSTP) Software

Sound speed data is processed with Velocwin, in-house software produced and maintained by NOAA’s
Hydrographic Systems and Technology Programs (HSTP) division. Velocwin creates and archives water column
profiles, performs quality assurance, and processes pressure based depth data. Velocwin creates a standard file
format across NOAA’s hydrographic fleet for sound speed profiles applied to shallow water multibeam and single
beam data.

Pydro, another NOAA program produced and maintained by HSTP, is used to produce Smooth Tides Requests
along with DTON and AWOIS Reports. In addition, PYDRO is used for Tidal Constituent and Residual
Interpolation (TCARI) tide application in conjunction with CARIS HIPS.

2.3.2 CARIS

CARIS HIPS™ (Hydrographic Information Processing System) is used to process all multibeam data including
data conversion, filtering, sound velocity, tide correcting, merging and cleaning. Vertical beam data is also
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processed using CARIS HIPS, where .RAW data is converted, filtered, tide corrected, merged, and displayed in
Fieldsheets. CARIS HIPS also calculates the Total Propagated Error (TPE) used to produce Bathymetry
Associated with Statistical Error (BASE) surfaces which assist the Hydrographer in data cleaning, analysis, and to
produce BASE surface deliverables.

CARIS SIPS™ (Sonar Information Processing System) is used to process all side scan imagery data including
data conversion, slant-range correction, beam pattern correction, and despeckling, if appropriate. CARIS SIPS is
also used to inspect the imagery for contacts and to produce side-scan imagery mosaics.

CARIS Notebook™ is used to compile and display source shoreline, shoreline updates and S-57 features that are
collected directly in the field, digitized, or imported from Pydro. The .hob files created in Notebook are the
current shoreline deliverables.

CARIS BaseEditor™ will be used for data quality assurance checks on the BASE surface deliverables. At the
time of writing the software was not available to Fairweather personnel.

2.3.3 Fledermaus™

Fledermaus ™, an Interactive Visualization Systems 3D™ (1S 3D) program, is used for data visualizations and
creation of data quality control products, public relations material and reference surface comparisons.

As an additional data quality assurance check, Fledermaus ™ is used to examine the CARIS surfaces prior to
submission. The combined BASE surface is exported from CARIS and then converted to a Fledermaus .sd file
via the Avggrid and Dmagic modules.

2.34 Geocoder

The Geocoder program is provided by University of New Hampshire CCOM and another implementation is
provided by Hypack. Our primary use of these programs is to produce imagery of gathered snippets and
bathymetry data. Hypack’s .81X and .HSX files are used to assemble snippets data and along with CARIS HIPS
processed depths as xyz grids for digital terrain model production.

3.0  Vessels
3.1 Vessel Inventory

The NOAA Ship Fairweather (S220) and her survey launches 1010 and 1018 are equipped to acquire multibeam
echosounder (MBES) and sound velocity profile (SVP) data. Launch 1018 is also the primary vessel for dive
operations. The AMBAR (2302) and Monark (1706) are used during shoreline verification, bottom sampling, and
horizontal and vertical control operations. All vessels may be used in support of tide gauge operations. See
Appendix | for the complete vessel inventory.

3.2 Noise Analysis

The Fairweather sonar systems, RESON 8160 and RESON 8111ER, underwent noise analysis testing on October
10 and 11, 2004 respectively. The results are used during acquisition to enhance data quality and are included in
Appendix [11-S220-7. Standard operating procedures utilizing the RESON 8160 and RESON 8111ER aboard the
Fairweather have survey speeds set to minimize noise based on these noise analyses.

4.0 Data Acquisition

4.1 Horizontal Control
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A complete description of horizontal control will be included in the project’s Horizontal and Vertical Control
Report (HVCR), submitted for each project under separate cover when necessary as outlined in the HSSD and
section 5.2.3.2.3 of the FPM.

The horizontal datum for all projects is the North American Datum of 1983 (NAD83) unless otherwise noted in
the individual descriptive reports.

Multibeam and shoreline data are differentially corrected in real time using correctors provided by Coast Guard
beacons. The specific beacons used for a given survey will be included in the Horizontal Control section of the
survey’s descriptive report. If loss of the differential beacon resulted in any data being recorded with C/A GPS
positions it will be noted in the Descriptive Report for the specific survey.

If DGPS is commonly lost during the survey, the original navigation of the survey vessel can be replaced with a
post processed kinematic (PPK) single best estimate of trajectory (SBET). The PPK solution is dependent on a
local base station supported by the ship and processed in Applanix POSPac software using Single Base mode. The
resulting navigation from PPK is an improvement over C/A and DGPS navigation. The use of PPK for a given
survey will be included in the Horizontal Control section of the survey’s descriptive report.

4.2 Multibeam Echosounder Acquisition and Monitoring Procedures

Methods of acquisition took into consideration system performance limitations, the bottom topography, water
depth, and the ability of the vessel to safely navigate the area.

All multibeam data are acquired in Hypack’s HYSWEEP® SURVEY extension (HSX) format and monitored in
real-time using the 2-D and 3-D data display windows and the on-screen displays for the RESON SeaBat 8101ER,
8111ER, and 8160. Adjustable parameters that are used to control the RESON either directly or from the Hypack
software include range scale, power, gain, and pulse width. These parameters are adjusted as necessary to ensure
best data quality. Vessel speed was predominantly between 6-6.5 knots and reduced as needed to eliminate noise
from the data and to ensure the required along-track coverage for object detection in accordance with the HSSD.
Survey personnel follow standard operating procedures documented aboard the Fairweather while setting and
utilizing the RESON systems and Hypack for acquisition of data.

Mainscheme multibeam sounding acquisition lines using the RESON SeaBat 8101ER, 8111ER, and 8160 are
generally run parallel to the contours and spaced no greater than three to four times the water depth and in most
cases at a tighter line spacing to ensure the appropriate data density for a given resolutions at a given depth range.
For discrete item developments, line separation was reduced to 2 times water depth to ensure least-depth
determination by multibeam near-nadir beams. Hypack Hysweep was used in lieu of planned line files. Hysweep
displays the acquired multibeam swath during acquisition and was monitored to ensure overlap and full bottom
coverage. If coverage was not adequate, additional lines are run while still in the area.

4.3 Shoreline Verification

Fairweather personnel conduct field shoreline verification at times near predicted low water, in accordance with
the Project Instructions and section 3.5 of the FPM.

The composite source file (CSF) provided with the project instructions is the primary source for shoreline features
to be verified. Additionally, AWOIS items and other features to be investigated are provided for a given survey
and are included in the files utilized during shoreline verification. Specific details regarding the composite source
and investigation features are included in the individual descriptive reports.

A Mean High Water (MHW) Buffer line, offset 0.8 mm at the scale of the largest chart in the area, is provided
with the project instructions or created from the composite source MHW line. This MHW Buffer line is used in
the shoreline acquisition software and on the boat sheet as a reference, and to determine the Navigable Area Limit
Line (NALL). The NALL is determined in the field as the farthest off-shore of either the MHW buffer specified
above, the 4-meter depth contour, or the inshore limit of safe navigation. All shoreline features from the
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composite source seaward of the Navigable Area Limit Line (NALL) are verified (including an update to depth
and/or position as necessary) or disproved during shoreline operations. Features off-shore of the NALL and not
addressed or features of an ambiguous nature are flagged with a marker note for further clarification.

Detached positions (DPs) acquired during shoreline verification indicate new features, revisions to source
features, or source features not found in the field. They are recorded in the shoreline acquisition software and on
DP forms.

5.0 Bottom Sample Acquisition

Bottom samples are acquired according to section 7.1 of the HSSD. Samples are acquired using the current
shoreline acquisition system and processed similarly to other shoreline features as outlined in the Descriptive
Report for the specific survey. Bottom sample results are included in the Notebook .hob deliverable layer,
HXXXXX_ Final_Feature_File.

B QUALITY CONTROL

The Fairweather has numerous standard operating procedures (SOPs) that are followed by personnel throughout
the survey to ensure consistent high quality data and products.

1.0  Uncertainty Modeling

Error values for the multibeam and positioning systems on Fairweather and her survey launches were compiled
from manufacturer specification sheets for each sensor (Heave, Pitch, Roll, Position, and Heading) and from
values set forth in section 4.2.3.6 and Appendix 4 — CARIS HVF Uncertainty Values of the FPM.

Estimates for the Motion Reference Unit ( MRU) alignment errors are the standard deviations of the values
determined by multiple personnel processing the patch test data (see section C 4.0). Initial MRU values were
significantly large and impacted the Total Propagated Uncertainty/Error (TPU/TPE) values in CARIS
inappropriately. Final MRU values used did not include the outlier patch test values to allow for more reasonable
MRU uncertainty and CARIS TPE values.

The Fairweather TPU Values spreadsheet located in Appendix 1V, lists the final uncertainty values for
Fairweather and her launches, including the default tides and sound velocity values. Uncertainty values relating
to vessels and survey systems are entered into the HIPS Vessel File (HVF) for each platform. The tidal errors for
the gauge and for zoning are determined on a project by project basis. Sound speed uncertainties for a given
survey are based upon either the defaults listed in the TPU value spreadsheet or based on utilization of NOAA
sound speed uncertainty estimation software. Survey specific uncertainty values for tides and sound speed that
are entered during the Compute TPE step in CARIS HIPS and how they were determined will be included in the
individual Descriptive Report.

2.0  Data Processing
2.1 Multibeam Echosounder Data Processing

Bathymetry processing followed section 4.2 of the FPM unless otherwise noted.

Raw HSX multibeam data are converted to Caris HDCS format using established and internally documented
settings. True heave, sound velocity and water level data are then applied to all lines and the lines merged. Once
lines are merged Total Propagated Error (TPE) was computed.

The data acquired by the systems aboard Fairweather and her launches do not provide adequate densities to allow

for representation at the resolutions and depth ranges specified in Hydrorgaphic Technical Directive (HTD) 2009-
2. A waiver from this specification was obtained from Jeffrey Ferguson, Chief, Hydrographic Surveys Division to
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Fairweather on May 19, 2009 and is included in Appendix V1. The general resolution, depth ranges, and CUBE
parameter settings outlined in the waiver and used for processing are listed in Table 1. These values may also
require adjustment by sheet managers for individual surveys to address visualization gaps between finalized
surfaces in areas of greater slope. The lesser depth range value of a coarser grid will be adjusted shoaler if
adjustment is necessary (ie 35-80m for an 8m resolution adjusted to 30-80m). Adjustments to the depth ranges
will be communicated to and agreed upon with the appropriate processing branch prior to data submission. A
detailed listing of the actual depth ranges used during the processing of each survey, along with the corresponding
fieldsheet(s), will be provided in the Descriptive Report of each survey.

BASE surfaces are created using the Combined Uncertainty and Bathymetric Estimator (CUBE) algorithm and
parameters contained in the NOAA Cubeparams.xml file as provided with (HTD) 2009-2. The Cubeparams.xml
will be included with the HIPS Vessel Files with the individual survey data. The NOAA parameter configurations
for resolutions 1-16 meters are used as listed in Table 1.

Surface Resolutions CUBE Parameters

Depth Range Grid Resolution Configuration Name
0to 23 meters 1 meter NOAA 1m
18 to 40 meters 2 meter NOAA 2m
35 to 80 meters 4 meter NOAA 4m
75 to 160 meters 8 meter NOAA 8m
155+ meters 16 meter NOAA 16m

Table 1: Resolutions and Depth Ranges

Multibeam data are reviewed and edited in HIPS swath editor and in subset mode as necessary. The finalized
BASE surfaces and CUBE hypotheses are used for directed data editing at the appropriate depth range in subset
editor. The surfaces and subset editor viewing are also used to demonstrate coverage and to check for errors
resulting from tide, sound velocity, attitude and timing.

Vessel heading, attitude, and navigation data are reviewed in HIPS navigation editor and attitude editor if deemed
necessary upon review of surfaces. Where necessary, fliers or gaps in heading, attitude, or navigation data are
manually rejected or interpolated for small periods of time. Any editing of this nature will outlined in the
Descriptive Report for the particular survey.

The Surface Filtering functionality in HIPS may be used in the processing of survey data to reject errant
soundings. If utilized, the individual Descriptive Report shall list the confidence level settings for standard
deviation used and discuss the particular way the surface filter was applied.

In areas of navigational significance, depths less than 30 meters, where the BASE surface did not depict the
desired depth for the given area, a designated sounding was selected. Designated soundings are selected as
outlined in section 5.1.1.3 of the HSSD.

Layers determining “IHOness” are added to the CUBE surfaces allowing the Hydrographer to see where and if the
surfaces meet IHO Order. The process is easily performed in HIPS and allows the Hydrographer to identify
problem areas and determine the severity of the situation. This is a spatial quality control check rather than just a
statistical list of nodes and allows for specific areas with problems to be isolated and addressed.

IHO surfaces are utilized during data collection as an additional child layer of the finalized surfaces to indicate
problem areas that need attention. Additionally, IHO child layer(s) are included with the submitted surface(s).
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The combined surface’s IHO layer exported from CARIS is examined to allow the Hydrographer to see the full
data distribution rather than just the minimum and maximum values in the surface. This data distribution is used
to assess the quality of the survey. Ninety-five percent of the data is highlighted in the histogram which allows
the Hydrographer to show whether the data for a given survey meets the appropriate IHO order as specified in
section 5.1.1.1 of the HSSD. An image of the histogram and/or its derived statistics will be included with the
Descriptive Report for the specific survey.

Additionally, a combined surface is reviewed in Fledermaus or CARIS Base Editor to ensure that the data are
sufficiently cleaned for submission.

2.2 Shoreline Data Processing

During shoreline verification, field detached positions (DP) are acquired with CARIS Notebook. Tide application
for features requiring tide correction is applied in CARIS Notebook when using discrete zoning and via Pydro
when TCARI is to be used.

An original composite source file (H####_Original_Composite_Source.hob), clipped to the sheet limits for a
particular survey, is saved prior to being edited and is submitted with the individual survey. New features and any
updates to the composite source shoreline, such as ledges or reefs, are acquired or digitized with S57 attribution
and reside in the H###### Final_Feature_File.hob. Updates to a source shoreline feature primarily include a
change in depth/height, position, or S57 classification. Notebook’s editing tools are used to modify source feature
extents or positions.

The SORIND and SORDAT S57 attribute fields for new features or modified source features are updated to
reflect the information for the associated survey number and date. All new or modified features are S57 attributed
as applicable. All unmodified source features retain their original SORIND and SORDAT values.

Short descriptive comments taken from the boat sheets or DP forms along with investigation or survey methods
are listed under the Remarks field. For significant features that deserve additional discussion or disprovals, the
Hydrographer included recommendations to the cartographer in the Recommendations field, along with the
Hydrographer notes and investigation methods provided in the Remarks field.

Features that are disproved or that do not adequately portray the shoreline are moved to the
H####t Disprovals.hob layer from the H##### Final_Feature_File.hob layer. Features in the disprovals layer
retain their original SORIND and SORDAT values.

Photos labeled and associated with a DP number are included with the survey data and stored in the
CARIS/Notebook photo folder with the deliverables.

AWOIS investigation items are received in the Project Reference File and investigated as necessary. Shoreline
features correlated to the AWOIS item are included in either the H##### Final_Feature_File.hob or

H##### Disprovals hob layers and labeled with the appropriate AWOIS number and include a remark and
recommendation from the Hydrographer.

The CARIS Notebook files along with CARIS HIPS BASE surface(s) are viewed to compare soundings and
features simultaneously. Standard operating procedures, for processing shoreline features in CARIS Notebook,
are followed by survey personnel aboard NOAA Ship Fairweather as outlined in section 4.4 of the FPM. A
detailed discussion of the procedures used and any deviations in shoreline processing from standard procedures or
the FPM are documented in the individual Descriptive Reports.

Final Shoreline Deliverables may include a report in spreadsheet format of features named the

H###HH# Tabulated Features_Listing included in Appendix Il of the individual Descriptive Reports and up to
three Notebook HOB files:
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HXXXXX_Original_Composite_Source,
HXXXXX_Final_Feature_File,
HXXXXX_Disprovals.

3.0 Data Review

Specific procedures are used on Fairweather to ensure quality control of data throughout acquisition, processing,
and submission. These procedures are documented and followed by the Hydrographer. A detailed Quality Control
Check is performed by the survey manager. A detailed Review is conducted by qualified survey personnel (FOO,
CST, SST, or PS) other than the survey manager as an outside review of the survey data and deliverables.
Submission checklists are used to ensure that all data and deliverables are complete and included upon
submission. Documentation of these tasks is completed for every survey but only the final processing log,
HXXXXX_Data_Log, is submitted with the individual survey data.

C Corrections to Echo Soundings

1.0 Vessel HVFs

CARIS HIPS Vessel Files (HVF) are created by Fairweather personnel and used to define a vessel’s offsets and
equipment uncertainty. The HVF is used for converting and processing data collected by each survey platform.
The HVFs used for a given project are included with the digital data submitted with those surveys.

2.0 Vessel Offsets

Sensor offsets are measured with respect to each vessel’s reference point. The reference point for Fairweather
and survey launches 1010 and 1018 is the IMU. Specific offset values are input into the POS/MV and the CARIS
HIPS Vessel File (HVF).

A ship survey was completed for the Fairweather by Westlake Consultants, Inc on September 23, 2003. A
POS/MV components spatial relationship survey of the Fairweather was conducted by National Geodetic Survey
(NGS) in February 2007. An additional POS/MV components spatial relationship survey was conducted by NGS
on February 15, 2009 while the ship was at Lake Union Drydock in Seattle, WA. The results of these surveys
were used to determine the offsets for the ship. The reports from each survey are located in Appendix I1l. The
S220 Offsets ¢ Measurements spreadsheet is also included in Appendix 111, listing the final values for
Fairweather’s offsets with explanations of how they were calculated.

Permanent control points were established on launches 1010 and 1018 in July of 2004. Sensor offsets were
measured by Fairweather personnel according to documented procedures. Total stations were utilized for
positioning the permanent control points (see Figure 20). The total station specifications are located in Appendix
I, the calibration certificates for the Nikon DTM 310 and the Sokkia SET 5F are included in Appendix V. A steel
tape was used to verify and update specific vessel offsets in March 2009 and the results are located in the
respective vessel’s Minimum Physical Measurements_2009 spreadsheet in Appendix I11-101X-1. The final offsets
for survey launches 1010 and 1018 are derived from a combination of values from the original full survey and the
values updated in the verification surveys. The 2009 transducer measurement values indicated agreement with the
2008 values. Since the angle bias was not documented during 2009 measurement the 2008 offset values were
used. Additionally, the values in the POSMV for the distances between the IMU to the Port Antenna and Heave
point remained those used in 2008 and were not updated with the 2009 measurements for both launch 1010 and
1018. Though this creates a slight difference to the lever arm in the POSMV, no appreciable affects have been
observed. The measurements, derivations, descriptions of methodology used, diagrams, and coordinate system
references are included in the respective vessel’s Offsets & Measurements spreadsheet in Appendix 111-101X-1.
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Figure 20: Permanent Control Point *"Benchmark C** on launch 1018

3.0  Static and Dynamic Draft

The static drafts (Waterline Height in the HVF) for launch 1010 and 1018 were calculated based on steel tape
measurements of the distance from benchmarks on the port and starboard quarter of the vessel to the waterline.

The bow and stern draft marks were used to perform a linear interpolation of the static draft at the Fairweather’s
IMU. The static draft was measured under different loading conditions: with different amounts of fuel. The Ship
Draft 2009 spreadsheet records the static draft values and is included with the ship offset documentation in
Appendix I11-5220-1.

The values and calculations for static draft are listed in each vessel’s Minimum Physical Measurements and
Offsets & Measurements spreadsheets located in Appendix I11-vssl-1.

Dynamic Draft measurements were conducted for Fairweather in February 2009, and for survey launches 1010
and 1018 in April of 2009. The measurements were made using the change in ellipsoid height while traveling at
different speeds in Lake Washington. The ellipsoid heights were determined using Post Processed Kinematics
(PPK) by recording POSPac on each vessel and then processing the data with local reference stations in Applanix
POSPac software. The resulting Single Best Estimate of Trajectory (SBET) was exported from POSPac and the
speed versus ellipsoid height was fit to a polynomial curve using a least squares fit method in a Python Script
written by ship’s personnel. The polynomial curve was used to derive the table used in the CARIS HVF’s for the
Reson 8101 multibeams that are swing-arm mounted to both launches 1010 and 1018, and the standard deviation
of the residuals was used to determine the associated uncertainty in the measurement. A written report about the
initial measurements carried out in February is provided for in Fairweather’s 2009 HSRR along with
spreadsheets containing applicable graphs and tables with comparison to previous years for launches 1010 and
1018. Documentation for the dynamic draft testing is located in the respective vessel’s folder in Appendix IlI.
Launch 1018 also completed a traditional bottom referenced dynamic draft measurement, and the results from this
test are plotted in the ellipsoidally referenced graph.

The dynamic draft measurement for Launch 1018 taken in February 2009 was conducted without the mounting
sled and Reson 8125 multibeam sonar head mounted to the hull of the vessel, which was mounted for the first
time in May 2009. A new dynamic draft measurement specifically for the Reson 8125 and sled mount
configuration was taken on August 7, 2009, in Dutch Harbor, AK, using the “Echosounder method” described on
page 31 of the FPM. The applicable acquisition, processing, and analysis spreadsheet is contained in Appendix
I1l. The dynamic draft values entered in the CARIS HVF for Launch 1018 are the derived values from this
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measurement. All data acquired during the 2009 field season to date with the Reson 8125 mounted to Launch
1018 has been corrected using these values.

4.0 Patch Tests

Patch tests were conducted in April 2009 on Fairweather for the RESON 8111 and 8160 multibeam acquisition
systems. Survey launches 1010 and 1018 with RESON 8101 transducers were also tested in April 2009. Survey
launch 1018 can be outfitted with an 8125 transducer attached via sled mount. Since this system is detachable a
patch test is conducted after each reattachment. The 8125 has had a patch test conducted in May 2009 during the
Ernest Sound (0119) project and in June 2009 during the Shumagin (P183) project. Additional patch tests will be
conducted after remounting of the 8125 sled and as necessary for the other systems. The results of all patch tests
to date, along with the acquisition and processing logs, are included in the individual MBES Calibration files in
Appendix I11-vssl-4. Also included in Appendix 11 is the Sounding System Comparison. This comparison
includes leadline to MBES comparisons and surface differencing between MBES reference surfaces. Average
differences between systems are less than one meter.

5.0 Attitude

All attitude corrections are generated by the POS/MV using data from the IMU-200 Inertial Measurement Unit
(IMU). All attitude data are applied in post-processing in HIPS for systems acquiring data with the RESON 8101,
8111, and 8125. The RESON 8160 has real-time roll and pitch stabilization applied, thus these components of
attitude were not applied in post-processing as to not double apply the correctors.

IMU values for uncertainty of heave, pitch and roll are included in the manufacturer specification in Appendix Il
and are included in the Fairweather TPE Values_2009 spreadsheet located in Appendix IV.

51 True Heave

Fairweather and her launches are equipped with the POS/MV TrueHeave™ (TH) option. True Heave™ is a
‘delayed’ heave corrector as opposed to ‘real time’ heave corrector and is fully described in Section 6 of the
POS/MV Version 4 Installation and Operation Manual. TrueHeave is logged along with other POSPac data in the
daily POS files (2009-ddd_vssl_.000) through the Ethernet Logging function in the POS/MV controller software.
To ensure proper calculation of TH, files are logged for at least three minutes past the end of each day’s survey
operations.

During daily processing the occurrence of “corrupted” TrueHeave files can occur. This is generally due to a
formatting problem in the POS file. A fix has been provided by CARIS in a tool called “fixTrueHeave.exe.” In
cases where this is necessary a new “fixed” file is created with the extension “.fixed” (2009-ddd_vssl_.000.fixed).
The new fixed True Heave file is then applied to the data in the CARIS HIPS program. The original corrupted file
is retained along with the fixed file with the raw data. Occurrences of this for specific surveys are noted in the
individual Descriptive Reports.

In cases where TrueHeave™ could not be applied, real time heave correctors are used. Real time heave data are
recorded in Hypack/Hysweep software and stored in the .HSX format and can be applied as the heave corrector
for multibeam data. Data that does not have TrueHeave™ applied will be listed in the individual Descriptive
Report for the survey.

6.0  Sound Velocity

SBE 19plus and SBE 19plusV2 sound velocity profilers are used regularly to collect sound speed data for the
RESON 8101 and RESON 8125 multibeam sonars on survey launches 1010 and 1018 and used on an as needed
basis for the Fairweather’s RESON 8111 and 8160 multibeam systems. The Brooke Ocean Technology Moving
Vessel Profiler (MVP) is primarily used to collect sound velocity data for sound speed correction of data acquired
with Fairweather’s RESON 8111 and 8160 multibeam systems.
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Daily sound speed profiles from the SBE 19plus and SBE 19plusV2 profilers are processed with Velocwin and
concatenated into single .svp files for each vessel per survey. Individual .svp files and the concatenated vessel
files for the survey are submitted with each survey.

Sound speed profiles acquired using the Brooke Ocean Technology Moving Vessel Profiler 200 (MVP) are stored
in files labeled .001, .001c, .001d, and .001e (collectively called BOT files) where the number increments by one
with each subsequent cast. The .00#c file for each cast was opened with Velocwin and converted into CARIS .svp
file format. The individual .svp profiles are concatenated into vessel specific .svp files for the entire survey.
Individual sound velocity profile files taken by the MVP will not be submitted due to the large number of casts
acquired; however, the daily concatenated files are submitted for backup purposes.

The concatenated sound velocity files are applied to multibeam data in CARIS HIPS during data processing.
CARIS HIPS uses one of four different algorithms to automatically apply a sound velocity profile stored in a
concatenated sound velocity file. They are: “previous in time,” “nearest in time,” “nearest in distance” and
“nearest in distance within time.” In general, “previous in time” is the method used for applying sound velocity
information in HIPS for launch data and “nearest in distance within time” is used for ship data, although the other
methods may be used in certain situations. The method of applying sound velocity is included in the processing
logs that are submitted with each survey.

7.0 Water Level

The vertical datum for projects conducted is Mean Lower Low Water (MLLW). Predicted, preliminary, and/or
verified water level correctors from the primary tide station(s) listed in the project letter instructions may be
downloaded from the CO-OPS website and used for water level corrections during the course of the project.
These tide station files are collated to include the appropriate days of acquisition and then converted to CARIS .tid
file format using FetchTides or HydroMI in Maplnfo.

Water level data in the .tid files are applied to data in CARIS HIPS using the zone definition file (.zdf) or a Tidal
Constituent and Residual Interpolation (TCARI) model supplied by CO-OPS. Upon receiving final approved
water level data, all data are reduced to MLLW using the final approved water levels (smooth tides) as noted in
the Descriptive Report included with the survey data.

A complete description of vertical control utilized for a given project can be found in the project specific

Horizontal and Vertical Control Report (HVCR), submitted for each project under separate cover when necessary
as outlined in section 5.2.3.2.3 of the FPM.
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Hydrographic Vessel Inventory

Field Unit: FAIRWEATER
Effective Date: April 20, 2009

Updated Through: July 18, 2009

SURVEY VESSELS

Vessel Name

FAIRWEATHER

Launch 1010

Launch 1018

Ambar 700

Skiff

Vessel Image

Hull Number S 220 1010 1018 2302 1706 2301
Call Letters WTEB
Manufacturer Aerojet-General Shipyards The Boat Yard, Inc. The Boat Yard, Inc. Marine Silverships, Inc MonArk Zodiak of North America
Year of Construction 1967 1973 1973 1998 2004
Type of Construction Welded steel hull - Aluminum hull Aluminum Hull RHIB Aluminum Hull RHIB
ice strengthened

Length Overall 70.4 m (231 ft) 8.8 m (28ft 10in) 8.8 m (28ft 10in) 7.0 m (23 ft) 5.2m (17 ft) 6.7 m (22 ft)
Beam 12.8 m (42 ft) 3.3 m (10ft 8in) 3.3 m (10ft 8in) 2.9 m (9ft 4in) 2.3 m (7ft 2in) 2.6 m (8ft 6in)
Draft 4.7 m (15ft 6in) 1.2m(4ft) 1.2m (4ft) 0.4 m (1ft 4in) 0.4 m (1ft 3in) 0.6 m (22 in)
Cruising Speed 12.5 knots 24 knots 24 knots 22 knots 20 knots 18 knots
Max Survey Speed 6 knots 6 knots 6 knots

- Origninal Survey 9/23/2003
Date of Effective Full Vessel POS/MV Offsets Surveyed 2004 2004

Static Offset Survey

2/2007 and 2/15/2009

Organization which Conducted
the Effective Full Offset Survey

Original Survey - Westlake
Consultants
POS/MV Spatial Surveys - NGS

NOAA Personnel
(Wetzler, Sampadian, Froelich)

NOAA Personnel
(Wetzler, Sampadian, Froelich)

Date of Last Partial Survey or

8101: 3/20/2009

Offset Verification & Methods n/a 312012009 8125: 4/29/2009
Steel Tape

Used Steel Tape

Date of Last Static Draft April-2009 4/7/2009 4/7/2009

Determination & Method Used Draft Marks Waterline to Benchmarks Waterline to Benchmarks

Date of Last Settlement and 2/23/2009 4/17/2009 4/16/2009

Squat/Dynamic Draft
Measurements & Method Used

Post Processed Kinematic
(Ellipsoidally referenced)

Post Processed Kinematic
(Ellipsoidally referenced)

Post Processed Kinematic
(Ellipsoidally referenced)




Hydrographic Hardware Inventory

Field Unit: FAIRWEATHER
Effective Date: 4/20/2009
Updated Through: 7/21/2009
SONAR & SOUNDING EQUIPMENT
] . . Date of last
Equipment Type Manufacturer Model Serial Number Firmware and(or version Install Location Date of laSF Field Manufacturer Additional Information
Software Version Date Cal/Testing :
Cal/Service
Dry: 8111-E209-6114 X
Processor RESON 81-P (8111) 35652 Wet: 8111-E101-AFAA Mar 2009 S220 N/A Bar Code : CD0001065312
Transducer RESON 8111ER unknown N/A Mar 2009 5220 4/28/2009 rep'aﬁ:rf;%”ozduce'
Dry: 8160-2.09-7C6D X
Processor RESON 81-P (8160) 35385 Wet: 8160-1.00-E9E1 May-2004 S220 N/A Bar Code : CD0001065313
Transducer RESON 8160 unknown N/A Apr-2004 $220 4/28/2009 '”Sta"zegof hull,
Dry: 8101-2.09-E34D X
Processor RESON 81-P 35737 Wet: 8101-1.08-C215 Jul-2004 1010 N/A Bar Code : CD0001065349
Transducer RESON 8101 ER 2701011 N/A Jul-2004 1010 4/17/2009
Dry: 8101-2.09-E34D X
Processor RESON 81-P 34497 Wet: 8101-1.08-C215 Jul-2004 1018 N/A Bar Code : CD0001065351
Transducer RESON 8101 ER 3102026 N/A Jul-2004 1018 4/16/2009
Processor RESON 81-p 31562 Dry: 8125-2.10-AS0F Unknown 1018 N/A Bar Code: CD0000825308

Wet: 8125-1.08-9E98

0119: 5/24/2009
Transducer RESON 8125 4400007 N/A Unknown 1018 P183: 6/27/2009 Unknown on loan from RUDE

preliminary testing

Towfish Klein 5000 293 N/A 1018/ S220 Bar Code: CD0000825404

5/14/2009
Processor Klein Sonar Workstation 23-326-2WS Sonar Pro 11.3 1018/5220 p’e";"/il”jrzyofgtmg Bar Code: CD0000B25155
Processor Od°m33§?é%g;aphi° Echotrac CVM-A 26034 Version 4.01 2302 /1706 new unit, May-2007 [, B Coe: O se)
Transducer (2) Odomsk;)s"tj;qgsraphic SMBB200-4A TR5162/TR5159 N/A N/A 2302 /1706 N/A N/A Two 4 degree (large)
Transducer (2) Od°m33§?é%g;aphi° SMBB200_9 TR5138/TR5139 N/A N/A 2302 /1706 N/A N/A Two 9 degree (small)
Divers Least Depth Gaug| PTC MODIll 68377 N/A N/A $220 4122/2009 41212008 CD0001698256

Lead Line FA Personnel Traditional 10_01_05 N/A N/A any 4/20/2009

Lead Line FA Personnel Traditional 10_02_05 N/A N/A any 4/20/2009

Lead Line FA Personnel Traditional 20_01_05 N/A N/A any 4/28/2009

Lead Line FA Personnel Traditional 20_02_05 N/A N/A any 4/28/2009

Lead Line FA Personnel Traditional 20_03_05 N/A N/A any 4/28/2009

Lead Line FA Personnel Traditional 30_01_05 N/A N/A any 4/28/2009

Lead Line FA Personnel V-100/Non-Traditional 10_05_09 N/A N/A any 4/28/2009

Lead Line FA Personnel V-100/Non-Traditional 10_06_09 N/A N/A any work in progress




POSITIONING & ATTITUDE EQUIPMENT

Firmware and/or Version Install Date of last Field Date of last
Equipment Type Manufacturer Model Serial Number . Location X Manufacturer Additional Information
Software Version Date Cal/Testing :
Cal/Service
! HW2.9-7, SW03.42 ~ S220 Bar Code : CD0001697462 Auth.
POS/MV PCS Applanix 320Vv.4 2411 POS Gt v. 40.2.0 Jun-2008 1P129.100.1 231 4/27/2009 No. 811025-00534537
POS/MV IMU Applanix LN200 292 N/A Apr-2004 S220 Bar Code : CD0001696450
POS/MV Primary Applanix BD950 SN:4611A66708 v.00211 Feb-2007 $220
GPS Receiver
POS/MV Secondary Applanix BD950 SN:4602A62806 v.00211 Feb-2007 5220
GPS Receiver
POS/MV Port Antenna Applanix OEM2 3151R S/N 60103854 HW1 Feb-2007 S220 P/N 39105-00 DC 4602
POS/MV Stbd Antenna Applanix OEM2 3151R S/N 60125191 HW1 Feb-2007 S220 P/N 39105-00 DC 4602
DGPS Receiver CSI Wireless MBX-3S 0324-11969-0002 N/A Jul-2004 S220 Bar Code: CD0001065375
DGPS Antenna CSI Wireless MGL3 9824-1779-0002 N/A Apr-2004 S220
) HW 2.6-7, SW 03.42 1010
POS/MV PCS Appl . ' - Bar Code : CD0001601275
pplanix 320Vv.4 2564 POS Crtlr v. 3.4.0.0 Jun-2008 1P129.100.1 231 4/15/2009 1/15/2008 ar Code
POS/MV IMU Applanix LN200 294 N/A Jul-2004 1010 Bar Code : CD0001696449
POS/MV Primary Applanix BD950 SN:4624A70264 v.00211 Mar-2007 1010
GPS Receiver
POS/MV Secondary Applanix BDO950 SN:4624A68956 v.00211 Mar-2007 1010
GPS Receiver
POS/MV Port Antenna Applanix OEM2 3151R S/N 60162863 HW1 Mar-2007 1010 P/N 39105-00 DC 4626
POS/MV Stbd Antenna Applanix OEM2 3151R SIN 60145247 HW1 Mar-2007 1010 P/N 39105-00 DC 4614
DGPS Receiver CSI Wireless MBX-3S 0331-12579-0008 N/A Jul-2004 1010 Bar Code: CD0001065289
DGPS Antenna CSI Wireless MGL3 0331-12579-0009 N/A Jul-2004 1010
) HW 2.6-7, SW 03.42 1018 .
POS/MV PCS Applanix 320v.4 2560 POS Cnirlr v. 3.4.0.0 Jun-2008 1P:129.100.1.231 4/15/2009 1/15/2008 Bar Code : CD0001601274
POS/MV IMU Applanix LN200 007 N/A Feb-2007 1018
POS/MV Primary Applanix BD950 SN:4624A70243 v.00211 Feb-2007 1018
GPS Receiver
POS/MV Secondary Applanix BD950 SN:4624A70263 v.00211 Feb-2007 1018
GPS Receiver
POS/MV Port Antenna Trimble OEM2 3151R S/N 60145158 N/A Feb-2007 1018 39105-00 DC 4618
POS/MV Stbd Antenna Trimbe OEM2 3151R SIN 60130644 N/A Feb-2007 1018 39105-00 DC 4604
DGPS Receiver CSI Wireless MBX-3S 0328-12362-0001 N/A Jul-2004 1018 Bar Code:00010652291
DGPS Antenna CSI Wireless MGL3 0328-12352-0002 N/A Jul-2004 1018
Trimble Backpack 1 Trimble Pathfinder Pro XRS 0224078543 Firmware v1.96 RevA Mar-2008 S220 Bar Code: CD0001269835
Trimble Backpack 1: Trimble 33580-50 0220341062 N/A N/A S220 no Bar Code
Antenna
Trimble Backpack 2 Trimble Pathfinder Pro XRS 0224090101 Firmware v1.96 RevA Mar-2008 S220 Bar Code: CD0001269836
Trimble Backpack 2: Trimble 33580-50 0220321059 N/A N/A S220 no Bar Code
Antenna
Handheld data collector Trimble TSCe 37318 N/A N/A S220 no Bar Code , PN 45268-50
Antenna cable Trimble P/N22628 S220
Camcorder Batteries Trimble P/N17466 S220
NMEA/RTCM cable Trimble P/N30232-00 S220
data/power cable Trimble P/N30231-00 S220
dual battery cable Trimble P/N24333 S220
GPS Pathfinder field Trimble PIN45052 $220
device cable
Laser Laser Tech Inc. Impuise Laser 109290 N/A N/A $220 Bar Code: CD0001269812
Rangefinder
Laser Laser Tech Inc. TruPulse 200 Laser 001481 N/A N/A $220 no Bar Code
Rangefinder
Laser Laser Tech Inc. TruPulse 200 Laser 000676 N/A N/A $220 no Bar Code
Rangefinder




SOUND SPEED MEASUREMENT EQUIPMENT

Firmware and/or Version Install Date of last Field Date of last
Equipment Type Manufacturer Model Serial Number . Location X Manufacturer Additional Information
Software Version Date Cal/Testing :
Cal/Service
Moving Vessel Profiler Brooke Ocean MVP-200-5 10328 S220 N/A Apr-2009 Visit by BOT tech Darrell Groom
winch Technology Inc.
Moving Vessel Profiler Brooke Ocean Visit by BOT tech Darrell Groom,
fish Technology Inc. MVP-FFF-SS-32-1 10478 S220 N/A Apr-2009 primary fish
Moving Vessel Profiler Brooke Ocean Visit by BOT tech Darrell Groom,
fish Technology Inc. MVP-FFF-SS-32-1 10329 S220 N/A Apr-2009 spare fish
zﬂeonv;z? Vessel Profiler | Applied Ml'j(rf Systems | AML smart sV +P 4986 $220 DQAs weekly 10/2/2009 installed in primary fish
Moving Vessel Profiler Applied Micro Systems AML Smart SV +P 5229 5220 DQAs Welekly ifin Returned to AML for service, April
sensor service 2009
Moving Vessel Profiler Applied Micro Systems AML Smart SV +P 5466 $220 DQAs we_ekly ifin 10/30/2009 Purchased 2008, installed in
sensor Ltd. service spare fish
SEACAT Profiler Sea-Bird SBE 19plus 19P36026-4585 1.4D S220 DQAs weekly 12/24/2008 CON file: 4585.con
SEACAT Profiler Sea-Bird SBE 19plus 19P36026-4616 1.4D 1010 or 1018 DQAs weekly 12/30/2008 CON file: 4616.con
SEACAT Profiler Sea-Bird SBE 19plus 19P36026-4617 1.4D 1010 or 1018 DQAs weekly 12/20/2008 CON file: 4617.con
SEACAT Profiler Sea-Bird SBE 19plus V2 19P50959-6121 2.1 1010 or 1018 DQAs weekly 8/28/2009 CON file: 6121.con
SEACAT Profiler Sea-Bird SBE 19plus V2 19P50959-6122 2.1 1010 or 1018 DQAs weekly 8/29/2009 CON file: 6122.con
Real Time
Sound Speed Profiler RESON SVP 70 4008077 S220 DQAs weekly 1/4/2009
Real Time Odom Hydrographic -
Sound Speed Profiler Systems Digibar Pro 98013-041609 SW1.11 1018 DQAs weekly 4/16/2009
TIDES & LEVELING EQUIPMENT
’ . . Date of last
Equipment Type Manufacturer Model Serial Number Firmware and(or version Install Location Date of IastA Field Manufacturer Additional Information
Software Version Date Cal/Testing :
Cal/Service
Level Carl Zeiss N12 333 100056 N/A N/A S220 Mar-2009 Mar-2008
Level Carl Zeiss N12 333 103267 N/A N/A S220 Mar-2009 Mar-2008
Level Leica NA2 100 5332739 N/A N/A S220 Spare
Level Lecia NA2 100 5332747 N/A N/A S220 Spare




HORIZONTAL AND VERTICAL CONTROL EQUIPMENT

. . Firmware and/or Version Install ) Date of last Field Date of last
Equipment Type Manufacturer Model Serial Number Software Version Date Location CalfTesting Manufactgrer Additional Information
Cal/Service
GPS Reciever Trimble NetR5 4910K61066 4.03 Apr-2009 S220 Apr-2009 obtained Apr-2009 Bar Code: CD0001526972
GPS Antenna Trimble Zephyr Geodetic 2 S220 Apr-2009 obtained Apr-2009 no Bar Code
GPS Reciever Trimble NetR5 4910K61054 4.03 Apr-2009 S220 Apr-2009 obtained Apr-2009 Bar Code: CD0001526973
GPS Antenna Trimble Zephyr Geodetic 2 30767941 S220 Apr-2009 obtained Apr-2009 no Bar Code
GPS Receiver Ashtech Z-Xtreme ZE1200339016 ZE21 Mar-2008 S220 Apr-2009 obtained Apr-2004 Bar Code: CD0001062363
GPS Antenna Ashtech Geodetic 4 8365 S220 Apr-2009 obtained Apr-2004 No Barcode
UHF Radio FreeWave HTP-900RE 884-8978 217 Mar-2009 S220 obtained Mar-2009 Bar Code: CD0001526970
UHF Radio FreeWave HTP-900RE 884-9190 217 Mar-2009 S220 obtained Mar-2009 Bar Code: CD0001526971
UHF Radio FreeWave HTP-900RE 8849511 2.17 May-2009 S220 obtained May-2009 no Bar Code
UHF Radio FreeWave HTP-900RE 8849301 217 May-2009 S220 obtained May-2009 no Bar Code
UHF Antenna PCTEL MAX9053 S220 obtained May-2009 no Bar Code
UHF Antenna PCTEL MAX9053 S220 obtained May-2009 no Bar Code
UHF Antenna PCTEL MAX9053 S220 obtained May-2009 no Bar Code
UHF Antenna PCTEL MAX9053 S220 obtained May-2009 no Bar Code
Solar Charger PWM EPRC5 S220 obtained May-2009 no Bar Code
Solar Charger PWM EPRC5 S220 obtained May-2009 no Bar Code
Solar Charger PWM EPRC5 S220 obtained May-2009 no Bar Code
Solar Panel Uni-Solar FLX-32 USF-32-14639 N/A N/A S220 no Bar Code
Solar Panel Uni-Solar FLX-32 USF-32-14634 N/A N/A S220 no Bar Code
Solar Panel Uni-Solar FLX-32 USF-32-14633 N/A N/A S220 no Bar Code
Solar Panel Uni-Solar FLX-32 USF-32-14529 N/A N/A S220 no Bar Code
Solar Panel Uni-Solar FLX-32 USF-32-14631 N/A N/A S220 no Bar Code
Solar Panel Uni-Solar FLX-32 USF-32-14625 N/A N/A S220 no Bar Code
Solar Panel Uni-Solar FLX-32 USF-32-14645 N/A N/A S220 no Bar Code
Solar Panel Uni-Solar MBC-525 525-011590 N/A N/A S220 Bar Code: CD000684513
Solar Panel Uni-Solar MBC-526 525-011093 N/A N/A S220 Bar Code: CD000684507
Solar Panel Uni-Solar MBC-527 525-011589 N/A N/A S220 Bar Code: CD000684510
Solar Panel Uni-Solar MBC-528 525-011607 N/A N/A S220 Bar Code: CD000684512
Solar Panel Uni-Solar MBC-529 525-011587 N/A N/A S220 Bar Code: CD000684511
Solutions Dongles Ashtech 600586 (A) KEB2083 N/A N/A S220 no Bar Code
Solutions Dongles Ashtech 600586 (A) KEB2077 N/A N/A S220 no Bar Code




ADDITIONAL POSITIONING EQUIPMENT

Firmware and/or Version Install Date of last Field Date of last
Equipment Type Manufacturer Model Serial Number . Location . Manufacturer Additional Information
Software Version Date Cal/Testing :
Cal/Service
GPS RTK Receiver Trimble DSM-232 225111661 3.57 Mar-2008 S220 Bar Code: CD0001697439
GPS Receiver Trimble DSM-232RS 225111655 3.57 Mar-2008 S220 Bar Code: CDCD0001697422
DGPS Antenna Trimble 33580-00 220395038 N/A N/A S220
GPS Antenna Trimble Zephyr Geodetic 30325441 N/A N/A $220 no Bar Code
Antenna
GPS Antenna Trimble SPS MSK 5876 N/A N/A S220 no Bar Code
GPS RTK Reciver Trimble MS 750 220339262 Bar Code: CD 0001478898
GPS Antenna Trimble Trimble "ﬂ'flrfzcemere" 220298707 NIA NIA $220 NOAA Launch Barcode A2008
Position Data Link High Pacific Crest PDL 4135 0424 0171 2.40 Apr-2004 $220 5/3/2007 obtained Apr-2004 |  Bar Code: CD0001269910
Powered Base Unit
Position Data Link Rover Pacific Crest PDL 4100 04240154 24 Apr-2004 S220 5/3/2007 obtained Apr-2004
Position Data Link Rover Pacific Crest PDL 4100 03473047 2.32 Apr-2004 S220 5/3/2007 obtained Apr-2004
Position Data Link Rover Pacific Crest PDL 4100 04240155 24 Apr-2004 S220 5/3/2007 obtained Apr-2004




FAIRWEATHER Computers
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FA_Proc_1 Plot Room DELL Precision 490 XP Pro 2002 SP3 Nov-07 2.66 GHz 3GB 2 256 MB 9MP1PD1 CD0001615385 [New DELL deskptop installed week of 12/4/07
FA_Proc_2 Plot Room DELL Precision 490 XP Pro 2002 SP3 Nov-07 2.66 GHz 3GB 2 256 MB 4NP1PD1 CD0001615382 |New DELL deskptop installed week of 12/4/07
FA_Proc_3 Plot Room DELL Precision 490 XP Pro 2002 SP3 Nov-07 2.66 GHz 3GB 2 256 MB 6MP1PD1 CD0001615383 [New DELL deskptop installed week of 12/4/07
FA_Proc_4 Plot Room DELL Precision 490 XP Pro 2002 SP3 Nov-07 2.66 GHz 3GB 2 256 MB 2NP1PD1 CD0001615380 |New DELL deskptop installed week of 12/4/07
FA_Proc_5 Plot Room DELL Precision 490 XP Pro 2002 SP3 Nov-07 2.66 GHz 3GB 2 256 MB 3MP1PD1 CD0001615381 [New DELL deskptop installed week of 12/4/07
FA_Proc_6 Plot Room Dell Precision T3400 XP Pro 2002 SP3 Apr-08 3.0GHz 3GB 2 512MB 1JKCZF1 CD0001615471 |New DELL deskptop installed week of 04/06/08
FA_Proc_7* Plot Room DELL Precision 490 XP Pro 2002 SP3 Nov-07 2.66 GHz 3GB 2 256 MB 8MP1PD1 CD0001615384 |New DELL deskptop installed week of 12/4/07
FA_Proc_8 Plot Room Dell Precision T3400 XP Pro 2002 SP3 Apr-08 3.0GHz 3GB 2 512MB 5JKCZF1 CD0001615467 [New DELL deskptop installed week of 04/14/08
FA_Proc_9 Plot Room Dell Precision T3400 XP Pro 2002 SP3 Apr-08 3.0GHz 3GB 2 512MB 3JKCZF1 CD0001615472 |New DELL deskptop installed week of 04/06/08
FA_Proc_10 DP-2 Dell Precision T3400 XP Pro 2002 SP3 Apr-08 3.0GHz 3GB 2 512MB JHKCZF1 CD0001615468 |New DELL deskptop installed week of 04/06/08
FA_CST Field Office Dell Precision T3400 XP Pro 2002 SP3 Apr-08 3.0GHz 3GB 2 512MB 4JKCZF1 CD0001615469 |New DELL deskptop installed week of 04/06/08
FA_FOO Field Office Dell Precision T3400 XP Pro 2002 SP3 Apr-08 3.0GHz 3GB 2 512MB DHKCZF1 CD0001615470 [New DELL deskptop installed week of 04/06/08
FA_O-LAB* O-LAB Dell Prcision 360 XP Pro 2002 SP3 3.0GHz 3.5GB 2 128MB GBBG451 CD0001741480
Toughbook 1 Laptop Panasonic CF-18 XP Pro 2002 SP2 ~ March 2004 ~ July 2006 1.1 GHz 25GB N/A 1 64 MB 4HKSA59499 CD0001269860 |*rebuilt after crash July 2006
Toughbook 2 Laptop Panasonic CF-18 XP Pro 2002 SP2 ~ March 2004 ~ September 2005 | 1.1 GHz 25GB N/A 1 64 MB 4HKSA59560 CD0001269858
Toughtab 1 Laptop Panasonic CF-18 XP Pro 2002 SP2 ~ March 2004 ~ September 2005 | 1.1 GHz 25GB N/A 1 64 MB 4GKSA55049 CD0001269859
Toughbook 3 Laptop Panasonic CF-29 XP Pro 2002 SP2 March 2006 N/A 1.6 GHz 25GB N/A 1 128 MB | 6AKSB06863 | CD0001698251
Toughbook 4 Laptop Panasonic CF-30 XP Pro 2002 SP3 March 2009 1.7GHz 1Gb 0 384 MB | 8HKSB80630 CD0001447100 |out for service
Toughbook 6 Laptop Panasonic CF-30 XP Pro 2002 SP3 March 2009 1.7GHz 1Gb 0 384 MB out for service
Toughbook 5 Laptop Panasonic CF-19 XP Pro 2002 SP3 March 2009 1.1GHz 1Gb 1 384 MB | 9AKSB43281 CD0001696424
1010_ACQ Launch 1010 ICI XP Pro 2002 SP2 Mar-08 2.66GHz 3GB 3 128MB CD0001615466
1018_ACQ Launch 1018 ICI XP Pro 2002 SP2 Mar-08 2.66GHz 3GB 3 128MB CD0001615463
S220_ACQ Plot Room Dell Precision T3400 XP Pro 2002 SP2 Mar-08 3.0GHz 3GB 3 512MB CSH8NF1 CD0001615444
FA_MVP200 Plot Room MVP-C1-2001 2000 SP4 ~ March 2004 ~ September 2005 | 2.4 GHz 230 MB 230 MB 1 64 MB SN: 10330 CD0001269854




Appendix Il

Equipment Specifications

1. Sonar Systems
a. RESON

i

.

il.
b. VBES

i

.

il.

c. SSS

i

2. Positioning

8101 Equipment Specs
8111 Equipment Specs
8160 Equipment Specs

Odom Echotrac CVM
SMBB200-9 Transducer Information
SMSW?200-4a Transducer Information

Klein 5000

a. POS MV

b. DGPS

i
il
3. Shoreline

v320

MBX-3S
SF-2050

a. Trimble

b. Lasers

i.
ii.
4, SV

a. MVP
i.
b. SBE
i.
ii.
iii.
iv.
V.
Vi.
Vii.

5. Control

Accuracy

Specs
TSCe

TruPulse 200
Impulse 200 LR

MVP 200

SBE 45

SVP 70
Specs-19p-4585
Specs-19p-4616
Specs-19p-4617
Specs-19pV2-6121
Specs-19pV2-6122

a. Leveling

Leica NA2 level
Zeiss NI2 level

b. HorCon

PDL
Z-Xtreme Ashtech GPS



6. Total Stations
a. Nikon DTM310
b. Sokkia SET5F



SeaBat 8101
PRODUCT SPECIFICATION

240kHz MULTIBEAM ECHO SOUNDER

Phase and Amplitude
Bottom Detection

150° Wide Swath
Coverage

240 kHz Frequency

Up to 500m Range
"""" Capability

Portable
Configuration

Meets USACE Class 1
Standards

Meets IHO Standards

The SeaBat 8101 Multibeam Echo Sounder measures discrete depths, enabling
complex underwater features to be mapped with precision. Dense coverage is
achieved utilizing up to 3,000 soundings per second for a swath that can be over
500 meters wide, even as the survey vessel travels at speeds of over 18 knots.

With high accuracy and a measurement rate up to 30 profiles per second, the
SeaBat 8101 enables surveys to be completed faster and in greater detail than
previously realized. The SeaBat is an integral part of the new, integrated
bathymetry surveying systems.

B - - The SeaBat transducer is available pressurized for depths from 100 to over 3,000
meters. Small and lightweight, it can be can be mounted on small un
vehicles (ROV, AUV or towed) and taken to where accurate measure
required.

RESON AfS RESOM INC. FESON OFFSHORE LTD.
Dermark USA United Kingdam
Tel:+4547 3300 22 Tel:+1 05 964-62680  Tel:+04 1224 727 427

Fx : + 45 47 38 00 66 Fax 41 805 964-T537  Faoco 4841204 727 438
E-mail: reson@rosondk - sales@veson.com salos@reson.infotrade.co.uk

http://www.reson.com
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SeaBat 8101 Built-In Test
Environment (“BITE”) Screen

DISPLAY SPECIFICATIONS

Screen Size: 14 inch Diagonal
Input: SVGA (800x600, 72 Hz)
Display: High Resolution Color

Power Consumption:

62 W

PROCESSOR SPECIFICATIONS

Power Requirements:

Data Output:

Video Output:

Graphics Colors:

115/230VAC, 50/60Hz,
100W max.

Selectable, 300-155.2 Kbaud
or Ethernet 10 base T

or 10 base 2

SVGA (800x600, 72 Hz)

or NTSC or PAL video.

256 colors (8-bit)

SYSTEM SPECIEICATIONS Dlsplay Mode: Sector Format
Display Arc: 150°
Operating Frequency: 240kHz Igp;ter?s\gﬁg i’gBl:;t(?: Zﬁi‘kbﬁn
Range Scales: 5, 10, 15, 20, 25, 35, 50, 75, 100, 125, ! 1ons- (266X48’3X434'r?1m HWD)
150, 175, 200, 250, 300, 350, 400, 450, )
Temperature: Operating: 0° to +40°C
500m.
— Storage: -30° to +55°C
Range Resolution: 1.25cm Weight: 20 ka (44 Ib
Number of Beams: 101 elght: g S)
Horizontal Beamwidth: 1.5°
Horizontal Coverage: 150°
Vertical Beamwidth: 1.5°

Update Rate:

Range-variable up to
30 times per second

SONAR HEAD SPECIFICATIONS

Power Requirement:

24VDC, 2 Amps max.
(Power available from
surface processor.)

SeaBat 8101 Head

Uplink: Digital, 76.8 Mbaud with j Fairings
Down Link Control: RS-232 or RS-422, 19,200 baud %qycﬁlejNg
Operating Depth: 100 meters
P 'ng Lep Option 033: Side Scan Upgrade

(300m, 1500m, 3000m & 6000m avbl.)

Option 034:

Mounting Plate Assembly

Dimensions: 266x320mm W/Diam . - .
(does not include projector) Option 035: Fairings (pictured above)
Temperature: Operating: -5° to +40°C Opt!on 036: S_pargs Kit .
Storage: -30° to +55°C Option 037: Titanium Housing
Weight (aluminum): Dry: 26.8 kg (59 Ibs) Option 038:  210° Swath _
Wet: 4.8 kg (10.6 Ibs) Option 040: Extended-Range Projector
Option 049: Increase Transducer Depth

Weight (titanium): Dry: 40 kg (88 Ibs)

©1999 RESON Inc.

Wet: 18 kg (39.6 Ibs)

Rating

Version 4.0
032399

Due to our policy of continuous product improvement,
specifications are subject to change without notice.

g



SeaBat 8111

B PRODUCT SPECIFICATION
— | MULTIBEAM ECHOSOUNDER

e Phase and amplitude
bottom detection

e 100 kHz frequency
e 150° swath coverage

¢ Real-time quality
control

e Sidescan upgradeable
e Modular and portable

e Pitch stabilization

The SeaBat 8111 is a modular multibeam echosounder system operating at
100 kHz. When installed on a vessel, it produces high-density, high-accuracy
soundings on the seafloor over a 150° swath. Major system components
include a transducer array, a transceiver unit, and a processor unit.

The SeaBat 8111 transducer array is comprised of a cylindrical receive array
and a linear transmitter array, mounted together on a support cradle that
provides mounting points to the vessel. Lightweight and portable, the array
can be installed temporarily over the side of a vessel of opportunity—a first for
a system in this frequency range.

The SeaBat 8111 transceiver features plug-in cards for easy maintenance and
is controlled from the sonar processor.

The Seabat 8111 processor is compatible with other SeaBat sonar heads, can
be updated in minutes to accommodate future requirements, and features a

user-friendly point-and-click interface.

www.reson.com

RESON A/S RESON Inc. RESON Offshore Ltd. RESON GmbH RESON SA(PTY)LTD  RESON-Telenav
Denmark USA UK Germany South Africa Singapore

Ph: +4547 3800 22 Ph: + 1 805 964 6260 Ph: + 44 1224 709 900 Ph: + 49 431 720 7180 Ph: + 27 21 786 3420 Ph: + 65 6 872 0863
Fax: + 4547 38 00 66 Fax: + 1 805 964 7537 Fax: +44 1224 709 910 Fax: +49431 7207181 Fax: +27 21 786 3462 Fax: +656 872 1334

email: reson@reson.dk  email: sales@reson.com  email: sales@reson.co.uk  email: reson@reson-gmbh.de  email: reson@reson.co.za email: telenav@mbox2 singnet.com.sg



SeaBat 8111 SYSTEM SPECIFICATIONS
SYSTEM PERFORMANCE

MECHANICAL INTERFACE

Frequency:
Range Resolution:
Swath Coverage:

Range:

Number of Beams:

Along-Track Beamwidth:

Across-Track Beamwidth:

Stabilization:

Projector Beam Control:

Accuracy:
Operational Speed:
Max. Update Rate:

Transducer Pressure Rating:

100 kHz
3.7 cm
150°

3m to 1200m
(with Option 040)

101

1.5° 3.0° 4.5° 6.0°*

1.5°

Pitch stabilization
within +/-15°

External motion
sensor required

IHO Compliant
Up to 20 knots
35 Hz
100m

*
operator selectable

INTERFACE

System Supply:

Video Display:
System Control:

Data Output:

Data Uplink:

Temperature:

90 to 260VAC, 50/60 Hz,

200W max.
SVGA, 800 x 600, 72 Hz

Trackball or from Ethernet

10 MB Ethernet or
serial RS232C

High-speed digital coax
with fiber-optic option

Operating: 0° to +40° C
Storage: -30° to +55° C

RELATED PRODUCTS

Dimensions (in mm):
Transducer Array:
Hydrophone:
Projector:
Processor:
Transceiver:

Weight:
Transducer Array:

Processor:
Transceiver:

Cable Length:

4[34

636 x 118 (Dia./Length)
113 x 650 (Dia./Length)
177 x 483 x 417
267 x 483 x 489

72 kg (dry) / 59 kg (wet)
with cables

20 kg
13.6 kg

15m

Transceiver

/)“

—' T
Hydrophone Projector
Transducer Array
SEAFLOOR COVERAGE

489

(with Extended Range option)

e Option 040
e Option 033
e Option 051

Extended range capabilities
Sidescan upgrade
24DC power supply for SeaBat

81-P Processor

Bottom Depth (meters)

Swath Width (meters)

5to 150 Up to 1110 (7.4 x water depth)
300 960 (3.2 x water depth)
450 810 (1.8 x water depth)
600 600 (1.0 x water depth)
750 450 (0.6 x water depth)
900 360 (0.4 x water depth)

Version: B0O06 030205
©1999 RESON Inc.

Due to our policy of continuous product improvement,
RESON reserves the right change specifications without notice.




SeaBat 8160

PRODUCT SPECIFICATION
MULTIBEAM ECHOSOUNDER SYSTEM

e Swath coverage
greater than 4x
water depth

e Operational depth:
10m to 3000m

¢ 50 kHz frequency
e 126 beams

e Hull-mount or
portable

e Meets IHO
accuracy

e Sidescan
upgradable

The SeaBat 8160 is a new addition to the 8100 series of multibeam
~echosounders. Operating at 50 kHz, the system ensonifies the whole
swath in-a-single ping, generating 126 simultaneous high-resolution
receive beams.

The SeaBat 8160 transducer array is comprised of a linear receive and
transmit array mounted together on a support-base. The T-shaped array
geometry provides the basis for a compact, high-resolution sonar which
is easily installed for portable or hull mounts—a first for a high-resolution
system in this frequency range.

The system features a pitch-stabilized transmitter and an active roll-
compensated receiver.

The SeaBat 8160 processor is compatible with other SeaBat sonar heads.
It can be updated in minutes to accommodate future requirements, and
features a user-friendly point-and-click interface.

RESON A/S « DENMARK RESON, INC. e USA

Tel +4547 38 00 22 Tel +1 805 964 6260

Fax +45 47 38 00 66 Fax +1 805 964 7537

Email: reson@reson.dk Email: sales@reson.com

RESON OFFSHORE e UK RESON, GmbH ¢« GERMANY
Tel +44 1224 709 900 Tel +49 4317207180

Fax +44 1224 709 910 Fax +49 431 720 7181

Email: sales@reson.co.uk Email: reson@reson-gmbh.de

www.reson.com



SeaBat 8160 SYSTEM SPECIFICATIONS

SYSTEM PERFORMANCE

INTERFA

CE

Frequency:
Depth Resolution:

Swath Coverage:

50 kHz
24 cm /9.6 cm

Greater than 4x
water depth

System Supply:

350W

Video Display:

System Control:

115V/230V 50/60 Hz,

SVGA, 800 x 600, 72 Hz

Trackball or from
Ethernet

Max Operational Depth: 3000 m
) Data Output: 10 MB Ethernet or
Number of Beams: 126 serial RS232C
- i . o
Along-Track Beamwidth: 1.5 Data Uplink: High-speed digital coax
Across-Track Beamwidth: 1.5° with fiber-optic option
Pitch Stabilization: +10° Temperature: Operating: 0° to +40° C

Accuracy:

Operational Speed:

Max. Update Rate:
Transducer Depth Rating:

IHO Special Order
Up to 20 knots
15

Storage: -30° to +55° C

MECHANICAL INTERFACE

Dimensions (HWD in mm):

Transceiver

1100mm 90.5mm Transducer Array: 1474.5 x 1100 x 90.5
. - Processor: 177 x 483 x 417
124.5
" . F Transceiver: 265 x 483 x 492
ik Weight:
Transducer Array: 50 kg (dry) / 30 kg (wet)
1350mm dk i Processor: 20 kg
Transceiver: 13.6 kg
) Transducer Array i
e
0 .|]_u1.u_|.LL|.|.LLI.u.I_u_|.|.|.|.u_|.|.|].__
- A1/
150mm 100m 489
| 483 “ﬁj
177
Mounting Frame Mo g
Option 034H Q . . N i

Processor

Version: B34-PDF-011009

Due to our policy of continuous product improvement,
RESON reserves the right change specifications without notice.
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The rugged and weatherproof Echotrac CVM™
outperforms other echo sounders in its class,
offering the utmost in portability without
sacrificing Odom performance standards.

ODOM

ECHOTRACCVM

With dual or single frequency configurations, optional built-in DGPS and bundled notebook
PC and your choice of data acquisition software, the CVM™ has everything you need in an
echo sounder —even when portability isn’t an issue.

Buy Odom - invest in your peace of mind.

S PECIFICATIONS

Frequency

+ High band: 100 kHz - 340 kHz

+ Low band: 24 kHz - 50 kHz
Output Power

« High: 200 kHz - 400 W RMS max
+ Low: 33 kHz-200 W RMS max
Input Power

+ 12to 24V DC (nominal) 15 watts
+ 1100r220VAC

Resolution

+ 0.01 m/0.1 ft

Accuracy

+ 0.01 m/0.10 ft +/- 0.1% of depth @ 200 kHz
+ 0.10 m/0.30 ft +/- 0.1% of depth @ 33 kHz

Depth Range

+ 0.2-200m/0.5-600 ft.@ 200 kHz
+ 0.5-600m /1.5-1968 ft.@ 200 kHz

Phasing

« Automatic scale change, 10%, 20%, 30% overlap or

manual

Sound Velocity

+ 1370-1700 m/s

+ Resolution 1 m/s

Transducer Draft Setting

« 0-15m(0-50ft)

Depth Display

+ On control PC

Clock

« Internal battery backed time,
elapsed time and date clock

Annotation

- Internal - date, time, GPS position
« External - from RS232 or Ethernet

Interfaces

« 2xRS232

« Inputs from external computer,
motion sensor, sound velocity

- Outputs to external computer

- Ethernetinterface

+ Heave - TSS and sounder sentence

Blanking
«+ 0tofull scale

Software

« Echotrac Control software

+ ChartView display and logging software

Help

- The function of each parameter and
its minimum and maximum values can
be displayed.

Environmental Operating Conditions

« 0°-50°C, 5-90% relative humidity, non-
condensing

Dimensions

+ 53cm(20.75in) Wx 44 cm (17.25in) D x
21.5cm (8.5in)H

Weight

+ 13.8kg (31 Ibs)

Options

+ One or two acoustic channels

« Side scan transducer - single or dual
channel side looking 200 kHz or 340 kHz
for search and reconnaissance

« Built-in DGPS

+ Ruggedized notebook PC bundled with data
aquisition software

@

[

odom

HYDROGRAPHIC SYSTEMS

1450 Seaboard Avenue
Baton Rouge, Louisiana 70810-6261 USA
E-mail: email@odomhydrographic.com

www.odomhydrographic.com

ODOM HYDROGRAPHIC SYSTEMS, INC. (225) 769-3051 - (225) 766-5122 FAx




Odom Hydrographic Systems, Inc.
1450 Seaboard Avenue

(g Baton Rouge, LA. 70810 -6261

odomhydrographic.com

SMBB200-9

225.769.3051, Facsimile 225.766.5122

1/2-14 NPS THREADS
@ 22mm
[0.867]
_ 84 mm
] [3.297]
43 mm 25 mm
1.717] [1.00%]
Performance Data
Frequency 200kHz - BClg
Beam Width 9°
Q (transmit) 2.5
Rated RMS Power 500 W
Balanced Impedance 60 ohms
Peak Figure of Merit -16
Bandwidth
Acoustic Window Material Urethane
Threads 12" —14NPS
Cable Type C33 (2-20 AWG)
Cable Size 6Mmm
Weight 1.3Kg.

Broadband with superlow Q of 2.5. Small housing with short stem
used primarily for navigation and survey applications. This model is
usually mounted on an extension tube but is adaptable to portable

survey and navigation systems.

[t contains a transformer which can

be used to match the impedance of the echosounder or allow the use

of longer cables.

The transducer is available in either a bronze or

stainless steel housing. Model SS510 provides good definition in hard

bottoms with side lobes.

SMBB200-9_information_sheet
Stern Mount, 200khz-9d, BROADBAND, SS510-2, C33, 10m,5P



Odom Hydrographic Systems, Inc.

1450 Seaboard Avenue

(g Baton Rouge, LA. 70810 -6261
odomhydrographic.com 225.769.3051, Facsimile 225.766.5122

. : {2.85"
SMSW200-4a ' =
@ 108mm
1 0
FAT =14 NPS
THREADS
! =5 e
1.05]
L : j
1 3%mm g i
2 .o —f &=
1
43 mm
[1.67¢]

Performance Data

Frequency 200kHz
Beam Width 4°
Q (transmit)
Rated RMS Power
Balanced Impedance 60 ohms
Peak Figure of Merit
Bandwidth
Acoustic Window Material Urethane
Threads %" —14NPS
Cable Type C37 (2-20 AWG)
Cable Size B6mm
Weight 1.3Kg.

The compact stainless steel housing is easily adapted to portable or hull
mounted applications. This unit is primarily used for shallow and mid-depth
survey applications where delineation of steep slopes and sounding in very
shallow water are important features. It contains a transformer that matches
the impedance of the transducer to that of the echo sounder and allows for
the use of longer cables without affecting performance.

SMSW200-4a_information_sheet
Stem Mount, Shallow Water BB 200kHz-4d,55538,C37,10m,SS,5p




Klein Associates, Inc.

KLEIN SYSTEM 5000

HiGH-RESOLUTION, DYNAMICALLY FOCUSED,
|V|ULTI BEAM SIDE SCAN SONAR

Conventional side scan sonar systems use a
single sonar beam per side to generate an image of
the seafloor. The physics of this type of sonar
results in degradation of image resolution with
range poor along track resolution, and requires
speeds of 5 knots or less to insure 100 percent
bottom coverage.

From a design perspective, these shortcomings can
be eliminated by designing a sonar that, through
beam steering and focusing techniques, simul-
taneously generates several adjacent, parallel
beams per side. Such a multi-beam design
approach permits higher towing speeds with 100
percent bottom coverage, while providing KEY FEATURES

high-resolution imaging to the maximum range of

e Multiple simultaneous beams

the sonar. per side each ping

This design approach is principally employed * High tow speed capability

by military side scan sonar systems designed e Dynamic digital auto-focusing
for high speed mine hunting applications. L-3 Klein « Very high resolution and 100%
is the first commercial company to offer coverage

a multi-beam side scan sonar using similar design « Sonar connected to PC display

techniques to military sonars, but at a fraction of on Ethernet LAN
the cost.

The two main benefits of the high-speed,
high- resolution System 5000 series are:
higher towing speeds with no loss of bottom
coverage, and range independent high-resolution
image capability.

Since operation costs are dependent on the amount
of at-sea time required to complete a survey, the

Klein System 5000 Multi-Beam Side Scan Sonar THE DIFFEREN c E

with survey speeds more than twice that of
conventional side scan sonars, minimize at-sea IS IN TH E IMAGE

time, thus greatly reducing survey costs.

C?ISR > GOVERNMENT SERVICES > AM&M > SPECIALIZED PRODUCTS '



Klein Associates, Inc.

KLEIN SYSTEM 5000

HiGH-RESOLUTION, DYNAMICALLY FOCUSED,
MuLTIi-BEAM SIDE SCAN SONAR

Towfish Specifications Transceiver Processor Unit (TPU) Specifications

i Standard 19-in rack-mount

Tow Cabhle

Type: steel Coaxial or fiber-optic double armored

Number of beams 5 port & 5 starboard
Range scales i 50, 75,100, 150 m
Pulse length 50 to 200 psec.

High-resolution mode 10 cm to 38 m
(along track) H

Standard resolution 20 cm to 75 m, thereafter
mode (along track) i increasing to maximum of 36
i ¢cm @ 150 m maximum range

Resolution (across track) 7.5 to 30 cm
Sonar digitization 16 bit / channel
Maximum operating range i 150 m (300 m Swath) Workstation PC

Eouyalaiot 194 cm (764 1m) SonarPro” installed : Optional, with SonarPro software

Sensors: :
Heading : Standard
Pitch & roll i Standard

Pressure / altimeter Standard
Depth rating* { 200 m standard Klein Associates, Inc.

Options 11 Klein Drive

Klein.Mail@L-3com.com communications

* For deeper depth rated systems, please contact Klein www.L-3Klein.com Klein Associates, Inc.

Windows 0S installed : installed

L-3. Headquartered in New York City, L-3 Communications employs over 64,000 people worldwide and is a prime contractor in aircraft
modernization and maintenance, C3ISR (Command, Control, Communications, Intelligence, Surveillance and Reconnaissance) systems and
government services. L-3 is also a leading provider of high technology products, subsystems and systems.

Cleared for public release. Specifications subject to change without notice. Call for latest revision. Windows NT, 2000, VxWorks, and Kevlar - are registered trademarks
of Microsoft Corp., Wind River Systems, Inc., and DuPont - respectively. SonarPro® is a registered trademark of L-3 Klein Associates, Inc. 4/09



Pos MV marine vessels

The New POS MV - Providing the Marine Industry with robust, reliable, and
repeatable position and orientation solutions

The new POS MV V4 - a tightly-coupled system utilizing
advanced Inertially-Aided Real-Time Kinematic (IARTK)
technology designed to increase your operational capability
and reduce downtime.

Tightly integrated inertial navigation — Continuous positioning
data can be generated while surveying in areas where GPS reception
is compromised by multipath effect and signal loss, such as close to
offshore structures, or in ports, harbors, near-shore coastal waters
and rivers. Raw GPS data from as few as one satellite can now be
processed directly within the POS MV reducing position drift and RTK
re-acquisition time.

The V4 Advantage

The Major Benefits

»  Faster, more robust heading aiding from GPS Azimuth
Measurement Subsystem (GAMS) when compared toV3

*  Proprietary Inertially Aided RTK providing almost
instantaneous reacquisition of RTK following a GPS outage

*  Superior low elevation tracking performance using lighter,
smaller Trimble Zephyr ™ geodetic antenna technology

»  Faster initial system calibration

*  Maintains heading accuracy longer when in a high multipath
environment

*  Increased component reliability

*  Automatic identification and error estimation for lever arm
distances and angles

The Latest Technology
V4 uses the latest Trimble BD950 receivers with the following
attributes:

*  Extremely fast response time

*  Latency of less than 20 milliseconds (at 20 times per second)

*  Very low noise LI and L2 carrier phase
measurements

*  Uses the Maxwell 4 Custom Survey
GPS chip for enhanced tracking
capability

Straightforward Installation and Operation
e All components mounted and installed using a straightforward,
one-time-only, systematic procedure.

Faster, More Reliable Networking Potential
e Animproved Ethernet raw data logging capability for
streamlined data acquisition of all motion variables with
microsecond-accurate time stamping

Upgradeability*
*  Convenient upgrade program for PCS and antennas, to allow
for maximum interoperability when moving from LI only to a
full L1/L2 RTK unit

The Most Accurate Position and Orientation Solution
POS MV V4 maintains positioning accuracy under the most demanding
conditions regardless of vessel dynamics.With its high data update rate,
the system delivers a full six degree-of-freedom position and orientation
solution to provide the following:

*  Position (latitude, longitude and elevation)

e Velocity (north, east and vertical)

e Attitude (roll, pitch and true heading)

*  Heave (real-time, delayed)

*  Acceleration Vectors

*  Angular Rate Vectors

* For detailed upgrade information please call your Applanix Marine office

SYSTEM COMPONENTS

POS Computer System (PCS) — A rugged, compact computer system contains the
core POS processor and IMU interface electronics, plus two GPS receivers and an optional
removable PC-card disk drive.The PCS provides system timing, position and velocity aiding,

together with GPS raw observables for use with GAMS.

POS Inertial Measurement Unit — The system’s primary sensor allows for the

continuous output of position and orientation data.

Primary GPS Receiver Antenna — A dual frequency antenna for use with GAMS.

Secondary GPS Receiver Antenna — A dual frequency antenna for use with GAMS.

APPLANIX

A TRIMBLE COMPANY



Accuracy

Pos MV marine vessels

POS MYV 320 Main Specifications (with Differential Corrections)

Roll, Pitch accuracy:

Heave Accuracy:
Heading Accuracy:

Position Accuracy:

Velocity Accuracy:

0.02° (I sigma with GPS or DGPS)
0.01° (I sigma with RTK)

5 cm or 5% (whichever is greater) for periods of 20
seconds or less

0.02° (I sigma) with 2 m antenna baseline, 0.01 (I
sigma) with 4 m baseline

0.5 -2 m (I sigma) depending on quality of differential
corrections

0.02 - 0.10 m (RTK) with input from auxiliary RTK or
optional internal RTK receiver

0.03 m/s horizontal

POS MYV 320 during GPS Outages

Roll, Pitch accuracy:

Heave accuracy:
Heading accuracy:

Position accuracy
degradation:

0.02° (I sigma)

5 c¢cm or 5% (whichever is greater) for wave periods
of 18s or less

Drift less than |° per hour (negligible for outages <
60s)

2.5 m (I sigma) for 30 s outages
<6 m (| sigma) for 60 s outages

POS MV 220 Main Specifications (with Differential Corrections)

Roll, Pitch accuracy:

Heave Accuracy:
Heading Accuracy:

Position Accuracy:

Velocity Accuracy:

0.05° (I sigma with GPS or DGPS)
<0.05° (I sigma with RTK)

5 cm or 5% (whichever is greater) for periods of 20
seconds or less

0.1° (I sigma) with 2 m antenna baseline, 0.05° (I
sigma) with 4 m baseline

0.5 - 4 m (I sigma) depending on quality of differential
corrections

0.02 — 0.10 m (RTK) with input from auxiliary RTK or
optional internal RTK receiver

0.05 m/s horizontal DPGS, .03 m/s horizontal RTK

POS MYV 220 during GPS Outages

Roll, Pitch accuracy:

Heave accuracy:
Heading accuracy:

Position accuracy
degradation:

0.05° (I sigma)

5 cm or 5% (whichever is greater) for wave periods
of 18s or less

Drift less than 3° per hour (negligible for outages <
60s)

2.5 m (I sigma) for 30 s outages
<6 m (| sigma) for 60 s outages

Applanix Marine Offices

Applanix Corporation
85 Leek Crescent
Richmond Hill, Ontario
Canada L4B-3B3

Tel: +1 905-709-4600
Fax:+1 905-709-6027

Applanix LLC
17461 Village Green Drive
Houston, TX
USA 77040

Tel: +1 713-896-9900
Fax:+1 713-896-9919

Physical Characteristics

Size
IMU: 204 mm X204 mm 7.95in X 7.95in

X 168 mm X 6.55in
PCS: 432 mm X 89 mm  17.00 in X3.50 in

X 356 mm X 14.05 in

2.0U 19 in rack

mount
GPS Antenna (x2): 187 mm X 53 mm  74in X 2.1 in
Weight
IMU: 3.5kg 7.7 |b (international)
Processor: 5 kg 11.0 Ib (international)
GPS Antenna: <0.5 kg <l.1 Ib (international)
Power
Processor: 110/230 Vac, 50/60 Hz, auto-switching 80 Watt
IMU: Power provided by PCS
GPS Antennas: Power provided by PCS
Environmental

Temperature Range (Operating)

IMU: -40 °C to +60 °C
0°Cto +55°C

-40 °C to +70 °C

Processor:
GPS Antenna:

Temperature Range (storage)
IMU: -40 °C to +60 °C

-40 °F to +140 °F
+32 °F to +131 °F
-40 °F to +158 °F

-40 °F to +140 °F

Processor: -25°Cto+85°C  -13 °Fto +185 °F
GPS Antenna: -50°Cto +70 °C  -58 °Fto +158 °F
Humidity

IMU: 10 - 80% RH, Ingress Protection of 65
Processor: 10 - 80% RH, non-condensing

GPS Antenna: 0 - 100% RH

Shock & Vibration (IMU)
Operating:

Non-Operating:

90 g, 6 ms terminal saw tooth
220 g, 5 ms half-sine

Applanix United Kingdom

Forester’s House,

Old Racecourse, Oswestry
SY10 7PW UK

Tel: +44 1691 659359
Fax: +44 1691 659299




APPLANiIX

TRIMBLE COMPANY
17461 Village Green Drive, Houston TX 77040
Tel: 713-896-9900 Fax: 713-896-8919

TO: NOAA- Ship Fairweather
1801 Fairview Ave E.
Seattie, WA 98102

ATTN: Larry Loewen

REPAIR REPORT

RMA #: L07-024

Date: 15 January, 2008
Repaired By: Bruce A. Francis

TEL: TEL: 713-896-9900
FAX:
PART NO. DESCRIPTION SERIAI. NUMBER
PCS29  |POSMV 320 V4 2560
PCS-29  |POSMV 320 V4 2564

ORIGINAL COMPLAINT / FAULT DESCRIPTION / VERIFICATION

IMU errors, GPS data gaps.

ITEM

REPAIR DETAILS

b

this problem.

B W

O oO~NOO,

We were able to reproduce problems with both PCS units in the shop- intermittant IMU failures.
2|Found resistor R on the power supply board not soldered correctly. This has been identified as a fault in POS
systems and have confirmed that these serial numbered units did received the fauity batch of power supplies with

Resoldered R9 and retested both systems on the bench for a number of days. No faults observed.

Installed latest firmware version 3.42 on both units whereas the previous version was 3.41. Version 3.42 adds
ASCII IP address output to COMS5 at bootup only to identify setting should it get changed by previous user.

Please verify all settings before use

ITEM pPTY

MATERIAL

—_

16hrs |Labor

N/C

ADDITIONAL INFORMATION & COMMENTS

As this issue with R9 was of our own making, there is no charge for this repair.

Applanix Repair Report RMA £07-024 NOAA PCS 2560 2564.xls

1 of 1
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©  csi wireless. " M BX- 3 S

The most popular commercial-grade
Coast Guard Beacon Receiver

* Dual-channel Coast Guard beacon receiver * Low power consumption extends battery life

* Supplements GPS systems with free differential corrections, * Automatic tuning mode for hands-free operation

enhancing accuracy * Integrated signal splitter outputs GPS signal from combined

* Fast signal acquisition GPS /differential antennas

* Wide input voltage range for a variety of power sources * Front-panel interface for easy configuration and status monitoring

csi wireless.

AUTHORIZED

BUSINESS PARTNER www.csi-wireless.com



The most popular commercial-grade DGPS Beacon Receiver

Receiver Specifications

Channels:
Channel Spacing:
Frequency Range:
MSK Bit Rates:
Cold Start Time:
Warm Start Time:
Demodulation:
Sensitivity:
Dynamic Range:
Frequency Offset:

Adjacent Channel Rejection:
Correction Output Protocol:

Input Status Protocol:

Communications
Interface:
Baud Rates:

2 independent channels
500 Hz

283.5 to 325.0 Hz

50, 100, 200 bps

<I min

<2 seconds

Minimum shift keying
2.5 pV/m for 6 dB SNR
100 dB

+8 Hz (27 ppm)

61 dB f, + 400 Hz
RTCM SC-104

NMEA 0183

RS-232C or RS-422
2400, 4800, 9600

Environmental Specifications

Operating Temperature:
Storage Temperature:
Humidity:

EMC:

Power Specifications
Input Voltage Range:
Nominal Power:

Nominal Current:

Antenna Voltage Output:
Antenna Input Impedance:

-30°C to +70°C

-40°C to +80°C

95% non-condensing
EN 60945

EN 50081-1

EN 50082-

FCC: Part 15, sub-part J,
class A digital device

9 to 40VDC
2.5W
210 mA

10VDC (5 VDC optional)

50 Q

Mechanical Specifications

Operating Modes
MBX-3 Mode (Default): RTCM SC-104 correction and
NMEA status message output
(Default Mode)

RTCM SC-104 correction and
NMEA status message output
and GPS NMEA message
input for position and satellite
status display

MBX-E Mode:

NMEA 0183 I/O

Receiver Automatic and Manual tune command
Frequency and data rate query

Receiver performance and operating status queries
Automatic search almanac queries (proprietary)
Baud rate selection command

Receiver tune command

Force cold start command (proprietary)

Software upgrade command (proprietary)
Configuration up-load command (proprietary)

Accessories

Antenna: Various
Power Cables: Various
Antenna Cables: Various
Data Cables: Various
CSI Beacon

MS Windows 95® beacon
control software

Command Center:

Pin-out

RS, 232C (DB9 PIN#)

Pin 2 TXD,RTCM SC-104/Status Output
Pin 3 RXD, configuration input

Pin 5 Signal return

150 mm Lx 125 mmW x 51 mmH
(5.9” L x4.9”W x 2.0” H)

Dimensions: RS-422 (DB9 PIN#)

Weight: 0.64 kg (1.4 1b) Pin 1 TXD +,RTCM SC-104 /
Display: 2-line x |6-character LCD Status Output

Keypad: 3-key switch membrane Pin 2 TXD -, RTCM SC-104 /
Power Connector: 2-pin circular locking Status Output

Data Connector: DB9-S Pin 4 RXD -, configuration input
Antenna Connector: BNC-S Pin 5 Signal return

Optional GPS Output Port:  TNC-S Pin 7 RXD +, configuration input

© Copyright September 2002, CSI Wireless Inc. All rights reserved. Specifications subject to change without notice.
CSl Wireless and the CSI Wireless logo are trademarks of CSI Wireless Inc. Made in Canada.

Warranty: Each CSIWireless product is covered by a limited one-year warranty on parts and labor.

CSl Wireless Dealer

csi wireless.

4110 - 9th Street SE - Calgary = AB - Canada - T2G 3C4
Phone (403) 259+33I1 - Fax (403) 2598866

Avery label #05260 (laser print)

Printed in Canada.
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receivers provide
position information for decimeter-level
position accuracy, anywhere in the world,
anytime. Onboard memory, and a geodetic
quality antenna enable millimeter level
accuracy from post-processing.

APPLICATIONS

The rugged and reliable SF-2050 series is
designed for productivity with minimal

setup time. The SF-2050G is designed for
backpack GIS and mapping applications while
the SF-2050M is ideal for vehicle mounting
to suit a wide variety of machine guidance and
control applications. The primary operating
mode uses the StarFire™ service, and offers
decimeter level accuracy for immediate results
in the field; great for navigation and relocation
of existing assets. The two onboard
WAAS/EGNOS channels provide free

GPS corrections, which coupled with dual
frequency measurements and NavCom'’s
enhanced SBAS algorithm typically provides
half-meter real-time accuracy. Simply connect
your controller solution to the serial port and
receive NMEA format position information,

or use a NavCom Partner controller solution
for additional configuration and monitoring
capabilities.

BENEFITS

The SF-2050 receivers use our NCT-2100D
GPS Engine, the fourth generation of the
Touchstone™ ASIC family, of which more
than 25,000 are in use worldwide. This
incorporates our patented interference
suppression and multi-path mitigation, up
to 50Hz raw data rate, geodetic quality
measurements, and up to 25Hz positioning.

The SF-2050 utilizes a compact tri-band
antenna capable of receiving GPS and
StarFire signals. This antenna provides
excellent phase center stability in a small,
robust, lightweight format.

Coupled with NavCom Technology's StarFire
subscription service, the SF-2050 delivers

10 cm position fixes without the use of a
second receiver serving as a base station.
Add the RTK option to your SF-2050, and

an external radio capable of receiving RTK
corrections from a Base station, and now your
SF-2050 is able to do RTK level surveys for
unsurpassed accuracy.

SF-2050G
SF-2050M

i = [ 2
maximum flexibility, the receivers offer a bin
user interface that allows for complete
command and control of the GPS and L-Band
Module, thus enabling customization of the
interface and receiver operation. The sensor
can receive GPS corrections in NCT
(NavCom'’s ultra compact binary format),
RTCM and CMR thus permitting optimum
correction source usage with seamless
position output.

FEATURES
e Fully integrated receiver in robust housing

e “All-in-view" tracking on 26 channels
(12 L1/L2 GPS + 2 SBAS)

e Global decimeter level accuracy using
StarFire™ corrections

e Fully automatic acquisition of StarFire
broadcast corrections

e Two dedicated WAAS/EGNOS channels

e |1 &L2 full wavelength carrier
phase tracking

e C/A, P1 & P2 code tracking

e 64MB internal memory for
data recording

Modular GPS

e User programmable measurement and

navigation data rates !

™

e Minimal data latency and StarFlre

e Superior interference suppression
e Patented multipath rejection

e Output format NMEA 0183 or
NavCom binary format

e CAN bus interface (SF-2050M Only)
e 1PPS Output (SF-2050M Only)
e Event Marker (SF-2050M Only)

e TruBlu™ Wireless Connectivity,
Bluetooth® compatible

receiver | provides

worldwide decimeter

level accuracy

anywhere, anytime
UPGRADES

e Raw measurement data rates
up to 50Hz

® Positioning rates up to 25Hz

e RTK positioning rates up to 25Hz
(external comm-link required)

e RTK Extend™ - RTK positioning
during comm. outages

A John Deere Company

20780 Madrona Avenue, Torrance, CA 90503 ¢ tel: + 1 310.381.2000 ¢ fax: + 1 310.381.2001 ¢ sales@navcomtech.com
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TECHNICAL SPEC

PHYSICAL/ENVIRONMENTAL

Size LxW xH): ..o 8.18in x 5.67in x 3.06in
(208mm x 144mm x 78mm)
Weight: ..o 4lbs (1.81 kg)

External Power:

Input Voltage: .......cccooveviiviiiiiiiiiiiens 10 VDC to 30 VDC
CONSUMPLION: ..o e SR S <8W
Connectors:

17O e i 2 x 7 pin Lemo
DC Power: ........ ks

GPS Antenna: ... i i .| S TNC-F
CAN bus + Event: ................ 5 pin Lemo (SF-2050M Only)
1PPS OUtpUL: ...occetiiieiteai et BNC (SF-2050M Only)

Temperature (ambient):

Operating: .....cccoceoevciiicins -40° to +55°C (-40° to +131°F)
Storage: ...coooovveiiiiiiiiie -40° to +85°C (-40° to +185°F)
Uil RS o SRR . S 95% non-condensing

Tested in accordance with MIL-STD-810F for:
low pressure, solar radiation, rain, humidity, salt fog,
sand & dust, and vibration

PERFORMANCE 1

Measurement Precision (RMS):

RaWAC//AScoCc: LIy, . . . 20 cm @ 42 dB-Hz

Raw carrier phase noise: .............. L1:0.95 mm @ 42 dB-Hz
L2: 0.85 mm @ 42 dB-Hz

VEIOCTLY: . veeeeneilsnmeeaiines . N R SR 0.01 m/s

Real-time StarFire Accuracy (RMS):
Position (H): .. 8 <10 cm
Pasition (V): ... S S <15cm

Enhanced SBAS (WAAS/EGNOS) Positioning Accuracy:
HOrZONtal:gii!. .. ... oieaeshiisne e T e sl s S USHEN 0.5m
Vertical: G oot e caee et .o SRS 0.7m

Code Differential GPS Positioning <200kms (RMS):
Horizontal: ...t i - 12 cm + 2ppm
Vertical: ..o ..o, 2, S 25 cm + 2ppm

8.18"

\( (207.8mm)

DC Power

RTK Positioning <10kms (Software option) (RMS):
MIBIEZSIATEN  ooeotormmonocecronai TR 1 cm + 1ppm
VERIERIL oot oo TSR 2cm + 1ppm

RTK Extend (Software option) (RMS):
IAZOMIENR oot R RN 2cm + Tppm
WEIRIGE:  oore o-crnderomromnomorron R T 4 cm + 1ppm

User programmable output rates:
Position Velocity Time: ............. 5 Hz (10Hz, 25Hz Optional)
Raw measurement data: ..5 Hz (10Hz, 25Hz, 50Hz Optional)

Data Latency:
Position Velocity Time: ..............cc..ccooe. < 20 ms at all rates
Raw measurement data: ....................... < 20 ms at all rates

Time-to-first-fix:
Cold Start, Satellite Acquisition: ........ < 60 seconds (typical

Satellite Reacquisition: ............c.coceiiiiiiiis < 1 second

Dynamics: (Speed & Altitude restricted by export laws)

Acceleration: ............ccceeeiiieniiiie e up to 6g
SpECC I e < 1,000 knots (515 m/s)
ATVl W S e < 60,000 ft (18.3km)
1PPS Resolution: ..........cccccccoeviis 12.5ns relative accuracy

(SF-2050M Only)

Performance dependent on location, satellite geometry, atmospheric
conditions and GPS corrections.

COMMUNICATIONS

COM 2

(4 pin Lemo) (7 pin Lemo) (7 pin Lemo) (BNC)

Messages:

Data/Control: ........cccoceiiiiiiiiiiee NCT Binary Messages

INIVIZA o cimorometin ot ALM, GGA, GLL, GSA, GST, GSV,
RMC, VTG, ZDA

Corrections:......coeeeervvieeeereeennn, RTCM Code (Msg. 1, 3 & 9)
SBAS (WAAS/EGNOS)

StarFire™

RIIN@oirections-.................oooe NCT Proprietary
(Optional) RTCM (Msg. 18/19 or 20/21)

CMR (Msg. 0, 1, 2)
CMR+

Back Panel SF-2050M Only

GPS ~ fa)
Antenna
(TNC)

COM 1 1PPS Event Marker/Can

Bus (5 pin Lemo)

Technical specifications are subject to change at NavCom'’s discretion.
NCT-SF-2050/060119-6



GPS Pathfinder Pro XRS

High-performance
GPS with a world of
real-time options

The versatile GPS Pathfinder® Pro XRS receiver is
the thoroughbred of GPS receivers. Offering a full
range of accurate real-time correction sources,
great performance in all GPS conditions, and
rugged design for the toughest environments, the
Pro XRS is an essential tool for collecting and
maintaining GPS data.

Built to meet your demands

With the Pro XRS, you don’t have to worry
whether your GPS receiver can stand up to harsh
conditions. All its components are sealed in a
robust casing. Waterproof, dustproof, and
shock-resistant, the Pro XRS can work

anywhere you can.

Just as tough is the custom-designed ergonomic
backpack. But it’s light and comfortable, so you
can wear it all day.

You’re spoiled for real-time choice

If you're navigating in the field, or finding your way
back to a previously recorded feature, you've got
all the real-time options covered. Corrections from
a radiobeacon, a satellite differential service such
as OmniSTAR, or a satellite-based augmentation
system (SBAS) like WAAS! or EGNOS?are not
just built in, they're seamlessly integrated into

the receiver. Want the freedom to connect to an
external correction source like a virtual reference
station (VRS)? You've got it. This array of real-time
sources makes the Pro XRS the most adaptable
real-time GPS receiver around.

High quality, accurate data for your GIS
With the Pro XRS, you can be sure that the data
you collect meets your high standards. Offering
submeter accuracy in real time, and centimeter-
level postprocessed accuracy, it's the obvious
choice for collecting the high quality GPS data

you need in your GIS. And it has advanced
design features, like EVEREST™ multipath
rejection technology, to ensure you get only the
best positions.

Get the results you want

The GPS Pathfinder Pro XRS’s advanced design
gives you complete control over GPS quality. You
can focus on productivity, to keep working even in
adverse GPS conditions. Or you can configure the

receiver to deliver only the most precise positions.

It's up to you.

Flexible data collection options

Pick the field device and software that fits your
workflow. The Pro XRS is ready to use with a
variety of field computers, including Trimble’s own
range of handheld computers: the GIS TSCe™
field device, the Trimble® Recon™ handheld, and
the GeoExplorer® series.

Choosing software? Try the TerraSync™ software,
for a complete solution from the field to the
office and back. Choose off-the-shelf GPS field
software. Or use the GPS Pathfinder Tools SDK
to build your own application that’s totally
customized to your needs.

®| Real-time submeter accuracy
[

Integrated satellite, beacon,
and WAAS/EGNOS differential
receiver

®| EVEREST multipath rejection
Rugged design

Ergonomic, comfortable
backpack system

Choice of field device and field
software

All you need

You need equipment that’s as
adaptable and hard-working

as you are. So when you’re
choosing GPS equipment,

don’t compromise. Get a

GPS Pathfinder Pro XRS receiver
and have it all.

& Trimble.
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Introduction

The GPS Pathfinder Systems receivers calculate very accurate GPS
positions on a second-by-second basis. After postprocessed
differential correction, the horizontal accuracy of each position for the
GPS Pathfinder Pro XR and Pro XRS receivers is better than

50 cm (RMS) + 1 part per million (ppm) times the distance between
the base and the rover. For the GPS Pathfinder Power receiver, the
horizontal accuracy is submeter (RMS) + 1 ppm. Using real-time
corrections, each position can be as accurate as submeter with the GPS
Pathfinder Systems, but is subject to a number of operational
conditions.

Note — RMS means that approximately 63% of the positions are within
the specified value.

Differential GPS Positioning Techniques

Differential GPS (DGPS) requires two or more receivers. One
receiver, called the reference station, is located at a known point to
determine the GPS measurement errors and compute corrections to
these errors. An unlimited number of mobile GPS Pathfinder Systems
receivers, commonly called rovers, collect GPS data at unknown
locations within the vicinity of the reference station. Errors common at
both the reference and rover receivers are corrected with DGPS either
in real time or during postprocessing.

Note — For more information about GPS and DGPS, review the
All About GPS tutorial on the Trimble website at www.trimble.com.

The GPS Pathfinder Systems receivers, in combination with Trimble
controlling software and the GPS Pathfinder Office software, provide
three ways of obtaining submeter positions:

e Real-time DGPS
e Postprocessed DGPS

e  Postprocessed real-time DGPS

GPS Pathfinder Systems User Guide



Accuracy 3

The accuracy figures given in the sections below are obtained under
the following conditions:

*  Number of satellites used: > 4
* PDOP:<6

*  Signal-to-noise ratio: > 4

*  Satellite elevation mask: > 15°

o Reference station receiver is a Trimble GPS Pathfinder Pro XL,
Pro XR, Pro XRS, 4700, 4800, 5700, 5800, 4600 LS, Series
4000 GPS receiver, DSM'", Reference Station, or equivalent.

*  Synchronized measurements are logged at the reference station.

*  The logging interval for the roving receiver is the same as, or a
multiple of, the logging interval at the reference station.

J The reference station uses the correct antenna.

Real-Time DGPS

When using real-time DGPS, the reference station broadcasts the
correction values to the rovers within coverage range, through a
transmitter such as a radiobeacon (beacon DGPS) or a satellite
(satellite DGPS). The rover applies the corrections to its position in
real time.

The positions calculated by the GPS Pathfinder Systems receivers
using real-time DGPS are of submeter accuracy + 1 ppm. If you use a
provider of real-time DGPS that uses VRS/VBS techniques, there is
no degradation associated with distance from the reference station,
and the accuracy always stays at the submeter level (RMS).

GPS Pathfinder Systems also supports corrections from satellite-based
augmentation systems (SBAS) such as WAAS and EGNOS.

For information on postprocessing GPS data collected with real-time
DGPS, see Postprocessed real-time DGPS, page 20.

GPS Pathfinder Systems User Guide 19
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Postprocessed DGPS

When real-time DGPS is not available, or is available only part of the
time, you have to postprocess the autonomous GPS data in your rover
file to obtain the stated accuracy. When using postprocessed DGPS,
the reference station stores the correction values in base data files on a
computer.

Many reference station owners provide their base data to the
community through the Internet or other means of communication.
Often this means that you do not have to set up your own reference
station for postprocessed DGPS, but can use an existing one. For a list
of available reference stations, visit the Trimble website
www.trimble.com/trs/findtrs.asp.

Postprocessed real-time DGPS

Postprocessed DGPS positions are generally more accurate than
DGPS positions obtained in real time. If you collect SuperCorrect
records as well as GPS positions using Trimble TerraSync or
GPScorrect' " software, or applications developed using the GPS
Pathfinder Tools SDK, you can use the SuperCorrect option in the
GPS Pathfinder Office software to process the data if the accuracy of
the real-time DGPS positions is not sufficient, provided that you have
access to suitable reference station base files.

The accuracy using postprocessed real-time DGPS is the same as for
postprocessed DGPS (see the previous section).

Factors Affecting Postprocessed DGPS Accuracy

The accuracy that you obtain after data collection depends on several
factors, including:

e Number of visible satellites
*  Multipath

. Distance between reference station and rover receivers

GPS Pathfinder Systems User Guide
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e Position Dilution of Precision (PDOP)

*  Signal-to-noise ratio (SNR)

*  Satellite elevations

e Occupation time at a point

*  Receiver type at reference station

*  Accuracy of the reference station position

*  Synchronized measurements are logged at the reference station.

*  The logging interval for the roving receiver is the same as, or a
multiple of, the logging interval at the reference station.

. The reference station uses the correct antenna.

Number of visible satellites

Generally, you need a minimum of four satellites to get a good
position. If you have five or more satellites, accuracy increases by a
small amount. You can obtain positions from only three satellites by
supplying a height value manually. However, Trimble recommends
that you do not use this method, as an inaccurate height can
significantly reduce horizontal accuracy.

Note — The TerraSync software always uses a minimum of four
satellites. You cannot configure this setting.

When the number of visible satellites drops below the required
number, the controlling software stops logging positions and displays
the message Too few satellites.

Multipath

GPS signals are sometimes reflected off nearby objects, particularly
metallic objects, creating false or erroneous results. This phenomenon
is known as multipath. Severe multipath may cause position errors of
many meters, while mild multipath may cause small, undetectable
errors. For optimal accuracy, collect data in an environment that is free

GPS Pathfinder Systems User Guide 21
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of large reflective surfaces, such as buildings and trees. EVEREST
multipath reduction technology in the receiver helps reduce the effects
of multipath.

Distance between reference station and rover

When you postprocess GPS Pathfinder Pro XR and Pro XRS data
using the GPS Pathfinder Office software Differential Correction
utility, the horizontal accuracy of the positions received is 50 cm
(RMS) at a 1 km base line (distance from reference station). For the
GPS Power receiver, the horizontal accuracy of the positions received
is submeter (RMS) at a 1 km base line.

Accuracy degrades by 1 ppm as the distance between the reference
station and the rover increases. This means that 1 mm of degradation
occurs for every kilometer between the reference station and the rover.
For example, you must collect data within 500 km (310 miles) of your
reference station to obtain submeter accuracy for the GPS Pathfinder
Pro XR and Pro XRS receiver.

PDOP

PDOP (Position Dilution of Precision) is a unitless measure of the
current satellite geometry. It indicates when the most accurate results
are provided. When satellites are spread around the sky, the PDOP
value is low, and the computed position is more accurate. When the
satellites are grouped closely together, the PDOP value is high, and the
computed position is less accurate. The lower the PDOP value, the
more accurate the GPS positions.

You can configure the PDOP mask so that if the PDOP exceeds the
mask value, the controlling software stops logging positions. A PDOP
mask of 6 is required for submeter accuracy.

GPS Pathfinder Systems User Guide
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SNR

SNR (signal-to-noise ratio) is a measure of the satellite signal strength
relative to the background noise. A strong signal with low noise
provides better accuracy. You can raise the SNR mask so that weak
signals with an SNR below the mask are excluded from the position
computation. In areas of dense canopy, the SNR mask can be lowered
so that you can collect GPS positions, although you may not achieve
submeter accuracy. For best results, the recommended setting for the
SNR mask is 4.

Elevation mask

When a satellite is low on the horizon, the GPS signals must travel
further through the atmosphere, delaying reception by the receiver. To
minimize noisy data, adjust the elevation mask. Satellites below the
mask are excluded from the position computation. For best results, the
recommended setting is 15°.

Occupation period

The GPS Pathfinder Systems receivers achieve the specified horizontal
accuracy with a one-second occupation time.

Note - To achieve higher levels of accuracy using a GPS Pathfinder
Systems receiver, collect carrier-phase data and postprocess using the
GPS Pathfinder Office software.

Receiver type

The following Trimble receiver models use Maxwell technology
and, when used as the reference station, yield submeter accuracy with
GPS Pathfinder Systems receivers:

*  GPS Pathfinder Pro XRS

*  GPS Pathfinder Pro XR

*  GPS Pathfinder Pro XL

GPS Pathfinder Systems User Guide 23
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e 5800 GPS receiver

e 5700 GPS receiver

e 4800 GPS receiver

e 4700 GPS receiver

e 4600 LS Surveyor

e 4000 series receiver

e DSM Reference Station

Warning — If the GPS receiver at the reference station has fewer than
12 channels, you may be unable to differentially correct some of your
data. If the reference station is not capable of logging data from all of the
satellites the rover is using, the data collected by the rover cannot be
differentially corrected using postprocessing.

Accuracy of the reference station position

Any inaccuracy in the reference station position is reflected in your
rover position accuracy. For information on the accuracy of your local
DGPS reference station coordinates, contact the provider of that
service, and check the Integrity Index in the GPS Pathfinder Office
version 3.00 Differential Correction utility when selecting a new base
station provider.

The Integrity Index provides you with an indication as to the quality of
available base data in comparison to other available sources. Poor base
data can result from a number of factors, such as an incorrect reference
position, bad environmental location, or a large distance between the
base and rover receivers. Base data downloaded from each station is
analyzed to formulate the quality indicator values and three key
measures are taken into account:

*  Bias (the measure of distance between an averaged GPS
position and a specified reference position)

»  Precision (the measure of the spread of actual GPS positions)

*  The distance between the base and rover receivers

GPS Pathfinder Systems User Guide
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Use the Integrity Index to avoid selecting base data that may provide
an inferior differential correction result. The quality indicator has a
range of 0 to 100, where O represents low quality base data and 100
represents high quality base data. For more information, refer to the
GPS Pathfinder Office 3.00 Differential Correction Help.

Synchronized measurements

To obtain optimal accuracy from differential correction, the reference
station must record reference data (or output differential corrections)
from synchronized measurements. Synchronized measurements occur
when the reference station receiver and rover receivers simultaneously
make measurements to all the satellites they are tracking.

When you use one of the receivers listed in Receiver type, page 23, as
a reference station receiver, the data is always synchronized. When
measurements are not synchronized, there is no equivalent reference
station position measured at exactly the same time as the rover
position. A simultaneous reference station position must be
interpolated, which reduces accuracy.

Logging intervals

Ideally, the logging interval at the reference station should be the same
as the logging interval at the rover. For example, if the reference
station is using a 5-second logging interval, the rover logging interval
should be 5 seconds. The rover logging interval can also be a direct
integer multiple of the interval at the reference station. For example, if
the reference station is logging every 5 seconds, the rover can log
every 10 seconds.

If the rover logging interval is not synchronized with the reference
station, the accuracy of the GPS positions logged by the rover may not
be submeter. This is because the reference station measurements must
be interpolated to correct the roving receiver’s measurements. For
more information, see Synchronized measurements, page 25.

GPS Pathfinder Systems User Guide 25
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If the synchronized measurement logging interval at the reference is
1 second, you can use any logging interval at the rover. However, this
generates a large file at the reference station. If the computer or data
collector at the reference station runs out of space, you cannot
differentially correct any rover data collected after the base file ends.

When disk space is at a premium, the best option is a 5-second logging
interval for synchronized measurement data at the reference station
and a 5-second logging interval for positions at the rover. This is
frequent enough to be practical at the rover and uses the default
reference station logging interval, which results in base files that are
not too large.

Table 3.1 gives examples of various reference station and rover
intervals and their effect on accuracy. They are valid for both
postprocessed and real-time corrections.

Table 3.1 Logging Interval Accuracy

Reference station Rover interval Base data Notes

interval (seconds) (seconds) interpolated?

1 1 No Recommended for best accuracy.

5 5 No Recommended if reference station
disk space is at a premium.

1 3,or5,0r6,etc. No The rover interval is a direct integer
multiple of the reference station
interval.

5 10 No The rover interval is a direct integer
multiple of the reference station
interval.

5 1 Yes Base data is interpolated at

seconds 1, 2, 3, and 4. A slight
degradation of accuracy occurs
with interpolation. One in five of the
rover positions is not interpolated.

26 GPS Pathfinder Systems User Guide
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Factors Affecting Real-Time DGPS Accuracy

Real-time DGPS offers similar accuracies to postprocessed GPS.
However, in addition to the factors discussed in Factors Affecting
Postprocessed DGPS Accuracy, page 20, there are other factors that
affect the accuracy of real-time DGPS positions. These factors
include:

*  Update rate of the corrections

. Corrections based on a different datum

Update rate of the corrections

The frequency, or rate, at which the RTCM differential correction
messages are output from the reference station affects the accuracy of
the GPS positions recorded by the roving receiver. The latency of the
corrections (that is, the time it takes for up-to-date information to get
from the reference station to the rover) also affects the rover position
accuracy.

Datum of corrections

Errors can occur if the reference stations use a datum other than
WGS-84 as the basis for the DGPS corrections. The error introduced
by using a reference station that transmits coordinates using a different
datum is generally quite small. However, in some places the margin of
error can be 5-10 meters. To avoid this type of error, set Trimble
controlling software to collect SuperCorrect data. You can then
postprocess the real-time DGPS positions if required.

GPS Pathfinder Systems User Guide 27



GPS Pathfinder Pro XRS

High-performance
GPS with a world of
real-time options

The versatile GPS Pathfinder® Pro XRS receiver is
the thoroughbred of GPS receivers. Offering a full
range of accurate real-time correction sources,
great performance in all GPS conditions, and
rugged design for the toughest environments, the
Pro XRS is an essential tool for collecting and
maintaining GPS data.

Built to meet your demands

With the Pro XRS, you don’t have to worry
whether your GPS receiver can stand up to harsh
conditions. All its components are sealed in a
robust casing. Waterproof, dustproof, and
shock-resistant, the Pro XRS can work

anywhere you can.

Just as tough is the custom-designed ergonomic
backpack. But it’s light and comfortable, so you
can wear it all day.

You’re spoiled for real-time choice

If you're navigating in the field, or finding your way
back to a previously recorded feature, you've got
all the real-time options covered. Corrections from
a radiobeacon, a satellite differential service such
as OmniSTAR, or a satellite-based augmentation
system (SBAS) like WAAS! or EGNOS?are not
just built in, they're seamlessly integrated into

the receiver. Want the freedom to connect to an
external correction source like a virtual reference
station (VRS)? You've got it. This array of real-time
sources makes the Pro XRS the most adaptable
real-time GPS receiver around.

High quality, accurate data for your GIS
With the Pro XRS, you can be sure that the data
you collect meets your high standards. Offering
submeter accuracy in real time, and centimeter-
level postprocessed accuracy, it's the obvious
choice for collecting the high quality GPS data

you need in your GIS. And it has advanced
design features, like EVEREST™ multipath
rejection technology, to ensure you get only the
best positions.

Get the results you want

The GPS Pathfinder Pro XRS’s advanced design
gives you complete control over GPS quality. You
can focus on productivity, to keep working even in
adverse GPS conditions. Or you can configure the

receiver to deliver only the most precise positions.

It's up to you.

Flexible data collection options

Pick the field device and software that fits your
workflow. The Pro XRS is ready to use with a
variety of field computers, including Trimble’s own
range of handheld computers: the GIS TSCe™
field device, the Trimble® Recon™ handheld, and
the GeoExplorer® series.

Choosing software? Try the TerraSync™ software,
for a complete solution from the field to the
office and back. Choose off-the-shelf GPS field
software. Or use the GPS Pathfinder Tools SDK
to build your own application that’s totally
customized to your needs.

®| Real-time submeter accuracy
[

Integrated satellite, beacon,
and WAAS/EGNOS differential
receiver

®| EVEREST multipath rejection
Rugged design

Ergonomic, comfortable
backpack system

Choice of field device and field
software

All you need

You need equipment that’s as
adaptable and hard-working

as you are. So when you’re
choosing GPS equipment,

don’t compromise. Get a

GPS Pathfinder Pro XRS receiver
and have it all.

& Trimble.
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What Can the GPS Pathfinder Systems Receivers

Do?

The GPS Pathfinder Systems receivers, with Trimble controlling
software, make an ideal system for all GIS data collection and
maintenance projects. The system allows you to collect precise data
for utility, urban, and natural resource databases. As the demand for
accurate and up-to-date position and attribute information increases,
the system allows you to update existing GIS data, ensuring that
decisions made with the GIS are based upon the most accurate,
current, and reliable data available.

The foundation of the GPS Pathfinder Systems receivers is precise
GPS positioning technology. The GPS receivers feature 12 parallel
channels for continuous satellite tracking. Using differential GPS, the
GPS Pathfinder Systems receivers deliver differentially corrected C/A
code positions to submeter accuracy on a second-by-second basis
under the most challenging operating conditions.

Integrated Satellite Based Augmentation System (SBAS)
receiver

Satellite Based Augmentation System (SBAS) support is integrated
into the GPS Pathfinder Pro XR, Pro XRS, and Power receiver. It
allows you free access to real-time solutions transmitted from
geostationary SBAS satellites, such as the Wide Area Augmentation
System (WAAS) in the United States and the European Geostationary
Navigation Overlay Service (EGNOS) in Europe.

Integrated beacon receiver

The MSK beacon receiver is included in the GPS Pathfinder Pro XR
and Pro XRS receivers. It allows you free access to real-time solutions
transmitted from DGPS radiobeacons operating in the MF (medium
frequency) band from 283.5 kHz to 325 kHz. The integrated MSK
beacon receiver is an advanced dual-channel radiobeacon receiver. It

GPS Pathfinder Systems User Guide



Product Overview 2

tracks broadcasts from DGPS radiobeacons conforming to the IALA
Standard. The beacon receiver uses its all-digital signal processing
techniques to track and demodulate signals from DGPS radiobeacons.

For an up-to-date list of beacon stations, visit the following Web page:

*  www.trimble.com/findbeacon.asp

Integrated satellite differential receiver

The integrated satellite differential capability of the GPS Pathfinder
Pro XRS and Power receivers decodes and uses satellite differential
corrections to provide submeter position accuracy. To receive and
decode these satellite signals, you must subscribe to a satellite
differential correction service. The GPS Pathfinder Pro XRS and
Power receivers support the OmniSTAR satellite differential
correction services. For information on obtaining a subscription,
subscription rates, and satellite coverage maps, visit
WWWw.omnistar.com

Once you have a subscription, you activate the service through an
on-the-air signal or an encrypted activation message entered into the
controlling software.

Satellite differential signals provide valid corrections over a large area.
Integrated virtual reference/base station (VRS/VBS) technology
permits the satellite corrections to be uniformly accurate over the
entire satellite coverage area, without the degradation in accuracy
associated with increasing distance from fixed reference stations.

Satellite differential signals are line-of-sight and can be blocked by
mountains, buildings, or tree canopy. Wet canopy, from a heavy rain,
reduces the signals even more. The same environmental factors that
affect the GPS signal, such as radar and microwave transmitters, can
interfere with the satellite signal. Power lines usually have no effect.



2  Product Overview

External differential correction receiver

The GPS Pathfinder Systems receivers can also receive differential
corrections from any external differential correction receiver that
communicates in the standard RTCM SC-104 data format.

Standard GPS Pathfinder Pro XR and Pro XRS
Features

The GPS Pathfinder Pro XR and Pro XRS receivers offer the
following:

*  12-channel DGPS receiver with EVEREST™ multipath
rejection technology, L1 C/A code tracking with carrier-phase
smoothing, and instantaneous full-wavelength carrier-phase
measurements.

*  Submeter accuracy — Typically horizontal accuracy less than
50 cm RMS with GPS Pathfinder Office software
postprocessing. This requires data to be collected with a
minimum of 4 satellites, maximum PDOP of 6, minimum SNR
of 4, minimum elevation of 15 degrees, and reasonable
multipath conditions.

* Integrated WAAS/EGNOS differential corrections

* 1 Hz position and velocity update rate.

e  Velocity computations incorporate carrier-phase data.
*  Time to First Fix typically less than 30 seconds.

*  Two RS-232 serial ports.

* NMEA-0183 output to external NMEA devices (supported
messages are ALM, GGA, GLL, GSA, GSV, VTG, and ZDA).

*  RTCM-SC 104 input from an external differential correction
receiver.

e TSIP protocol to/from the field device.

*  Fully automatic and manual beacon operating modes, fast
acquisition of differential beacon signals.

10 GPS Pathfinder Systems User Guide



Product Overview 2

*  Immunity to MSK jamming signals, advanced techniques for
combating atmospheric noise in the beacon receiver.

*  Integrated GPS/MSK beacon antenna.
»  User-upgradeable receiver firmware.
*  Receiver manual.

e  CE Mark compliance.

Additional GPS Pathfinder Pro XRS receiver features

The GPS Pathfinder Pro XRS GPS/MSK/beacon/satellite differential
receiver offers the items previously listed, and also:

* Integrated L-band satellite differential correction receiver

J Combined L1 GPS/beacon/satellite differential antenna



2  Product Overview

Combined L1 GPS/beacon/satellite differential antenna

The GPS Pathfinder Pro XRS receiver integrated L1
GPS/beacon/satellite differential antenna (P/N 33580-50) features two
antenna components:

J L1 GPS/satellite differential antenna

This active antenna is designed to filter out unwanted signals
and amplify the L1 GPS and satellite differential signals for
transmission over the antenna cable to the receiver.

*  MSK H-field loop beacon antenna

This antenna features a pre-amplifier for filtering out signal
interference such as AM radio broadcasts and noise from
switching power supplies. After filtering, the pre-amplifier
amplifies the MF signal for transmission over the same antenna
cable to the beacon receiver.

The coaxial antenna cable also carries DC power to the pre-amplifier
of both the L1 GPS/satellite differential and beacon antennas over the
center conductor of the cable.

The antenna assembly integrates the L1 GPS/satellite differential
antenna and a beacon antenna into a single antenna assembly, as
shown in Figure 2.2. The antenna assembly is completely
weatherproof and is designed to withstand harsh environmental
conditions.

Figure 2.2  Combined L1 GPS/beacon/satellite differential antenna
(for the GPS Pathfinder Pro XRS receiver)

14 GPS Pathfinder Systems User Guide



B  Specifications
Introduction

This appendix lists specifications for GPS Pathfinder Systems

receivers and antennas, and pinouts for cables that are supplied with

the receivers.

Specifications

Table B.1 lists specifications for the GPS Pathfinder Pro XR and

Pro XRS receiver.

Table B.1 GPS Pathfinder Pro XR and Pro XRS receiver

specifications

Parameter Specification

General 12 channel, L1/CA code tracking with carrier phase
filtered measurements and multibit digitizer

Update Rate 1 Hz

Time to First Fix < 30 seconds, typical

Size 11.1ecmx 5.1 cm x 19.5cm (4.4" x 2.0" x 7.7")

Weight 0.76 kg (1.68 Ib)

Power XR 6 W (maximum)
XRS 7 W (maximum)
both 10 to 32 VDC

Temperature —20 °C to 65 °C (—4 °F to 149 °F) operating
—30 °C to 85 °C (-22 °F to 185 °F) storage

Humidity 100% non-condensing

Casing Dustproof, splashproof, shock-resistant, sealed to 5psi
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Table B.3 lists specifications for the GPS Pathfinder Pro XRS antenna.

Table B.3 Combined L1 GPS/beacon/satellite differential antenna
specifications

Parameter Specification

General Right-hand, circular polarized; omnidirectional;
hemispherical coverage

Size 15.5 cm diameter x 14 cm high (6.1" x 5.5")

Weight 0.55 kg (1.2 Ib)

Temperature —20 °C to 65 °C (—4 °F to 149 °F) operating
—40 °C to 85 °C (—40 °F to 185 °F) storage

Humidity 100% fully sealed

Casing Dustproof, waterproof, shock resistant
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Specifications B

Pinouts

Table B.5 lists the pinouts for the GPS Pathfinder Pro XR and
Pro XRS receiver’s data/power cable.

Table B.5 Data/power cable pinout (P/N 30231-00)

To GPS Pathfinder Pro XR and Field Input Power

Pro XRS receiver Device

Conn P1 7 Cond Cbl Conn P2 2Conn Cbl Conn P3

#1 DE9S-F #2 TA3-M

Event In 1 in — — — —

TXD 2 Orange 2 RXD — —

out

RXD 3 in Red 3 TXD — —
ChgCtrl 4 in Black 4 DTR — —_

Sig Gnd 5 Shield 5 SigGnd — —

in/out

DSR 6 Yellow 6 DSR — —

out

Pwr On 7 in Brown 7 RTS — —

CTS 8 Green 8 CTS — —

out

Charge 9 Blue 9 RI — —

out

V+In 10 in — — White 1 V+in
V-In 11 in — — Black 2 V-Out
PPS 12 — — — —_
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Specifications B

Table B.7 lists the pinouts for the GPS Pathfinder Pro XR and
Pro XRS receiver’s NMEA/RTCM cable.

Table B.7 NMEA/RTCM cable pinout (P/N30232-00)

To GPS Pathfinder Pro XR and NMEA/RTCM output connectors

Pro XRS receiver

Conn P1 9 Cond ConnP2 7 Conn Conn P3
Cbl #1 DE9-M Cbl #1 DES-F

Event In 1 in — — — —

TX-(232) 2 out — — Orange 2 TXD

RX-(232) 3 in Red 2 RXD — —

ChgCtrl 4 in — — Shield

SigGnd 5 in/out Shield 5 Sig — 5 Sig
Gnd Gnd

TX+(422) 6 out — — —

Pwr On 7 in — — — —

RX+ (422) 8 out — — — —

Charge 9 out  Yellow 9 Pwr — —

V+In 10 in — — — —

V-In 11 in — — - —

PPS 12 — = = Brown 4 DTR
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GPS Pathfinder Pro XRS

High-performance
GPS with a world of
real-time options

The versatile GPS Pathfinder® Pro XRS receiver is
the thoroughbred of GPS receivers. Offering a full
range of accurate real-time correction sources,
great performance in all GPS conditions, and
rugged design for the toughest environments, the
Pro XRS is an essential tool for collecting and
maintaining GPS data.

Built to meet your demands

With the Pro XRS, you don’t have to worry
whether your GPS receiver can stand up to harsh
conditions. All its components are sealed in a
robust casing. Waterproof, dustproof, and
shock-resistant, the Pro XRS can work

anywhere you can.

Just as tough is the custom-designed ergonomic
backpack. But it’s light and comfortable, so you
can wear it all day.

You’re spoiled for real-time choice

If you're navigating in the field, or finding your way
back to a previously recorded feature, you've got
all the real-time options covered. Corrections from
a radiobeacon, a satellite differential service such
as OmniSTAR, or a satellite-based augmentation
system (SBAS) like WAAS! or EGNOS?are not
just built in, they're seamlessly integrated into

the receiver. Want the freedom to connect to an
external correction source like a virtual reference
station (VRS)? You've got it. This array of real-time
sources makes the Pro XRS the most adaptable
real-time GPS receiver around.

High quality, accurate data for your GIS
With the Pro XRS, you can be sure that the data
you collect meets your high standards. Offering
submeter accuracy in real time, and centimeter-
level postprocessed accuracy, it's the obvious
choice for collecting the high quality GPS data

you need in your GIS. And it has advanced
design features, like EVEREST™ multipath
rejection technology, to ensure you get only the
best positions.

Get the results you want

The GPS Pathfinder Pro XRS’s advanced design
gives you complete control over GPS quality. You
can focus on productivity, to keep working even in
adverse GPS conditions. Or you can configure the

receiver to deliver only the most precise positions.

It's up to you.

Flexible data collection options

Pick the field device and software that fits your
workflow. The Pro XRS is ready to use with a
variety of field computers, including Trimble’s own
range of handheld computers: the GIS TSCe™
field device, the Trimble® Recon™ handheld, and
the GeoExplorer® series.

Choosing software? Try the TerraSync™ software,
for a complete solution from the field to the
office and back. Choose off-the-shelf GPS field
software. Or use the GPS Pathfinder Tools SDK
to build your own application that’s totally
customized to your needs.

®| Real-time submeter accuracy
[

Integrated satellite, beacon,
and WAAS/EGNOS differential
receiver

®| EVEREST multipath rejection
Rugged design

Ergonomic, comfortable
backpack system

Choice of field device and field
software

All you need

You need equipment that’s as
adaptable and hard-working

as you are. So when you’re
choosing GPS equipment,

don’t compromise. Get a

GPS Pathfinder Pro XRS receiver
and have it all.

& Trimble.



Reference Materials

If you have a problem and cannot find the information you need in the
product documentation, contact your local Distributor. Alternatively,
go to the Trimble Support page at www.trimble.com/support.html, and
then do one of the following:

e Browse the available online support resources.
e Request technical assistance from Trimble Support, click the
submit an inquiry link, fill in the form, and then click Send.

Trimble: www.trimble.com/support.html

Survey Controller: www.trimble.com/tsce.html
Survey Pro: www.tdsway.com
GIS TSCe: www.trimble.com/gistsce.html

ActiveSync™: www.microsoft.com/windowsmobile/
resources/downloads/pocketpc/default. mspx

Windows CE: www.microsoft.com/windows/embedded/ce.net

Hardware Specifications

Feature TSCe

Processor Intel StrongARM SA-1110, 206 MHz
Memory 64 MB low-power SDRAM

Storage 512 MB non-volatile flash disk
Screen 1/4 VGA transflective color LCD

Touch Screen

Passive - 87% transmissivity

Keyboard 57 key tactile action

9-Pin serial port RS232 COM1

26-Pin MultiPort RS232 COM2, Ethernet 10BaseT, USB
client, power in/out and audio in/out

Infrared IrDA Typel COM3

Audio Integrated speaker and microphone

Batteries NiMH rechargeable pack, 3800 mAH,

18.5W-h, 4.8V

AC Adaptor

Line voltage: 100 -240V AC 47-63 Hz




SPECIFICATIONS FOR LASER TECH TRUPULSE 200 LASER RANGEFINDER

Dimensions

5" x 2" x 3.5" (12cm x 5¢cm x 9cm)

Weight

8 ounces (220 g)

Data Communication

Serial, via wired RS232 (standard)

Power

3.0 volts DC nominal

Battery Type (2) AAor (1) CRV3
. AA: Approximately 7,500 measurements

ERUEg7 PUIE CRV3: ID,g\pproxima?tlely 15,000 measurements
Eye Safety FDA Class 1 (CFR 21)
Environmental Impact, Water & Dust Resistant. NEMA 3, IP 64
Temperature -4°F to +140°F (-20°C to +60°C)
Optics 7X Magnification (Field-of-view; 330 ft @ 1000 yards)
Display In-scope LCD
Units Feet, Yards, Meters, and Degrees

Monopod/tripod mount

¥ " - 20 female thread

Measurement Range

Distance

0 to 3280 ft (1000 m) typical, 6560 ft (2000m) max to reflective target

Inclination + 90 degrees

Accuracy
Distance +1 ft (= 30 cm) to high quality targets, £1 yd (x1 m) to low quality targets
Inclination +0.25 degrees

Measurement Modes

Horizontal Distance, Vertical Distance, Slope Distance and Inclination, and 3-point
flexible height routine with auto sequencing

Target Modes

Standard, Closest, Farthest, Continuous, and Filter (requires reflector and foliage
filter)




IMPULSE 200 LR LASER

Our Impulse lasers are specifically designed for optimal performance under whatever conditions you might encounter
in the field. They are lightweight, extremely rugged, completely waterproof and versatile. Use them as a handheld

unit or mount them on a tripod for added stability.

Hardware Specifications:

Impulse Laser w/
1.5 to 4 X Zoom Scope

Typical Target IMPULSE 200 LR and Mounting Bracket

Accuracy & Range (Imperial) (Metric)
Accuracy (Typical) 0.1-0.2ft 3-5cm
Accuracy (Max) 0.5 ft 15 cm
Overhead cable / Stake 330 ft 100 m
Phone pole / Stockpile 655 ft 200 m
Tree / Tower 985 ft 300 m
Rock Face / Building 1640 ft 500 m
Max Distance 1885 ft 575 m
Range Resolution .01 ft 0.01m
Inclination Limits +/- 90 deg +/- 90 deg
Inclination Accuracy +/- 0.1 deg +/- 0.1 dec_;
Weight 2.2 Ibs. 1 kg
Size 6x2.5x5in. 15.2x6.4x 12.7 cm
Power Supply (2) AA batteries (20 hours of use)
Environment Waterproof to IP 67 and NEMA 6 For3-D data collection,
Temperature -2to+140F || -30to+60C mtefﬁz tgfainslp 2::;w1th
(Max distances are approximate) b e

MapStar MapStar
e

- Custom backlit LCD display
- Audible and visual indicators

- Impulse laser
- Red-dot scope

- RS232 serial output for - Hand strap
electronic data storage - Tripod / monopod Impulse Laser w/
- Selective range gating for mounting bracket ;Zd;f;; dsgi)iz
positive target acquisition - (2) AA batteries
- Built-in tilt sensor - Operator's manual
- Filter system to discriminate - Padded carrying case

reflective targets
- Cumulative distance capability
- Determines the distance

between two in-line objects
- Integrates with GPS

- 1.5 to 4 X zoom scope
- Yoke and staff
- Remote trigger data cable

r \ v
* 'q ’ C
P L GR 7070 S. Tucson Way, Centennial, CO 80112 USA

Qo TeCHNOLOGY Toll Free: 1 (800) 280-6113 | Local: 1 (303) 649-1000

Redefining Measurement = Web Page: www.lasertech.com | E-mail: info@lasertech.com

* All specifications are subject
to change without notice.
(Rev. 11/15/03)
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1 SYSTEM DESCRIPTION

The MYF200 system is a self-contained profiling system capable of sampling water
column profiles to 200m depth from a vessel moving at up to 12 knots, and deeper
depths at slower speeds. The system provides vertical profiles of oceanographic data
such as Sound Velocity, CTD, paricle counts, etc. for various operations including the
calibration of mulfi-beam sounder systems for hydrographic operations. The MVP200 is
completely autonomous and can be controlled by computer without the requirement for
personnel on deck. The system consists of a single or multi-sensor free-fall fish (fish),
an integrated winch and hydraulic power unit, fowing hoom and a remotely located user
interface controller. The MVP200 system is shown in Figure 1. The system block
diagram is shown in Figure 2.

Main
Control Box

Hydraulic
Power Unit

High Powwer
Electrical Box

Figure 1: MVP200

Ohd-0443-04-010 Brooke Ocean Technology Lid.



MVP200 Operafion and Mainfenance Manual 2

Remote
Dota Qut Comm. Fish Comm. — 1 E-stop
RE232 RS232 {optional}
WP Controller
Contraollar Interface
MMEA Comm., Wirch Camm,
Emargancy
R5232 R5232 ] Srlgp
Winch Data [RS422) e
E—Stop Winch ound Lisg nection
Fram GPS, atc Fish Data (RS422)
| rommiervm—
RS422
To Multibeom
Pump Mokor 2-gmis | | FRemote
Contoctor Joystick Contred Unit
L T - Main L =
: Coantrol
- Haox
Froewhaal margency | | -
Mode Slop | ‘ ‘ Inglruments
| l
Furmp Wineh /Baam Winch ik
In/Qut Salal Freawheal Releass
I |
Mechanical Cable
Limit Metering
Ewitches Sensor

Figure 2: System Block Diagram

Upon actuation, the system deploys the fish from a towed position by setting the winch
in ‘freewhesl’ mode and releasing the brake. This allows the fish to free-fall almost
straight down through the water at its terminal velocity of approximately 3 m/s. Once the
(pre-set) depth limit is reached, the brake is applied to stop the cable pay-out. When the
winch drum has stopped, the motor is engaged to haul in the cable until the fish is
towed at the surface. Subsequent deployments occur from this position, either actuated
[vy the operator or timed automatically with the automatic deployment sefting.

The system operates in the automatic mode described above or in manual mode
operated from controls at the winch. Manual mode is used as a convenient method to
launch and recover the fish, but is not intended for moving vessel profiling.

COh-0443-04-010 Brooke Ocean Technology Lid.
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1.1 FREE-FALL FISH

The free-fall fish can be either a single sensor or a multi sensaor fish. The fish houses
the main instrument, either a CTD or 3V&F sensor.  The instrument is normally
configured for R5-485 serial communications.

The mulii-sensor fish can support auxiliary sensors in addition to the main CTDISVEP
instrument.  If auxiliary sensors are used, a ODTMMux is required in the fish. The
DTMIMux 15 a data telemetry module with additional digitization and multiplexing
circuitry. This allows data from various analog and digital sensors o be added fo the
main instrument’s serial output stream, which is transmitted to the surface.

111 Single-Sensor Free-Fall Fish

The Single Sensor Free-Fall Fish (SSFFF) (see Figure 3) is machined from brass with a
stainless steel towing bridle. The sensor guard at the tail of the fish is made from
stainless steel. The shape of the fish allows minimal resistance while providing stability
during free-fall and retrieval. The fish can be fitted with an Applied Microsystems Lid.
(AML) Sound Velocity and Pressure (SV&P) Smart Sensor or an AML CTD Micro
Sensor. (A small plastic support is built into the sensor guard for use with the sound
velocity sensor). An Impulse underwater connector allows the fish to be removed easily
from the electromechanical cable.

The AML CTD Micro Sensor measures conductivity, temperature and pressure. The
AML SVEFP Sman Sensor measures sound velocity and pressure. The information is
sent through the Electro-Mechanical cable to the main control box, through the deck
cable to the Instrument Interface box where it then connects to the MVFP Controller. If
the sensor is & CTD, software in MVF Controller then computes sound velocity and
salinity from the measured parameters using the UNESCO equations of state.

Figure 3: Single Sensor Free-Fall Fish

COh-0443-04-010 Brooke Ocean Technology Lid.
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3 SPECIFICATIONS

31 OPERATING DEPTH

+« 600 m @ 0 knots*
« 350m @ 5 knots
« 200m @ 12 knots

* Ensure sensor(s) are rated for this depth before operations

3.2 WINCH AND HYDRAULIC POWER UNIT

Cirum dimensions: 324 mm (12.77) harrel diameter
99 mm (3.97) wide
711 mm (28.07) flange QD
Line Pull: Bare Drum - 410 kg (200 [bs.)
Capacity: 660 m (2132 ft) of 6.0 mm (0.247) cable
Cable: Jackeied Electro-Mechanical | 4 conductor,
1089 kg (2400 Ibs.) maximum hreak strength
Hydraulic Winch Motor: Valmet Black Bruin # 403 040 2120
Fotator Motor: White # 700540C8540ALA44
Slip Ring: Focal Technologies Model 120 ESR
Hydraulic Pump: Rexroth #AA10%G18EF21M10R-NSCEE-FO045
Feservoir: 40 litre Stainless Steel Reservoir
Maximum ocperating pressure: 3000 psi (207 Bar)
Electric motor: 15 hp TEFC 230/460VAC 60 Hz, 208/416VAC 50 Hz, 3-phase
Suction ling filter: LHA Element #3PE-15-BTA-10
Footprint: 1.22m x 0.71m (48" ¥ 28" excluding boom
Height: 3.18m (125"
Approximate Weight: 630 kg (1500 Ibs.)

3.3 FREE-FALL FISH

3.341

Single Sensor Free-Fall Fish

Weight: 32 kg (72 Ibs.) with sensor, in air

Body Length: 673 mm (26.5") excluding bridie

Body Diameter: 114 mm (4.57)

Sensors: - AML Sound Velocity and Pressure (SV&P) “Smart Sensor”, or
- AML SVPAT Micro Sensor
- AML CTD Micro Sensor

Multi-Sensor Free-Fall Fish
Weight: 88.5 kg (195 [hs.) with sensor, in air
Body Length: 1041 mm (41") excluding bridie
Body Section: 147 mm x 279 mm (5.687 x 11.07)

COh-0443-04-010 Brooke Ocean Technology Lid.
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Sensars: - AML Sound Velocity and pressure (SY&P) "Smart Sensor”
- AML CTD Micro Sensor
- AML Dissolved Oxygen (DO) Sensor
-'Wet Labs fluorometers (\Wet star, FLF300, and ECQ)
- Satlantic OCR-500 series digital optical sensors
- Brooke Ocean Technology Lid. - Laser Optical Plankton Counter (LOFPC)

3.4 MVP CONTROLLER
Minimum requirements (refer 1o system factory configuration for details)

+ Operating system: Windows 2000 Professional

* Processor: FPentium 600 or higher

« Ram: 128 Mb

« Hard Disk: 5 GB Hard drive

+ \ideo: 1024x766 SVGA with 64 thousand colors
+* Pointing Device: Microsofi Whesl Mouse

»  Serial ports: 4 senial (RS232) ports

« [Drive: CD-ROM drive and a 1.44 Mb Floppy drive
« DMonitor: 157 Video Monitor

+  Keyhoard: PSi2 Keyhoard

« Hardware: Metwork Card

3.5 POWER REQUIREMENTS

Winch Power Rarings:
« ‘essel circuit breaker value 904 at 230v and 454 at 460v, maximum setting
« ‘oltage: 3-phase, 4-wire

« 2300460V £10%, 34174 at 60 Hz or

o 208416V +10%, 42/214 at 50 Hz

(Mote that system supply voltage must be selected at time of order. 1t is not a figld
configurable item)

« 50A main disconnect, circuit breaker

« 15 HP Motor, dual frequency rating with 110V anti-condensation heater
« PMotor contactor with thermal overload.

« Includes internal 110% auxiliary distribution: 7AM 20V/340W

MVFP Controller (Lab Computer) Power Ratings:
+« Voltage: 1-phase, 100-230 VAC
« Currant: 5-8A
« Frequency: 50 or 860 Hz

OM-0443-04-040 Brooke Ocean Technology Lid.



MicroTSG (Thermosalinograph) SBE 45

The SBE 45 MicroTSG Thermosalinograph is an externally
powered, high-accuracy instrument, designed for shipboard
determination of sea surface (pumped-water) conductivity and
temperature. Salinity and sound velocity can also be computed.
The MicroTSG is constructed of plastic and titanium to ensure
long life with minimum maintenance.

OPERATION OVERVIEW

Communication with the MicroTSG is over an internal, 3-wire,
RS-232C link, providing real-time data transmission. Commands
can be sent to the MicroTSG to provide status display, data
acquisition setup, data display and capture, and diagnostic tests.
User-selectable operating modes include:

*  Polled sampling — On command, the MicroTSG takes one
sample and sends the data to the computer.

*  Autonomous sampling — At pre-programmed intervals, the
MicroTSG samples and sends the data to the computer.
The MicroTSG does not enter quiescent (sleep) state
between samples.

+ Serial Line Sync — A pulse on the serial line causes
the MicroTSG to wake up, sample, and enter quiescent
state automatically.

Calibration coefficients stored in EEPROM allow the MicroTSG to transmit data in engineering units.

SENSORS

The MicroTSG retains the temperature and conductivity sensors used in the SBE 21 Thermosalinograph, but has
improved acquisition electronics that increase accuracy and resolution, and lower power consumption. The MicroTSG's
aged and pressure-protected thermistor has a long history of exceptional accuracy and stability (typical drift is less than
0.002 “C peryear). Electrical isolation of the conductivity electronics eliminates any possibility of ground-loop noise.

The MicroTSG’s internal-field conductivity cell is unaffected by external fouling, and uses expendable
anti-foulant devices.

OPTIONAL PNS0402 - SBE 45 POWER, NAVIGATION, and REMOTE TEMPERATURE INTERFACE BOX
An optional AC- or DC-powered Interface Box:

«  Providesisolated DC power and an optically isolated RS-232 data interface.

= Contains a NMEA 0183 port for appending navigation information from a NMEA navigation device to the data stream.

«  Contains an RS-232 port for appending the output of an optional remote temperature sensor (SBE 38), allowing for
measurement of sea surface temperature with minimal thermal contamination from the ship’s hull.

«  Qutputs the data stream (MicroTSG, NMEA navigation device, and SBE 38 data) to the computer over an
RS-232 interface.

SOFTWARE
The MicroTSG is supplied with a powerful Win 95/98/NT/2000/XP software package, SEASOFT®-win32.
SEASOFT's modular programs include:

«  SEATERM —terminal program for instrument setup and data display.
- SEASAVE — real-time data acquisition and display
«  SBE Data Processing —filtering, aligning, averaging, and plotting of data and derived variables.

SB Sea-Bird Electronics, Inc. E-mail: seabird@seabird.com
1808 136th Place NE, Bellevue, Washington 98005 USA Telephone: (425) 643-9866
(CELEEELL, \\icbsite: hitp://www.seabird.com Fax: (425) 643-9954



MicroTSG (Thermosalinograph)

SBE 45

SPECIFICATIONS

Measurement Range
Conductivity:
Temperature ™

Initial Accuracy

0-7 S/m (0-70 mSicm)
-5 t0 35 °C

Conductivity: 0.0003 S/m (0.003 mS/cm)

Temperature ™ 0.002 °C

Salinity: 0.005 PSU, typical
Typical Stability (per month)

Conductivity: 0.0003 S/m (0.003 mS/cm)

Temperature ™ 0.0002 °C

Saiinity: 0.003 PSU, typical
Resolution

Conductivity: 0.00001 S/m (0.0001 mSicm)

Temperature ™ 0.0001 °C

Salinity: 0.0002 PSU, typical
Calibration Range

Conductivity: 0-6 S/m (60 mS/cm); physical

calibration 2.6-6 S/m (26-60 mSfcm),
plus zero conductivity (air)

Temperature ™ +1to +32°C
Time Resolution 1 second
Clock Stability 13 seconds/month
Input Power 8-30 vDC

Acquisition Current
Quiescent Current
Acquisition Rate
Operating Pressure

34 mA at 8 VDC; 30 mA at 12-30 VDC
10 microamps

1 Hz maximum

34.5 decibars (50 psi) maximum

Flow Rate 10 to 30 ml/sec (0.16 to 0.48 gal/min)
Materials PVC housing
Weight 4.6 kg (10.2 Ibs)

* For specifications for optional SBE 38 remote temperature sensor,
see SBE 38 datashest.

216 Dimensionsin
(8 5) | millimeters
3/8 in. U.S. standard ) ’ (inches)
NPT threads, with
nylon hose barb 0]
fitting for 3/8 in. / C
tubing (typical) L 152
6.0
__76.2__ ©0)
(3.0) e}
EEE— Connector
(MCBH4SS)
© ]|
QuUT 5 e
438 6.35 mm T
133 (1/4 in.) 136
(13.3) mount hole (5.4)
(typical) N, L
IN o [+]
(] o) 101
(4.0)
i BN - S - = = _L
— 135 l-_?dg%)
5.3) )
Pin Signal
1 Common
. |_=or 2 RS-232 RX from computer
orientation 3 RS-232 TX to computer
4 External power in
(8 -30VDC)

System Schematic: SBE 45 with Optional PN 90402 Interface Box
and Remote Temperature Sensor

System Schematic: SBE 45

[ ]]

IBM-compatible
computer .
( : Optional
(not included) SR 80407
Interface Box AC input

LD

NMEA 0183
navigation interface

—‘—‘—‘_"———._
¢ Optional mounting kit
IBM-compatible P/N 50244 Data
computer Power supply 110 cable
(not included) (not included) |
RS-232 . oy Plastic
(RS-485 optional) . Seal
] ) - = RS-232
PRy 1| ~Stainless
steel
/ 7
Seawater Out k‘h(\( k\\ Seawater Out
SBE 45 SBE 45
MicroTSG Stainless pip2 nipples includad MicroTSG
Seawater In \ Optional Seawater In
\ remote sensor
SBE 38
[

Pum Pump

(not mcluded) (not included)
Seawater Intake Seawalter Intake
(as close to ship's bow as possible) (as close to ship's bow as possible)
(0304

SB Sea-Bird Electronics, Inc.
(CRLCLCEC

Website: http://www.seabird.com

1808 136th Place NE, Bellevue, Washington 98005 USA

E-mail: seabird@seabird.com
Telephone: (425) 643-29866
Fax: (425) 643-9954



SVP 70

A new generation of fixed-mount sound velocity probes

SVP 70
« Accurate & reliable sound The RESON SVP 70 sound velocity probe is developed for fixed-mount
velocity measurement in installation on surface ships, outboard rigs, submarines, AUVs, ROVs and
seawater other self-propelled platforms. The SVP 70 uses the latest electronic

technology combined with an innovative mechanical design to yield a

» Compact housing in titanium compact, robust, yet very flexible product.

for corrosion immunity and

high strength . . . .
The SVP 70 uses a direct path echosounding technique that instantly
- Mechanical design for easy compensates for temperature and pressure with internal sensors.
cleaning, optimal flow and
flexible integration The SVP 70 comes in a water resistant case including brackets for mounting,
a 3m accessory cable, bolts, and a user manual with system description.
+ Galvanically isolated multiple Additional adaptor kits and fairing accessories are available.
communication interfaces as
standard

- Direct path ultrasonic echo-
sounding with 2MHz trans-
ducer element

- Instant electronic temperature
and pressure compensation
via internal sensors

+ Integrated electronics and up
to 6000m depth rating

www.reson.com



SVP 70

A new generation of fixed-mount sound velocity probes

PRODUCT SPECIFICATION

Sound velocity

Range: 1350-1800m/s
Resolution: 0.01m/s
Accuracy: (0-50m +0.05m/s
Accuracy: (6000m) £0.25m/s

Sampling Rate:

20Hz and lower, programmable

Sampling Mode:

On request, continuous

1/0 Interfaces

Connector: Birns MCBHOMTT* (Titanium)

Output: (MCBH9M) True RS-232 and True RS-422
Baud Rate: 2400-115200

Galvanic Insulation: Yes

Output Options: Direct, filtered, validity

Output Formats:

Universal Programmable ASCII, Valeport, AML, SVP24, NMEA,
and others

Electrical

Supply: 8-55VDC

Current: 150mA @ 12V

Physical

Diameter: 44mm (maximum)

Length: 165mm (excl. connector)
End-Cap Height: 69mm (maximum)

Connector (MCBHOM): 52.5mm x @23mm

Weight: approximately 1.0kg (excl. cable)

Environmental

Pressure:

0-630bar

Temperature:

-20 to +55°C

Sales Package

900-63-0000-00 - SVP 70

904-63-0800-00 - Accessories Kit (5 pcs. DIN912 M6*10, 5 pcs. DIN933 M6*10, 4 x Mounting
O-rings, 7.5ml Silicon oil for connectors, Microfibre cloth

7211C03

- 2 x Mounting Brackets with rubber membrane

904-63-0801-00 - Plastic Transport Case

904-63-0802-00 - Operators Manual

904-63-0803-00 - Quick Reference Manual

904-63-0804-00 - Test Cable 1.5m long terminated with RS232 and R$232 D-sub connections
904-63-0808-00 - 25m Wet Cable with connector

906-63-0800-00 - MCA Female locking sleeve

Optional Cables (All wet cable pigtails with connectors)
904-63-0805-00 - 1.5m ¢ 904-63-0806-00 - 5m « 904-63-0807-00 - 10m «
904-63-0808-00 - 25m * 904-63-0809-00 - 60m

RESON reserves the right to change specifications without notice. © 2006 RESON A/S
For Acoustical Measurement Accuracy please refer to www.reson.com or contact sales.

RESON A/S

Denmark

Tel: +45 4738 0022
E-mail: reson@reson.com

RESON GmbH

Germany
Tel: +49 431 720 7180
E-mail: reson@reson-gmbh.de

RESON Inc.

USA

Tel: +1 805 964-6260
E-mail: sales@reson.com

RESON B.V.

The Netherlands

Tel: +31 (0) 10 245 1500
E-mail: info@reson.nl

Www.reson.com

RESON Offshore Ltd.
United Kingdom

Tel: +44 1224 709 900
E-mail: sales@reson.co.uk

RESON (Pte.) Ltd.
Singapore

Tel: +65 6725 9851
E-mail: sales@reson.com




SBE 19plus
SEACAT PROFILER

Conductivity, Temperature, and Pressure Recorder
with RS-232 Interface

Serial Number: 19P36026-4585

Sea-Bird Electronics, Inc.

1808 136" Place NE

Bellevue, Washington 98005 USA
Tel: 425/643-9866
Fax:425/643-9954



LIMITED LIABILITY STATEMENT

Extreme care should be exercised when using or servicing this equipment. It should be used or
serviced only by personnel with knowledge of and training in the use and maintenance of
oceanographic electronic equipment.

SEA-BIRD ELECTRONICS, INC. disclaims all product liability risks arising from the use or servicing of
this system. SEA-BIRD ELECTRONICS, INC. has no way of controlling the use of this equipment or of
choosing the personnel to operate it, and therefore cannot take steps to comply with laws pertaining to
product liability, including laws which impose a duty to warn the user of any dangers involved in
operating this equipment. Therefore, acceptance of this system by the customer shall be conclusively
deemed to include a covenant by the customer to defend, indemnify, and hold SEA-BIRD
ELECTRONICS, INC. harmless from all product liability claims arising from the use of servicing of this
system.



WARNING !!

Do not submerge this instrument (S/N 19P36026-4585)
beyond the depth rating of the lowest rated component listed below!

Main Housing (Titanium) 7000 meters
Pressure Sensor (3500 dBar) Druck 3500 meters

Pump (SBE 5M) 10500 meters



SYSTEM CONFIGURATION

Model SBE 19plus

Instrument Type

Firmware Version
Communications

Memory

Housing

0 Conductivity Raw Frequency
Pressure Sensor

Number of Voltages Sampled:
Serial RS-232C Sensor

Data Format:

Count

Frequency
Count

Pump (SBE 5M)

Voltage Delay Setting (standard)

14 June 2004

S/N 19P36026-4585

SBE 19plus SeaCarT Profiler

1.4D

9600 baud, 8 data bits, no parity, one stop bit
8192K

7000 meter (3AL-4V Titanium)

2630.97 Hz

Strain Gauge: 3500 dBar, S/N 5433

0

None

Temperature
Conductivity
Pressure, Strain gauge

050647

(standard) 0 seconds



IMPORTANT SOFTWARE & HARDWARE CONFIGURATION INFORMATION

Sea-Bird supplies two versions of our software package for communication, real-time data acquisition, and data
analysis and display:

e SEASOFT-Win32 - Windows software for PC running Win 95/98/NT/2000/XP

e SEASOFT-DOS - DOS software for IBM-PC/AT/386/486 or compatible computer with a hard drive
Detailed information on the use of the Windows software follows:

SEASOFT-Win32

SEASOFT-Win32 software was supplied on a CD-ROM with your CTD. This software package is designed to run on a PC running Win

95/98/NT/2000/XP. The CD-ROM also contains software manuals that describe the appropriate applications for the various programs, the

procedure for installing the software, and instructions on using the programs. There are three primary programs used with the CTD for

setup, data collection and retrieval, data display, and data processing:

e SEATERM - terminal program for setup of the CTD and uploading of data from the CTD memory (Note: If using the CTD with the
90208 Auto Fire Module or SBE 17plus V2 SEARAM, use SeatermAF instead of SEATERM)

e SEASAVE - real-time data acquisition program

e SBE Data Processing - data processing program

Instructions for using the software are found in their Help files.

To communicate with the CTD to set it up or to upload data from the CTD memory to the computer hard drive,
SEATERM must have information about the CTD hardware configuration (communication parameters, internal
firmware, etc.) and about the computer. To communicate with the CTD, double click on Seaterm.exe:
1. In the Configure menu, select the CTD. The Configuration Options dialog box appears.
A. On the COM Settings tab, select the firmware version (if applicable), baud rate, data bits, and parity to match the CTD’s
configuration sheet. If necessary, change the com port to match the computer you are using.
B. On the Upload Settings tab, enter upload type (all as a single file, etc.) as desired.
For the SBE 17 and 25 only: enter the serial number for the SBE 3 (temperature) and SBE 4 (conductivity) modular sensors,
exactly as they appear in the configuration (.con) file.
C. On the Header Information tab, change the settings as desired.
Click OK when done. SEATERM saves the settings in a SEATERM.ini file.
2. On the Toolbar, click Connect to communicate with the CTD.
To set up the CTD prior to deployment:
On the Toolbar, click Status. SEATERM sends the Status command and displays the response. Verify that the
CTD setup matches your desired deployment. If not, send commands to modify the setup.
4. To upload data from the CTD:
On the Toolbar, click Upload to upload data from the CTD memory to the computer.

»

Sea-Bird CTDs store and/or transmit data from their primary and auxiliary sensors in the form of binary or
hexadecimal number equivalents of the sensors’ frequency or voltage outputs. This is referred to as the raw data.
The calculations required to convert from raw data to engineering units of the measured parameters (temperature,
conductivity, pressure, dissolved oxygen, pH, etc.) are performed using the software, either in real time, or after
the data has been stored in a file. SEASAVE creates the file in real time. As noted above, SEATERM uploads the
recorded data and creates the file on the computer hard drive.

To successfully store data to a file on the computer and subsequently convert it to engineering units, the software
must know the CTD type, CTD configuration, and calibration coefficients for the sensors installed on the CTD.
This information is unique to each CTD, and is contained in a configuration file. The configuration file, which has
a .con extension, was written onto a floppy disk and the CD-ROM shipped with the CTD. The .con file for a given
CTD is named with the last four digits of the serial number for that CTD (e.g., 1234.con). The configuration file is
created or modified (e.g., changing coefficients after recalibration, or adding another sensor) by using the
Configure menu in SEASAVE or

SBE Data Processing. The configuration file is used by SEASAVE to convert raw data to engineering units
when it acquires, stores, and displays real-time data. The configuration file is also used by some modules in

SBE Data Processing (Data Conversion and Derive) that convert raw data to engineering units during data
processing.



The instrument type and instrument configuration settings of the .con file and the required setup for the
SEATERM.ini file for the CTD as delivered are documented below. The calibration coefficients for the CTD's
sensors are contained in the calibration coefficient section of the CTD manual.

NOTE:
SEATERM will not upload data correctly without a properly configured SEATERM.ini file. SEASAVE and SBE
Data Processing will not interpret the data correctly without the correct .con file.

SEASOFT CONFIGURATION:

The correct instrument type for your instrument is SBE 19plus SEACAT Profiler. The correct settings for the configuration of your
instrument as delivered are documented below:

Configuration for the SBE 19 Seacat pluz CTD Ed |

ASCI file opened: Mone

Freszure zenzor lppe IStrain Gauge j

Esternal vaoltage channels I 0 vl

Mode [Frafie =]
Sample interval seconds |-| i

Scans bo average |1

[ Suface PAR voltage added
[~ MMEL position data added

Channel Senzor M
1. Count
2. Frequency Conductivity EREI
3. Count Prezzure, Strain Gauge ErawE

Save bz

Selenh.

Fl ELE

odify. .

Feport... Help... E xit I Cancel




SPECIFICATIONS

SBE 19plus SpeCifiCations..........cccveveereeeiieenen e

SBE 5M PUMP.... vvveereereeeerseeeeeeeeesesssesesssssessesesssessssesseee




SEACAT Profiler SBE 19plus
(S L ELL

The SBE 19plus is the next generation Personal CTD, bringing numerous improvements in accuracy, resolution (in fresh as
well as salt water), reliability, and ease-of-use to the wide range of research, monitoring, and engineering applications
pioneered by its legendary SEACAT predecessor. The 19plus samples faster (4 Hz vs 2), is more accurate (0.005 vs 0.01 in
T, 0.0005 vs 0.001 in C, and 0.1% vs 0.25% — with seven times the resolution — in D), and has more memory (8 Mbyte vs 1).
There is more power for auxiliary sensors (500 ma vs 50), and they are acquired at higher resolution (14 bit vs 12). Cabling is
simpler and more reliable because there are four differential auxiliary inputs on two separate connectors, and a dedicated
connector for the pump. All exposed metal parts are titanium, instead of aluminum, for long life and minimum maintenance.

The 19plus can be operated without a computer from even the smallest boat, with data recorded in non-volatile FLASH
memory and processed later on your PC. Simultaneous with recording, real-time data can be transmitted over single-core,
armored cable directly to your PC'’s serial port (maximum transmission distance dependent on number of auxiliary sensors,
baud rate, and cable properties). The 19plus’ faster sampling and pump-controlled TC-ducted flow configuration significantly
reduces salinity spiking caused by ship heave, and allows slower descent rates for improved resolution of water column features.
Auxiliary sensors for dissolved oxygen, pH, turbidity, fluorescense, PAR, and ORP can be added, and for moored deployments the
19plus can be set to time-series mode using software commands. External power and two-way real-time communication over
10,000 meters of cable can be provided with the SBE 36 CTD Deck Unit and Power and Data Interface Module (PDIM).

The 19plus uses the same temperature and conductivity sensors proven in 5000 SEACAT and MicroCAT instruments, and a
superior new micro-machined silicon strain gauge pressure sensor developed by Druck, Inc. Improvements in design,
materials, and signal acquisition techniques yield a low-cost instrument with superior performance that is also easy to use.
Calibration coefficients, obtained in our computer-controlled high-accuracy calibration baths, are stored in EEPROM memory.
They permit data output in ASCII engineering units (degrees C, Siemens/m, decibars, Salinity [PSU], sound velocity [m/sec],
etc.). The 19plus can be factory-configured to emulate the .hex output format and 2 Hz data rate of old SEACATs for
compatibility with existing software or instrument fleets.

Accuracy, convenience, portability, software, and support; compelling reasons why the 19plus is today’s best low-cost CTD.

CONFIGURATION AND OPTIONS Shown with
A standard SBE 19plus is supplied with: optional cage,
+ Plastic housing for depths to 600 meters SBE 5T pump,
+ Strain-gauge pressure sensor & SBE 43
* 8 Mbyte FLASH RAM memory / DO sensor

* 9O D-size alkaline batteries

* Impulse glass-reinforced epoxy bulkhead connectors: 4-pin /0,
2-pin pump, and two 6-pin (two differential auxiliary A/D inputs each)

* SBE 5M miniature pump and T-C Duct

Options include:

« Titanium housing for depths to 7000 meters

» Sensors for oxygen, pH, fluorescence, light (PAR), light transmission,
and turbidity

* SBE 5T pump in place of SBE 5M for use with dissolved oxygen and/or
other pumped sensors

 Stainless steel cage

* MCBH Micro connectors

* Ni-Cad batteries and charger

SOFTWARE

SEASOFT®-Win32, our complete Windows 95/98/NT/2000/XP software package,

is included at no extra charge. Its modular programs include:

+ SEATERM® — communication and data retrieval

+ SEASAVE® — real-time data acquisition and display

» SBE Data Processing® — filtering, aligning, averaging, and plotting of CTD and
auxiliary sensor data and derived variables

SB Sea-Bird Electronics, Inc. Email: seabird@seabird.com
1808 136th Place NE, Bellevue, Washington 98005 USA Telephone: (425) 643-9866
m Website: http://www.seabird.com Fax: (425) 643-9954
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SEACAT Profiler

OO O OO O

o) °etO 0000
oS o -
| 808 (31.80) |
99 (3.90) DIA Optional
\ OOC=2 OO Auiiry
—_l Input
e o/H—h
] H=h /
[ : ] Pump
575 (22.65)
SPECIFICATIONS
Measurement Range
Temperature -51t0 +35 °C
Conductivity 0to 9 S/m
Pressure 0to20/100/350/1000 /2000 /3500 /7000 meters
Initial Accuracy
Temperature 0.005 °C
Conductivity 0.0005 S/m
Pressure 0.1% of full scale range
Typical Stability (per month)
Temperature 0.0002 °C B
Conductivity 0.0003 S/m A'rl bleed [
Pressure 0.004% of full scale range valve
Resolution
Temperature 0.0001 °C Yflttlng
Conductivity 0.00005 S/m (most oceanic waters; resolves 0.4 ppm in salinity)
0.00007 S/m (high salinity waters; resolves 0.4 ppm in salinity)
0.00001 S/m (fresh waters; resolves 0.1 ppm in salinity)
Pressure 0.002% of full scale range
Memory 8 Mbyte non-volatile FLASH memory
Data Storage Recorded Parameter Bytes/Sample
T+C 6
pressure 5
each external voltage 2
Real-Time Clock 32,768 Hz TCXO accurate to +1 minute/year
Internal Batteries 9 alkaline D-cells provide 60 hours continuous CTD operation;

External Power Supply 9-28 VDC

optional 9-cell rechargeable nickel-cadmium battery pack
provides approximately 24 hours operation per charge

Power Requirements (covering temperature
Sampling 65 mA sensor, TC duct, &
SBE 5M pump 95 mA conductivity sensor)
Quiescent 30 YA

Auxiliary Voltage Sensors

Auxiliary power out up to 500 mA at 10.5-11 VDC

A/D resolution 14 bits

Input range

Housing Materials — Depth Rating — Weight

0-5VvVDC

Acetal Copolymer Plastic housing — 600 meter (1950 feet) — 7.3 kg (16 Ibs)
3AL-2.5V Titanium housing — 7000 meter (22,900 feet) — 13.7 kg (30 Ibs)

SBE 19plus

Dimensions
in millimeters
(inches)

~

Conductivity cell guard

SBE 5M
pump

O
O
O
O
O
O
/

Water intake

(CELLTLEL

Data I/O
cable

/ _Pump

inlet port

|~ Pump
exhaust port

SB Sea-Bird Electronics, Inc.
1808 136th Place NE, Bellevue, Washington 98005 USA

Website: http://www.seabird.com

Email: seabird@seabird.com
Telephone: (425) 643-9866
Fax: (425) 643-9954



Mini Submersible Pump

100

SBE 5M

The SBE 5M pump module consists of a centrifugal pump
head and a long-life, DC ball bearing motor contained in a
compact, titanium, pressure housing usable to
10,500 meters deep. The pump impeller and electric drive
motor are coupled magnetically through the housing,
providing high reliability by eliminating moving seals. Motor
speed and pumping rate remain constant over the entire
input voltage range. The motor drive electronics is
intrinsically protected against accidental reversed polarity.

APPLICATIONS

The SBE 5M is standard on the SBE 19 and 19plus
SEACAT Profiler CTD. It is optional on the SBE 16, 16plus,
and 16plus-IM SEACAT C-T Recorder. The pump flushes
water through the conductivity cell at a constant rate,
independent of the CTD's motion, improving dynamic
performance. For applications requiring pumping through
additional sensors (for example, a dissolved oxygen
sensor), use the SBE 5T pump instead.

Specify:

e Option 5M-1 for profiling (continuous duty) applications
such as the SBE 19plus.

e Option 5M-2 for moored (pulsed duty) applications such
as the SBE 16plus or 16plus-IM.

Contact Sea-Bird for use in other applications.

SPECIFICATIONS

Option 5M-1 (continuous duty):
Input voltage range 9 - 18 VDC

Flow Rate 25 ml/s supply current 95 ma
Note: Supply current is independent of operating voltage.

Option 5M-2 (pulsed duty):
Input voltage range 6 - 18 VDC

Pulse Duration Flow Volume Electrical Charge
0.5 seconds 15 ml 0.148 amp-seconds
1.0 seconds 21 mi 0.283 amp-seconds
1.5 seconds 31 ml 0.418 amp-seconds
2.0 seconds 40 ml 0.553 amp-seconds
Weight

In Air: 0.42 kg (0.91 Ibs)

In Water: 0.28 kg (0.60 Ibs)

0.5in.(13mm)

/\\< Intake \
o )
N4

2.03in.
(51 mm) "

0.5in. (13 mm)

I |
= 0.56 in. (14 mm)
I
@] ~+-=—— Plastic
impeller
housing
4.1 in.
(104 mm)
—— Titanium

1.7in.
(44 mm)

. 1.5in. __|
(38 mm)
XSG-2BCL-HP-SS
_ Pin Signal
(1) Ground
1@ «2 |(2) + Power

-~ Optional
. wet-pluggable

20 @1 connector,
MCBH-2MTI

06/03

Sea-Bird Electronics, Inc.

m Website: http://www.seabird.com

1808 136" Place NE, Bellevue, Washington 98005 USA

E-mail: seabird@seabird.com
Telephone: (425) 643-9866
Fax: (425) 643-9954



105

S B E Sea-Bird Electronics, Inc. FAX: (425) 643-9954

1808 136th Place NE, Bellevue, Washington 98005 USA Tel: (425) 643-9866
m Website: http://www.seabird.com Email: seabird@seabird.com

SBE SM MINI SUBMERSIBLE PUMP CONFIGURATION SHEET

Serial Number: 0647
Job Number: 36026
Customer: NOAA/PMC

Delivery Date:  6/14/2004

Single Connector Housing with Titanium screws

Pressure Case: 10,500 meters (titanium)

Maxon Motor Type:
P/N 90337, Motor PN 20130 (Low power 6 VDC, 2000 RPM MAX) ]
P/N 90335, Motor PN 20130 (Low power 9 VDC, 2000 RPM MAX)

Vin 15V voltage across C2: 8.015 VDC  Current  7.73 mA
Vin 9V voltage across C2: 8.014 VDC  Current 74 mA

Vin 6V voltage across C2: 5.888 VDC  Current 7.61 mA

Pump submerged test, no load, Vin 12VDC Average current draw in water: 121 mA



SBE 19plus
SEACAT PROFILER

Conductivity, Temperature, and Pressure Recorder
with RS-232 Interface

Serial Number: 19P36026-4616

Sea-Bird Electronics, Inc.

1808 136" Place NE

Bellevue, Washington 98005 USA
Tel: 425/643-9866
Fax:425/643-9954



WARNING !!

Do not submerge this instrument (S/N 19P36026-4616)
beyond the depth rating of the lowest rated component listed below!

Main Housing (Plastic) 600 meters
Pressure Sensor (1000 dBar) Druck 1000 meters

Pump (SBE 5M) 10500 meters



SYSTEM CONFIGURATION

Model SBE 19plus

Instrument Type

Firmware Version
Communications

Memory

Housing

0 Conductivity Raw Frequency
Pressure Sensor

Number of Voltages Sampled:
Serial RS-232C Sensor

Data Format:

Count

Frequency
Count

Pump (SBE 5M)

Voltage Delay Setting (standard)

14 June 2004

S/N 19P36026-4616

SBE 19plus SeaCarT Profiler

1.4D

9600 baud, 8 data bits, no parity, one stop bit
8192K

600 meter (Celcon plastic)

2686.52 Hz

Strain Gauge: 1000 dBar, S/N 5512

0

None

Temperature
Conductivity
Pressure, Strain gauge

050651

(standard) 0 seconds



IMPORTANT SOFTWARE & HARDWARE CONFIGURATION INFORMATION

Sea-Bird supplies two versions of our software package for communication, real-time data acquisition, and data
analysis and display:

e SEASOFT-Win32 - Windows software for PC running Win 95/98/NT/2000/XP

e SEASOFT-DOS - DOS software for IBM-PC/AT/386/486 or compatible computer with a hard drive
Detailed information on the use of the Windows software follows:

SEASOFT-Win32

SEASOFT-Win32 software was supplied on a CD-ROM with your CTD. This software package is designed to run on a PC running Win

95/98/NT/2000/XP. The CD-ROM also contains software manuals that describe the appropriate applications for the various programs, the

procedure for installing the software, and instructions on using the programs. There are three primary programs used with the CTD for

setup, data collection and retrieval, data display, and data processing:

e SEATERM - terminal program for setup of the CTD and uploading of data from the CTD memory (Note: If using the CTD with the
90208 Auto Fire Module or SBE 17plus V2 SEARAM, use SeatermAF instead of SEATERM)

e SEASAVE - real-time data acquisition program

e SBE Data Processing - data processing program

Instructions for using the software are found in their Help files.

To communicate with the CTD to set it up or to upload data from the CTD memory to the computer hard drive,
SEATERM must have information about the CTD hardware configuration (communication parameters, internal
firmware, etc.) and about the computer. To communicate with the CTD, double click on Seaterm.exe:
1. In the Configure menu, select the CTD. The Configuration Options dialog box appears.
A. On the COM Settings tab, select the firmware version (if applicable), baud rate, data bits, and parity to match the CTD’s
configuration sheet. If necessary, change the com port to match the computer you are using.
B. On the Upload Settings tab, enter upload type (all as a single file, etc.) as desired.
For the SBE 17 and 25 only: enter the serial number for the SBE 3 (temperature) and SBE 4 (conductivity) modular sensors,
exactly as they appear in the configuration (.con) file.
C. On the Header Information tab, change the settings as desired.
Click OK when done. SEATERM saves the settings in a SEATERM.ini file.
2. On the Toolbar, click Connect to communicate with the CTD.
To set up the CTD prior to deployment:
On the Toolbar, click Status. SEATERM sends the Status command and displays the response. Verify that the
CTD setup matches your desired deployment. If not, send commands to modify the setup.
4. To upload data from the CTD:
On the Toolbar, click Upload to upload data from the CTD memory to the computer.

»

Sea-Bird CTDs store and/or transmit data from their primary and auxiliary sensors in the form of binary or
hexadecimal number equivalents of the sensors’ frequency or voltage outputs. This is referred to as the raw data.
The calculations required to convert from raw data to engineering units of the measured parameters (temperature,
conductivity, pressure, dissolved oxygen, pH, etc.) are performed using the software, either in real time, or after
the data has been stored in a file. SEASAVE creates the file in real time. As noted above, SEATERM uploads the
recorded data and creates the file on the computer hard drive.

To successfully store data to a file on the computer and subsequently convert it to engineering units, the software
must know the CTD type, CTD configuration, and calibration coefficients for the sensors installed on the CTD.
This information is unique to each CTD, and is contained in a configuration file. The configuration file, which has
a .con extension, was written onto a floppy disk and the CD-ROM shipped with the CTD. The .con file for a given
CTD is named with the last four digits of the serial number for that CTD (e.g., 1234.con). The configuration file is
created or modified (e.g., changing coefficients after recalibration, or adding another sensor) by using the
Configure menu in SEASAVE or

SBE Data Processing. The configuration file is used by SEASAVE to convert raw data to engineering units
when it acquires, stores, and displays real-time data. The configuration file is also used by some modules in

SBE Data Processing (Data Conversion and Derive) that convert raw data to engineering units during data
processing.



The instrument type and instrument configuration settings of the .con file and the required setup for the
SEATERM.ini file for the CTD as delivered are documented below. The calibration coefficients for the CTD's
sensors are contained in the calibration coefficient section of the CTD manual.

NOTE:
SEATERM will not upload data correctly without a properly configured SEATERM.ini file. SEASAVE and SBE
Data Processing will not interpret the data correctly without the correct .con file.

SEASOFT CONFIGURATION:

The correct instrument type for your instrument is SBE 19plus SEACAT Profiler. The correct settings for the configuration of your
instrument as delivered are documented below:
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SEACAT Profiler SBE 19plus
(S L ELL

The SBE 19plus is the next generation Personal CTD, bringing numerous improvements in accuracy, resolution (in fresh as
well as salt water), reliability, and ease-of-use to the wide range of research, monitoring, and engineering applications
pioneered by its legendary SEACAT predecessor. The 19plus samples faster (4 Hz vs 2), is more accurate (0.005 vs 0.01 in
T, 0.0005 vs 0.001 in C, and 0.1% vs 0.25% — with seven times the resolution — in D), and has more memory (8 Mbyte vs 1).
There is more power for auxiliary sensors (500 ma vs 50), and they are acquired at higher resolution (14 bit vs 12). Cabling is
simpler and more reliable because there are four differential auxiliary inputs on two separate connectors, and a dedicated
connector for the pump. All exposed metal parts are titanium, instead of aluminum, for long life and minimum maintenance.

The 19plus can be operated without a computer from even the smallest boat, with data recorded in non-volatile FLASH
memory and processed later on your PC. Simultaneous with recording, real-time data can be transmitted over single-core,
armored cable directly to your PC'’s serial port (maximum transmission distance dependent on number of auxiliary sensors,
baud rate, and cable properties). The 19plus’ faster sampling and pump-controlled TC-ducted flow configuration significantly
reduces salinity spiking caused by ship heave, and allows slower descent rates for improved resolution of water column features.
Auxiliary sensors for dissolved oxygen, pH, turbidity, fluorescense, PAR, and ORP can be added, and for moored deployments the
19plus can be set to time-series mode using software commands. External power and two-way real-time communication over
10,000 meters of cable can be provided with the SBE 36 CTD Deck Unit and Power and Data Interface Module (PDIM).

The 19plus uses the same temperature and conductivity sensors proven in 5000 SEACAT and MicroCAT instruments, and a
superior new micro-machined silicon strain gauge pressure sensor developed by Druck, Inc. Improvements in design,
materials, and signal acquisition techniques yield a low-cost instrument with superior performance that is also easy to use.
Calibration coefficients, obtained in our computer-controlled high-accuracy calibration baths, are stored in EEPROM memory.
They permit data output in ASCII engineering units (degrees C, Siemens/m, decibars, Salinity [PSU], sound velocity [m/sec],
etc.). The 19plus can be factory-configured to emulate the .hex output format and 2 Hz data rate of old SEACATs for
compatibility with existing software or instrument fleets.

Accuracy, convenience, portability, software, and support; compelling reasons why the 19plus is today’s best low-cost CTD.

CONFIGURATION AND OPTIONS Shown with
A standard SBE 19plus is supplied with: optional cage,
+ Plastic housing for depths to 600 meters SBE 5T pump,
+ Strain-gauge pressure sensor & SBE 43
* 8 Mbyte FLASH RAM memory / DO sensor

* 9O D-size alkaline batteries

* Impulse glass-reinforced epoxy bulkhead connectors: 4-pin /0,
2-pin pump, and two 6-pin (two differential auxiliary A/D inputs each)

* SBE 5M miniature pump and T-C Duct

Options include:

« Titanium housing for depths to 7000 meters

» Sensors for oxygen, pH, fluorescence, light (PAR), light transmission,
and turbidity

* SBE 5T pump in place of SBE 5M for use with dissolved oxygen and/or
other pumped sensors

 Stainless steel cage

* MCBH Micro connectors

* Ni-Cad batteries and charger

SOFTWARE

SEASOFT®-Win32, our complete Windows 95/98/NT/2000/XP software package,

is included at no extra charge. Its modular programs include:

+ SEATERM® — communication and data retrieval

+ SEASAVE® — real-time data acquisition and display

» SBE Data Processing® — filtering, aligning, averaging, and plotting of CTD and
auxiliary sensor data and derived variables

SB Sea-Bird Electronics, Inc. Email: seabird@seabird.com
1808 136th Place NE, Bellevue, Washington 98005 USA Telephone: (425) 643-9866
m Website: http://www.seabird.com Fax: (425) 643-9954
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SEACAT Profiler
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[ : ] Pump
575 (22.65)
SPECIFICATIONS
Measurement Range
Temperature -51t0 +35 °C
Conductivity 0to 9 S/m
Pressure 0to20/100/350/1000 /2000 /3500 /7000 meters
Initial Accuracy
Temperature 0.005 °C
Conductivity 0.0005 S/m
Pressure 0.1% of full scale range
Typical Stability (per month)
Temperature 0.0002 °C B
Conductivity 0.0003 S/m A'rl bleed [
Pressure 0.004% of full scale range valve
Resolution
Temperature 0.0001 °C Yflttlng
Conductivity 0.00005 S/m (most oceanic waters; resolves 0.4 ppm in salinity)
0.00007 S/m (high salinity waters; resolves 0.4 ppm in salinity)
0.00001 S/m (fresh waters; resolves 0.1 ppm in salinity)
Pressure 0.002% of full scale range
Memory 8 Mbyte non-volatile FLASH memory
Data Storage Recorded Parameter Bytes/Sample
T+C 6
pressure 5
each external voltage 2
Real-Time Clock 32,768 Hz TCXO accurate to +1 minute/year
Internal Batteries 9 alkaline D-cells provide 60 hours continuous CTD operation;

External Power Supply 9-28 VDC

optional 9-cell rechargeable nickel-cadmium battery pack
provides approximately 24 hours operation per charge

Power Requirements (covering temperature
Sampling 65 mA sensor, TC duct, &
SBE 5M pump 95 mA conductivity sensor)
Quiescent 30 YA

Auxiliary Voltage Sensors

Auxiliary power out up to 500 mA at 10.5-11 VDC

A/D resolution 14 bits

Input range

Housing Materials — Depth Rating — Weight

0-5VvVDC

Acetal Copolymer Plastic housing — 600 meter (1950 feet) — 7.3 kg (16 Ibs)
3AL-2.5V Titanium housing — 7000 meter (22,900 feet) — 13.7 kg (30 Ibs)

SBE 19plus

Dimensions
in millimeters
(inches)

~

Conductivity cell guard

SBE 5M
pump
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O
O
O
O
O
/

Water intake

(CELLTLEL

Data I/O
cable

/ _Pump

inlet port

|~ Pump
exhaust port

SB Sea-Bird Electronics, Inc.
1808 136th Place NE, Bellevue, Washington 98005 USA

Website: http://www.seabird.com

Email: seabird@seabird.com
Telephone: (425) 643-9866
Fax: (425) 643-9954
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SBE 5M

The SBE 5M pump module consists of a centrifugal pump
head and a long-life, DC ball bearing motor contained in a
compact, titanium, pressure housing usable to
10,500 meters deep. The pump impeller and electric drive
motor are coupled magnetically through the housing,
providing high reliability by eliminating moving seals. Motor
speed and pumping rate remain constant over the entire
input voltage range. The motor drive electronics is
intrinsically protected against accidental reversed polarity.

APPLICATIONS

The SBE 5M is standard on the SBE 19 and 19plus
SEACAT Profiler CTD. It is optional on the SBE 16, 16plus,
and 16plus-IM SEACAT C-T Recorder. The pump flushes
water through the conductivity cell at a constant rate,
independent of the CTD's motion, improving dynamic
performance. For applications requiring pumping through
additional sensors (for example, a dissolved oxygen
sensor), use the SBE 5T pump instead.

Specify:

e Option 5M-1 for profiling (continuous duty) applications
such as the SBE 19plus.

e Option 5M-2 for moored (pulsed duty) applications such
as the SBE 16plus or 16plus-IM.

Contact Sea-Bird for use in other applications.

SPECIFICATIONS

Option 5M-1 (continuous duty):
Input voltage range 9 - 18 VDC

Flow Rate 25 ml/s supply current 95 ma
Note: Supply current is independent of operating voltage.

Option 5M-2 (pulsed duty):
Input voltage range 6 - 18 VDC

Pulse Duration Flow Volume Electrical Charge
0.5 seconds 15 ml 0.148 amp-seconds
1.0 seconds 21 mi 0.283 amp-seconds
1.5 seconds 31 ml 0.418 amp-seconds
2.0 seconds 40 ml 0.553 amp-seconds
Weight

In Air: 0.42 kg (0.91 Ibs)

In Water: 0.28 kg (0.60 Ibs)

0.5in.(13mm)

/\\< Intake \
o )
N4

2.03in.
(51 mm) "

0.5in. (13 mm)

I |
= 0.56 in. (14 mm)
I
@] ~+-=—— Plastic
impeller
housing
4.1 in.
(104 mm)
—— Titanium

1.7in.
(44 mm)

. 1.5in. __|
(38 mm)
XSG-2BCL-HP-SS
_ Pin Signal
(1) Ground
1@ «2 |(2) + Power

-~ Optional
. wet-pluggable

20 @1 connector,
MCBH-2MTI
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Sea-Bird Electronics, Inc.

m Website: http://www.seabird.com

1808 136" Place NE, Bellevue, Washington 98005 USA

E-mail: seabird@seabird.com
Telephone: (425) 643-9866
Fax: (425) 643-9954
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S B E Sea-Bird Electronics, Inc. FAX: (425) 643-9954

1808 136th Place NE, Bellevue, Washington 98005 USA Tel: (425) 643-9866
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SBE SM MINI SUBMERSIBLE PUMP CONFIGURATION SHEET

Serial Number: 0651
Job Number: 36026
Customer: NOAA/PMC

Delivery Date:  6/14/2004

Single Connector Housing with Titanium screws

Pressure Case: 10,500 meters (titanium)

Maxon Motor Type:
P/N 90337, Motor PN 20130 (Low power 6 VDC, 2000 RPM MAX) ]
P/N 90335, Motor PN 20130 (Low power 9 VDC, 2000 RPM MAX)

Vin 15V voltage across C2: 7.929 VDC  Current  9.29 mA
Vin 9V voltage across C2: 7.928 VDC  Current 8.8 mA

Vin 6V voltage across C2: 5.885 VDC  Current 7.99 mA

Pump submerged test, no load, Vin 12VDC Average current draw in water: 120 mA



SBE 19plus
SEACAT PROFILER

Conductivity, Temperature, and Pressure Recorder
with RS-232 Interface

Serial Number: 19P36026-4617

Sea-Bird Electronics, Inc.

1808 136" Place NE

Bellevue, Washington 98005 USA
Tel: 425/643-9866
Fax:425/643-9954



LIMITED LIABILITY STATEMENT

Extreme care should be exercised when using or servicing this equipment. It should be used or
serviced only by personnel with knowledge of and training in the use and maintenance of
oceanographic electronic equipment.

SEA-BIRD ELECTRONICS, INC. disclaims all product liability risks arising from the use or servicing of
this system. SEA-BIRD ELECTRONICS, INC. has no way of controlling the use of this equipment or of
choosing the personnel to operate it, and therefore cannot take steps to comply with laws pertaining to
product liability, including laws which impose a duty to warn the user of any dangers involved in
operating this equipment. Therefore, acceptance of this system by the customer shall be conclusively
deemed to include a covenant by the customer to defend, indemnify, and hold SEA-BIRD
ELECTRONICS, INC. harmless from all product liability claims arising from the use of servicing of this
system.



WARNING !!

Do not submerge this instrument (S/N 19P36026-4617)
beyond the depth rating of the lowest rated component listed below!

Main Housing (Plastic) 600 meters
Pressure Sensor (1000 dBar) Druck 1000 meters

Pump (SBE 5M) 10500 meters



SYSTEM CONFIGURATION

Model SBE 19plus

Instrument Type

Firmware Version
Communications

Memory

Housing

0 Conductivity Raw Frequency
Pressure Sensor

Number of Voltages Sampled:
Serial RS-232C Sensor

Data Format:

Count

Frequency
Count

Pump (SBE 5M)

Voltage Delay Setting (standard)

14 June 2004

S/N 19P36026-4617

SBE 19plus SeaCarT Profiler

1.4D

9600 baud, 8 data bits, no parity, one stop bit
8192K

600 meter (Celcon plastic)

2801.47 Hz

Strain Gauge: 1000 dBar, S/N 5513

0

None

Temperature
Conductivity
Pressure, Strain gauge

050649

(standard) 0 seconds



IMPORTANT SOFTWARE & HARDWARE CONFIGURATION INFORMATION

Sea-Bird supplies two versions of our software package for communication, real-time data acquisition, and data
analysis and display:

e SEASOFT-Win32 - Windows software for PC running Win 95/98/NT/2000/XP

e SEASOFT-DOS - DOS software for IBM-PC/AT/386/486 or compatible computer with a hard drive
Detailed information on the use of the Windows software follows:

SEASOFT-Win32

SEASOFT-Win32 software was supplied on a CD-ROM with your CTD. This software package is designed to run on a PC running Win

95/98/NT/2000/XP. The CD-ROM also contains software manuals that describe the appropriate applications for the various programs, the

procedure for installing the software, and instructions on using the programs. There are three primary programs used with the CTD for

setup, data collection and retrieval, data display, and data processing:

e SEATERM - terminal program for setup of the CTD and uploading of data from the CTD memory (Note: If using the CTD with the
90208 Auto Fire Module or SBE 17plus V2 SEARAM, use SeatermAF instead of SEATERM)

e SEASAVE - real-time data acquisition program

e SBE Data Processing - data processing program

Instructions for using the software are found in their Help files.

To communicate with the CTD to set it up or to upload data from the CTD memory to the computer hard drive,
SEATERM must have information about the CTD hardware configuration (communication parameters, internal
firmware, etc.) and about the computer. To communicate with the CTD, double click on Seaterm.exe:
1. In the Configure menu, select the CTD. The Configuration Options dialog box appears.
A. On the COM Settings tab, select the firmware version (if applicable), baud rate, data bits, and parity to match the CTD’s
configuration sheet. If necessary, change the com port to match the computer you are using.
B. On the Upload Settings tab, enter upload type (all as a single file, etc.) as desired.
For the SBE 17 and 25 only: enter the serial number for the SBE 3 (temperature) and SBE 4 (conductivity) modular sensors,
exactly as they appear in the configuration (.con) file.
C. On the Header Information tab, change the settings as desired.
Click OK when done. SEATERM saves the settings in a SEATERM.ini file.
2. On the Toolbar, click Connect to communicate with the CTD.
To set up the CTD prior to deployment:
On the Toolbar, click Status. SEATERM sends the Status command and displays the response. Verify that the
CTD setup matches your desired deployment. If not, send commands to modify the setup.
4. To upload data from the CTD:
On the Toolbar, click Upload to upload data from the CTD memory to the computer.

»

Sea-Bird CTDs store and/or transmit data from their primary and auxiliary sensors in the form of binary or
hexadecimal number equivalents of the sensors’ frequency or voltage outputs. This is referred to as the raw data.
The calculations required to convert from raw data to engineering units of the measured parameters (temperature,
conductivity, pressure, dissolved oxygen, pH, etc.) are performed using the software, either in real time, or after
the data has been stored in a file. SEASAVE creates the file in real time. As noted above, SEATERM uploads the
recorded data and creates the file on the computer hard drive.

To successfully store data to a file on the computer and subsequently convert it to engineering units, the software
must know the CTD type, CTD configuration, and calibration coefficients for the sensors installed on the CTD.
This information is unique to each CTD, and is contained in a configuration file. The configuration file, which has
a .con extension, was written onto a floppy disk and the CD-ROM shipped with the CTD. The .con file for a given
CTD is named with the last four digits of the serial number for that CTD (e.g., 1234.con). The configuration file is
created or modified (e.g., changing coefficients after recalibration, or adding another sensor) by using the
Configure menu in SEASAVE or

SBE Data Processing. The configuration file is used by SEASAVE to convert raw data to engineering units
when it acquires, stores, and displays real-time data. The configuration file is also used by some modules in

SBE Data Processing (Data Conversion and Derive) that convert raw data to engineering units during data
processing.



The instrument type and instrument configuration settings of the .con file and the required setup for the
SEATERM.ini file for the CTD as delivered are documented below. The calibration coefficients for the CTD's
sensors are contained in the calibration coefficient section of the CTD manual.

NOTE:
SEATERM will not upload data correctly without a properly configured SEATERM.ini file. SEASAVE and SBE
Data Processing will not interpret the data correctly without the correct .con file.

SEASOFT CONFIGURATION:

The correct instrument type for your instrument is SBE 19plus SEACAT Profiler. The correct settings for the configuration of your
instrument as delivered are documented below:
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SEACAT Profiler SBE 19plus
(S L ELL

The SBE 19plus is the next generation Personal CTD, bringing numerous improvements in accuracy, resolution (in fresh as
well as salt water), reliability, and ease-of-use to the wide range of research, monitoring, and engineering applications
pioneered by its legendary SEACAT predecessor. The 19plus samples faster (4 Hz vs 2), is more accurate (0.005 vs 0.01 in
T, 0.0005 vs 0.001 in C, and 0.1% vs 0.25% — with seven times the resolution — in D), and has more memory (8 Mbyte vs 1).
There is more power for auxiliary sensors (500 ma vs 50), and they are acquired at higher resolution (14 bit vs 12). Cabling is
simpler and more reliable because there are four differential auxiliary inputs on two separate connectors, and a dedicated
connector for the pump. All exposed metal parts are titanium, instead of aluminum, for long life and minimum maintenance.

The 19plus can be operated without a computer from even the smallest boat, with data recorded in non-volatile FLASH
memory and processed later on your PC. Simultaneous with recording, real-time data can be transmitted over single-core,
armored cable directly to your PC'’s serial port (maximum transmission distance dependent on number of auxiliary sensors,
baud rate, and cable properties). The 19plus’ faster sampling and pump-controlled TC-ducted flow configuration significantly
reduces salinity spiking caused by ship heave, and allows slower descent rates for improved resolution of water column features.
Auxiliary sensors for dissolved oxygen, pH, turbidity, fluorescense, PAR, and ORP can be added, and for moored deployments the
19plus can be set to time-series mode using software commands. External power and two-way real-time communication over
10,000 meters of cable can be provided with the SBE 36 CTD Deck Unit and Power and Data Interface Module (PDIM).

The 19plus uses the same temperature and conductivity sensors proven in 5000 SEACAT and MicroCAT instruments, and a
superior new micro-machined silicon strain gauge pressure sensor developed by Druck, Inc. Improvements in design,
materials, and signal acquisition techniques yield a low-cost instrument with superior performance that is also easy to use.
Calibration coefficients, obtained in our computer-controlled high-accuracy calibration baths, are stored in EEPROM memory.
They permit data output in ASCII engineering units (degrees C, Siemens/m, decibars, Salinity [PSU], sound velocity [m/sec],
etc.). The 19plus can be factory-configured to emulate the .hex output format and 2 Hz data rate of old SEACATs for
compatibility with existing software or instrument fleets.

Accuracy, convenience, portability, software, and support; compelling reasons why the 19plus is today’s best low-cost CTD.

CONFIGURATION AND OPTIONS Shown with
A standard SBE 19plus is supplied with: optional cage,
+ Plastic housing for depths to 600 meters SBE 5T pump,
+ Strain-gauge pressure sensor & SBE 43
* 8 Mbyte FLASH RAM memory / DO sensor

* 9O D-size alkaline batteries

* Impulse glass-reinforced epoxy bulkhead connectors: 4-pin /0,
2-pin pump, and two 6-pin (two differential auxiliary A/D inputs each)

* SBE 5M miniature pump and T-C Duct

Options include:

« Titanium housing for depths to 7000 meters

» Sensors for oxygen, pH, fluorescence, light (PAR), light transmission,
and turbidity

* SBE 5T pump in place of SBE 5M for use with dissolved oxygen and/or
other pumped sensors

 Stainless steel cage

* MCBH Micro connectors

* Ni-Cad batteries and charger

SOFTWARE

SEASOFT®-Win32, our complete Windows 95/98/NT/2000/XP software package,

is included at no extra charge. Its modular programs include:

+ SEATERM® — communication and data retrieval

+ SEASAVE® — real-time data acquisition and display

» SBE Data Processing® — filtering, aligning, averaging, and plotting of CTD and
auxiliary sensor data and derived variables

SB Sea-Bird Electronics, Inc. Email: seabird@seabird.com
1808 136th Place NE, Bellevue, Washington 98005 USA Telephone: (425) 643-9866
m Website: http://www.seabird.com Fax: (425) 643-9954
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SEACAT Profiler
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SPECIFICATIONS
Measurement Range
Temperature -51t0 +35 °C
Conductivity 0to 9 S/m
Pressure 0to20/100/350/1000 /2000 /3500 /7000 meters
Initial Accuracy
Temperature 0.005 °C
Conductivity 0.0005 S/m
Pressure 0.1% of full scale range
Typical Stability (per month)
Temperature 0.0002 °C B
Conductivity 0.0003 S/m A'rl bleed [
Pressure 0.004% of full scale range valve
Resolution
Temperature 0.0001 °C Yflttlng
Conductivity 0.00005 S/m (most oceanic waters; resolves 0.4 ppm in salinity)
0.00007 S/m (high salinity waters; resolves 0.4 ppm in salinity)
0.00001 S/m (fresh waters; resolves 0.1 ppm in salinity)
Pressure 0.002% of full scale range
Memory 8 Mbyte non-volatile FLASH memory
Data Storage Recorded Parameter Bytes/Sample
T+C 6
pressure 5
each external voltage 2
Real-Time Clock 32,768 Hz TCXO accurate to +1 minute/year
Internal Batteries 9 alkaline D-cells provide 60 hours continuous CTD operation;

External Power Supply 9-28 VDC

optional 9-cell rechargeable nickel-cadmium battery pack
provides approximately 24 hours operation per charge

Power Requirements (covering temperature
Sampling 65 mA sensor, TC duct, &
SBE 5M pump 95 mA conductivity sensor)
Quiescent 30 YA

Auxiliary Voltage Sensors

Auxiliary power out up to 500 mA at 10.5-11 VDC

A/D resolution 14 bits

Input range

Housing Materials — Depth Rating — Weight

0-5VvVDC

Acetal Copolymer Plastic housing — 600 meter (1950 feet) — 7.3 kg (16 Ibs)
3AL-2.5V Titanium housing — 7000 meter (22,900 feet) — 13.7 kg (30 Ibs)

SBE 19plus

Dimensions
in millimeters
(inches)
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SB Sea-Bird Electronics, Inc.
1808 136th Place NE, Bellevue, Washington 98005 USA

Website: http://www.seabird.com

Email: seabird@seabird.com
Telephone: (425) 643-9866
Fax: (425) 643-9954
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SBE 5M

The SBE 5M pump module consists of a centrifugal pump
head and a long-life, DC ball bearing motor contained in a
compact, titanium, pressure housing usable to
10,500 meters deep. The pump impeller and electric drive
motor are coupled magnetically through the housing,
providing high reliability by eliminating moving seals. Motor
speed and pumping rate remain constant over the entire
input voltage range. The motor drive electronics is
intrinsically protected against accidental reversed polarity.

APPLICATIONS

The SBE 5M is standard on the SBE 19 and 19plus
SEACAT Profiler CTD. It is optional on the SBE 16, 16plus,
and 16plus-IM SEACAT C-T Recorder. The pump flushes
water through the conductivity cell at a constant rate,
independent of the CTD's motion, improving dynamic
performance. For applications requiring pumping through
additional sensors (for example, a dissolved oxygen
sensor), use the SBE 5T pump instead.

Specify:

e Option 5M-1 for profiling (continuous duty) applications
such as the SBE 19plus.

e Option 5M-2 for moored (pulsed duty) applications such
as the SBE 16plus or 16plus-IM.

Contact Sea-Bird for use in other applications.

SPECIFICATIONS

Option 5M-1 (continuous duty):
Input voltage range 9 - 18 VDC

Flow Rate 25 ml/s supply current 95 ma
Note: Supply current is independent of operating voltage.

Option 5M-2 (pulsed duty):
Input voltage range 6 - 18 VDC

Pulse Duration Flow Volume Electrical Charge
0.5 seconds 15 ml 0.148 amp-seconds
1.0 seconds 21 mi 0.283 amp-seconds
1.5 seconds 31 ml 0.418 amp-seconds
2.0 seconds 40 ml 0.553 amp-seconds
Weight

In Air: 0.42 kg (0.91 Ibs)

In Water: 0.28 kg (0.60 Ibs)

0.5in.(13mm)

/\\< Intake \
o )
N4

2.03in.
(51 mm) "

0.5in. (13 mm)

I |
= 0.56 in. (14 mm)
I
@] ~+-=—— Plastic
impeller
housing
4.1 in.
(104 mm)
—— Titanium

1.7in.
(44 mm)

. 1.5in. __|
(38 mm)
XSG-2BCL-HP-SS
_ Pin Signal
(1) Ground
1@ «2 |(2) + Power

-~ Optional
. wet-pluggable

20 @1 connector,
MCBH-2MTI
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Sea-Bird Electronics, Inc.
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1808 136" Place NE, Bellevue, Washington 98005 USA
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Telephone: (425) 643-9866
Fax: (425) 643-9954
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1808 136th Place NE, Bellevue, Washington 98005 USA Tel: (425) 643-9866
m Website: http://www.seabird.com Email: seabird@seabird.com

SBE SM MINI SUBMERSIBLE PUMP CONFIGURATION SHEET

Serial Number: 0649
Job Number: 36026
Customer: NOAA/PMC

Delivery Date:  6/14/2004

Single Connector Housing with Titanium screws

Pressure Case: 10,500 meters (titanium)

Maxon Motor Type:
P/N 90337, Motor PN 20130 (Low power 6 VDC, 2000 RPM MAX) ]
P/N 90335, Motor PN 20130 (Low power 9 VDC, 2000 RPM MAX)

Vin 15V voltage across C2: 7.947 VDC  Current 11.8 mA
Vin 9V voltage across C2: 7.948 VDC  Current 11.0 mA

Vin 6V voltage across C2: 5.868 VDC  Current 10.2 mA

Pump submerged test, no load, Vin 12VDC Average current draw in water: 124 mA



SBE 19plusV2
SEACAT PROFILER

Conductivity, Temperature, and Pressure Recorder
with RS-232 Interface

Serial Number: 19P50959-6121

User Manual, Version 002

Sea-Bird Electronics, Inc.
1808 136" Place NE

Bellevue, Washington 98005 USA
Tel: 425/643-9866
Fax:425/643-9954



LIMITED LIABILITY STATEMENT

Extreme care should be exercised when using or servicing this equipment. It should be used or
serviced only by personnel with knowledge of and training in the use and maintenance of
oceanographic electronic equipment.

SEA-BIRD ELECTRONICS, INC. disclaims all product liability risks arising from the use or servicing of
this system. SEA-BIRD ELECTRONICS, INC. has no way of controlling the use of this equipment or of
choosing the personnel to operate it, and therefore cannot take steps to comply with laws pertaining to
product liability, including laws which impose a duty to warn the user of any dangers involved in
operating this equipment. Therefore, acceptance of this system by the customer shall be conclusively
deemed to include a covenant by the customer to defend, indemnify, and hold SEA-BIRD
ELECTRONICS, INC. harmless from all product liability claims arising from the use of servicing of this
system.



WARNING !!

Do not submerge this instrument (S/N 19P50959-6121)
beyond the depth rating of the lowest rated component listed below!

Main Housing (Plastic) 600 meters
Pressure Sensor (600 dBar) Druck 600 meters

Pump (SBE 5M) 600 meters



SYSTEM CONFIGURATION

Model SBE 19plusV?2
Instrument Type

Firmware Version
Communications

Memory

Housing

0 Conductivity Raw Frequency
Pressure Sensor

Computer communications (Data I/O) connector
Number of Voltages Sampled:

Serial RS-232C Sensor

Data Format:

Count

Frequency
Count

Pump (SBE 5M)

30 September 2008

S/N 19P50959-6121

SBE 19plusV2 SeaCaT Profiler

2.1

9600 baud, 8 data bits, no parity, one stop bit
64MB

600 meter (Acetron Plastic)

3148.83 Hz

Strain Gauge: 600 dBar, S/N 2752079

Located on the P/N 17709 Y-Cable
0

None

Temperature

Conductivity
Pressure, Strain Gauge

051056



IMPORTANT SOFTWARE & HARDWARE CONFIGURATION INFORMATION

Sea-Bird supplies two versions of our software package for communication, real-time data acquisition, and data
analysis and display:

e SEASOFT-Win32 - Windows software for PC running Win 95/98/NT/2000/XP

e SEASOFT-DOS - DOS software for IBM-PC/AT/386/486 or compatible computer with a hard drive
Detailed information on the use of the Windows software follows:

SEASOFT-Win32

SEASOFT-Win32 software was supplied on a CD-ROM with your CTD. This software package is designed to run on a PC running Win

95/98/NT/2000/XP. The CD-ROM also contains software manuals that describe the appropriate applications for the various programs, the

procedure for installing the software, and instructions on using the programs. There are three primary programs used with the CTD for

setup, data collection and retrieval, data display, and data processing:

e SEATERM - terminal program for setup of the CTD and uploading of data from the CTD memory (Note: If using the CTD with the
90208 Auto Fire Module or SBE 17plus V2 SEARAM, use SeatermAF instead of SEATERM)

e SEASAVE - real-time data acquisition program

e  SBE Data Processing - data processing program

Instructions for using the software are found in their Help files.

To communicate with the CTD to set it up or to upload data from the CTD memory to the computer hard drive,
SEATERM must have information about the CTD hardware configuration (communication parameters, internal
firmware, etc.) and about the computer. To communicate with the CTD, double click on Seaterm.exe:
1. In the Configure menu, select the CTD. The Configuration Options dialog box appears.
A. On the COM Settings tab, select the firmware version (if applicable), baud rate, data bits, and parity to match the CTD’s
configuration sheet. If necessary, change the com port to match the computer you are using.
B. On the Upload Settings tab, enter upload type (all as a single file, etc.) as desired.
For the SBE 17 and 25 only: enter the serial number for the SBE 3 (temperature) and SBE 4 (conductivity) modular sensors,
exactly as they appear in the configuration (.con) file.
C. On the Header Information tab, change the settings as desired.
Click OK when done. SEATERM saves the settings in a SEATERM.ini file.
On the Toolbar, click Connect to communicate with the CTD.
To set up the CTD prior to deployment:
On the Toolbar, click Status. SEATERM sends the Status command and displays the response. Verify that the
CTD setup matches your desired deployment. If not, send commands to modify the setup.
4. To upload data from the CTD:
On the Toolbar, click Upload to upload data from the CTD memory to the computer.

W

Sea-Bird CTDs store and/or transmit data from their primary and auxiliary sensors in the form of binary or
hexadecimal number equivalents of the sensors’ frequency or voltage outputs. This is referred to as the raw data.
The calculations required to convert from raw data to engineering units of the measured parameters (temperature,
conductivity, pressure, dissolved oxygen, pH, etc.) are performed using the software, either in real time, or after
the data has been stored in a file. SEASAVE creates the file in real time. As noted above, SEATERM uploads the
recorded data and creates the file on the computer hard drive.

To successfully store data to a file on the computer and subsequently convert it to engineering units, the software
must know the CTD type, CTD configuration, and calibration coefficients for the sensors installed on the CTD.
This information is unique to each CTD, and is contained in a configuration file. The configuration file, which has
a .con extension, was written onto a floppy disk and the CD-ROM shipped with the CTD. The .con file for a given
CTD is named with the last four digits of the serial number for that CTD (e.g., 1234.con). The configuration file is
created or modified (e.g., changing coefficients after recalibration, or adding another sensor) by using the
Configure menu in SEASAVE or

SBE Data Processing. The configuration file is used by SEASAVE to convert raw data to engineering units
when it acquires, stores, and displays real-time data. The configuration file is also used by some modules in

SBE Data Processing (Data Conversion and Derive) that convert raw data to engineering units during data
processing.



The instrument type and instrument configuration settings of the .con file and the required setup for the
SEATERM.ini file for the CTD as delivered are documented below. The calibration coefficients for the CTD's
sensors are contained in the calibration coefficient section of the CTD manual.

NOTE:
SEATERM will not upload data correctly without a properly configured SEATERM.ini file. SEASAVE and SBE
Data Processing will not interpret the data correctly without the correct .con file.

SEASOFT CONFIGURATION:

The correct instrument type for your instrument is SBE 19plus V2 SEACAT Profiler. The correct settings for the configuration of
your instrument as delivered are documented below:

-,

rConfiguration for the SBE 19plus V2 Sea...

Configuration file opened: Mone

Pressure sensor type |Strain Gauge ﬂ

Extemal voltage channels |5 «

Mode Profile

Seral RS-232C sensar |None j

Sample interval seconds
Scans to average i

[~ Surface PAR voltage added [ Scan time added

[ MMEA position data added E
Channel Sensor Mew
1. Count Temperature
s Cpen...
2. Frequency Corductivity
3. Count Pressure, Strain Gauge

Save As..

Modify...

P EEE

Repaort ... Help... | Euit | Cancel




SPECIFICATIONS

SBE 19plus-V2 Specifications..........cccceeveereriiieenensieeeneen,

SBE 5M PUMP.....vvveereereeeerseeeseeeeesesseeeesssssesesssssessssesseee




SEACAT Profiler CTD SBE 19plus V2

The SBE 19plus V2 (Version 2) Seacat Profiler CTD measures conductivity, temperature, and pressure (depth) and provides high accuracy
and resolution, reliability, and ease-of-use for a wide range of research, monitoring, and engineering applications. The pump-controlled,
T-C ducted flow configuration minimizes salinity spiking caused by ship heave and allows for slow descent rates without slowing sensor
responses, improving dynamic accuracy and resolving small scale structure in the water column. The V2 is the most versatile successor
in the line of Personal CTDs begun with the original SBE 19 SEACAT in 1987.

Compared to the previous 19plus, the 19plus V2 incorporates an electronics upgrade and additional features. The V2 has two additional
(6 total) auxiliary A/D input channels, FLASH memory is increased from 8 to 64 MB, and one RS-232 data input channel is added. An
optional Digiquartz® pressure sensor provides highest-accuracy pressure measurement. Data can be output in XML as well as ASCII and
HEX formats. Firmware upgrades can be downloaded through the communications port by the user, without opening the instrument.

The 19plus V2 samples continuously at up to 4 scans per second (4 Hz) (2 Hz with Digiquartz®), is battery-powered and self-recording,
and is commonly used in the field without a computer, recording up to 1000 individual profiles. Data can be uploaded to a PC and
processed later, or can typically be transmitted in real time more than 100 meters to a PC for acquisition and display using SEASOFT
software provided (maximum cable length is dependent on the number of auxiliary sensors, sampling rate, baud rate, and cable properties).
The 19plus V2 can supply power to 7 external sensors and log their outputs with each CTD scan. Nine D-size alkaline batteries provide
up to 60 hours of continuous operation when logging C, T, and P at 4 Hz (operation time is shorter if powering auxiliary sensors).

The 19plus V2 is easily integrated with an SBE 32 Carousel Water Sampler and is ideal for integration with the SBE 55 ECO Water Sampler.
Both real-time and autonomous auto-fire operations are possible with any Sea-Bird CTD / Water Sampler system.

The 19plus V2 can operate in moored mode, recording time series measurements at user-programmable intervals. Moored mode is easily
configured using setup commands and by removing the profiling T-C Duct and installing optional anti-fouling devices. (If profiling is not
needed, the 16plus V2 Seacat Recorder offers greater moored-mode programming flexibility and a pressure sensor is optional.)

Accuracy, convenience, portability, software, and support: compelling reasons why the 19plus V2 is today’s best low-cost CTD.

CONFIGURATION, OPTIONS, AND ACCESSORIES () Shown with
: optional cage,
A standard SBE 19plus V2 is supplied with: SBE 5P pump,

* Plastic housing for depths to 600 meters & SBE 43
DO sensor

* Strain-gauge pressure sensor

* 64 Mbyte FLASH RAM memory

* 9 D-size alkaline batteries

* Glass-reinforced epoxy bulkhead connectors

» SBE 5M miniature pump with plastic housing for depths to 600 m, and T-C Duct

Options and accessories include:

« Titanium housing for depths to 7000 meters

* Wet-pluggable MCBH series connectors

» SBE 5M miniature pump with titanium housing for 7000 meters

» SBE 5P (plastic) or 5T (titanium) in place of SBE 5M for use with dissolved oxygen and/or other
pumped sensors

* Digiquartz® pressure sensor

« Stainless steel protection cage

 Auxiliary sensors for Dissolved Oxygen, pH (Profiling mode only), fluorescence, radiance
(PAR), light transmission, and optical backscatter (turbidity)

* Plastic shipping case

* Nickel Metal Hydride (NiMH) batteries and charger

» Moored mode conversion kit with anti-foulant device fittings

* Load-bearing underwater cables for hand-hauled, real-time profiling

» SBE 36 CTD Deck Unit and Power/Data Interface Module (PDIM) for real-time operation on
single-core armored cable up to 10,000 meters

SOFTWARE

The SBE 19plus V2 is supplied with a powerful Windows 2000/XP software package, SEASOFT®-Win32, which includes programs for
communication and data retrieval, real-time data acquisition and display, and data processing (filtering, aligning, averaging) and plotting.

SB Sea-Bird Electronics, Inc. E-mail: seabird@seabird.com
1808 136th Place NE, Bellevue, Washington 98005 USA Telephone: (425) 643-9866
(GECLLLLL,  \\chsite: hitp://www.seabird.com Fax: (425) 643-9954
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SBE 19plus V2

“ SEACAT Profiler CTD

=K==k —R=2
Y20 00 O O}
cc:—!:cc::ol

808 (31.80) |

*Note: 19plus V2 with optional
Quartz pressure sensor is
190 mm (7.5 inches) longer
than shown in drawing.

Auxiliary

Differential

99 (3.90) Diameter
-\ |OOQ= O(;):l]] Inputs
@

Auxiliary Dimensions
RS-232 in millimeters
input (inches)

— = /
il
S Data 1/O,
575 (22.65) Bume, and
: (4'05) External
Power
Measurement Initial Typical
Range Accuracy Stability Resolution
0.00005 (most oceanic waters; resolves 0.4 ppm in salinity)
Conductivity (S/m) Oto9 0.0005 0.0003/month | 0.00007 S/m (high salinity waters; resolves 0.4 ppm in salinity)
0.00001 S/m (fresh waters; resolves 0.1 ppm in salinity)
Temperature (°C) -5 to +35 0.005 0.0002/month 0.0001
0 to 20/100/350/600/ | 0.1% of 0.1% of
Pressure - 1000/2000/3500/ full scale full scale 0.002% of full scale range
Strain Gauge 7000 meters range range/year
0 to 20/60/130/200/
Pressure - 270/680/1400/ 0.02% of 0.025% of 0.0025% of full scale range
Quartz 2000/4200/7000/ full scale full scale
10,500 meters range range/year
Memory 64 Mbyte non-volatile FLASH memory

Data Storage

Real-Time Clock

Internal Batteries

Recorded Parameter Bytes/Sample

T+C 6

pressure - strain gauge or Quartz 5

each external voltage 2

auxiliary RS-232 sensor sensor dependent

32,768 Hz TCXO accurate to +1 minute/year ‘;‘:;Ea ]
9 alkaline D-cells (Duracell MN1300, LR20) provide 60 hours profiling; valve~_

optional 9-cell NiMH battery pack provides 40 hours profiling per charge;
optional 9-cell Ni-Cad battery pack provides 24 hours profiling per charge  v.ging

External Power Supply 9 - 28 VDC; consult factory for required current

Power Requirements
Sampling

Pump
Communications
Quiescent

Auxiliary Sensors
Auxiliary power out

Voltage sensor A/D resolution 14 bits

Voltage sensor input range 0-5VDC

Housing Materials, Depth Rating, Weight in air*, Weight in water* gf;‘r‘f,“ﬁjgﬂ‘;‘ﬁf,f;" B

Acetal Copolymer Plastic housing, 600 m (1950 ft), 7.3 kg (16 Ibs), 2.3 kg (5 Ibs) temperature

3AL-2.5V Titanium housing, 7000 m (22,900 ft), 13.7 kg (30 Ibs), 8.6 kg (19 Ibs) ;eggggﬁ Vg;d-

*Weights listed are without pump; pump adds (in air) 0.3 to 0.7 kg (0.6 to 1.5 Ibs), sensar) q;l I;"

70 mA

SBE 5M: 100 mA Optional SBE 5T or 5P: 150 mA

65 mA
20 uA

up to 500 mA at 10.5 - 11 VDC

depending on pump model selected. See pump brochures for details.

Optional Cage

(for 19plus V2 with strain-gauge pressure) 1016 x 241 x 279 mm (40 x 9.5 x 11 in.), 6.3 kg (14 Ibs) Water intake ‘

Pump
inlet

2 POit

//Pump

- / exhaust

pump port

NOOOOOOF——>

(for 19plus V2 with Digiquartz pressure) 1219 x 241 x 279 mm (48 x 9.5 x 11 in.) /
02/08
SB Sea-Bird Electronics, Inc. E-mail: seabird@seabird.com
1808 136th Place NE, Bellevue, Washington 98005 USA Telephone: (425) 643-9866
(GECLLLLL,  \\chsite: hitp://www.seabird.com Fax: (425) 643-9954
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Mini Submersible Pump SBE 5M

The SBE 5M pump module consists of a centrifugal pump head and a
long-life, DC, ball-bearing motor contained in a compact, titanium
pressure housing usable to 10,500 meters (34,400 ft) deep. A plastic
housing for depths to 600 meters (1960 ft) is available as an option. The
pump impeller and electric drive motor are coupled magnetically through
the housing, providing high reliability by eliminating moving seals. Motor
speed and pumping rate remain constant over the entire input voltage
range. The motor drive electronics is intrinsically protected against
accidental reversed polarity.

APPLICATIONS _

. Standard i Optional
The SBE 5M is standard on the SBE 19plus V2 SEACAT Profiler CTD, titanium - plastic
and is optional on the SBE 16plus V2 and 16plus-IM V2 SEACAT C-T housing housing It
Recorders. The pump flushes water through the conductivity cell at a !

constant rate, independent of the CTD's motion, improving dynamic performance For applications requiring pumping
through additional sensors (for example, a dissolved oxygen sensor), use the SBE 5T or 5P pump instead.

e Option 5M-1 for profiling (continuous duty) applications such as the (2.03in.) —===
SBE 19plus V2.

e Option 5M-2 for moored (pulsed duty) applications such as the
SBE 16plus V2 or 16plus-IM V2.

Specify: 51 mm

Contact Sea-Bird for use in other applications.

13 mm
(0.5in.) = -
| 14 mm (0.56 in.)
i
SPECIFICATIONS { |
—=—— Plastic
impell
Option 5M-1 (continuous duty): Ir:gﬁ:i:gr
Input voltage range 9 - 18 VDC
104 mm
Flow Rate 25 ml/s Supply current 95 mA #.1in.) e 38 MM |
Note: Supply current is independent of operating voltage. (1:5in)
Option 5M-2 (pulsed duty): —~=—1— Titanium
or
Input voltage range 6 - 18 VDC ] optional
plastic
Pulse Duration Flow Volume Electrical Charge 101
0.5 seconds 15 ml 0.148 Amp-seconds
1.0 seconds 21 mi 0.283 Amp-seconds
1.5 seconds 31 mi 0.418 Amp-seconds B —
2.0 seconds 40 ml 0.553 Amp-seconds e
! A Pin Signal
:.‘ .2 1. ! 1 Ground
2 + Power
Weight et
With standard titanium housing: We?gﬂ,ognga;me Cit,?:s;gdn
In Air - 0.42 kg (0.91 Ibs); In Water - 0.28 kg (0.60 Ibs) connector, XSG-2BCL-
With optional plastic housing: MCsE/;;]ZM?h(t\,NB)’ T HP-SS
In Air - 0.28 kg (0.60 Ibs); In Water - 0.13 kg (0.29 Ibs) B30 brset 05108
B Sea-Bird Electronics, Inc. E-mail: seabird@seabird.com
1808 136" Place NE, Bellevue, Washington 98005 USA Telephone: (425) 643-9866

m Website: http://www.seabird.com Fax: (425) 643-9954
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SBE 5SM MINI SUBMERSIBLE PUMP CONFIGURATION SHEET

Serial Number: 1056

Job Number: 50959

Customer: NOAA/PMC
Delivery Date:  10/3/2008

Single Bulkhead Connector.

Pressure Case: 10,500 meters (titanium)

Maxon Motor Type:

P/N 801605, Motor PN 20130 (Pulsed Duty 6 VDC, 2000 RPM MAX) L]

P/N 801606, Motor PN 20127 (Continuous Duty 9 VDC, 2000 RPM MAX)

Vin 15V voltage across C2: 7.96 VDC  Current 15.8 mA
Vin 9V voltage across C2: 7.96 VDC  Current 15.7 mA

Vin 6V voltage across C2: 5.9 VDC Current 10.4 mA

Pump submerged test, no load, Vin 12VDC Average current draw in water: 120 mA



SBE 19plusV2
SEACAT PROFILER

Conductivity, Temperature, and Pressure Recorder
with RS-232 Interface

Serial Number: 19P50959-6122

User Manual, Version 002

Sea-Bird Electronics, Inc.
1808 136" Place NE

Bellevue, Washington 98005 USA
Tel: 425/643-9866
Fax:425/643-9954



LIMITED LIABILITY STATEMENT

Extreme care should be exercised when using or servicing this equipment. It should be used or
serviced only by personnel with knowledge of and training in the use and maintenance of
oceanographic electronic equipment.

SEA-BIRD ELECTRONICS, INC. disclaims all product liability risks arising from the use or servicing of
this system. SEA-BIRD ELECTRONICS, INC. has no way of controlling the use of this equipment or of
choosing the personnel to operate it, and therefore cannot take steps to comply with laws pertaining to
product liability, including laws which impose a duty to warn the user of any dangers involved in
operating this equipment. Therefore, acceptance of this system by the customer shall be conclusively
deemed to include a covenant by the customer to defend, indemnify, and hold SEA-BIRD
ELECTRONICS, INC. harmless from all product liability claims arising from the use of servicing of this
system.



WARNING !!

Do not submerge this instrument (S/N 19P50959-6122)
beyond the depth rating of the lowest rated component listed below!

Main Housing (Plastic) 600 meters
Pressure Sensor (600 dBar) Druck 600 meters

Pump (SBE 5M) 600 meters



SYSTEM CONFIGURATION

Model SBE 19plusV?2
Instrument Type

Firmware Version
Communications

Memory

Housing

0 Conductivity Raw Frequency
Pressure Sensor

Computer communications (Data I/O) connector
Number of Voltages Sampled:

Serial RS-232C Sensor

Data Format:

Count

Frequency
Count

Pump (SBE 5M)

1 October 2008

S/N 19P50959-6122

SBE 19plusV2 SeaCaT Profiler

2.1

9600 baud, 8 data bits, no parity, one stop bit
64MB

600 meter (Acetron Plastic)

2523.44 Hz

Strain Gauge: 600 dBar, S/N 2752080

Located on the P/N 17709 Y-Cable
0

None

Temperature

Conductivity
Pressure, Strain Gauge

051058



IMPORTANT SOFTWARE & HARDWARE CONFIGURATION INFORMATION

Sea-Bird supplies two versions of our software package for communication, real-time data acquisition, and data
analysis and display:

e SEASOFT-Win32 - Windows software for PC running Win 95/98/NT/2000/XP

e SEASOFT-DOS - DOS software for IBM-PC/AT/386/486 or compatible computer with a hard drive
Detailed information on the use of the Windows software follows:

SEASOFT-Win32

SEASOFT-Win32 software was supplied on a CD-ROM with your CTD. This software package is designed to run on a PC running Win

95/98/NT/2000/XP. The CD-ROM also contains software manuals that describe the appropriate applications for the various programs, the

procedure for installing the software, and instructions on using the programs. There are three primary programs used with the CTD for

setup, data collection and retrieval, data display, and data processing:

e SEATERM - terminal program for setup of the CTD and uploading of data from the CTD memory (Note: If using the CTD with the
90208 Auto Fire Module or SBE 17plus V2 SEARAM, use SeatermAF instead of SEATERM)

e SEASAVE - real-time data acquisition program

e  SBE Data Processing - data processing program

Instructions for using the software are found in their Help files.

To communicate with the CTD to set it up or to upload data from the CTD memory to the computer hard drive,
SEATERM must have information about the CTD hardware configuration (communication parameters, internal
firmware, etc.) and about the computer. To communicate with the CTD, double click on Seaterm.exe:
1. In the Configure menu, select the CTD. The Configuration Options dialog box appears.
A. On the COM Settings tab, select the firmware version (if applicable), baud rate, data bits, and parity to match the CTD’s
configuration sheet. If necessary, change the com port to match the computer you are using.
B. On the Upload Settings tab, enter upload type (all as a single file, etc.) as desired.
For the SBE 17 and 25 only: enter the serial number for the SBE 3 (temperature) and SBE 4 (conductivity) modular sensors,
exactly as they appear in the configuration (.con) file.
C. On the Header Information tab, change the settings as desired.
Click OK when done. SEATERM saves the settings in a SEATERM.ini file.
On the Toolbar, click Connect to communicate with the CTD.
To set up the CTD prior to deployment:
On the Toolbar, click Status. SEATERM sends the Status command and displays the response. Verify that the
CTD setup matches your desired deployment. If not, send commands to modify the setup.
4. To upload data from the CTD:
On the Toolbar, click Upload to upload data from the CTD memory to the computer.

W

Sea-Bird CTDs store and/or transmit data from their primary and auxiliary sensors in the form of binary or
hexadecimal number equivalents of the sensors’ frequency or voltage outputs. This is referred to as the raw data.
The calculations required to convert from raw data to engineering units of the measured parameters (temperature,
conductivity, pressure, dissolved oxygen, pH, etc.) are performed using the software, either in real time, or after
the data has been stored in a file. SEASAVE creates the file in real time. As noted above, SEATERM uploads the
recorded data and creates the file on the computer hard drive.

To successfully store data to a file on the computer and subsequently convert it to engineering units, the software
must know the CTD type, CTD configuration, and calibration coefficients for the sensors installed on the CTD.
This information is unique to each CTD, and is contained in a configuration file. The configuration file, which has
a .con extension, was written onto a floppy disk and the CD-ROM shipped with the CTD. The .con file for a given
CTD is named with the last four digits of the serial number for that CTD (e.g., 1234.con). The configuration file is
created or modified (e.g., changing coefficients after recalibration, or adding another sensor) by using the
Configure menu in SEASAVE or

SBE Data Processing. The configuration file is used by SEASAVE to convert raw data to engineering units
when it acquires, stores, and displays real-time data. The configuration file is also used by some modules in

SBE Data Processing (Data Conversion and Derive) that convert raw data to engineering units during data
processing.



The instrument type and instrument configuration settings of the .con file and the required setup for the
SEATERM.ini file for the CTD as delivered are documented below. The calibration coefficients for the CTD's
sensors are contained in the calibration coefficient section of the CTD manual.

NOTE:
SEATERM will not upload data correctly without a properly configured SEATERM.ini file. SEASAVE and SBE
Data Processing will not interpret the data correctly without the correct .con file.

SEASOFT CONFIGURATION:

The correct instrument type for your instrument is SBE 19plus V2 SEACAT Profiler. The correct settings for the configuration of
your instrument as delivered are documented below:

-,

rConfiguration for the SBE 19plus V2 Sea...

Configuration file opened: Mone

Pressure sensor type |Strain Gauge ﬂ

Extemal voltage channels |5 «

Mode Profile

Seral RS-232C sensar |None j

Sample interval seconds
Scans to average i

[~ Surface PAR voltage added [ Scan time added

[ MMEA position data added E
Channel Sensor Mew
1. Count Temperature
s Cpen...
2. Frequency Corductivity
3. Count Pressure, Strain Gauge

Save As..

Modify...

P EEE

Repaort ... Help... | Euit | Cancel




SPECIFICATIONS

SBE 19plus-V2 Specifications..........cccceeveereriiieenensieeeneen,

SBE 5M PUMP.....vvveereereeeerseeeseeeeesesseeeesssssesesssssessssesseee




SEACAT Profiler CTD SBE 19plus V2

The SBE 19plus V2 (Version 2) Seacat Profiler CTD measures conductivity, temperature, and pressure (depth) and provides high accuracy
and resolution, reliability, and ease-of-use for a wide range of research, monitoring, and engineering applications. The pump-controlled,
T-C ducted flow configuration minimizes salinity spiking caused by ship heave and allows for slow descent rates without slowing sensor
responses, improving dynamic accuracy and resolving small scale structure in the water column. The V2 is the most versatile successor
in the line of Personal CTDs begun with the original SBE 19 SEACAT in 1987.

Compared to the previous 19plus, the 19plus V2 incorporates an electronics upgrade and additional features. The V2 has two additional
(6 total) auxiliary A/D input channels, FLASH memory is increased from 8 to 64 MB, and one RS-232 data input channel is added. An
optional Digiquartz® pressure sensor provides highest-accuracy pressure measurement. Data can be output in XML as well as ASCII and
HEX formats. Firmware upgrades can be downloaded through the communications port by the user, without opening the instrument.

The 19plus V2 samples continuously at up to 4 scans per second (4 Hz) (2 Hz with Digiquartz®), is battery-powered and self-recording,
and is commonly used in the field without a computer, recording up to 1000 individual profiles. Data can be uploaded to a PC and
processed later, or can typically be transmitted in real time more than 100 meters to a PC for acquisition and display using SEASOFT
software provided (maximum cable length is dependent on the number of auxiliary sensors, sampling rate, baud rate, and cable properties).
The 19plus V2 can supply power to 7 external sensors and log their outputs with each CTD scan. Nine D-size alkaline batteries provide
up to 60 hours of continuous operation when logging C, T, and P at 4 Hz (operation time is shorter if powering auxiliary sensors).

The 19plus V2 is easily integrated with an SBE 32 Carousel Water Sampler and is ideal for integration with the SBE 55 ECO Water Sampler.
Both real-time and autonomous auto-fire operations are possible with any Sea-Bird CTD / Water Sampler system.

The 19plus V2 can operate in moored mode, recording time series measurements at user-programmable intervals. Moored mode is easily
configured using setup commands and by removing the profiling T-C Duct and installing optional anti-fouling devices. (If profiling is not
needed, the 16plus V2 Seacat Recorder offers greater moored-mode programming flexibility and a pressure sensor is optional.)

Accuracy, convenience, portability, software, and support: compelling reasons why the 19plus V2 is today’s best low-cost CTD.

CONFIGURATION, OPTIONS, AND ACCESSORIES () Shown with
: optional cage,
A standard SBE 19plus V2 is supplied with: SBE 5P pump,

* Plastic housing for depths to 600 meters & SBE 43
DO sensor

* Strain-gauge pressure sensor

* 64 Mbyte FLASH RAM memory

* 9 D-size alkaline batteries

* Glass-reinforced epoxy bulkhead connectors

» SBE 5M miniature pump with plastic housing for depths to 600 m, and T-C Duct

Options and accessories include:

« Titanium housing for depths to 7000 meters

* Wet-pluggable MCBH series connectors

» SBE 5M miniature pump with titanium housing for 7000 meters

» SBE 5P (plastic) or 5T (titanium) in place of SBE 5M for use with dissolved oxygen and/or other
pumped sensors

* Digiquartz® pressure sensor

« Stainless steel protection cage

 Auxiliary sensors for Dissolved Oxygen, pH (Profiling mode only), fluorescence, radiance
(PAR), light transmission, and optical backscatter (turbidity)

* Plastic shipping case

* Nickel Metal Hydride (NiMH) batteries and charger

» Moored mode conversion kit with anti-foulant device fittings

* Load-bearing underwater cables for hand-hauled, real-time profiling

» SBE 36 CTD Deck Unit and Power/Data Interface Module (PDIM) for real-time operation on
single-core armored cable up to 10,000 meters

SOFTWARE

The SBE 19plus V2 is supplied with a powerful Windows 2000/XP software package, SEASOFT®-Win32, which includes programs for
communication and data retrieval, real-time data acquisition and display, and data processing (filtering, aligning, averaging) and plotting.

SB Sea-Bird Electronics, Inc. E-mail: seabird@seabird.com
1808 136th Place NE, Bellevue, Washington 98005 USA Telephone: (425) 643-9866
(GECLLLLL,  \\chsite: hitp://www.seabird.com Fax: (425) 643-9954
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SBE 19plus V2

“ SEACAT Profiler CTD

=K==k —R=2
Y20 00 O O}
cc:—!:cc::ol

808 (31.80) |

*Note: 19plus V2 with optional
Quartz pressure sensor is
190 mm (7.5 inches) longer
than shown in drawing.

Auxiliary

Differential

99 (3.90) Diameter
-\ |OOQ= O(;):l]] Inputs
@

Auxiliary Dimensions
RS-232 in millimeters
input (inches)

— = /
il
S Data 1/O,
575 (22.65) Bume, and
: (4'05) External
Power
Measurement Initial Typical
Range Accuracy Stability Resolution
0.00005 (most oceanic waters; resolves 0.4 ppm in salinity)
Conductivity (S/m) Oto9 0.0005 0.0003/month | 0.00007 S/m (high salinity waters; resolves 0.4 ppm in salinity)
0.00001 S/m (fresh waters; resolves 0.1 ppm in salinity)
Temperature (°C) -5 to +35 0.005 0.0002/month 0.0001
0 to 20/100/350/600/ | 0.1% of 0.1% of
Pressure - 1000/2000/3500/ full scale full scale 0.002% of full scale range
Strain Gauge 7000 meters range range/year
0 to 20/60/130/200/
Pressure - 270/680/1400/ 0.02% of 0.025% of 0.0025% of full scale range
Quartz 2000/4200/7000/ full scale full scale
10,500 meters range range/year
Memory 64 Mbyte non-volatile FLASH memory

Data Storage

Real-Time Clock

Internal Batteries

Recorded Parameter Bytes/Sample

T+C 6

pressure - strain gauge or Quartz 5

each external voltage 2

auxiliary RS-232 sensor sensor dependent

32,768 Hz TCXO accurate to +1 minute/year ‘;‘:;Ea ]
9 alkaline D-cells (Duracell MN1300, LR20) provide 60 hours profiling; valve~_

optional 9-cell NiMH battery pack provides 40 hours profiling per charge;
optional 9-cell Ni-Cad battery pack provides 24 hours profiling per charge  v.ging

External Power Supply 9 - 28 VDC; consult factory for required current

Power Requirements
Sampling

Pump
Communications
Quiescent

Auxiliary Sensors
Auxiliary power out

Voltage sensor A/D resolution 14 bits

Voltage sensor input range 0-5VDC

Housing Materials, Depth Rating, Weight in air*, Weight in water* gf;‘r‘f,“ﬁjgﬂ‘;‘ﬁf,f;" B

Acetal Copolymer Plastic housing, 600 m (1950 ft), 7.3 kg (16 Ibs), 2.3 kg (5 Ibs) temperature

3AL-2.5V Titanium housing, 7000 m (22,900 ft), 13.7 kg (30 Ibs), 8.6 kg (19 Ibs) ;eggggﬁ Vg;d-

*Weights listed are without pump; pump adds (in air) 0.3 to 0.7 kg (0.6 to 1.5 Ibs), sensar) q;l I;"

70 mA

SBE 5M: 100 mA Optional SBE 5T or 5P: 150 mA

65 mA
20 uA

up to 500 mA at 10.5 - 11 VDC

depending on pump model selected. See pump brochures for details.

Optional Cage

(for 19plus V2 with strain-gauge pressure) 1016 x 241 x 279 mm (40 x 9.5 x 11 in.), 6.3 kg (14 Ibs) Water intake ‘

Pump
inlet

2 POit

//Pump

- / exhaust

pump port

NOOOOOOF——>

(for 19plus V2 with Digiquartz pressure) 1219 x 241 x 279 mm (48 x 9.5 x 11 in.) /
02/08
SB Sea-Bird Electronics, Inc. E-mail: seabird@seabird.com
1808 136th Place NE, Bellevue, Washington 98005 USA Telephone: (425) 643-9866
(GECLLLLL,  \\chsite: hitp://www.seabird.com Fax: (425) 643-9954
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Mini Submersible Pump SBE 5M

The SBE 5M pump module consists of a centrifugal pump head and a
long-life, DC, ball-bearing motor contained in a compact, titanium
pressure housing usable to 10,500 meters (34,400 ft) deep. A plastic
housing for depths to 600 meters (1960 ft) is available as an option. The
pump impeller and electric drive motor are coupled magnetically through
the housing, providing high reliability by eliminating moving seals. Motor
speed and pumping rate remain constant over the entire input voltage
range. The motor drive electronics is intrinsically protected against
accidental reversed polarity.

APPLICATIONS _

. Standard i Optional
The SBE 5M is standard on the SBE 19plus V2 SEACAT Profiler CTD, titanium - plastic
and is optional on the SBE 16plus V2 and 16plus-IM V2 SEACAT C-T housing housing It
Recorders. The pump flushes water through the conductivity cell at a !

constant rate, independent of the CTD's motion, improving dynamic performance For applications requiring pumping
through additional sensors (for example, a dissolved oxygen sensor), use the SBE 5T or 5P pump instead.

e Option 5M-1 for profiling (continuous duty) applications such as the (2.03in.) —===
SBE 19plus V2.

e Option 5M-2 for moored (pulsed duty) applications such as the
SBE 16plus V2 or 16plus-IM V2.

Specify: 51 mm

Contact Sea-Bird for use in other applications.

13 mm
(0.5in.) = -
| 14 mm (0.56 in.)
i
SPECIFICATIONS { |
—=—— Plastic
impell
Option 5M-1 (continuous duty): Ir:gﬁ:i:gr
Input voltage range 9 - 18 VDC
104 mm
Flow Rate 25 ml/s Supply current 95 mA #.1in.) e 38 MM |
Note: Supply current is independent of operating voltage. (1:5in)
Option 5M-2 (pulsed duty): —~=—1— Titanium
or
Input voltage range 6 - 18 VDC ] optional
plastic
Pulse Duration Flow Volume Electrical Charge 101
0.5 seconds 15 ml 0.148 Amp-seconds
1.0 seconds 21 mi 0.283 Amp-seconds
1.5 seconds 31 mi 0.418 Amp-seconds B —
2.0 seconds 40 ml 0.553 Amp-seconds e
! A Pin Signal
:.‘ .2 1. ! 1 Ground
2 + Power
Weight et
With standard titanium housing: We?gﬂ,ognga;me Cit,?:s;gdn
In Air - 0.42 kg (0.91 Ibs); In Water - 0.28 kg (0.60 Ibs) connector, XSG-2BCL-
With optional plastic housing: MCsE/;;]ZM?h(t\,NB)’ T HP-SS
In Air - 0.28 kg (0.60 Ibs); In Water - 0.13 kg (0.29 Ibs) B30 brset 05108
B Sea-Bird Electronics, Inc. E-mail: seabird@seabird.com
1808 136" Place NE, Bellevue, Washington 98005 USA Telephone: (425) 643-9866

m Website: http://www.seabird.com Fax: (425) 643-9954
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SBE 5SM MINI SUBMERSIBLE PUMP CONFIGURATION SHEET

Serial Number: 1058

Job Number: 50959

Customer: NOAA/PMC
Delivery Date:  10/3/2008

Single Bulkhead Connector.

Pressure Case: 10,500 meters (titanium)

Maxon Motor Type:

P/N 801605, Motor PN 20130 (Pulsed Duty 6 VDC, 2000 RPM MAX) L]

P/N 801606, Motor PN 20127 (Continuous Duty 9 VDC, 2000 RPM MAX)

Vin 15V voltage across C2: 7.95 VDC  Current 13.2 mA
Vin 9V voltage across C2: 7.95 VDC  Current 13 mA

Vin 6V voltage across C2: 5.87 VDC Current 9.96 mA

Pump submerged test, no load, Vin 12VDC Average current draw in water: 116 mA



LEICA NA2 - NAK2

Universal automatic level

Geosystems




LEICA NA2

The classical level from Leica Geosystems

The NA2 universal auto-
matic level meets all
requirements regarding
precision, convenience
and reliability.

It was designed by sur-
veyors and development
engineers with years of
experience and who know
what a field instrument
has to be able to do.

The NA2 soon pays for
itself, because it can be
used for all types of sur-
veying job; on building
sites for routine levelling,
in engineering projects,
and for geodetic control at
all levels of accuracy.

Universal application

e Levelling of all types and
all orders of accuracy

* Precise levelling and
settlement determinations
on buildings

* Routine heighting for
the construction of roads,
railways, pipelines,
tunnels and so forth

e Setting-out work and
control measurements on
the construction site

e Area levelling of high
accuracy

e Tacheometric levelling
with the K-version on flat
terrain by combining
stadia and angular meas-
urements with height
readings

e Deformation measure-
ment and monitoring of
bridges




Quickly set up, simple to use

Strong tripods

In principle, the NA2

can be set up on any Leica
Geosystems tripod. In
practice, for all-round
purposes, we recommend
the heavy-duty GST20
telescopic-leg tripod.

For precise levelling the
GST40 fixed-leg tripod

is suitable because of its
extreme rigidity.

The modular relationship
between instrument and
tripod is an advantage
when transport space is
limited.

Push-button for compensator control

Centring is easy

The circular level only
needs to be centred
approximately to bring the
compensator well into its
working range of ~30', and
so setting-up goes quicker.

The bubble is viewed
positively via a pentaprism
and is monitored down
the eyepiece.

Endless horizontal drive

Footscrew

Play-free footscrews

The pitch of the smooth-
running and backlash-free
footscrews is such that
the bubble can be centred
in a very short time.

Independent of
temperature

Unlike the tubular level of

a traditional instrument, the
NA2 universal automatic
level is relatively insensitive
to direct solar radiation

and an umbrella need only
be considered for the most
precise levelling.

Open sight

Rapid / fine focusing knob

Pentaprism for viewing circular level

Endless horizontal drive

Footscrew




Adjust the line of sight automatically

Easy to level up

The advantage of this
instrument is that, as soon
as the bubble is centred,
the line of sight is horizontal
for all pointings of the
telescope. The observer is
freed of the time-consuming
centring procedure involved
with the traditional tubular
level, and can concentrate
on the business of staff
readings.

Push-button control —
added security

With most automatics one
taps the tripod or instru-
ment to check if the com-
pensator is functioning.
Leica Geosystems offers a
far more sophisticated
solution.

Pressing the button under
the NA2 eyepiece gives the
compensator a gentle tap,
so that you see the staff
image swing smoothly

Robust and automatic

The compensator is
essentially a pendulum
with a prism (4).

The suspension system
comprises four flexed

tapes (1) made of a special
alloy to ensure faultless
functioning even at extreme
temperatures. The compen-
sator, which is located
between the focusing lens
and the crosshair reticle,

is pneumatically damped
against mechanical vibra-
tion and is screened against
magnetic fields.

away and then float gently
back to give the horizontal
line of sight. This check,
which takes less than

a second, is technically
perfect, as the pendulum
itself is activated and
swings through its full
range. It is also immediately
apparent if the bubble

is not centred.

Minimum maintenance

In the unlikely event that
the compensator is
damaged (and this can only
happen as a result of
extremely harsh treatment)
it is replaced easily, being
held only by three screws.

2/NAK2 compensator

uspension tapes

rism (fixed)

‘ompensator body

"endulum with prism

ine of sight

'ush-button

pring which taps pendulum
'neumatic damping mechanism

am T ==
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Top-class optics

Top-class optics

The telescope is of excellent
quality and gives a bright,
high-contrast, erect image,
even in poor light — an
essential for accurate
levelling. With the standard
eyepiece the magnification
is 32x, the optimum for
most applications of the
instrument. Optional
eyepieces are available; the
40x may be preferred for
precise levelling, the 25x

in hot, shimmer conditions.
Eyepiece exchange takes
only a second or so.

The focusing knob has a

coarse/fine movement:

— coarse, for rapid setting
with minimum turning

— fine, for the final delicate
touch to give the perfect
image.

At an advantage on
unstable ground

If a tubular level is used
on unstable ground it tilts
out of range and has to be
continuously reset. By
contrast, the pendulum of
the NA2 “compensates”
and keeps the line of sight
horizontal.

Fatigue-free viewing

The reticle has:

— a single horizontal hair
for reading normal staffs

— a wedge-shaped hair for
use with invar staffs

— stadia hairs for distance
measurement and three-
wire levelling.

The general layout of

the controls, the smooth
friction-braked rotation

of the instrument, and the
endless horizontal drive
with bilateral knobs,

all combine to make the
instrument easy to use.

Angle measurement
with the NAK2

Civil engineers and contrac-
tors often require a circle
for angle measurement

and setting-out work. Even
simple detail surveys, by
taking angle, distance and
height, and plotting with
the polar method, can be
done with a level.

The model NAK2 has an
internal glass circle which
is read via a scale micro-
scope and which can be set
to any value by turning

the rim around the base

of the instrument.

NA2Z field of view with metric levelling staff
Reading at horizontal hair: 1.143 m

NAK2
circle reading (400 gon)
3292.66 gon

NAK2
circle reading (360°)
314°42"




High-performance accessories for precise levelling

GPM3
parallel-plate micrometer

This optional accessory
slips over the telescope
objective and blends
perfectly with the smooth
lines of the NA2. With

a compensator setting
accuracy of +0.3” (equiva-
lent to 0.01 mm in 10 m)
and a micrometer reading
to 0.1 mm direct and

0.01 mm by estimation, the
NA2 with GPM3 is an ideal
combination for precise
levelling, deformation
studies, and even optical
tooling. The micrometer
drive for raising and lower-
ing the line of sight is con-
veniently located and read-
ings are taken on a glass
scale viewed through an
eyepiece just above the
telescope eyepiece. This
optical reading system,
which is digital apart from
the last and estimated
figure in the metric and
inch versions, is superior
to the usual metal drum
system.

GPM6
parallel-plate micrometer

There are tasks for which
a micrometer is needed,
yet for which the very high
accuracy of the GPM3 is
not essential.

To meet this requirement,
a simpler micrometer
attachment, the GPM6
with drum reading,

is available for the NA2.

The GPMB6 fits on to the
telescope objective in the
same manner as the GPMS3,
but the graduation is
engraved on a metal drum.

Eyepiece accessories for
specialized tasks

Because of the bayonet
fastening of the inter-
changeable eyepiece, all
theodolite eyepiece acces-
sories can be used with
the NA2.

e Diagonal eyepiece for
observing from above,
below, and from the side;
useful in cramped spaces

* Eyepiece lamp for con-
verting the NA2 into
a horizontal collimator
for laboratory work

e Autocollimation eye-
piece for setting machine
parts and instrument
components precisely
vertical



Compact

Precise

Reliable, automatic,
maintenance-free

Easy handling

Quick levelling-up

Superh telescope

Effortless focusing

Abundant accessories;
many applications

The rugged NA2 is indifferent
to weather conditions and

is extremely reliable in the
rough world of the building
site. The pendulum compen-
sator is protected against
knocks and shocks. There is
a highly-effective vibration-
damping mechanism.

The high setting accuracy
ensures that the line of
sight stays put. The attach-
able parallel-plate micro-
meter renders the NA2
ideal for precise fine
levelling.

The instantaneous check
facility with the push-button
control not only makes
work easier; it also
promotes confidence.

The convenient, well-
arranged controls are
designed for maximum
convenience. The bilateral,
endless horizontal

drive promotes rapid
fine-pointing.

The instrument is quickly
set up with the three rapid-
action footscrews. Their
self-adjusting threads
make subsequent resetting
unnecessary.

Telescope with excellently-
corrected optics for bright,
high-contrast images.
All optical components are
coated on both sides.

The erect image seen down
the telescope is quickly

and accurately brought into
focus with the convenient
rapid and fine focusing
knob.

Additional items such as
the parallel-plate micro-
meter, the laser eyepiece,
or theodolite eyepiece
accessories, offer almost
unlimited possibilities.




LEICA NA2- NAK2

Proven reliability ensures precise results

Versatile accessories for
demonstrable success

A comprehensive program
of accessories enables you
to expand the performance
and applications range

of each instrument.

This way, you can match
your equipment exactly

to requirements.

The possibilities are
described in brochure
“Survey accessories”
710 883en.

Technical data

Robust container for
safe transport

The NA2 is supplied in a
foam-padded container
made of high performance
synthetic material. The
foam padding absorbs all
jolts and shocks. The
container provides perfect
protection for the NA2.

Standard deviation for 1 km double-run
levelling, depending on type of staff and on

procedure up to 0.7 mm
With parallel-plate micrometer 0.3 mm
Telescope erect image
Standard eyepiece 32x
FOK73 eyepiece (optional) 40x
FOK117 (optional) 25x%
Clear objective aperture 45 mm
Field of view at 100 m 2.2m
Shortest focusing distance 1.6 m
Multiplication factor 100
Additive constant 0
Working range of compensator ~30’
Setting accuracy of compensator (stand. dev.) 0.3
Sensitivity of circular level 8'/2 mm
Glass circle (K version) 400 gon (360°)
Graduation diameter 70 mm
Graduation interval 1 gon (1°)
Reading by estimation to 10 mgon (1')
Water- and dust resistance IP53
Temperature range:

Operation —-20°C to +50°C (- 4°F to 122°F)
Storage —-40°C to +70°C (-40°F to 158°F)

Parallel-plate micrometer Range Interval Estimation
(optional accessory)

GPM3, with glass scale 10 mm 0.1mm 0.01 mm
GPMB6, with metal drum 1M0mm 0.2mm 0.05 mm

lllustrations, descriptions, and technical data are not binding and may be changed.
Printed in Switzerland — Copyright Leica Geosystems AG, Heerbrugg, Switzerland, 1999

710 837en - V.03 - RDV

/S0 9001/ 150 14001

Total Quality Management —
Our commitment to total
customer satisfaction

Ask your local Leica
Geosystems agent for
more information

about our TQM program.

L
Geosystems

Leica Geosystems AG
CH-9435 Heerbrugg
(Switzerland)

Phone +41 71727 31 31
Fax +4171727 46 73
www.leica-geosystems.com
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Optical Data

Telescope with Zeiss T-coating

Magnification

Aperture

EShortest sighting distance

Field of view

2%

158 in (40 mm )
1Mt (33m)
23 # at 1000 ft

Estimation of wee ft. on Ve ft. graduation up to 120 R

{1 mm onalcm graduationup to 120 m)

Circular Level
Sensitivity

Circle (on request)
Material
Diameter
Graduation

Graduation interval

15 per 2 mm

Glass
285 in (75 mm)
360° or 4009

1% or 19

Readings through reading microscope

Magnification
Scale interval

Estimation to

17 =
10 or 018
1 or 0019



Fig. 1 Ni2 with herizental circle
{about Ya natural size)

1 Focus control with guick-fine
movemeant

2 Viewing prism for eircular lavel

1 Eyapiece of reading microscops
tor circle

4 Telezcope eyvepiecs with
dioptre scale

& Serew cover over raticle
adjusting screw

6 Lateral fine movement controls

7 Leveling screw

B Knurled setting ring for
circle orientation

9 Adjusting screw for tripod
hinges

10 Adjusting screws far circular
level

11 Clamping screw for tripod
feg fitting

Mechanical Data

Dimensions:

Length of telescope

Height of instrument .
Diameter of base .
External dimengions of case

5 3 tripod extending from
S 2 triped extending from

Weights:

Mi 2 without circla

Mi 2 with circle . :
Case for Ni 2 without circle
Case for Ni 2 with circle,
with plumb bob

Parallel plate micrometer
in leather case .

Torch with supports
Leather case for torch

S 3 tripod

S 2 tripod

Leveling staff (03) 4 m. folding to 2 m. .

Leveling staff (05) 3 m.
folding to 1.5 m.

Invar staff (06) 3 m., rigid
“Scotch light™ staves,
additional weight .

4

o

1006 in. (27 cm.)

5.1 in. (13 cm.)

51in. (13 em.)

13XE69XE61 in.

(3IBX175X156 cm.) : 02
Jft.5in to 5 fr. 7 in.

{approx.)
(102—170 cm.) 03

IftSin. to 5t 7 im.

(approx.)
(102-170 ¢m)

4.8 Ibs. (2.1 kg.)
5.3 Ibs. (2.4 kg.)
64 lbs. (29 kg.)

6.6 Ibs. (3.0 kq.) 04

1.3 Ibs. (0.6 kg.)
0.7 Ibs. (0.3 kg.)
1.7 Ibs. (0.7 kg.)
11.6 Ibs. (5.3 kg.) 06
136 Ibs. (6.2 kg.)
12 Ibs. (5.5 kg.)

05

6.4 Ibs. (2.9 kg.) B

9 Ibs. (4.0 kg.) |

0.45 Ibs. (0.2 kg.}

Tripod leg:
only, not n
stifrnass o
(1 m.) apar
tips moder:

Lift instrum
secure tigh

Center circ
hairs on a
the eyepiec

Caution: C
aver an ex
dried with :
ellowed to
of the cont.

Aim telesc
edge of the

For fine zal
the fine mo

Focus for
focus cont
matically ir

Read staff
necessary :
slightly tap
maovement
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Mechanical Data

Dimensions:

Length of telescope

Height of instrument |,
Diameter of base .
External dimensicns of case

5 3 tripod extending from
5 2 tripod extending from

Weights:

Mi 2 without circle

Mi 2 with circle . 5
Casge for MNi 2 without circle
Case for Mi 2 with circle,;
with plumb bob

Parallel plate micrometer
in leather case .

Torch with supports
Leather case for tarch

S 3 tripod ,

S 2 tripod _—

Loveling staff (03) 4 m. folding te 2 m. .

Leveling staff (05) 3 m
foldingte 1.5m, . . .
Invar staff (06) 3 m., rigid
“Scotch light™ staves,
additional weight .

4

106 in. (27 em.)
5.11n. (13 cm.)
51in. (13 cm,)
13%6.9X86.1 in.

(33X 175156 cm.)
Aft S5in.to5ft. T in.

{approx.)
{(102—170 cm.)

3ft.5in.to 5t T in.

{approx.)
(102170 em.)

46 Ibs. (2.1 kg.)
5.3 Ibs. (2.4 kg.)
6.4 Ibs, (2.9 kg.)

6.6 Ibs. (3.0 ka))

1.3 Ibs. (0.6 kg.)
0.7 Ibs. (0.3 kg)
1.7 lbs. (0.7 kg.)
116 Ibs. (5.3 kq.)
13.6 Ibs. (6.2 kg.)
12 Ibs. (5.5 kg.)

6.4 Ibs. (2.8 kg )
9bs (40 kg)

0.45 Ibs. (0.2 kg.)

o

03

113
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Setting up, Reading

Tripod legs should be extended to a convenient height
only, not necessarily to their maximum; observe correct
stifiness of joints (see MNo. 43); spread legs about 3 ft.
{1 m.) apart; level tripod head to eyesight; tread tripod
tips moderately into ground.

Lift instrument slightly to find thread for center screw and
secure tightly.

Center circular level with leveling screws. Focus cross-
hairs on a bright background by turning the milled ring of
the eyepiece (4, fig, 1),

Caution: Do not store wel instrument in the container
over an extended pericd of tme. Instrument should be
dried with a cloth on the outside as soon as possible and
allowed to get completely dry overnight (to be taken out
of the container for that purpose).

Aim telescope roughly onto target by viewing along one
edge of the telescope housing.

For fine setting observe through telescope and use one of
the fine movement screws (6).

Focus for a parallax-free staff image with dual speed
focus control (1). Reversing the sense of rotation auto-
matically intreduces a slow motion [range: Ya turn).

Read staff graduation against horizootal crosshairs (if
necessary also stadia lines, fig. 2). As a checking measure
slightly tap the telescope with a pencil or operate the fine
movement screw jerkily to and fro. After a small oscillat-

2



Positioning Data Link

PDL

High Performance
Data Link

Designed for Survey Systems

19,200 Baud Rate
Higher Over-the -Air Link Rate
Extends Your Battery Life

Enhanced User Interface

Change Channels in the Field
View Status Information

Compatible with GPS
RTK Equipment
Worldwide

Complete Kit Solutions Available
for Your Application

Reliable
Rugged, All Season Operation

Surveyors utilizing Global Positioning Systems require a rugged radio
modem data link for precise positioning information. The PDL is compact
and lightweight and offers power efficient operation. It is easy to use, and
provides high performance and rugged dependability for the toughest
survey environments.

PDL Products are designed to easily mount on all standard tripods and
range poles. Complete kit solutions are available.

2Year Warranty

Lower Cost of Ownership

T

PACIFIC CREST

CORPORATION



Positioning Data Link’

Channel Button with AutoBase and AutoRover.”
Digital Display.
Modem/Power Status Indicators.
RF Power Select Toggle Switch.

Channel Button with AutoBase and AutoRover.”
Digital Display.
Modem/Power Status Indicators.

High Power Base Low Power Base Rover
General Specifications
DTE — DCE Interface 3 Wire, RS-232, 38.4k Baud Maximum.
User Interface On/Off Button. On/Off Button. On/Off Button.

Channel Button with AutoBase and AutoRover.
Digital Display.
Modem/Power Status Indicators.

Modem Specifications
Link Rate/Modulation

19,200 bps/4 Level FSK.
9600 bps/4 Level FSK.
9600 bps/GMSK.
4800 bps/GMSK.

Power

External 9-16VDC.

Internal Battery 1 [J NAO O O O O NA O O O O Lithium lon Battery Pack.
During TX (nominal) [ 110 Watts.[J O O O Il Watts. [T O O N/A.

During RX (nominal) [ 1.9 Watts. [T O O O 0.9 Watts. [ O O 0.3 Watts.

Antenna

External (] O  |soowmBNCO 0O 0 0 50 Ohm,NMO.O O 0 0 50 Ohm, NMO.

Link Protocols

Transparent, Packet Switched, Digipeater,
TRIMTALK."

Transparent, Packet Switched, Digipeater,
TRIMTALK."

Transparent, Packet Switched, TRI MTALK.™

Forward Error Correction
Radio Specifications
Frequency Bands

Hamming Code (12, 8) with Data Interleaving.

Refer to price list for available frequency bands.

Frequency Control

Synthesized 12.5k Hertz Resolution.
+2.5 ppm Stability.

>-60 dB at 19,000 bps/4 Level FSK.

RF Power Selectl] [ Low/High. OO Edctory Programmable. [J O NVA.

RF Transmitter Output [ 3/35 Watts Maximum. [ O O 05-2Watts. 0 [ O O 0 Watt (Receive Only).
Sensitivity -116 dBm (12 dB SINAD).

Adjacent Channel Selectivity >-60 dB. >-70 dB at 9600 bps/GMSK. >-60 dB.

Type Certification

Operating Temperature

Environmental Specificatio

ns

-22° to +140° F (-30°t0 +60°C).

All models are type accepted and certified for operation in the U.S. and Canada.
For detailed information concerning your country's type certification, please contact your sales representative.

-40 to +140° F (-20° to +85° C).

Storage Temperature

-67° to +185° F(-55°to +85°C).

-4%10 +1850F (-20° to +85° C).

Vibration/Shock

ANSI/ASAE EP455.

Enclosure

Mechanical Specifications
Dimensions

6.23"Wx277"Hx 658" L.

IEC 60529 I.P. 66.
Water Tight and Dust Proof.

8.25" L x 2.40" Diameter.

8.25" L x 2.40" Diameter.

(158ecmW x7.0cmHx 16.7 cm L).

(21.0 ecm L x 6.1 cm Diameter).

(21.0 ecm L x 6.1 cm Diameter).

Weight O O O 2.9 Ibs. (134 Kg).O [0 O O 0.65 Ibs. (0.30 Kg). O O O ] V5 Ibs. (034 Kg).
Data/Power Connector[] 5 Pin LEMO #1 Shell. [T O O 5 Pin LEMO #0 Shell. [T O ] 5 Pin LEMO #0 Shell.
Mount 0 O O Tripod Bracket. 0 [ O O 5/8" - I Range Pole. I O 5/8" - 11 Range Pole.

NN

PACIFIC CREST

CORPORATION

Web: www.paccrst.com,
©2000 Pacific Crest Corporation.

990 Richard Avenue, Suite 110, Santa Clara, CA 95050
1-800-795-1001, Tel: 408-653-2070, Fax: 408-748-9984

E-mail: sales@paccrst.com

License required prior to operation of radio communication equipment. Specifications subject to change without prior notice.
TRIMTALK™ is a trademark of Trimble Navigation Limited.
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Z-Xtreme
Survey System

Z-XTREME

The Ashtech® z-Xtreme™ from Thales Navigation professional
products is a rugged, weather-proof, dual-frequency GPS receiver
designed to provide surveyors with cost-effective, centimeter-accurate
positions in a variety of system configurations.

The Z-Xtreme receiver begins with state-of-the-art satellite electronics
coupled with patented Z-Tracking™ to deliver the highest GPS signal
reception level. A removable battery and flash memory card provide
enough capacity to last all day for maximum utility. Components are
completely integrated inside a weather-proof, high impact plastic
housing, ensuring your investment is safe, rain or shine. Use the easy-
to-operate interface on the front panel for important functions such as
site information entry, survey status, and set-up of RTK base stations
without the additional cost of a handheld controller. The result:
Z-Xtreme with Instant-RTK® outperforms all other receivers in its class!

ZX-SOoLUTIONS

The Z-Xtreme survey system from Thales Navigation provides a range
of solutions designed for the vast array of positioning needs — from
entry level static or kinematic post-processed surveys, all the way up
to real-time functions such as stake out. The entry level ZX-Solutions™
system dramatically increases your productivity for control surveys and
other post-processed applications. Add an optional kinematic kit to
make topographic feature collection more cost effective. Use Ashtech
Solutions™ software to easily process the field data, export results and

www.thalesnavigation.com

4

47°12.381'N
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INSTANT-RTK TECHNOLOGY

generate reports. Purchase only what you need for the job at hand
because ZX-Solutions is fully upgradeable.

ZX-SUPERSTATION

Eclipse the productivity of optical instrument stake out with a ZX-
SuperStation™. The ZX-SuperStation is a field-to-finish GPS surveying
system that combines the Z-Xtreme receiver with a powerful data
collector and wireless modems for centimeter accuracy in real-time.
Instant-RTK gives you the ability to initialize the centimeter solution in
a fraction of the time of conventional RTK systems. Powerful data
collection software gives you the ability to efficiently perform GPS
surveying techniques and to interface seamlessly with optical total stations.

THALES

NAVIGATION



Z-XTREME

TECHNICAL SPECIFICATIONS

Ashtech Technology

¢ 12 channel all-in-view operation

« Full-wavelength carrier on L1 and L2

« Z-Tracking

* Multipath mitigation

¢ Dual-frequency smoothing for improved code
differential

* Instant-RTK

Performance Figures®

Static, Rapid Static
* Horizontal: 0.005 m + 1 ppm
(0.016ft+1ppm)
« Vertical: 0.010 m + 1 ppm
(0.033ft + 1ppm)
Post-Processed Kinematic
« Horizontal: 0.010 m + 1 ppm
(0.033ft + 1ppm)
« Vertical: 0.020 m + 1 ppm
(0.065ft+1ppm)
Real-Time Code Differential Position
e <1m(3.28ft)
Real-Time Z Kinematic Position (Fine Mode)
¢ Horizontal: 0.010 m + 2 ppm
(0.033ft + 2 ppm)
« Vertical: 0.020 m + 2 ppm
(0.065ft + 2 ppm)
* Azimuth (arc sec): 0.4 + 2.0/baseline (km)
RTK Occupation Time
« 2 seconds (typical - sub-centimeter accuracy
with longer occupation time)
Instant-RTK Initialization
¢ 99.9% reliability
* Typically <2 seconds with 6 or more satellites,
PDOP <5, baseline length <7 km (4.35 mi),
open sky and low multipath conditions
RTK Operating Range
* Recommended: 10 km (6.21 mi)
* Maximum: 40 km (24.85 mi)

Standard Features

¢ 16 MB PCMCIA removable memory card

* NMEA 0183 output

« Selectable update rate from 999 sec to 10 Hz
« Event marker

 Point positioning

« 1 PPS timing signal

« Session programming

Thales Navigation, Inc.

Corporate Headquarters, Santa Clara, CA, USA

+1 408 615 5100 * Fax +1 408 615 5200

Toll Free (Sales in USA/Canada) 1 800 922 2401

Email professionalsales@thalesnavigation.com

In Washington, DC  +1 703 476 2212 * Fax +1 703 476 2214
In South America +56 2 234 56 43 * Fax +56 2 234 56 47
In China +86 10 6566 9866 * Fax +86 10 6566 0246

European Headquarters, Carquefou, France

+33228 09 38 00 * Fax +33 2 28 09 39 39

Email professionalsalesemea@thalesnavigation.com

In Germany +49 81 6564 7930 * Fax +49 81 6564 7950

In Russia +7 095 956 5400 * Fax +7 095 956 5360

In UK +44 (0) 870 601 0000 * Fax +44 (0) 208 391 1672

In the Netherlands +31 78 61 57 988 * Fax +31 78 61 52 027
Web site  www.thalesnavigation.com

» Wide array of coordinate transformations

* Removable internal battery

* 8-character alphanumeric LED display with 4-
button interface

« 3 function LED display - Radio,Memory,
Satellites/Power

 Multi-function audible alarm

* Quick reference card holder

» External mount capabilities

 External power input

* 4 RS-232 ports (115200 baud max, 3
external, 1 internal)

 1-year warranty

* Free factory technical support

Standard Accessories

» Communications software

» Padded system bag and hard case
* RS-232 data cable

» Receiver operating manual

* Quick reference field card

Technical Data

Environmental
Z-Xtreme Receiver
* Meets MIL-STD 810E for wind driven rain
and dust
» Operating temperature: -30° to +55°C
(-22° to 131°F)
 Storage temperature: -40° to +85°C
(-40° to 185°F)
Geodetic 4 Antenna
» Meets IPX7 specifications for submersion
» Operating temperature: -55 to +75°C
(-40° to 149°F)
 Storage temperature: -55° to +75°C
(-67° to 167°F)

Physical

Weight

* Receiver: 1.59 kg (3.50 Ib)

» Antenna: 0.82 kg (1.81 Ib)

* Battery: 0.43 kg (0.95 Ib)
Dimensions

*76.2 Hx 196.85 W x 222.25 D mm
* (0.25 H x 0.646 W x 0.729 D ft)
Power

*10-28VDC, 6.0 W

Internal battery
« Capacity: 6000 mAh
* >9 hours (typical) @ 25°C (77°F)
» Operating temperature: -30° to +55°C
(-22° to 131°F)
« Storage temperature: -40 to +60°C
(-40° to + 140°F)

PC card
* ATA Type || PCMCIA memory card (16 MB

standard)
* Temperature range: -40° to +85°C

(-40° to 185°F)

 Data capacity: 4500 epochs per 2 MB*
* Based on one session, eight satellites' data
and full measurements. This number can vary
significantly depending on the conditions of the
session.

Optional Features

* Real-time kinematic (base and rover modes)
for cm-accuracy

* RTCM 2.2 (Types 1, 2, 3, 9, 16, 18, 19, 20,
21, 22)

« Internal UHF or spread spectrum radio for
RTK rover operations

« External UHF or spread spectrum radio for
RTK base and rover operations

» Geodetic 4 antenna ground plane kit

» Kinematic antenna kit

« Aircraft antenna kit

* AC power cable

» Choke ring antenna

« Long haul backpack kit

« All-on-a-pole kit

Optional Application Software

GPS data processing
» Ashtech Solutions

Land Surveying and Construction
¢ TDS Survey Pro

« Carlson SurvCE

« Ashtech Survey Control Il

» Ashtech GPS Fieldmate

Mining and Land Seismic
» Ashtech Mine Surveyor Il
 Ashtech Seismark II

1 Specifications assume operation follows all the
procedures recommended in the product manual utilizing
Instant-RTK, post processing with Ashtech Solutions or
Ashtech Office Suite for Survey. High-multipath areas,
high PDOP values, low satellite visibility, and periods of
adverse atmospheric conditions and/or other adverse
circumstances will degrade system performance. All
accuracy specifications are RMS values.

Thales Navigation follows a policy of continuous product improvement; specifications and descriptions are thus subject to change without notice.
Please contact Thales Navigation for the latest product information.

© 2003 Thales Navigation, Inc. All ights reserved. Ashtech, Z-Xtreme, Instant-RTK, ZX-SuperStation, ZX-Solutions, Z-Tracking, GPS FieldMate, Survey Control Il and Ashtech Solutions are trademarks
of Thales Navigation. All other product and brand names are trademarks or registered trademarks of their respective holders. Ashtech P-code GPS technology has been FGCC tested and is capable
of performing first order surveys (report available upon request). rev(5.03) part # 830190
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TOP GUN'
DTM-310

ELECTRONIC TOTAL STATION




Valuable functions, superior cost-performance,
longer battery life and enhanced software

Nikon has just taken the world-renowned Top Gun® DTM-300 total station to a
whole new level. The new Top Gun® DTM-310’s enhanced keyboard and on-board
software enable easy code input in both alphabet and numbers, the way you've
always wanted. It builds on existing features — such as the large four-line LCD
and full numeric key pad — to improve overall convenience. And software
upgrades make it easier to search and display data. In fact, the Top Gun®
DTM-310 provides customers in any field — from civil construction to cadastral
surveying and mapping — with greater ease of operation.

ENHANCED BASIC FUNCTIONS

Large four-line display with full alphanumeric input on both faces
Meets basic requirements for distance and angle measurement
Resume function for quick startup and power management
Enhanced, powerful built-in programs

500-point on-board data slotage function

7.3 hours continuous measuring with one on-board battery
Compact and lightweight

Quick access to the 20 most recently stored codes

CONVENIENT ALPHANUMERIC INPUT

The inclusion of alphabetic input enables you to store codes in a
combination of letters and numerals. Codes, target heights (HT) and point
numbers are easily input for each new measurement. And codes can also
be selected from the most recent 20 codes stored in the memory,
eliminating the need to repeatedly input the same codes.

ANG 1| xvz u| REC *

‘e e
RDM ST S0 )
KEKIREKERIKD

B KEY DESCRIPTIONS

MSR: Distance measurement in normal measurement mode

DSP: Selects display item by scrolling display

TRK: Distance measurement in high-speed measurement mode

ANG: Horizontal angle zero-set, user-defined angle input or hold

XYZ: Coordinate measurement

RDM: Remote distance measurement (continuous or radial)

REM: Remote elevation measurement

STN: Station setup (known point, 2-point resection or 3-point resection)

§-0: Stakeout by inputting angle distance or coordinates

INlumination: Display illumination

REC: Data record to internal memory

ENT: Data entry or sending observation data to communication port in normal
observation mode

FNC: Input of temperature and barometric pressure, prism constant, and height
of target; simple COGO calculation; settings; view/edit stored data;
communication (internal memory); vertical collimation correction




Ennancep, PowerruL BuiLt-iNn PRoGRAMS

On-board data storage function
Thie OTM-310 mamary stores up 1o 500
raw or coordnate records. Coordinate data
can ba manually input, measured or

uplnadad from a PG, (Contac your Mikan
distributor for downksadiuplead and iommal
carversion software.) (ata can Do nstanthy
racalled and raviewad for station selug,
stakaout and COGO.

sigtion satup cbtained by mputting the co-
ordinale of backsight or direction angles,
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number. code and coordinale daka can ba
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RDM
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COGO calculation

Enables point-to-point inverse caboula-
tions, plus azimuth and distance cabloula-
oS, Goordingles can be Searched amnd
rajrignsed lrom the on-board memony, and
calcutaied coondinates can be saved

Data display

The DTM-310 enables you fo search data
bry traacing biasck ram Be mas! recen recond
from specifs station points, or from & simple
painl nember.
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Basic MEASUREMENT

FuncTions

= Buill-in Autesmatic Verical Compensation
= Vertical Anghe Zaro-Degres Sat Handled in Threoe

7.3 Hours ConTinuOUS
OrperaTiNG TIME

Intermal bathery BC-80 provides abaul 7.3 hours {with full charge, at 200G,
far distancelangle measurements) of continuous oparation. The remaining

batbary power & indicated by the LCD, As Mi-kH batbery BC-80 containg no Mades

harmful substance, recyeling ks nod necessary. Ouick recharge can be = Grsde Display

parformed in about 2 hours with standard battery charger Q-TOUAS-TOE. = With Triple Prism, to 1.2km or 3,900 fes! {under
The Q-FOUND-70E"s discharging funclion presarves the batheries’ minimem good conditions)

» (5 4 Jppm x Dpmm Frecision

» Auiomatic Environmental Compansation

+ Selpctable Angle Fesding ol 5107, 0.5 mgon,
0,020, 05MIL

= Angle Measurament Accuracy ol 571 Gmgon'
0.02MIL (standard deviation basad on DINTETE3)

power and protects againgt detenoration.

Resume FuncTion

Thes resuma funchon can automatically rever B0 1he arientalion pooar 1o
powar OFF, gr aulomalically display the previouws horizontal angla.
I guarantess tha aataly of all previous data sellings.



Standard Package -

* DTM-310 main unit

* On-board battery BC-60

= Battery charger
Q-70U/Q-70E

* Lens cap

Optional Accessories

» Diagonal eyepiece prism

* High-power (32x) and
low-power (16x)
eyepiece lenses

* Compass (tubular type)
and compass adapter

Specifications

Telescope
Tube length
Etfective diameter of objective

Magpnification

Field of view

Resolving power

Minimum focusing distance

Angle measurement

Reading system

Unit of reading

Least count (selectable)
(360°)

(400G)

(6400MIL)
Accuracy (Standard deviation based
on DIN 18723)
Tilt sensor (Automatic Vertical
Compensator)
Working range
Distance measurement
Range (with Nikon prism)
(Normal conditions: ordinary haze,
visibility 20km/12.5 miles)

with mini prism

with single prism

with triple prism
(Good conditions: no haze,
visibility 40km/25 miles)

with mini prism

with single prism

with triple prism
Accuracy

Maximum measurement display
Least count
Standard MSR mode
Tracking mode

* Plumb bob

* Tool set

* Plastic case

» Vinyl cover

* Instruction manual

« Zenith prism

* Solar filter

« Solar reticle

* External battery B4

150mm/5.9 in.

36mm/1.41 in.

(EDM aperture 40mm/1.57 in.)
26x (standard)

1°30'

3.5"

1.0m/3.3 ft.

Incremental encoder
Degree/Gon/6400MIL

5" or 10"

0.5mgon or 1mgon
0.02MIL or 0.05MIL
5°/1.6mgon/0.02MIL

Liquid type
+3'

380m/1,300 ft.
800m/2,600 ft.
1,100m/3,700 ft.

450m/1,500 ft.

1,000m/3,300 ft.

1,200m/3,900 ft.

(5 + 3ppm x D)mm,

=10°C to +40°C/+14°F to +104°F
+(5 + 5ppm x D)mm,

-20°C to +50°C/-4°F to +122°F
1,230m/4,000 ft.

1mm/0.005 ft.
10mm/0.05 ft.

Measuring intervals
Standard MSR mode
Tracking mode

Measuring mode

Ambient temperature range

Atmospheric correction range
Temperature range
Pressure range

Display

On-board battery BC-60 and
battery charger Q-70U/Q-70E

4 sec.

1.2 sec.
Continuous/Single/Average (2 - 99)
-20°C to +50°C (-4°F to +122°F)

—40°C 1o +60°C (-40°F to +140°F)
400 to 999mmHg (1mmHg step)
15.8 to 39.3 in.Hg (0.1 in.Hg step)
533 to 1,332hPa (1hPa step)
Dot-matrix LCD

16 characters x 4 lines

Level vial
Sensitivity of plate level vial
Sensitivity of circular level vial
Leveling base

Tribrach e
Optical plummet

Image

Magnification

Field of view

Power sources

Type

Continuous operating time

Quick battery chargor ger (Q-70U/Q-70E)
Input voltage

Recharging time
Dimensions (W x D x H
Main unit (with carrying handle)
Weight

Main unit w/battery

Battery BC-60

Carrying case

_1.5 hrs.

30%/2mm
10'/2mm

Detachable
Erect

3x

5°

0.5m/1.6 f. to o0
Ni-MH 7.2V DC
7.3 hrs. or 8,760 measurements

(for distance/angle measurement)
22 hrs. (for angle measurement only)

115V for Q-70U, 220/240V for Q-70E

164 x 177 x 335mm/6.5 x 7.0 x 13.2 in.

5.5kg/12.1 Ibs.
0.5kg/1.1 Ibs.
2.5kg/5.5 Ibs.

These products (DTM-310 and battery charger Q-70U/E) are strategic products subject to Japanese/International export
control regime. They should not be exported without authorization from the appropriate governmental authorities.

Specifications and equupment are subject to change without any notice or obligation
on the part of the manufacturer. February 1997
©1997 NIKON CORPORATION

East Coast:
NIKON INC.

Instrument Group, Surveying Dept.
1300 Walt Whitman Road, Melvilie, NY 11747-3064

Phone: (516) 547-4200 Telefax: (51

West Coast:
NIKON INC.

6) 547-8669

Instrument Group, Surveying Dept.
19601 Hamilton Avenue, Torrance, CA 90502

Phone: (310) 516-7124 Telefax: (31

0) 719-9772

http://www.niko
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V. SPECIFICATIONS

1. Main Unit

® Telescope
Image
Magnification
Effective diameter of objective
Field of view
Minimum focusing distance
Resolving power

® Distance Measurement
Distance range of Nikon prisms:

Precision

Measuring time response

Least count
Display
Display unit

® Angle Measurement
Accuracy

Reading system

Display unit

: Erect/unreversed
C 26X

. 36mm

:1°30

:1.0m

: 3.5

450m with mini prism
1000m with single prism

1200m or longer with triple prism
* With visibility 40km (25miles)

;= (Bmm+3ppm X D)

*With accurate measurement mode,
at —10°C~ +40°C/+14°F~ +104°F
D i1s measuring distance, mm unit
+(5mm+5ppm xD) at —20°C<t< - 10°C/
—4°F<t< +14°F and +40°C<t=50°C/
+104°F<t=+122°F

: (MSR) mode: About 4sec.

(initial: about bsec.)
(TRK) mode (cm):About 1.2sec
(initial: about 2 .2sec.)

Tmm
: Up to 1230m
- m/ft-INT/ft-US

- 5" (Standard deviation based on DIN

18723)

. Photoelectric detection by incremental

encoder single-sided reading

: Degree/Gon/MIL

56



V. SPECIFICATIONS

57

® Automatic Vertical Compensator

System
Working range

® Optical plummet
Image
Magnification
Field of view
Focusing range

® Clamps/tangent screws
® Sensitivity of level vials

Plate level vial
Circular level vial

® Tribrach

® Dimensions and weight
Main body

Case

. Liquid-electric detection
3

. Erect

: 3X

. B°
:0.5m~o

: Coaxial dual speed tangents

: 307/2mm

1 10/2mm

: Detachable

: 5.5kg (12Ibs) including BC-6 battery

pack
: About 3.5kg (7 .6lbs)

® Operating temperature range:

=20°C~b0°C/—4'F~+122°F



SURVEYING INSTRUMENTS

SOKKIN SETSF

TOTAL STATION

Enhanced software with 3,000-point data memory.




Flexible, Friendly and Featherweight

The SET5F's powerful EDM, dependable dual-axis compensator and 3,000-point data memory
are conveniently packaged in a compact, lightweight body. Software [Version 01-00) has
been enhanced for more effective survey work, and "softkey" assignments can be freely
customized to suit all user needs.

Dependable
Hardware

Proven Dual-axis Compensator
«Since its introduction with the Series C
total station in 1989, Sokkia's dual-axis
compensator has proven its reliability and
accuracy at survey sites all over the world.
*The dual-axis tilt sensor monitors
deviations of both the X and Y axes and the
correct horizontal and vertical angle
readings are automatically computed and
applied. The result is easier and faster
instrument leveling.

-
Truge Perpendicular
Axis

Inclined Vertical
Axis ==

True Horizontal
Plane

Inclined Horizontal
Flane

True Perpendicular
Axis

Inclined Vertical
Axis

True Horizontal
Plane

Inclined Horizontal
Plane

The High-performing EDM
+1,500m/4,900ft range with a single prism
under good ambient conditions (40km/
25miles visibility, with no haze, overcast,
no scintillation).

*Outstanding precision;
+(3+2ppmxD)mm. This corresponds to a

deviation of a mere £3.2mm at a distance
of 100m and £5mm at 1,000m.

*Supreme speed; only 1.7 seconds initial
measuring time in the rapid measurement
mode.

Average Conditions |Good Conditions

CPO01 Compact Prism {700 m/2,300 ft.

One APO1 Prism 1,200 m/3,900 ft. 1,500 m 4,900 ft.

Three APO1 Prisms  |1,600 m/5,200 ft. 2,000 m 6,500 ft.

Powerful Telescope

*Highest magnification in its class: 30x

*Easy, accurate sighting of prisms or

targets
; -«3\-‘-_9{

Outstanding Mobility

Total carrying weight (including instrument,
tribrach, battery and hard case) is a mere 8
kag/18 Ibs. The secret lies in the lightest and
most compact carrying case of its kind
(W390 x D255 x
H220mm / W15.3 x
D10.0 x H8.6in.), making
the SET5F supremely
portable.

*A convenient
shoulder strap is
provided as
standard. An
optional back
pack (SC94) is
ideal for longer
day treks.

Enhanced
Software

The SET5F can be easily customized
to your preferred key assignments.
*The SET5F offers optimum keyboard
flexibility. Any keyboard layout can be
configured. For example, functions can be
assigned to any key position on any page,
and unused functions can be temporarily
deleted.

*A powerful "softkey" feature facilitates
input of coordinate values,

feature codes, etc.

PpmM £ R.C.

Key assignent mode

Spacious 3,000-point Internal
Memory

*The SET5F's internal memory is large—
holding a full 3,000 data points—and
secure. For optimum convenience,
measurements can be performed and
recorded at the touch of a key.

*Up to five (5) job files can be created to
efficiently organize multiple survey tasks.
*Forty (40) feature codes (max.13 charac-
ters each) can be kept in the memory for
easy recall as needed.

ppm /A P.CL

ppm S P.CL

Sophisticated Application Software
Missing Line Measurement (MLM)

*The SET5F measures horizontal distance,
slope distance, height difference, and slope
in percent (%) between two prisms, all at the
touch of a key.



The SET5F brings full freedom to survey work.

Remote Elevation Measurement
(REM)

*The SET5SF can be used to easily
determine the height of a point where a
prism cannot be placed. The system
sights a prism directly above or below the
target point, and then S|ghts the point
desired. b

Angle Repetition

*For enhanced accuracy in the horizontal
angle measurement, the SET5F can
measure in repetition. It then calculates
and displays the average of the multiple
angle measurements.

Azimuth Angle Setting

*Using the coordinates of the instrument
station and a backlight point, the SET5F
can automatically set the horizontal angle
to the azimuth of the backlight.

Backsight Station

: : \—--.

Azimuth Angle

Resection

*With 2 to 5 known points, the SET5F can
be used to determine the azimuth and
coordinates of the unknown instrument
station.

*When using 2 known points, both angles
and distances are measured. When

using 3 or more points, the distance does
not always have to be measured.

r Known Stations |
et
A |

z |

N ? Azimuth Angle :

b | T\ |
/1Y Unknown Point

| E i |

3-D Coordinate Measurement

*The SET5F calculates 3-D coordinate
values of measuring points.

*The operator may choose display settings
either of "N, E, Z" or "E, N, Z2."

i A
h——f

z // ENEEE

N $—— e
A

. I\ ARICT.

3-D Setting-out

*The SET5F can be used to perform
3-dimensional setting-out with N, E and/or
Z coordinates.

A.,' | 2
l ‘

\ /k M,E andior Z

Offset Measurements

Two basic offset measurement methods
are provided to measure the hidden
points. One calls for input of the offset
distance and the direction between the
measuring point and the prism. The other
uses a prism set on the left or right side of
the measuring point at the same distance
from the SET5F; the angles and distance
to the prism are measured, and the
measuring point is sighted. In both cases,
the SET5F calculates the horizontal and
vertical angles and distance, or the N, E,
Z coordinates.

BMeasuring Paint

Ottset Point
5
L
~e |

i
Measuring
Point

15 hr. charger
CDC14 (100V AC) S
CDC14A [120V AC) :::-I:J\I.L‘L—.il?ri,
CDC14D {220-2400 AC)  BReqs Y

Cable (2m)
EDC3

AC/DC converter
EDC2/EDC2A 100-240V AC)

Car cigarette lighter
cable (5m)
EDC4 12V DC)

= @_ﬂ

DC/DC converter
EDC14

Car battery cable (5m)
EDCS (12Y DC)

“Fitted with a Euro plug (twe round pins).

L
80 min. quick
CDC27 (90-125V
CDC31* (180 zb"l\u Hl:l

90 min. quick charger
CDCI1A* (230 AC+10%)

12 hr. charger
CDC11 (100-120V ACH
CDC11D {220-2400 AC)

CRCTIE" (220-240V AC)
Rechargeable
BDC25 A
-2~

80 min. double quick
charger

CDL28 (90-264Y AC)
with power cable
EDC34 or EDC35"

80 min. car cigarette lighter

charger
CDC32 (11-16V DC)




Standard Configuration

The SET5F comes with two (2) BDC25
rechargeable batteries EDC19 battery
charging adapter CDC27, CDC31 or
CDC31A quick charger, CP7 tubular
compass, sunshade, lens cap, plumb bob,
vinyl cover, tool kit, operator's manual,
carrying case and shoulder strap.

Electronic Field Books
(SDR33/SDR31)

Thanks to its advanced two-way commu-
nications port, the SET5F's functions can
all be accessed by external controller. For
example, by connecting one of the
Sokkia's acclaimed Electronic Field Books
(SDR33 or SDR31), complex field
operations such as traverse adjustment,
intersection, area calculations and roading
can be carried out with remarkable ease.

CICT
oo

Optional Accessories

DE17A Diagonal Eyepiece
OF1/0OF1A Solar Filters
SC9%4 Back Pack

SETS5F Specifications

Length 165mm (6.5in)
Objective aperture 45mm (1.8in)
Magnification, image 30x, Erect
Resolving power 3.0"

Field of view 1°30'(26m/1,000m)
Minimum focus 1.3m (4.3ft.)

Reticle illumination

Bright or Dim, selectable

Display resolution H&V 1"/ 0.2 mgon/ 0.005 mil, 5"/1 mgon/ 0.02 mil

Angle unit H&V Degree/Gon/Mil

Accuracy H&V 5" (1.5 mgon/ 0.02 mil) according to DIN18723

Dual-axis compensator Liquid dual-axis tilt sensor, range: £3' (55 mgon)

Display mode H Clockwise/ Counterclockwise, Repetition, Oset, Hold available
V Zenith 0°/ Horizontal 0°/ Horizontal 0°+90°/ Slope%

Measuring range (slope distance)

A: Average conditions; slight haze, visibility about 20km(12 miles),
sunny periods, weak scintillation.

G: Good conditions; no haze, visibility about 40km (25 miles),
overcast, no scintillation.

Maximum ranges are achieved with Sokkia CP/AP prisms.

With CPO1 compact prism A:1.3m (4.3ft.) to 700m (2,300ft.)

With one APO1 prism A:1.3m (4.3ft.) to 1,200m (3,900ft.), G: 1,500m (4,900ft.)
With three APO1 prism A:1.3m (4.3ft.) to 1,600m (5,200ft.), G: 2,000m (6,500ft.)
Distance unit Meters or feet, selectable

Accuracy (Fine measurement)
Measuring unitand time  Fine

+(3+2ppmxD)mm D=measuring range, unit=mm
0.001 m Every 3.2 seconds (initial 4.7 seconds)

(slope distance) Rapid

0.001 m 1.7 seconds

Tracking

0.01 m Every 0.3 seconds (initial 1.4 seconds)

Average

0.0001 m (average of 2 to 9 times measurement)

Atmospheric correction

Key-in the temperature and pressure, or -499 to +499ppm.

Prism constant

-99 to Omm (1 mm steps)

Refraction & Earth-curvature
correction

On/off selectable (K=0.142)

Display LCD dot matrix display (20 characters x 4 lines) on both faces with
back light.

Keyboard 5 keys on both faces, free assignment of functions.

Resume function Onl/off selectable

Sensitivity of levels

Plate level: 40"/2mm, Circular level: 10'/2mm (in tribrach)

Optical plummet

Image: erect, Magnification: 3x, Minimum focus: 0.5m (1.6ft.)

Interface

Asynchronous serial, RS-232C compatible, baud rate 1200/
9600bps

2-way communication

Provided

Data storage

3,000-point data memory

Operating temperature

-20°C to +50°C (-4°F to +122°F)

Tilting/Trunnion axis height

236mm (9.3in) from tribrach bottom, 193mm (7.6in) from
tribrach dish.

Size with handle and battery

W150 x D165 x H353mm, W5.9 x D6.5 x H13.9in.

Weight with handle and battery

5.4kg (11.9lbs)

Weight of parts

Battery level display

BDC25 battery: 240g (8.50z.), Handle: 100g (3.50z.),
Tribrach: 7409 (1.6 Ibs), Case:2.4kg (5.3Ibs)

4 steps with warning message.

Automatic power cut-off

On/off selectable (30 minutes after the last operation)

Power source BDC25 rechargeable battery, Ni-Cd 6V, 2 supplied as standard.
Working duration at 25°C (77°F) Distance & angle measurement: about 5 hours, about 600 points
w/one BDC25 battery (Fine & single measurement with 30 seconds intervals).
Angle measurement only: about 9 hours.
Charging time CDC27/31: about 80 minutes, CDC31A: about 90 minutes

Designs and specifications are subject to change without notice.

SOKKIA CO.,LTD.

1-1, TOMIGAYA I-CHOME, SHIBUYA-KU, TOKYO, 151 JAPAN
PHONE +81-3-3465 5211 FAX +81-3-346-5203
INTERNATIONAL DEPT. PHONE +81-3-346-5201 FAX +81-3-3465-5202

Sokkia is a sponsor |
of the ‘

Conficate No. J0A-0857
S0 BO01/BS EN 50 S001/EN 29001 LS 25501

International Federation
of Surveyors.




Appendix Il

Vessel Reports, Offsets, and Diagrams

Launch 1010

Offsets

Patch Test

DDSSM and Settlement & Squat
POS Gams Calibration

Wire Diagram

arwnE

Launch 1018

Offsets

Patch Test

DDSSM and Settlement & Squat
POS Gams Calibration

Wire Diagram

arwnE

S220

Offsets

Patch Test

DDSSM and Settlement & Squat
POS Gams Calibration

Wire Diagram

Correspondence
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Waterline Measurements Fill in Yellow squares only!

Measuring Party: Rice, Argento, Campbell, Beduhn
Waterline Measurements should be Negative!

1010 Date: 4/7/2009 Dn 097

Benchmark A to Waterline Benchmark B to Waterline Fuel Level: 5+
Measure 1 -86.2 -88.5 Draft Tube:
Measure 2 -86.6 -89.2
Measure 3 -87.6 -96.0 Port-to-Stbd Z-difference
Avg (cm) -86.80 -91.23 Theoretical Actual Error
Avg (m) -0.8680 -0.9123 0.0327 -0.0443  -0.0770
Stdev 0.00721 0.04143
BM Z-value (m) -0.02017 -0.05283 BM C to WL Average (m)
BM C to WL (m) -0.888 -0.965 -0.927||(This value added to 1010_Offsets & Measurements_200X.xIs)
Individual -0.88217 -0.93783
measurement -0.88617 -0.94483
StDev for TPU xIs || 0.04986 -0.89617 -1.01283 |lutilized in Offsets and Measurements and TPU spreadsheet If

(of 6 #'s)



the new POS M/V antenna.

This spreadsheet is designed to compute the z-values of the phase centers of

All offsets are in the Theodolite Coordinate System

BME X 1.665536
y -0.892424
z 1.612667
BM F X 1.668082
y -0.001217
z 1.649000
BM G X 1.668115
y 0.957794
z 1.578000

Measuring Party (fill in yellow spaces only):
Rice, Argento, Campbell, Beduhn

Distances

Port Ant to BM 'E' 0.693 0.693
Port Ant to BM 'F' 1.11 1.11
Port Ant to BM 'G' 1.967 1.97
Stbd Ant to BM 'E' 1.959 1.964
Stbd Ant to BM 'F' 1.166 1.167
Stbd Ant to BM 'G' 0.707 0.705
Antenna Post Diameter Radius

0.0255 0.01275

0.693
1.112
1.97

1.962
1.167
0.705

Port Ant X

y

z

Stbd Ant  x

y

z
Date:
4/7/2009

0.70575
1.1234167
1.98175

1.9744167
1.1794167
0.7184167

added.

The distances from the antenna post to each benchmark was measured
three times and averaged. The post offset to phase center (radius) was then

POS MV V4 Installation and Operation Guide

Drawings |

2.316862
_0886431 Phase Cantra 23T CM

Unknown / %,

0.73CM \

2.324270 ] l
0.952574 T . . , )

Unknown = =1 i \ /

—ﬁm L
Figure 79: GPS Antenna Footprint
Serial #- Port Serial #- Stbd |
60162863 60145247
z-Values
Ant. Base Phase Center
1.884369 1.930369
1.888889 1.934889
1.902489 1.948489
1.886629 1.932629 AVERAGE
0.0094 STDEV

1.858381 1.904381
1.874221 1.920221
1.870499 1.916499
1.872360 1.918360 AVERAGE

0.0083 STDEV

The distance is 0.046m (4.60cm) from the bottom of the
antenna to the Phase center, obtained from the POSM/V
v4 guide, see image above.




Offsets from Aft Benchmark to Phase Center of Transducer

|79

|Launch 1010

|Campbel|, Argento, Beduhn

3/20/2009
Date DN Vessel Personnel
2701011

Instructions: The purpose of this measurementis to check for
gross movement of the tranducer. Fill in yellow spaces only.

While the boat is in the cradle, gently lower the transducer and
lock it in place. Using a metric tape measure, plumb bob and
carpenter's level, measure the horizontal and vertical offsets from
the aft benchmark (BM H) to the phase center of the transducer.
The phase center is measured at the forward edge of the black
insulating layer, as shown in the photos. If you have trouble
locating the center, borrow a compass from the navigation

Serial Number of Transducer

department.

Notwithstanding a major accident, BM H will be outboard, aft and
higher than the phase center; as such, enter all offsets as positive

numbers (in cm) and the proper signs will be applied.

Once offsets have been measured, apply a digital level to the IMU
to determine any pitch or roll bias in the orientation of the launch.

For the purposes of this spreadsheet, a positive angle (measured
in degrees) will imply the bow is higher than the stern and the port

side is higher than the starboard side.

All measurements should be done in triplicate to aid in the

calculation of the uncertainty (needed in the HVF). The IMU to
Phase Center values will be calculated automatically.

Offset Measurements (positive cm): Average

Bow-Stern 10.6 10.7 11.0 10.8
Port-Stbd 15.9 15.9 15.8 15.9
Up-Down 35.5 35.4 36.0 35.6

BM H to Phase Center

(Theodolite Coordinate System)
X __#REF! cm
y #REF! cm
z #REF! cm

Measured by NOAA Personnel
inserted into Offset Worksheet,

if to be used in IMU to 8101 calculation

Angle Bias (deg):
Bow Up
Port Up

The measuring crew should
insure there will be no yaw bias.

(CARIS Coordinate System)

X #REF! m
y #REF! m
z #REF!I m

Calculated Value for check purposes

.

I_I

Std Dev:
Bow-Stern| 0.16
Port-Stbd 0.05
Up-Down 0.30

These 2009 values were not used for the hvf
offsets due to the angle bias not being entered.
The 2008 values were used instead and the 2009
values were used as a check that the unit had not
been displaced.



1010 Offsets and Measurements - Summary

Measurement |IMU to RP* Port Ant to 8101
aka Nav to Trans x,y,z
Coord. Sys. Caris Caris Caris Caris Caris
X 0.000 0.250 0.250 1.147 n/a
y 0.000 -0.133 -0.133 1.066 n/a
z 0.000 0.549 0.549 3.665 -0.256
*IMU is RP (Reference Pt)
Vessel Offsets for 1010_8101 are derived from the Horizontal, Vertical & XYZ worksheets in this spreadsheet. 2008 Measured Values
Calculations
coord. Sys. [N [ Port Ant to 8101 |
Theodolite IMU (m) X 3.516 IMU (m) X 3.516 IMU (m) X 3.516
y 0.011 y 0.011 y 0.011
z -1.183 z -1.183 z -1.183
BM H X 3.271447 Port Antenna X 2.317 BMC X 0.000
y 0.425598 y -0.886 y 0.000
z -1.37667 z 1.933 z 0.000
IMU x  -0.244 IMU to X -1.199 BM C to IMU
toBM H y 0.415 Port Antenna y -0.897 X n/a
z -0.194 z 3.116 y n/a
z -1.183
BM H to x 11.10496 IMU to X -0.133
Phase Ctr (cm) y| -16.466 Phase Citr y 0.250 BM C to Waterline
measured z -35.540 z -0.549 measured X n/a
y n/a
BM H to x 0.11105 z -0.927
Phase Ctr (m) y -0.16466
z -0.3554
see
Coord. sys. NN [ PotAnosior ] [ RPioWatedne |
Theodolite IMU to X -0.133 X 1.066 X n/a
Phase Ctr y 0.250 y 1.147 y n/a
z -0.549 z -3.665 z 0.256
Coord. Sys. Coord. Sys. Coord. Sys.
X 0.250 X 1.147 X n/a
y -0.133 y 1.066 y n/a
z 0.549 z 3.665 z -0.256




1010 Offsets and Measurements - Summary

Port Ant to Stbd Ant

Scalar Distance 1.839

2009 Measured Values

IMU to Port Antenna IMU to Heave

Caris Pos/Mv Caris Pos/Mv
-0.897 -1.199 -0.011 -1.176
-1.199 -0.897 -1.176 -0.011
-3.117 -3.117 -0.243 -0.243

Values in the POSMV remained as entered in 2008.

2007 Measured Values

Port Ant to Stbd Ant

Port Ant (m) X 2.317
y -0.886
z 1.933

Stbd Ant (m) X 2.324
0.953
1.918

N <

Port Ant to Stbd Ant

Scalar Distance 1.839

IMU to Port Antenna IMU to Heave

IMU (m) X 3.516 IMU (m) y 0.011
y 0.011 X is nfa z -1.183
z -1.183
Heave Pt (m)
Port Ant (m) X 2.317 (centerline) y 0.000
y -0.886
z 1.934 BM C to Waterline (m) -0.940

measured scalar dist

BM C
Xx&y are n/a z 0.000

BM C to Waterline (m)
(Heave PY) z -0.940

IMU to LCG X -1.176
See IMU to Heave tab

IMU to Port Antenna IMU to Heave

X -1.199 X -1.176

y -0.897 y -0.011

z 3.117 z 0.243
Coord. Sys. Coord. Sys.

X -1.199 X -1.176

y -0.897 y -0.011

z -3.117 z -0.243

See IMU to Heave tab




Description of Offsets for Launch 1010

All Values Shown are in CARIS Coordinates

The Ship Reference Frame (SRF) for Launch 1010 was based from benchmark (BM) C as the 0 point. Physical locations were measured with x,y,z offsets
from this point. These locations were used to calculate offsets of items with respect to each other, as described for each offset.
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X y z
0.250 -0.133 0.549

The physical positions of the IMU
and the phase center of the 8101
with respect to the Ship
Reference Frame were
measured by NOAA personnel.
These physical measurements
were used to calculate the xyz
offsets from the IMU to BM H.
Measurements from BM H to the
Phase Center of the 8101 were
collected by NOAA personnel
while the boat was secured on
the pier and thought to be as
level as possible. The measured
offsets from BM H to the phase
center were then added to the
offset from the IMU to BM H.
The result is the offset from the
IMU to the phase center of the
transducer. The values in the X
and Y fields are transposed and
the inverse of the Z value is used
to give the offsets in CARIS
coordinates.

Port Ant to 8101
X y z
1.147 1.066 3.665

NOAA personnel calculated the
distance between the port
antenna and the phase center of
the port antenna subtracting the
IMU to Port Antenna value from
the IMU to Phase Center value.

RP to Waterline
X y z
N/A N/A -0.256

The average vertical distance
from BM A and B to the waterline
was measured by
FAIRWEATHER personnel using
a steel tape and bubble level.
These values were used to
calculate the BM C to the
waterline value. With the
knowledge of the BM C height
above the IMU, the waterline
height above the IMU could be
calculated. On launch 1010, the
IMU is used as the reference
point.

Port Ant to Stbd Ant
Scalar Distance
1.839

The location of the phase center
of the port and starboard
POS/MV antennas were
measured by NOAA personnel
with respect to the SRF. The
scalar distance between the
phase centers was then
calculated.

IMU to Port Antenna

X y z
-0.897 -1.199 -3.117

The location of the IMU and the
location of the port antenna were
measured by NOAA personnel
with respect to the Ship
Reference Frame (SRF). The
xyz offsets from the IMU to the
port antenna could be calculated
from these physical locations.

IMU to Heave

X y z
-0.011 -1.176 -0.243

The heave point was positioned
differently on each of the axes.
The distance for the longitundinal
axis was determined as
described in the "IMU to Heave"
tab in this workbook. The
athwart ships axis was the vessel
centerline. Lastly, the waterline
was used as the height of the
heave point, which was
calculated earlier in 'RP to
Waterline'.




1010 Vessel Diagram

All Values Shown are in Theodolite Coordinates

945 degree list <3
A
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Note: Both antenna have been replaced for the POS
V4. While their x-y values are not thought to have
changed, the z-value has been remeasured.
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FAIRWEATHER
Multibeam Echosounder Calibration

4/17/2009  ]107

Launch 1010

Vessel

|Lake Washington, Seattle, Washington

Date Dn Local Area

Rice, Beduhn, Forney, Marcum

Calibrating Hydrographer(s)

Reson 8101 Jswing Arm-Hull Mount

Jnot available

MBES System MBES System Location

2701011

Date of most recent EED/Factory Check

|35737

Sonar Serial Number

Swing Arm

Processing Unit Serial Number

|3/20/2009

Sonar Mounting Configuration

DGPS - Woodby Island

Date of current offset measurement/verification

J4/15/2009

Description of Positioning System

Acquisition Log

Date of most recent positioning system calibration

4/17/2009]107 |Lake Washington |5-10kt, >1ft
Date Dn Local Area Wx
J10m-80m

Bottom Type

Marcum, Rice, Forney, Beduhn

Approximate Water Depth

Personnel on board

Beacon: 302 Hz Whidbey, MBES lines 2009__1071850_1 through 2009__1072047_5, 24 lines collected

Comments

TH_1010_107

TrueHeave filename

09107175_4616.5nv Jo:00 J47/39/01.97 |122/16/17.32 |51 |

SV Cast #1 filename UTC Time Lat Lon Depth Ext. Depth
09107202.3nv Jo:00 |47/39/15.82 |122/15/31.53 |51 |

SV Cast #2 filename UTC Time Lat Lon Depth Ext. Depth
09107210.0nv Jo:00 J47/39108.84 |122/14/06.18 Jis Je0

SV Cast #3 filename UTC Time Lat Lon Depth Ext. Depth



view parallel to track, one line with induced roll (outerbeam) or same lines bounded slope (nadir)
NAV TIME LATENCY [same direction, different speed)]

SV Cast# |XTF Line Filename Heading Speed (kts) |Remarks
1]2009_1071923_1 271 5.4
1]2009_1071925_1 093 5.1
1]2009_1071927_1 272 5.0
1]2009_1071929 1 091 5.0
1]2009_1071914_1 272 2.9
1]2009_1071917_1 090 2.7
1]2009_1071931_1 272 2.5
PITCH view parallel to track, same line (at nadir) [opposite direction, same speed)]

SV Cast# |XTF Line Filename Heading Speed (kts) |Remarks
1]2009_1071850_1 272 4
1J2009_ 1071910_1 92 4
1]2009__1071905_1 93 4
1J2009__1071907_1 271 4
1]2009 1071903 1 270 4

HEADING/YAW view parallel to track, offset lines (outerbeams) [opposite direction, same speed]

SV Cast# |XTF Line Filename Heading Speed (kts) |Remarks
1[2009 1071945 _4 272 4]N
1]2009__1071938_4 272 4IN
1[2009 1071935 _4 94 4]N
1J2009_ 1071941 _4 93 4IN
1]2009_1071955_2 092 4]s
1J2009__ 1071959_2 272 41S
1]2009 1071949 2 092 4]s
1J2009__1071952_2 272 41S

ROLL view across track, same line [opposite direction, same speed]

SV Cast# |XTF Line Filename Heading Speed (kts) |Remarks
2]2009__1072043_5 04 3.8
2]2009__1072039_5 183 3.5
2]2009__1072047_5 184 3.5
2]2009__1072035_5 03 3.9




Processing Log

4/18/2009  |108 Jwelton
Date Dn Personnel

Data converted --> HDCS_Data in CARIS

TrueHeave applied

SVP applied

Tide applied

Zone file na

Lines merged

Data cleaned to remove gross fliers [ ]

Compute correctors in this order

1. Precise Timing 2. Pitch bias 3. Heading bias 4. Roll bias

Do not enter/apply correctors until all evaluations are complete and analyzed.

PATCH TEST RESULTS/CORRECTORS

Evaluators Latency (sec) Pitch (deg) Roll (deg) Yaw (deg)
FOO Ringel -0.05 0.20 1.50 0.50
B. Welton 0.02 -0.35 1.50 0.35
G. Rice 0.01 0.43 1.48 0.28
N.Morgan 0.06 1.48
A. Raymond 0.02 0.00 1.46 0.20
CST Morgan 0.00 -0.40 1.48 0.60
Averages 0.01 -0.02 1.48 0.39
Standard Deviation 0.04 0.36 0.04 0.02 0.16 0.08
FINAL VALUES 0.00 -0.02 1.48 0.39
Final Values based on averages with outliers removed

Resulting HVF File Name FA_1010_Reson8101_2009.hvf

Actual values used

MRU Align StdDev
MRU Align StdDev gyro 016 Value from standard deviation of Heading offset values 0.075 gyro

MRU Align StdDev
MRU Align StdDev Roll/Pitch 019 Value from averaged standard deviations of pitch and roll offset values 0.025 Roll/Pitch

NARRATIVE
Lines from Dn108 (2009_1081822_11 through 2009_1082211_2) were also utilized to assess patch test values.
Dn108 did not have True Heave applied as the Pos file was not logged, therefore a full patch write-up was not conducted.

Removed N. Morgan pitch (-1.6 deg) and yaw (1.62) values from the averages as outliers.

Initial MRU values were too high, TPU values reassessed with outliers removed.

HVF Hydrographic Vessel File created or updated with current offsets

Name: CST/FOO/Welton Date: 04/24/09




Ellipsoid Referenced Dynamic Dratft Launch 1010

4/17/2009 107 Lake Washington Rice
Date DN Local Area Processor
SEAI TH_1010_107.000.002 1018 ERDDM.txt
Primary Station POSPac File SBET File
proc_erddm.py, v0.12 4
Processing Method Coefficients
measurements
— best-fit pol
-18.50 . . : poty
—18.55}
__—18.60
E 1865}
S -18.70
2
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—18.85}
-18.90;;
@
® 015
E
g olor
2 0.05-
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% _U 15 Il Il 1 1 1 1
g 1 2 3 4 5 6
Speed (m/s)
1.24e-003*X® +-2.15e-002*X> +1.05e-001*X
Speed (m/s) Delta Draft (m)
0.00 0.00
0.50 -0.05
1.00 -0.07
1.50 -0.06
2.00 -0.03
2.50 -0.01
3.00 0.01
3.50 0.02
1.00 0.02
4.50 0.01
5.00 -0.05
5.50 -0.10
= 6.00 -0.17
2 oo0s . 650 . . i EL
o
g 0.00
G —0.05
2
- —0.10
E
i -0.15
S -0.20
] o 1 Il 1 1 1
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()]
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Dynamic Draft Comparison 2009-ERDDM-Descrete
2008
0.2 —— 2007
0.15 —e— 2006
0.1 vand~
A0.05
£
: 0 \ \ \ \ \
8 0 2 4 5 o 7 8
20.05 \/ > :
-0.1
-0.15
-0.2
Speed (m/s)
2009 HVF Values
|2009-ERDDM-Descrete |
speed (m/s)|draft (m)
0 0
0.5 -0.05
1 -0.07
1.5 -0.06
2 -0.03
2.5 -0.01
3 0.01
3.5 0.02
4 0.02
4.5 -0.01
5 -0.05
55 -0.1
6 -0.17
2008 2006
speed (m/s) |draft (m) speed (m/s) |draft speed (m/s) |draft
0 0 0 0 0 0
2.68 0.08 2.58 -0.041 2.385 -0.07
3.81 0.11 3.1 -0.031 3.205 -0.03
4.68 0.17 3.98 0.023 4.2 -0.02
5.92 0.08 4.6 0.053 5.065 -0.01
5.17 0.102 6.29 -0.03
5.37 0.089




NOAA POS/MV Calibration Report

Fill out all fields! See previous years as an example.

Yellow areas require screen grabs!

Ship: FAIRWEATHER Vessel: 1010
Date: 4/15/2009 Dn: 105
Personnel: W Renoud, L Morgan, T Beduhn
PCS Serial # 2564 IMU Serial # 294
IP Address: 129.100.1.231
Port Antenna Serial # 60162863 Stbd Antenna Serial # 60145247

POS controller Version (Use Menu Help > About)

POS Version (Use Menu View > Statistics)

GPS Receivers
Primary Receiver Serial #:

Secondary Receiver Serial #:

3.4.0.0

MV-320,VER4,S/N2564,HW2.6-7,SW03.42-May28/07,ICD03.25,
0S425B14,IMU2,PGPS13,SGPS13,RTK-0,THV-0,DPW-0

4624A70264

4622A68956

~POS Version

|MV—320.VER4.S!N2564.HW26—15W03.42—May28#0?.ICD03.25‘OS425E3'I4.IMUZPGF’SW 3,5GPS13 RTK-0,THY-0,DPYW-0

~GPS Receivers
Primary Receiver

Secondary Receiver

|BD950 SN:4624A70264, v.00211, channels:24

|BD950 SN:4622A68956, v.00211, channels:24

~Statistics
Total Hours 1315.0
Total Runs 275
Average Run (hours) 4.8
Longest Run (hours) 41.0
Current Run (hours) 4.2

Calibration area
Location: Lake Washington, N of Sandpoint

Approximate Position:

DGPS Beacon Station: Whidbey

Frequency: 302HZ

Lat
Lon

Close
47 43 41
122 16 30

DGPS Receiver Serial#: 0331-12579-0008




Satellite Constellation

(Use View> GPS Data)

Primary GPS Secondary GPS
Insert screen grabs Note any differences from Primary GPS Receiver
L L
Recaiver Status & Frimary GFS Rcaiver Stats
Madde 3D CIA mode. Moda 3-D CIA mode
HDOP 0829 e HDOP 08E1
VDOF 1481 VDOF 1212
Geoidal Separation (m) AT2N 12 e Gecidal Separation (m) 7231
Tirming L] ié ? Tirming
GPSILITC Wk Nurnber 1627 3 - GPSIUTC Weak Number 1827
GPS Time Offsat (se<) 16.000 & 1.3 GPS Time Offsat (sec) 15.000
Mav Message Latency (sec) 0116 w MNav Massage Latenty (sec) oors
Duffiarential GRS Dufferential GRS
Raoference Station LY Reference Stabon MIA
Comaction Latency (sec) 0.000 Comaction Latency (sec) 0.000
PPS
Tirrwe 17:06:36.000000 UTC
Fulse Count 3242 r-
3 [ a 14 18 19 21 22 24 26 sV 3 8 9 14 5 18 19 21 22 24
LiphikeLiphicLiphicLiphicLiphikcLiphikcLliphicliphikcLiphicLiphicLiphic | Siitus fLiphicLiphicLiphicliphicLiphicLiphicLiphicLiphicllphicllphic
2890 2730 1020 1850 540 3150 1080 2450 1080 500 QIAth| 289 0 2720 1020 1850 450 40 3150 1060 2450 1080
43 0 520 80 160 820 220 520 640 100 320 160 230 820 20 520 64.0 10.0
47 & 48 w0 s 470 455 463 E30 TS5 450 400 418 493 428 473 503 385
360 85 183 25 05 45 65 420 175 A0 00 00 00 00 00 00 00
s | |
PDOP 1.736 (Use View> GAMS Solution)

POS/MV Configuration

Settings

Gams Parameter Setup

Configuration Notes:

GAMS Parameter Setup

(Use Settings > Installation > GAMS Intallation)

x|

Two Antenna Separation [m]

Heading Carection [deg)

Heading Calibration Threshold (deal

=7

[ Baseline Vector

# Camponent [m)
% Companent [m)

Z Camponent [m)

| Apply |




POS/MV Calibration

Calibration Procedure: (Refer to POS MV V4 Installation and Operation Guide, 4-25)
Start time:

End time:

Heading accuracy achieved for calibration: 0.091°

Calibration Results:

Gams Parameter Setup (Use Settings > Installation > GAMS Intallation)
n l
5
Twio Antenna Separation (m) IT 833
Heading Calibration Threshald [deg] IEI 300
Heading Corection [deg] ID 000
[ Baseline Yector
# Companent [m] IEI 0o
Y Companent [m] IT 838
Z Camponent [m] IU 037
= Ok | Claze I Apply | Wiew |
GAMS Status Online X
Save Settings X

Calibration Notes:

Save POS Settings on PC (Use File > Store POS Settings on PC)
File Name: 1010_Dn105_POS_Config_new.nvm

General Notes:
The POS/MV uses a Right-Hand Orthogonal Reference System
The right-hand orthogonal system defines the following:

* The x-axis is in the fore-aft direction in the appropriate reference frame.
* The y-axis is perpendicular to the x-axis and points towards the

right (starboard) side in the appropriate reference frame.
» The z-axis points downwards in the appropriate reference frame.

The POS/MV uses a Tate-Bryant Rotation Sequence

Apply the rotation in the following order to bring the two frames of reference
into complete alignment:

a) Heading rotation - apply a right-hand screw rotation 6z about the
z-axis to align one frame with the other.

b) Pitch rotation - apply a right-hand screw rotation 8y about the
once-rotated y-axis to align one frame with the other.

c) Roll rotation - apply a right-hand screw rotation 6x about the
twice-rotated x-axis to align one frame with the other.




SETTINGS
Input/Output Ports
CcoMm1

com2

COoM3

COom4

COMS5

(Use Settings > Input/Output Ports)




SETTINGS Continued

Heave Filter (Use Settings > Heave)
Heave Filter k x|

Heave Bandwidth (sec) (20.000
Damping Ratio 0.707

=l Ok I Close | Apply |

Events (Use Settings > Events)

x|

I

—Event 1 Ly

i Positive Edge Trigger

" Negative Edge Trigger

—Event

+ Positive Edge Trigger

" MNegative Edge Trigger

Close | Apply |

Time Sync (Use Settings > Time Sync)

|:| User Time Conversion (Units/Sec.)

INSTALLATION (Use Settings > Installation)
Lever Arms and Mounting Angles (Use Settings > Installation > Lever Arms and Offsets)
|
Lever Arms & Mounting Angles I Sensor Mounting I Tags, Multipath & AutnStanl
—Ref. to MU Lever Arm———— IMU Frame w.rt. Ref. Frame—————
A |0.000 # (deg) 0.000
Y [oooo ¥ (deg) 0,000
Ziml oo 7 (ded) oo

—Ref. to Primary GPS Lever Arm- ~Ref. to Vessel Lever Arm

Xfm) 1199 X {rn) 0.000
W) |0897 ¥ (m) 0,000
Zm [3117 Z (m pooo
Motes: —Ref. to Centre of Rotation Lever Arm—
; Ref = R\‘a’:’f:a;;e;ce T % () 1176
wert ="With Respect To .
3. Reference Frame and Yessel ¥ {m) 001
Frame are co-aligned Zi{m) -0.243

Aoply Wiew

In Mavigation Mode . to change parameters go to Standby Mode !

Tags, Multipath and Auto Start (Use Settings > Installation > Tags, Multipath and Auto Start)
x|
Lever Arms & Mounting Angles | Sensar Mounting  Tags, Mulipath & AutoStart I
—Time Tag 1 Multipath
 POS Time Loy
" GPS Time ! Iediurm S
@ UTC Time = High
Time Tag 2
@ POS Time
© GPE Time
© UTC Time
" User Time
—AutoStart
© Disabled
& Enabled
= [k Aoply Wiew

In Mavigation Mode . to change parameters go to Standby Mode !




Sensor Mounting (Use Settings > Installation > Sensor Mounting)

Lever Arms & Mounting Angles x|
Lever Arms & Mounting Angles  Sensor Mounting |Tag5, Multipath & AutnStanl

Ref. to Aux. 2 GPS Lever Arm

Ref. to Aux. 1 GPS Lever Arm—

Wim)  |0.000 % frmi) 0.000
¥ {m) |0.000 ¥ {m) 0.000
Z(m) o000 Z(m) 0.000

Ref. to Sensor 1 Lever Arm —Sensor 1 Frame w.rt. Ref Frame

®{m)  |0.000 ® (deg) i0.000
¥ () |0.000 T (deg) i0.000
Zm  [oooo Z (i) o.000
Ref. to Sensor 2 Lever Arm Sensor 2 Frame wert. Ref. Frame
i) |0.000 X (deg) 0.000
¥  |0.000 W {deg) 0.000
Zim)  [o'ooo Z (deg) 0000
= [k Aoply Wiew

In Mavigation Mode . to change parameters go to Standby Mode !

User Parameter Accuracy (Use Settings > Installation > User Accuracy)

B
RMS Accuracy
Attitude (deg) i0.050
Heading (deg)  |0.050
Pasition () 2.000
“elocity (m/s) IEI.SDD
Close | Apply |
Frame Control (Use Tools > Config)
User Frame Primary GPS Measurement
IMU Frame Auxiliary GPS Measurement

|:|Use GAMS enabled

GPS Receiver Configuration (Use Settings> Installation> GPS Receiver Configuration)

Primary GPS Receiver

Secondary GPS Receiver

i
Primary GPS Receivar |Secundary GPS Hecewerl
—Primary GPS———— GPS 1 Port
GPS Output Rate Baud Rate
1 Hz =] | fesno |
Parity Data Bits Stop Bits
9 (e C 7Bits | | & 16t
rAuta Configuration  Even
& Enabled  Odd 1+ 8 Bits 2 Bits
" Disablad
ak | Apply |
x
Primary GPS Receiver Secondary GPS Receiver |
Secondary GPS 5PS 2 Port
GPS Output Rate Baud Rate
1 Hz =l | fesno =
Parity Data Bits Stop Bits:
& Mone C 7Bits | | & 1Bit
Auto Configuration " Even
@@ Enabled ~ Odd = 8 Bits 2 Bits
© Disabled
Ok Apply
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Measure 1
Measure 2
Measure 3
Avg (cm)
Avg (m)
Stdev

BM Z-value (m)
BM C to WL (m)

Individual
measurement

Waterline Measurements
Measuring Party: Rice, Argento, Campbell, Beduhn
Waterline measurements should be negative!

1018
Benchmark A to Waterline Benchmark B to Waterline
-80.8 -81.0
-81.3 -82.1
-81.1 -81.9
-81.07 -81.67
-0.8107 -0.8167
0.00252 0.00586
0.29933 0.27567
-0.511 -0.541

StDev for TPU xlIs || 0.016742

(of 6 #'s)

Measure 1
Measure 2
Measure 3
Avg (cm)
Avg (m)
Stdev

BM Z-value (m)
BM C to WL (m)

Individual
measurement
StDev for TPU xls
(of 6 #'s)

-0.50867
-0.51367
-0.51167

Measuring Party: Raymond, Welton

-0.53433
-0.54533
-0.54333

1018
Benchmark A to Waterline Benchmark B to Waterline
-82.4 -82.2
-82.3 -82.2
-82.0 -81.1
-82.23 -81.83
-0.8223 -0.8183
0.00208 0.00635
0.29933 0.27567
-0.523 -0.543

0.011572

-0.52467
-0.52367
-0.52067

-0.54633
-0.54633
-0.53533

Fill in Yellow squares only!

Date: 4/7/2009
Fuel Level: 0.75
Draft Tube:

Port-to-Stbd Z-difference
Theoretical Actual Error

0.0237 -0.0060  -0.0297

BM C to WL Average (m)

|| -0.526(|(Add this value to 1018_Offsets & Measurements_200X.xls)

|[utilized in Offsets and Measurements and TPU spreadsheet I

Date: 4/16/2009
Fuel Level: half full
Draft Tube: na

Port-to-Stbd Z-difference
Theoretical Actual Error

0.0237 0.0040 -0.0197

BM C to WL Average (m)
-0.533 (or add this value to 1018_Offsets & Measurements_2008)




centers of the new POS M/V antenna.

This spreadsheet is designed to compute the z-values of the phase

All offsets are in the Theodolite Coordinate System

BME x 1.825761
y -0.861405
z 2.018667

BM F X 1.826865
y -0.002043
z 2.054333

BM G x 1.828354
y 0.918931
z 1.998333

Measuring Party (fill in yellow spaces only):

Rice, Argento, Campbell, Beduhn

Distances

Port Ant to BM 'E' 0.652
Port Ant to BM 'F' 1.109
Port Ant to BM 'G' 1.941
Stbd Ant to BM 'E' 1.884
Stbd Ant to BM 'F' 1.111
Stbd Ant to BM 'G' 0.648
Antenna Post Diameter

0.0255

0.652
111
1.945

1.882
1.112
0.647

Radius
0.01275

0.653
1111
1.943

1.889
1.113
0.647

POS MV V4 Installation and Operation Guide

Drawings

Port Ant  x  2.445325
y -0.913449 Phase Centra ssrem
z  Unknown
Y
Stbd Ant  x  2.444676 N "T"‘ \
y 0.920569 (’f +1“-*\! . ! \J
z Unknown T EIIIL f /
Y A 2
460 CM \\‘_\_'__/

Figure 79: GPS Antenna Footprint

Date: Serial #- Port Serial #- Stbd |
4/7/2009 60145158 60130644
z-Values
Ant. Base Phase Center
0.665083 2.254818 2.300818
1.12275 2.272081 2.318081
1.95575 2.292759 2.338759
2.263449 2.309449 AVERAGE
0.019 STDEV
1.89775 2.225956 2.271956
1.12475 2.233664 2.279664
0.660083 2.234669 2.280669
2.234166 2.280166 AVERAGE
0.005 STDEV

then added.

The distances from the antenna post to each benchmark was measured
three times and averaged. The post offset to phase center (radius) was

The distance is 0.046m (4.60cm) from the bottom of
the antenna to the Phase center, obtained from the
POSM/V v4 guide, see image above.




Offsets from Aft Benchmark to Phase Center of Transducer

3/20/2009 |79 |Iaunch 1018 |Campbell, Argento, Rice, Beduhn

Date DN Vessel Personnel
3102026

Serial Number of Transducer

Instructions: The purpose of this measurement is to check for
gross movement of the tranducer. Fill in yellow spaces only.

While the boat is in the cradle, gently lower the transducer and
lock it in place. Using a metric tape measure, plumb bob and
carpenter's level, measure the horizontal and vertical offsets from
the aft benchmark (BM H) to the phase center of the transducer.
The phase center is measured at the forward edge of the black
insulating layer, as shown in the photos. If you have trouble
locating the center, borrow a compass from the navigation
department.

Notwithstanding a major accident, BM H will be outboard, aft and
higher than the phase center; as such, enter all offsets as positive
numbers (in cm) and the proper signs will be applied.

Once offsets have been measured, apply a digital level to the IMU
to determine any pitch or roll bias in the orientation of the launch.

For the purposes of this spreadsheet, a positive angle (measured
in degrees) will imply the bow is higher than the stern and the port
side is higher than the starboard side.

All measurements should be done in triplicate to aid in the
calculation of the uncertainty (needed in the HVF). The IMU to
Phase Center values will be calculated automatically.

Offset Measurements (positive cm): Average

Bow-Stern 8.7 8.7 8.8 8.7
Port-Stbd 15.9 15.9 15.8 15.9
Up-Down 35.5 35.4 36.0 35.6

BM H to Phase Center

Angle Bias (deg): Std Dev:

Bow Up Bow-Stern 0.06
Port Up Port-Stbd 0.06
The measuring crew should Up-Down 0.32

insure there will be no yaw bias.

(Theodolite Coordinate System) (CARIS Coordinate System)
X 8.733 cm X 0.287 m
y -15.867 cm y -0.156 m
z_ -35.633 cm z 0.546 m
Measured by NOAA Personnel Calculated Value for check purposes
inserted into Offset Worksheet, * see Math Explanation tab

if to be used in IMU to 8101 calculation

These 2009 values were not used for the hvf
offsets due to the angle bias not being
entered. The 2008 values were used instead
and the 2009 values were used as a check
that the unit had not been displaced.



Offsets from Aft Benchmark to Phase Center of Transducer

4/29/2009 |119 |Iaunch 1018 |Argento, Andrews, Foster, Nuckols

Date DN Vessel Personnel
4400007

Serial Number of Transducer

Instructions: The purpose of this measurement is to check for
gross movement of the tranducer. Fill in yellow spaces only.

While the boat is in the cradle, connect the 8125 sled with the
sonar head attached. Using a metric tape measure, plumb bob
and carpenter's level, measure the horizontal and vertical offsets
from the aft benchmark (BM H) to the phase center of the
transducer. The phase center is measured at the center middle of
the black insulating layer below the flat faced transducer, as
shown in the photos. If you have trouble locating the center,
borrow a compass from the navigation department.

Notwithstanding a major accident, BM H will be outboard, aft and
higher than the phase center; as such, enter all offsets as positive
numbers (in cm) and the proper signs will be applied.

Once offsets have been measured, apply a digital level to the IMU
to determine any pitch or roll bias in the orientation of the launch.

For the purposes of this spreadsheet, a positive angle (measured
in degrees) will imply the bow is higher than the stern and the port
side is higher than the starboard side.

All measurements should be done in triplicate to aid in the
calculation of the uncertainty (needed in the HVF). The IMU to
Phase Center values will be calculated automatically.

Offset Measurements (positive cm): Average

Bow-Stern 123.2 122.0 122.4 122.5
Port-Stbd 84.2 84.4 84.1 84.2
Up-Down 55.7 56.2 56.5 56.1

BM H to Phase Center
(Theodolite Coordinate System)

x| 122,533 cm
y._ -84.233 cm
z  -56.133 cm

X

y

z

Figurs 3 - Transducer array outline dimensions

Angle Bias (deg):
Bow Up -0.5
Port Up -2.0

The measuring crew should
insure there will be no yaw bias.

(CARIS Coordinate System)

-0.396 m
0.982 m
0.751 m

Measured by NOAA Personnel
inserted into Offset Worksheet,

Calculated Value for check purposes
* see Math Explanation tab

if to be used in IMU to 8101 calculation

Std Dev:

Bow-Stern 0.61
Port-Sthd 0.15
Up-Down 0.40




Measurement Port Ant to 8125 Port Ant to Sthd Ant IMU to Port Ant
aka Nav to Trans x,y,z

Coord. Sys. Caris Caris Caris

X -0.396 0.502 n/a Scaler Distance 1.834 -0.898

y 0.982 2.082 n/a -1.101

z 0.751 3.919 -0.333 -3.161

-1.101
-0.898
-3.161

Caris

0.015]
-1.114

-0.336

-1.114
0.015
-0.336

Vessel Offsets Horizontal Vertical & XYZ worksheets in this spreadsheet. 2009 Measured Value
Calculations
Coord. Sys. Port Ant to 8125
Theodolite  IMU (m) X 3.54587 IMU (m) x 3.545867
y -0.01516 y -0.01516
z -0.85883 z -0.85883
BMH X 3.30204 Port Ant (m) X 2.445
y 0.43081 y  -0.913
z -1.0485 z 2.309
IMU x  -0.244 IMU to x  -1.101
toBMH y 0.446 Port Antenna y -0.898
z -0.190 z 3.168
BM H to x 122.533 IMU to X 0.982
Phase Ctr (cm) y -84.216 Phase Ctr y -0.396
measured z -56.133 z -0.751
BM H to X 1.225
Phase Ctr (m) vy -0.842
z -0.561
Coord. Sys. Port Ant to 8125
Theodolite  IMU to X 0.982 X 2.082
Phase Ctr y -0.396 y 0.502
z -0.751 z  -3.919
Coord. Sys. Coord. Sys.
x| -0.396 X 0.502
y| 0.982 y 2.082
z 0.751 z 3.919




Description of Offsets for Launch 1018
All Values Shown are in CARIS Coordinates
The Ship Reference Frame (SRF) for Launch 1018 was based from benchmark (BM) C as the 0 point. Physical locations were measured with x,y,z offsets from this point. These locations

were used to calculate offsets of items with respect to each other, as described for each offset.
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X y z
0.282] -0.145]  0.548|

X y z
-0.396]  0.982] 0.751]

The physical positions of the IMU
and the phase center of the 8101
with respect to the Ship
Reference Frame were
measured by NOAA personnel.
These physical measurements
were used to calculate the xyz
offsets from the IMU to BM H.
Measurements from BM H to the
Phase Center of the 8101 were
collected by NOAA personnel
while the boat was secured on
the pier and thought to be as
level as possible. The measured
offsets from BM H to the phase
center were then added to the
offset from the IMU to BM H.
The result is the offset from the
IMU to the phase center of the
transducer. The values in the X
and Y fields are transposed and
the inverse of the Z value is used
to give the offsets in CARIS
coordinates.

| Port Ant to 8101 |
X y z
1.181 0.955 3.717

X y z
0.502 2.082 3.919

NOAA personnel calculated the
distance between the port
antenna and the phase center of
the port antenna subtracting the
IMU to Port Antenna value from
the IMU to Phase Center value.

X

| vy | z
N/A| N/A|  -0.333]

The average vertical distance
from BM A and B to the waterline
was measured by
FAIRWEATHER personnel using
a steel tape and bubble level.
These values were used to
calculate the BM C to the
waterline value. With the
knowledge of the BM C height
above the IMU, the waterline
height above the IMU could be
calculated. On launch 1018, the
IMU is used as the reference
point.

Port Ant to Sthd Ant

Scalar Distance
1.834

The location of the phase center
of the port and starboard
POS/MV antennas were
measured by NOAA personnel
with respect to the SRF. The
scalar distance between the
phase centers was then
calculated.

IMU to Port Antenna
y

IMU to Heave
X y

X Y4
[ -0.898] -1.101] -3.161]

Y4
[ 0015 -1.114] -0.336|

The location of the IMU and the
location of the port antenna were
measured by NOAA personnel
with respect to the Ship
Reference Frame (SRF). The
xyz offsets from the IMU to the
port antenna could be calculated
from these physical locations.

The heave point was positioned
differently on each of the axes.
The distance for the longitundinal
axis was determined as
described in the "IMU to Heave"
tab in this workbook. The
athwart ships axis was the vessel
centerline. Lastly, the waterline
was used as the height of the
heave point, which was
calculated earlier in 'RP to
Waterline'.




1018 Vessel Diagram

All Values Shown are in Theodolite Coordinates
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FAIRWEATHER
Multibeam Echosounder Calibration

4/16/2009]106 JL. washington

Launch 1018

Vessel

Date Dn Local Area

FOO Ringel, CST Morgan, LT Welton, ENS Morgan

Calibrating Hydrographer(s)

8101 Jio18 Jnot available
MBES System MBES System Location Date of most recent EED/Factory Check
3102026 |34497

Sonar Serial Number

JHull mounted swing arm

Processing Unit Serial Number

J03/20/2009

Sonar Mounting Configuration

POSMV v4 GPS (DGPS corrected)

Date of current offset measurement/verification

Jo4/15/2009

Description of Positioning System

Acquisition Log

Date of most recent positioning system calibration

4/16/2009]106 JL. washington Jcalim
Date Dn Local Area Wx
|30-190 feet

Bottom Type

Welton, ENS Morgan, Raymond, Heiner

Approximate Water Depth

Personnel on board

Comments

TH_1018_Patch_Test_Dn105

TrueHeave filename

081060818 Jo:00 | | | |
SV Cast #1 filename UTC Time Lat Lon Depth Ext. Depth
SV Cast #2 filename UTC Time Lat Lon Depth Ext. Depth



ROLL

SV Cast# |XTF Line Filename |Heading  |Speed (kts) |Remarks
005_1832.81X 3 5.9 roll
005_1838.81X 183 6.0]roll
005_1844.81X 03 6.0]roll

PITCH

SV Cast# |XTF Line Filename Heading Speed (kts) |Remarks
001_1730.81X 274 51
001_1741.81X 092 5.1
002_1751.81X 272 5.2
002_1801.81X 092 5.1

HEADING/YAW

SV Cast# |XTF Line Filename Heading Speed (kts) |Remarks
91060818]001_1730.81X 274 5.1]Heading
001_1741.81X 092 5.1|Heading
002_1751.81X 272 5.2]Heading
002_1801.81X 092 5.1|Heading (1805 overtaking boat noise)

NAV TIME LATENCY

SV Cast# |XTF Line Filename Heading Speed (kts) |Remarks
001_1811.81X 272 4.8]timing
001_1823.81X 092 8.0]timing
001_1741.81X 092 5.1|Heading

Processing Log

4/16/2009  |DN106 JENS Morgan

Date Dn Personnel
Data converted --> HDCS_Data in CARIS

TrueHeave applied yes

SVP applied yes

Tide applied  zerotide.tid

Zone file na

Lines merged

Data cleaned to remove gross fliers

Compute correctors in this order

1. Precise Timing 2. Pitch bias 3. Heading bias 4. Roll bias

Do not enter/apply correctors until all evaluations are complete and analyzed.




PATCH TEST RESULTS/CORRECTORS

Evaluators Latency (sec) Pitch (deg) Roll (deg) Yaw (deg)
FOO (in progress) -0.05 -0.80 2.88 -0.40
CST 0.00 0.30 2.86 -0.50
Nick 0.03 -0.94 2.86 -0.35
Bri -0.03 -1.06 2.90 -0.10
Averages -0.01 -0.63 2.88 -0.34
Standard Deviation 0.04 0.63 0.13 0.02 0.17 0.04
FINAL VALUES 0.00 -0.63 2.88 -0.34
Final Values based on CST/FOO Averages Averages Averages

Resulting HVF File Name FA_1018_Reson8101_2009

Actual values used

MRU Align StdDev

MRU Align StdDev gyro 017 Value from standard deviation of Heading offset values 0.035 gyro
MRU Align
MRU Align StdDev Roll/Pitch 0.32 Value from averaged standard deviations of pitch and roll offset values 0.075 StdDev Roll/Pitch

NARRATIVE
Values based on two patch tests- one performed on DN106 in Lake Washington using the bounded slope method and one
performed on DN1070n the Shilshole reference surface using the target method.

Initial MRU values were too high, TPU values reassessed with outliers removed.

HVF Hydrographic Vessel File created or updated with current offsets

Name: Ringel, Welton, Morgan Date: 4/18/09




FAIRWEATHER

Multibeam Echosounder Calibration Launch 1018

6/27/2009]178

Vessel

|Shumagin Islands, Near Northeast Harbor

Date Dn Local Area

Welton, FOO Ringel, CST Morgan

Calibrating Hydrographer(s)

8125 Ji018 Juknown (on loan from RUDE)

MBES System MBES System Location Date of most recent EED/Factory Check

4400007

|31562

Sonar Serial Number

Sled hull mount

Processing Unit Serial Number

|4/29/2009

Sonar Mounting Configuration

POSMV w/ DGPS correctors

Date of current offset measurement/verification

|4/15/2009

Description of Positioning System

Acquisition Log

6/27/2009]178

Date of most recent positioning system calibration

|Shumagin Islands, Near Northeast Harbor |Wind Igt vrb, waves <1ft (Awesome)

Date Dn

rock

Local Area WX

|20-30 meters

Bottom Type

Froelich, Francksen, Walker

Approximate Water Depth

Personnel on board

Comments

2009-178_1018.000

TrueHeave filename

SV Cast #1 filename

UTC Time Lat Lon Depth Ext. Depth

SV Cast #2 filename

UTC Time Lat Lon Depth Ext. Depth



view parallel to track, one line with induced roll (outerbeam) or same lines over bounded slope or

NAV TIME LATENCY feature (nadir) [run same direction, different speed]
SV Cast # Line Filename Heading Speed (kts) |Remarks
H12702_1018_Dn12009L_1781804 022 6.0]roll time bias method

PITCH view parallel to track, same line (nadir) over feature or bounded slope [opposite direction, same speed]
SV Cast # Line Filename Heading Speed (kts) |Remarks
H12702_1018_Dn]2009L_1781750 110 6.0

2009L_1781753 290 6.0

HEADING/YAW

view parallel to track, offset lines from feature

or slope (outerbeams) [opposite direction, same speed]

SV Cast # Line Filename Heading Speed (kts) |Remarks

2009L_1781756 110 6.0

2009L_1781800 290 6.0
ROLL view across track, same line over flat area in [opposite direction, same speed]
SV Cast # Line Filename Heading Speed (kts) |Remarks
H12702_1018_Dn]2009L_1781750 110 6.0

2009L_1781753 290 6.0




Processing Log

6/27/2009 J178 |
Date Dn Personnel
Data converted --> HDCS_Data in CARIS
| TrueHeave applied
SVP applied Previous in Time
Tide applied

Zone file predicted- Sand Point, AK

Lines merged

Data cleaned to remove gross fliers

Compute correctors in this order

1. Precise Timing 2. Pitch bias 3. Heading bias 4. Roll bias
Do not enter/apply correctors until all evaluations are complete and analyzed.
PATCH TEST RESULTS/CORRECTORS
Evaluators Latency (sec) Pitch (deg) Roll (deg) Yaw (deg)

Welton 0.00 -0.90 -1.98 -2.20
FOO 0.00 -0.30 -1.95 -1.70
CST 0.00 -0.40 -1.91 -1.50
Averages 0.00 -0.53 -1.95 -1.80
Standard Deviation 0.00 0.32 0.04 0.36
FINAL VALUES 0.00 -0.53 -1.95 -1.80

Final Values based on Averages

Resulting HVF File Name added to FA 1018 Reson8125 2009

MRU Align StdDev gyro
MRU Align StdDev Roll/Pitch

0.36
0.18

Value from standard deviation of Heading offset values
Value from averaged standard deviations of pitch and roll offset values



Ellipsoid Referenced Dynamic Draft

Launch 1018

4/16/2009 106 Lake Washington Rice
Date DN Local Area Processor
SEAI TH_1018 patch_test dn105.000.002 1018 _ERDDM.txt
Primary Station POSPac File SBET File
proc_erddm.py, v0.12 4
Processing Method Coefficients
measurements
-18.55 : : . — bestHit poly
—18.60 - 8
—~ —18.65
£
% —18.70
o
2 -18.75
< _18.80
-18.85
—18.90
T
% 0.15
£
2 010
L
<  0.05
<)
E 0.00
7 —0.05
m
£ 010
T -0.15} .
E —-0.20 L L I L I
é 0 1 2 3 4 5 6
Speed (m/s)
-3.50e-003*X° +3.31e-002*Xx2 +.1.04e-001*X
Speed [(mM/s] Delta Draft (m)
0.00 0.00
0.50 0.05
1.00 0.06
1.50 0.07
2.00 0.07
2.50 0.07
3.00 0.09
3.50 0.10
4.00 0.10
4.50 0.07
=) 5.00 -0.00
= 5.50 -0.15
[=] T T
=)
2 oo0s} -
g 0.00 1
E -0.05} .
=
® —0.10} 1
a
T s 1 L 1 L 1
£ %1% 1 2 3 4 5 6
(=]

Speed (m/s)



Dynamic Draft Comparison

—e— 2009-ERDDM-Descrete

0.25 2009 Bottom Referenced
4 | —m-2008
0.15 / 2007
0.1 7/"-* — 2006
E | — ~
< 0.05 \
J i
= 0 1 \ é
-0.05 @ \ &
-0.1 \
-0.15 *
-0.2
Speed (Mm/s)
2009 HVF Values
2009-ERDDM-Descrete 2009 Bottom Referenced
speed (m/s) |draft (m) speed (m/s) |draft (m)
0 0 0 0
0.5 0.05 2.52 0.062
1 0.06 3.07 0.088
15 0.07 3.66 0.131
2 0.07 4.06 0.149
25 0.07 4.47 0.152
3 0.09
3.5 0.1
4 0.1
4.5 0.07
5 0
5.5 -0.15
2008 2007 2006
speed (m/s) |draft (m) speed (m/s) |draft (m) speed (m/s) |draft (m)
0 0 0 0 0 0
3.09 0.09 2.58 0.039 25 0.109
4.12 0.18 3.1 0.061 3 0.079
5.14 0.19 3.82 0.11 4 0.135
6.17 0.21 4.24 0.151 5.1 0.19
4.81 0.133 6 0.01
5.32 0.074




NOAA POS/MV Calibration Report

Fill out all fields! See previous years as an example. Yellow areas require screen grabs!

Ship: FAIRWEATHER Vessel: 1018
Date: 4/15/2009 Dn: 104

Personnel: Andrews, Welton, Forney, Shetler

PCS Serial # 2560 IMU Serial #

007
IP Address: 129.100.1.231
Port Antenna Serial # 60145158 Stbd Antenna Serial # 60130644

POS controller Version (Use Menu Help > About) 3.4.0.0
POS Version (Use Menu View > Statistics) MV-320,Ver 4
GPS Receivers

Primary Receiver Serial #: 4624A70243

Secondary Receiver Serial #: 4624A70263

POS Version
Mv-320 VERS, S/NZE60 HWW2 B-7, SW03 42-May26/07 |C003.25, 05425014 [MU2 PGPS13 SGPS13 RTH-0,THY-0 DFW-0

GRS Receivers
Primary Receiver I
BOY950 SN:4624A470243,v.00211, channels; 24

Secondary Receiver
BD950  SN:4624AT70263, v.00211, channels: 24

Statistics

Total Hours 1383.5
Total Runs 300
Average Run (hours) 46
Longest Run (hours) 93.0
Current Run (hours) 08

Calibration area
Location: Lake Washington, Seattle, WA

Approximate Position: Lat 47 39 35.8
Lon 122 15 35.6
DGPS Beacon Station: Whidbey Island DGPS Receiver Serial#: 0328-12352-0001

Frequency: 302



Satellite Constellation (Use View> GPS Data)

Primary GPS Secondary GPS

PDOP 1.823 (Use View> GAMS Solution)

POS/MV Configuration

Settings
Gams Parameter Setup (Use Settings > Installation > GAMS Intallation)
GAMS Parameter Setup gl
Two &ntenna Separation [m) 1-831
Heading Calibration Thieshold (deg) 0500
Heading Carrection [deg] 0000
Bascling Vector
* Companent (m) 0,004
¥ Companent (m) 1.831
Z Component (m) 0.028
[ a ] e | s | v |

Configuration Notes:

POS/MV Calibration

Calibration Procedure: (Refer to POS MV V4 Installation and Operation Guide, 4-25)

Start time: 1722 UTC
End time: 1723 UTC
Heading accuracy achieved for calibration: 0.324

Calibration Results:

Gams Parameter Setup (Use Settings > Installation > GAMS Intallation)

Two Antenna Separation [m] 1.632
Heading Calibration Threshold (deg) 0.500
Heading Canection [deg) 0.000
Baseline Vector

% Component (] 006
v Component (m] 1.631
Z Component (m) 0.026

& [ h ] Close ‘ dpply | view |

GAMS Status Online Ready Online
Save Settings Yes

Calibration Notes:

Save POS Settings on PC (Use File > Store POS Settings on PC)
File Name: C:\Documents and Settings\1018acq\Desktop\POS-MV Settings\GAMS_Parameter_104_2009.nvm




General Notes:

The POS/MV uses a Right-Hand Orthogonal Reference System
The right-hand orthogonal system defines the following:
« The x-axis is in the fore-aft direction in the appropriate reference frame.
« The y-axis is perpendicular to the x-axis and points towards the
right (starboard) side in the appropriate reference frame.
* The z-axis points downwards in the appropriate reference frame.

The POS/MV uses a Tate-Bryant Rotation Sequence

Apply the rotation in the following order to bring the two frames of reference
into complete alignment:

a) Heading rotation - apply a right-hand screw rotation 8z about the
z-axis to align one frame with the other.

b) Pitch rotation - apply a right-hand screw rotation 8y about the
once-rotated y-axis to align one frame with the other.

c) Roll rotation - apply a right-hand screw rotation 8x about the
twice-rotated x-axis to align one frame with the other.




SETTINGS
Input/Output Ports
COM1

Ccom2

CcOomM3

(Use Settings > Input/Output Ports)

Input/Output Poris Set-up

com1 |comz | com3 | comd | coms |

Parity Data Bits ~Stop Bits- -Flow Contral
Baud Rate & None = & None
EEn] = 7 Bits & 1 Bit
" Even " Hardware
© Odd 8 Bits ¢ 2Bits £ XOM/KOFF
MMWEA Output
Output Select £ Undate R Ruoll Positive Sense
I $INGST e | pdate Rate * Port Up " Starboard Up
S L FINGGA THz =
~ §INHDT Pitch Positive Sense
§INZDA = & Bow Up " Starn Up
Talker ID
FINVTG m Heave Positive Sense
EPASHR . w @ Heave Up " Heawe Down
Input Select
Mone 52
Ciose | Aoty |
Inp itput Ports Set-up R
comi [COMZ | com3 | com4 | coms |
Parity Data Bits ~Stop Bits- -Flow Contral
Baud Rate & Maone - 7 Bit & 1 Bit & Mong
T i ‘
" Even " Hardware
© Odd 8 Bits ¢ 2Bits £ XOM/KOFF
Binary Output
Output Select ) j : FE— Roll Positive Sense
it it .
’m ESEHE Eii2 = & Sensorl * Port Up " Starboard Up
= ] F Sensor? Pitch Positive Sense
& Bow Up " Starn Up
Farmula Select = e
pave Pogitive Sense
|TSSW j @ Heave Up " Heawe Down
Input Select
Mone 52
Close | Apply J
Inp itput Ports Set-up
comi | comz [COME | comd | coms |
Parity Data Bits ~Stop Bits- -Flow Contral
Baud Rate & Maone - 7 Bit & 1 Bit & Mong
EET i ‘
" Even " Hardware
© Odd 8 Bits ¢ 2Bits £ XOM/KOFF

Output Select

Mone o

Input Select

Base 1 GPS  ~

Base GPS Input

Input Type |RTCM 1 or 9 =
Line i
& Serial ¢ Modem o Adlily)

Close | Apply




SETTINGS Continued
Heave Filter

Heave Filter

(Use Settings > Heave)

Heave Bandwidth (sec) [20000

Damping Ratio

| ok]

Close I

0.707

Apply J

Events
Events
“Event 1
& Puositive Edge Trigger

© Negative Edge Trigger
~Event 2

@ Positive Edge Trigger
© Negative Edge Trigger

Close |

(Use Settings > Events)

%]

Apply I

INSTALLATION

Lever Arms and Mounting Angles
Lever Arms & Mounting Anglaks
Lewer Arms & Mounting Angles ] Sensor Mounting

Ref to IMU Lever Arm

IMU Frame wert. Ref Frame

(Use Settings > Installation)

(Use Settings > Installation > Lever Arms and Offsets)
]

] Tage, Multipath & AutUStartl

x(m [oooo X (deg) 0.000

Yim o faood i o000

20 o000 < (deg) oo

Ref. to Primary GPS Lever Arm-| - Ref. to Wessel Lever Arm

() -1.101 X (m) 0.000

¥ (m) 0898 ¥ () 0.000

Zm) L3161 Zim) 0.000

Motes: Ref to Centre of Rotation Lever Arm—
;. REf.I: R;Jﬁ;e;ce i ¥ () L1114

w.rt. = With Respect To e
3. Reference Frame and Wessel L) S
Frarme are co-aligned Zm) -0.336
= Ok Apply I i |

Tags, Multipath and Auto Start

Lever Arms & Mounting Angles

Lewer Arms & Mounting AnglE{«a\\\i Sensor Mounting

Time Tag 1
 POE Time

" GPE Time
& UTC Time

Multipath
o

Fall
r
Time Tag 2

« POS Time

 GPS Time

© UTC Time

" User Time

AutoStart

" Disabled

+ Enabled

(Use Settings > |

3]

nstallation > Tags, Multipath and Auto Start)

Tags. Multipath & AutoStart ]

Apply

Wigw




Sensor Mounting (Use Settings > Installation > Sensor Mounting)

3]

Lever Arms & Mounting Angles

Lewver Arms & Mounting Angles  Sensor Mounting ]Tﬁgs, Multipath & AutnSIan}
Ref. to Aux. 1 GPS Lever Arm Ref. to Aux. 2 GPS Lever Arm
¥igw)  pooo ¥ () oo
Yim o [pooo Y () 0000
Zim)  [oooo Z m) 0000
Ref. to Sensor 1 Lever Arm Sensor 1 Frame wert. Ref Frame
¥ge) oo ¥ (deg) oo
Y [pooo ¥ (deg) 0.000
I [pooo Z (dag) 0.000
Ref. 1o Sensor 2 Lever Arm Sensor 2 Frame we.rt. Ref Frame
¥ge) oo ¥ (deg) oo
Y [oooo Y (deg) o000
I fpooo I (deg) 0.000

o ok ] " Close | Apply I View |

User Parameter Accuracy (Use Settings > Installation > User Accuracy)

User Parameter Accuracy

RMS Accuracy

Attitude (deg) ,EIEIEEI—
Heading (deg) ,ﬁﬂ—
Paosition (m) '2EIEIEI7
Velocity (m/fs) ’EIEDU7

Close J Apply J

GPS Receiver Configuration (Use Settings> Installation> GPS Receiver Configuration)

Primary GPS Receiver

Primary GPS Receiver | Secondary GPS Recetver |

Primary GPS GPS 1 Port

GPS Output Rate Baud Rate

1 Hz =] | | |e600 ~|

Parity- Data Bits Stop Bits

; S 2l C7Bls | ® 1Bt
-Auto Configuration-  Even

& Enabled ~ dd « & Bits 2 Bits
" Disabled

ok ] cose | mpoy |

Secondary GPS Receiver

Primary GPS Receiver Secondary GPS Recever ]

Secondary GPS GPS 2 Port

GPS Output Rate Baud Rate

1 Hz =] | | |e600 ~|

Parity- Data Bits Stop Bits

; S 2l C7Bls | ® 1Bt
-Auto Configuration-  Even

& Enabled ~ dd « & Bits 2 Bits
" Disabled

. Cloze Apply
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SBE 19plus CTD
@
38400, N, 8, 1 6
AlS
D
o)
<
o)
o)
<
=
o
. 9600, N,8,1, NULL
129.100.1.231 DIFF RTCM 102
POSPAC Groups $UTC, 9600, N,8,1, NULL
1Hz
25 Hz COM2
o
| «—129.100.1.230 o R
oS
1 T
| +———10.48.12.32 NZ
— &
-
g _Z Data Y
c
Switch — Data Y
1018-Acq
10.48.12.28 «COM3
L UDP 1070 Reson 8101 COM1.
o COM2—
=
N
9600, N,8,1, NULL]
Reson Controller
+—COoM3
10.48.12.29 Reson 8125
UDP 1020 L o/ ¢—COML
ey
Serial . K
Crossover Launch 1018 Wire Diagram
Patch

L Rev 4.0 12 July 2009

LT Ringel

W
)




———— 9600, N,8,1, NULL E

SBE 19plus CTD

DGPS Reciever
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Measurement

Port Ant to 8111 (Nav to Trans)

Coord. Sys. Caris Caris

X 2.868 2.071
y 8.252 20.144
z 4.752 17.792

*Top of IMU is RP (Reference Pt)

Vessel Offsets for S220_8111 are derived from Westlake-Survey-Report-NOAA-Fairweather-09-23-03.pdf

and Fairweather NGS Report Feb gOO?.doc

Waterline to RP*

| caris

n/a
n/a

0.014

Scaler Distance | 1.997

2009 Measured Value

Calculations

Coord. Sys.  Westlake
IMU easting 0.000
Base northing 0.000
(ft/m) elevation 0.000
Westlake
8111 easting 27.072
(ft) northing 9.410
elevation 15.042
Westlake
8111 easting 8.252
(m) northing 2.868
elevation 4.585
Westlake
Base of IMU to Top of IMU
(m) elevation -0.168
These rows
Westlake (m) easting 8.252
unless noted Top of IMU northing 2.868
otherwise to 8111  elevation 4.752
Coord Sys.
X 2.868
y 8.252
z 4.752

Port Ant to 8111

Waterline to RP*

NGS 2009 IMU Base to baseline at Keel
Top of Port x  -11.892 (ft) elevation 12.856
Ant y 0.797 IMU Base to baseline at Keel
(m) z 13.047 (m) elevation 3.919
Top of Ant to Phase Center
(m) z 0.007 Waterline to Keel
Phase Cntr x -11.892 (ft) elevation 13.45
Port Ant y 0.797 Waterline to Keel
(m) z 13.040 (m) elevation 4.100
See Ship's Draft Tab
Port X 0.797
Ant y -11.892 Top of IMU to Base of IMU
(m) z -13.040 (m) elevation 0.168
Westlake Top of IMU to Keel
(m) easting 8.252 (m) 4.086
Top of IMU northing 2.868
to 8111  elevation 4.752
(m) X 2.868
Top of IMU y 8.252
to 8111 z 4,752
[ Port Ant to 8111 Waterline to RP*
X 2.071 (m) easting N/A
y 20.144 Waterline northing N/A
(m) z 17.792 to IMU elevation 0.014
Coord Sys. Coord. Sys.
X 2.071 x|N/A
y  20.144 y N/A
z 17.792 _—7 z 0.014

See Description Tab

NGS 2009

Top of x  -11.892

Port Ant y 0.797
(m) z 13.047

Top of Ant to Phase Center

(m) z 0.007
NGS 2009
Top of x -11.886
Sthd Ant y 2.794
(m) z 13.051

Scalar Distance (m) 1.997




Caris
0.797 -11.892
-11.892 0.797
13.047 -13.047

Caris

1.866 -7.028
-7.028 1.866
-2.086 -2.086

Value in POSMV is top of
antenna rather than the phase
center to IMU.

NGS 2009
IMU Top (m) X 0.000
y 0.000
z 0.000
NGS 2009
Top of Port x  -11.892
Ant y 0.797
(m) z 13.047
Top of Ant to Phase Center
(m) z 0.007
NGS 2009
Phase Cntr x  -11.892
Port Ant y 0.797
(m) z 13.047

NGS 2009 (m) x  -11.892
Top of IMU y 0.797
to Port Ant z 13.047
Coord Sys. Pos/Mv
x| -11.892
y 0.797
z| -13.047

IMU to Bulkhd (Frame) 52
(ft) easting  -11.638
(m) easting -3.547

Frame 0 (FP) to Frame 52
(m) easting  -27.737
IMU to Frame 0 (FP)
(m) easting 24.190

Heave Pt* to Frame O (FP)
(ft) easting 102.42
(m) easting 31.218

IMU to Centerline
(ft)  northing 6.122
(m)  northing 1.866

Heave Pt* to Centerline

(m)  northing 0

(m) easting -7.028
Top of IMU northing 1.866
to Heave Pt* elevation -2.086

Coord. Sys. Pos/Mv

x| -7.028
y 1.866
z| -2.086

see Description Tab

IMU Base to baseline at Keel
(ft) elevation 12.856
(m) elevation 3.919

Top of IMU to Base of IMU

(m) elevation 0.168
Top of IMU to Keel
(m) elevation 4.086

Center of Gravity above baseline

(ft) elevation 16.37
Mean Metacentric height
(ft) elevation 3.88

Heave Pt* to baseline at Keel
(ft) elevation 20.25
(m) elevation 6.172

(*Heave Pt is Metacenter)
(FP is Forward Perpendicular)




[Measurement| IMU to 8160 (MRUto Trans) |  [PortAntto 8160 (Navto Trans)[ | Waterline to RP*
Coord. Sys. Caris Caris |

X 0.493 -0.304

y 7.665 19.557,

z 4.726 17.766,

*Top of IMU is RP (Reference Pt)

Caris |
n/a

n/a
0.014

Caris Caris
|Scaler Distance | 1.997| 0.797 -11.892 1.866
-11.892 0.797 -7.028
13.047 -13.047 -2.086

-7.028]
1.866
-2.086]

Vessel Offsets for S220_8111 are derived from Westlake-Survey-Report-NOAA-Fairweather-09-23-03.pdf,

Fairweather NGS_Report_02-07.pdf_and  FairweatherCenterlineSurvey 03-09.pdf,

Derivations

Coord. Sys.

Westlake
IMU easting 0.000
Base northing 0.000

(ft/m) elevation 0.000

Westlake
8160 easting 25.149
(ft) northing 1.619
elevation 14.956

Westlake
8160 easting 7.665
(m) northing 0.493
elevation 4.559

Base of IMU to Top of IMU
(m) elevation -0.168

Westlake easting 7.665
Top of IMU  northing 0.493
to 8160 (m) elevation 4.726

Coord Sys

X 0493
y 7.665
z 4.726

NGS 2009
Top of Port X -11.892
Ant y 0.797
(m) z 13.047
Top of Ant to Phase Center
(m) z 0.007
Phase Cntr X -11.892
Port Ant y 0.797
(m) z 13.040
Port X 0.797
Ant y -11.892
(m) z -13.040
Westlake
(m) easting 7.665
Top of IMU northing 0.493
t0 8160  elevation 4.726
(m) X 0.493
Top of IMU y 7.665
to 8111 z 4.726
X -0.304
y 19.557
(m) z 17.766
Coord Sys
X -0.304]
Y| 19.557
z 17.766




Description of Offsets for FAIRWEATHER S-220

All Values Shown are in CARIS Coordinates

IMU to Port Antenna
x:0.797
y: -11,892
z:-13.47

IMU to Heave Point

: x: 1.866 ;
y:-7.028  IMU=Reference Point (RP)
7:-2.086  x:0.000

‘lI y: 0.000
2:0.000

Fer A;te—gn;oﬁ) i IMU to Seabat 8160
y: 19.557 x: 0.493
z:17.766 y: 7.665
2:4.726
Port Antenna to 8TTT IMU to Seabat 8111
x:2.071 X: 2.868
y: 20.144 y: 8.252
z:17.792 z: 4.752

IMU to Port Antenna
x:0.797 § %
y:-11.892 F

z:-13.047




[ MUto 8111 (MRU to Trans) |
X y z

2.868 8.252 4.752
The lever arms between the IMU
and phase center of the 8160
transducer are taken from the
Westlake report with the addition of
the 0.168 m offset included for the
height of the IMU.

Port Ant to 8111 (Nav to Trans)
X y z
2.071 20.144 17.792
This information comes from a
combination of the Westlake and
NGS surveys. Subtraction of the
distance between Top of Antenna
and the Phase Center were
included in final value
determination. Relative positions
obtained from Port Ant to 8111 via
IMU.

Scaler Distance 1.997
Using the NGS 2009 survey values
for the antennas, a calculated
vector for antenna separation was
determined. The distance from Top
of Antenna to Phase Center does
not affect this calculation and
therefore was not included.

Waterline to RP*
X y z

n/a n/a 0.014]
The height of the IMU above the
keel comes from the Westlake
survey value of 3.919 m plus the
measured value of the top of the
IMU to the base plate, to get an
IMU height above the keel. The
draft (waterline to keel) used for the
FAIRWEATHER is based on
observations, Ship's Draft
spreadsheet. Differencing the
value of IMU to keel and waterline
to keel gives the waterline to RP
distance.

[ MUto 8160 (MRU to Trans) |
X y z

0.493 7.665 4.726)
The lever arms between the IMU
and phase center of the 8111
transducer are taken from the
Westlake report with the addition
of the 0.168 m offset included for
the height of the IMU.

[ PortAnt to 8160 (Nav to Trans)|
X y z

-0.304 19.557 17.766
This information comes from a
combination of the Westlake and
NGS surveys. Subtraction of the
distance between Top of Antenna
and the Phase Center were
included in final value
determination. Relative positions
obtained from Port Ant to 8160 via
IMU.

[ ™UwPortAnt |
X y z

0.797 -11.892 13.047
This information comes directly
from the NGS 2009 survey.
Subtraction of the distance
between Top of Antenna and the
Phase Center were included in
final value determination.

X y z

From pg 3 of the Westlake Survey

1.866 -7.028 -2.086|
Key points on the IMU, from the
Westlake survey, are its location
with respect to the ship’s reference]
frame. Itis 4.087 m (3.919 m to
base line + 0.168 m for IMU height|
above base plate) above the keel,

SUMMARY

IMU foundation plate is level to within +/-0.001 feet
IMU foundation plate is located 12.856 feet above baseline established at the keel
IMU is parallel to ship's centerline to within +/- 0.001 feet

Location of scribed centerline intersection is 6.122 feet port of ship's centerline.
IMU foundation plate centerline is located 11.638' feet forward of bulkhead 52.

1.866 m port of centerline and
3.547 m forward of frame 52. This
information is needed to reference
the IMU to the ship’s Heave
Measurement Location (Heave
Point). *

the metacenter.

Lynn - read through and check

* From the Art Anderson inclination experiment the position of the metacenter was used as the position of the ship’s Heave Point. (There ma
be a better way to determine the Heave Point, but this decision was based upon available information). The metacenter is defined by the
center of buoyancy. As a vessel inclines through small angles, the center of buoyancy moves through the arc of a circle whose center is at

Important numbers and information determined from the Art Anderson report are the location of the metacenter and how it is positioned with
respect to the vessel. The longitudinal location of the metacenter is defined as 102.42 feet (31.217 m) aft of the forward perpendicular. The
height of the metacenter is 20.25 feet (6.172 m) above the keel. There is an assumption of the metacenter being on the centerline of the
vessel. Similar values for the RAINIER’s metacenter are 32.52 m aft of the forward perpendicular and 5.2 m above the keel. The difference
in the height of the metacenter can be attributed to the difference between the FA’'s and RA’s average draft which is 13.12 feet as opposed tg
approximately 14.5 feet respectively.

Referencing the metacenter (Heave Point, HP) to the IMU information requires information about the frame spacing of the vessel. From the
Westlake survey, the IMU is located 3.547 m forward of frame 52. From Inclination document, the HP is 31.217 m aft of the forward
perpendicular. From engineering drawings of the ship frame spacing is approximately 21 inches. The calculation for the longitudinal location|
of the HP with respect to frame zero, the Forward Perpendicular (FP) is as follows:

52 (frame) * 21 (inches/frame)/12(inches/ft)*.3048(m/ft)-3.547 m = 24.190 m from frame 0.
31.217 m (HP aft of FP) — 24.190 m (IMU aft of FP) = 7.027 m (HP aft of IMU)

The calculation for the vertical separation between the IMU and the HP is based on the height of the metacenter being 6.172m and the heigh
of the IMU being 4.087 m above the keel. Differencing yields the metacenter being 2.085 m above the IMU.

The calculation for the athwartship separation is based upon the assumption that the HP is on the centerline and the knowledge that the IMU
is 1.866 m to port of the centerline.




Sources

Offset values for the ship were derived from three sources. Two static offset surveys, an inclination experiment, and values measured or
approximated by ship’s personnel.

On September 23, 2003 an offset survey of the NOAA Ship FAIRWEATHER was conducted by:

Westlake Consultants, Incorporated

15115 SW Sequoia Parkway, Suite 150

Tigard, Oregon 97224

Phone (503) 684-0652

...and the relocation of the POS M/V antenna forced a partial resurvey in Feb. 2007 by Steven Breidenbach of NGS.

These values relate the physical positions of one sensor to the next with the base plate of the IMU being the point of origin. All
dimensions in the document are given in feet and decimal feet.

On July 16, 2004 an inclination experiment was conducted at MOC-P by:

Art Anderson Associates
202 Pacific Avenue
Bremerton, WA 98337-1932

Calculations

The values for the required lever arms are listed in the S220_Offsets and Measurements spreadsheet. The reference point and the
IMU are identical. Difference in documentation between Westlake and FA calculations are based off of measuring up from the
IMU base (Westlake’s origin) and the top of the IMU. The top center of the IMU for the POS/MV is the defined origin for the
POS/MV and the origin that is being used on all FAIRWEATHER vessels. The distance from the base plate to the top of the
IMU is 0.168 m, a value measured by ship’s complement. Conversions factor from feet to meters is 0.3048 m/ft.

As a requirement for the TPE, the standard deviation for each position is 3 mm. This value is based upon a conversation with
Elaine McDonald of Westlake and is followed up by an Email documenting that fact. The email is located at the end of this
document.
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PURPOSE
The primary purpose of the survey was to precisely determine the spatial relationship of various
components of a POS MV navigation system aboard the NOAA ship FAIRWEATHER.

Additionally, various reference points (bench marks) were re-established onboard the vessel to
aid in future spatial surveys aboard the boat.

PROJECT DETAILS

This survey was conducted while the ship was in dry dock at the Lake Union dry dock in Seattle,
WA. The weather conditions over the two days required to conduct this survey were windy,
cool, with intermittent rain.

INSTRUMENTATION

The Leica TC2003 total station was used to make all measurements.
Technical Data:

Standard Deviation

Horizontal angle 0.5 seconds
Vertical angle 0.5 seconds
Distance measurement 0.2mm + 2ppm

A Leica precision prism was used as a sighting target. This prism was configured to have a zero
mm offset.

PERSONNEL

Kendall Fancher ~ NOAA/NOS/NGS/GSD/I&M BRANCH
(540) 373-1243

Dennis Lokken NOAA/NOS/NGS/GSD/1&M BRANCH
(540) 373-1243
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DEFINITION OF THE REFERENCE FRAME

To conduct this survey a local coordinate reference frame was established where the Northing
(YY) axis runs along the centerline of the ship and is positive from the IMU towards the bow of
the ship. The Easting (X) axis is perpendicular to the centerline of the ship and is positive from
the IMU towards the right, when looking at the ship from the stern. The Up (Z) axis is positive
in an upward direction from the IMU.

SURVEY METHODOLOGY

02/15/2009

Coordinates of 100.000N, 100.000E, and 100.000U were assumed for temporary control point 1.
A distance and height difference were measured between temporary control points 1 and 3.
These values were used to determine the coordinates at temporary control point 3. Temporary
control points 1 and 3 were located along the top deck and on the north side of the dry dock
vessel.

Temporary control point 1 was occupied and temporary control point 3 was observed for a
backsight. After initialization, temporary control points 2 and 4(located on the top deck of the
dry dock vessel), H1 (located on the bottom deck of the dry dock vessel), and BOW BM were
observed in both direct and reverse.

Temporary control point 2 was occupied and temporary control point 3 was observed for a
backsight. After initialization, temporary control point W1 (located on the top deck of the dry
dock vessel) and D1 (located inside the ship on the D deck along the port side) were observed in
both direct and reverse. Temporary control point 1 was also observed and yielded an inverse
check of 0.001m horizontally and 0.001m vertically.

Temporary control point 4 was occupied and control point 1 was observed for a backsight. After
initialization, temporary control point 5 (located on the south side and on the top deck of the dry
dock vessel) was observed in both direct and reverse.

Temporary control point 5 was occupied and control point 4 was observed for a backsight. After
initialization, temporary control point D2 (located inside the ship on the D deck along the
starboard side) was observed in both direct and reverse.



Temporary control point H1 was occupied and control point 1 was observed for a backsight.
After initialization, temporary control point H2 (located on the bottom deck of the dry dock
vessel), and USBL BM were observed in both direct and reverse.

Temporary control point H2 was occupied and temporary control point H1 was observed for a
backsight. After initialization, 8111 BM and 8160 BM were observed in both direct and reverse.
Temporary control point W1 was also observed and yielded an inverse check of 0.019m
horizontally and 0.033m vertically.

Temporary control point D1 was occupied and temporary control point D2 was observed for a
backsight. After initialization, temporary control point D3 (located in the doorway leading to the
mess hall on the D deck) was observed in both direct and reverse.

Temporary control point D3 was occupied and temporary control point D1 was observed for a
backsight. After initialization, temporary control point C1 (located on the C deck near the IMU)
was observed in both direct and reverse. Temporary control point D2 was also observed and
yielded an inverse check of 0.026m horizontally and 0.0001m vertically.

Temporary control point C1 was occupied and temporary control point D3 was observed for a
backsight. After initialization, IMU, IMU BOW PORT CORNER, IMU BOW STAR CORNER,
IMU STERN STAR CORNER, and IMU STERN PORT CORNER were observed in both direct
and reverse.

02/16/2009

Temporary control point 4 was occupied and control point 1 was observed for a backsight. After
initialization, temporary control point 6 (located on the south side and on the top deck of the dry
dock vessel) and BOW BM were observed in both direct and reverse. Temporary control point
D2 was also observed and yielded an inverse check of 0.0004m horizontally and 0.083m
vertically.

Temporary control point 6 was occupied and temporary control point 4 was observed for a
backsight. After initialization, TRANSOM PIVOT POINT PORT, STERN BM, POS GPS ANT
RAIL BM, POS IMU ANT DECK BM, POS GPS ANT STARBOARD, and POS GPS ANT
PORT were observed in both direct and reverse.

Temporary control point 3 was occupied and temporary control point 1 was observed for a
backsight. After initialization, TRANSOM PIVOT POINT STARBOARD, STERN BM, POS
GPS ANT STARBOARD, and POS GPS ANT PORT were observed in both direct and reverse.
Temporary control point 6 was also observed and yielded an inverse check of 0.0006m
horizontally and 0.001m vertically.

The reference frame was rotated using STERN BM as the point of rotation. A zero degree
azimuth was used during the rotation from STERN BM to BOW BM. The reference frame was
then translated to relocate the origin of the reference frame to the IMU.
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INVERSE RESULTS

Inverses were computed between the determined positions of those ship benchmarks and
sensor points which were determined from two separate locations The results of these inverses
are:

ID Horizontal Dist.(m) Elevation Diff(m)
BOW BM 0.0150 0.0240
STERN BM 0.0060 0.0010
POS GPS ANT STARBOARD 0.0100 0.0001
POS GPS ANT PORT 0.0100 0.0000
DISCUSSION

The Fairweather was in dry dock during this survey, however, the dry dock vessel was still
subject to movement due to wave action. Conducting a survey such as this while the ship is
moving requires that the automatic compensators in the survey instrument be turned off. The
survey is therefore conducted with all survey instrumentation set up relative to the mean
movement of the related level vials. While every effort was made to make the most precise
measurements possible, some additional error accumulation cannot be avoided under these type
observing conditions.

The POS GPS antenna coordinates were determined to the top center of the antennas. The Z
value should be corrected to the Antenna Reference Point (ARP). In order to apply this
correction, the mechanical height of the antenna should be determined and subtracted from the Z
value determined during this survey for both of the POS GPS antennas.



NOAA SHIP FAIRWEATHER

POS MV COMPONENTS SPATIAL RELATIONSHIP SURVEY

Coordinate Listing using IMU as the Reference Frame Origin

ID X(NORTHING)m | Y(EASTING)m | Z(UP)m
IMU CENTER 0.000 0.000 0.000
IMU STERN PORT CORNER -0.071 -0.089 -0.001
IMU BOW PORT CORNER 0.070 -0.086 -0.001
IMU BOW STARBOARD CORNER 0.069 0.087 0.000
IMU STERN STARBOARD CORNER -0.073 0.086 0.000
BOW BM 28.378 1.805 7.796
STERN BM -40.306 1.805 2.255
USBL BM -28.354 1.738 -4.204
8160 BM 8.407 0.395 -4.400
8111 BM 8.532 3.002 -4.666
POS GPS ANT RAIL BM -12.011 1.785 10.381
POS IMU ANT DECK BM -11.790 1.780 9.305
POS GPS ANT STARBOARD -11.886 2.794 13.051
POS GPS ANT PORT -11.892 0.797 13.047
TRANSOM PIVOT POINT STARBOARD -39.727 3.366 2.385
TRANSOM PIVOT POINT PORT -39.722 0.240 2.345
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IMU STERN PORT CORNER ==>

IMU Reference Points
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==GPS Starboard Side - Top PS Port Side==> o
enter of GPS antenna. - Top center of GPS s

antenna.

POS GPS ANTENNAS
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== Punch Mark in top center of bolt welded
to bow deck.

BOW CENTERLINE REFERENCE POINT
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"‘\-\ ‘ ‘

jios oy
==Centerline Reference Peoint - Punch mark in top of
M Y-olt welded to G deck. *

CENTERLINE REFERENCE POINT ON G DECK
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(

{

%
==Canterline Reference Point - Punch mark in top I
of bolt welded to rail on G deck.
e 3

CENTERLINE REFERENCE POINT ON RAIL AT G DECK
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on fantail.

CENTERLINE STERN REFERENCE POINT
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TRANSOM REFERENCE POINT ON STARBbARD SIDE
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Fairweather Draft - 2009

Immediately prior to the FA field season, the draft measurements were taken prior to fueling when the takes were
very empty after shipyard (Empty) . And again after fueling and once the engineers had transferred the fuel in a
satisfactory manner (Full). The waterline at the IMU was then calculated based on a linear interpolation.

2009  (April) Fwd Aft slope  IMU Depth (ft) IMU Depth (m)
x1 yl x2 y2 Min Max

Empty 5.25 13.83 189 12.83  -0.00544 12.83 14.17
Full 5.25 13.00 189 14.17 0.00635

5.25 189 0.00000 0.00 0.000

5.25 189 0.00000 0.00 0.000

5.25 189 0.00000 0.00 0.000

Draft at IMU (ft) AVG  Value Used in Offsets
The IMU x-value (ft): 79.36 0.009 STDEV  Value used for Waterline Loading Uncertainty
x-value (m): 24.19
Distance Aft Fwd Perpendicular (ft)
0.00 25.00 50.00 75.00 100.00 125.00 150.00 175.00 200.00
12.9

13.1

13.7

13.9

14.1
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PURPOSE

The primary purpose of the survey was to accurately determine the spatial relationship of various
components of a POS MV navigation system aboard the NOAA ship FAIRWEATHER.
Reference points were also established to determine the spatial location of differential GPS
antennas, Additionally, various reference points (bench marks) were restablished onboard the
vessel to aid in future spatial surveys aboard the boat.

PROJECT DETAILS

This survey was conducted while the ship was docked at the USCG in Seattle, WA . The weather
was cool with a steady breeze.

INSTRUMENTATION

The Topcon 3000LW total station was used to make all measurements.
Technical Data:
Angle Measurement
Smallest unit in display 0.1 seconds

Standard Deviation

Horizontal angle 1.0 seconds
Vertical angle 1.0 seconds
Distance measurement 2mm + 2ppm

A standard “peanut” prism was used as a sighting target. This prism was configured to have a zero
mm offset.

PERSONNEL

Steve Breidenbach  NOAA/NOS/NGS/GSD/I&M BRANCH
(540) 373-1243

Dennis Lokken NOAA/NOS/NGS/GSD/I&M BRANCH
(540) 373-1243
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ESTABLISHING THE REFERENCE FRAME

To conduct this survey a local coordinate reference frame was established where the X axis runs
along the centerline of the boat and is positive from IMU towards the bow of the boat. The Y axis
is perpendicular to the centerline of the boat (X axis) and is positive from IMU towards the right,
when looking at the boat from the stern. The Z axis is positive in an upward direction from the
IMU. In this reference frame the IMU has the following coordinates;

X =100.000(m)

Y =100.000(m)

Z =100.000(m)

At the end of the survey all the coordinates were rotated to a right-handed coordinate system. The
coordinates were translated to the IMU origin and the Granite Block origin.

DISCUSSION

I recommend conducting the survey again, once the ship is put into dry dock. Conducting a survey
such as this while the boat is in the water requires that the automatic compensators in the survey
instrument be turned off. The survey is therefore conducted with all survey instrumentation set up
relative to the mean movement of the related level vials. While every effort was made to make the
most precise measurements possible, some additional error accumulation cannot be avoided under
these type observing conditions.



The positions given for the IMU GPS antenna are to the bottom of the bolt as depicted on the
photo below.




Position of the C-NAV Antenna
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Point Summary Report
~ Name | StdDevn(m Std Dev e (m Std Dev Hz (m ‘ Std Dev u (m

10FLOOR 0.003 0.003 0.004 ‘ 0.002
11FLOOR 0.003 0.004 0.005 0.002
1CLEAT 0.004 0.018 0.019 ‘ 0.002
1DECK 0.004 0.018 0.018 ‘ 0.002
1FLOOR 0.000 0.000 0.000 ‘ 0.000
1LOCKER 0.004 0.004 0.005 ‘ 0.003
1RAIL 0.004 0.022 0.023 ‘ 0.002
1IWALL 0.003 0.002 0.004 ‘ 0.001
1IWALLS3 0.003 0.003 0.004 ‘ 0.002
2CLEAT 0.003 0.021 0.021 ‘ 0.002
2CLEAT1 0.004 0.022 0.022 ‘ 0.003
2FLOOR 0.001 0.001 0.001 \ 0.001
2RAIL 0.004 0.022 0.022 ‘ 0.002
2WALL 0.002 0.003 0.004 ‘ 0.002
3ANT 0.003 0.006 0.007 ‘ 0.003
3FLOOR 0.002 0.002 0.003 ‘ 0.002
3WALL 0.003 0.003 0.005 ‘ 0.002
4FLOOR 0.001 0.001 0.002 ‘ 0.003
5FLOOR 0.002 0.004 0.005 ‘ 0.001
6FLOOR 0.002 0.002 0.003 ‘ 0.003
7FLOOR 0.005 0.003 0.006 ‘ 0.002
8FLOOR 0.004 0.004 0.005 ‘ 0.002
9FLOOR 0.002 0.013 0.013 ‘ 0.003
ABOLT 0.003 0.026 0.026 ‘ 0.003
ANT DECK 0.003 0.006 0.007 ‘ 0.003




Std Dev Hz (m \
ANT DECK BM 0.004 0.007 0.008 \ 0.003
ANT PORT 0.003 0.007 0.008 \ 0.003
ANT RAIL 0.004 0.006 0.007 \ 0.003
ANT RAIL BM 0.003 0.007 0.007 \ 0.003
ANT STAR 0.004 0.007 0.008 0.003
BOW BM 0.004 0.023 0.024 \ 0.003
BOW BM2 0.004 0.023 0.023 \ 0.003
BRIDGEPORT 0.005 0.011 0.012 \ 0.003
BRIDGESTAR 0.005 0.011 0.012 \ 0.003
BRIDGESTAR2 0.005 0.011 0.012 \ 0.003
DOOR 0.001 0.001 0.002 \ 0.001
GRANITE BOW 0.002 0.001 0.002 \ 0.001
GRANITE CENTER 0.002 0.001 0.002 \ 0.001
GRANITE PORT 0.002 0.001 0.002 \ 0.001
GRANITE STAR 0.003 0.002 0.003 \ 0.001
GRANITE STERN 0.002 0.001 0.002 \ 0.001
IMU BM 0.003 0.001 0.003 0.003
IMU BOW PORT 0.002 0.001 0.002 \ 0.001
IMU BOW STAR 0.002 0.001 0.002 \ 0.001
IMU CENTER 0.000 0.000 0.000 \ 0.000
IMU STERN PORT 0.002 0.001 0.002 \ 0.001
IMU STERN STAR 0.002 0.001 0.002 0.001
LADDER 0.002 0.002 0.002 \ 0.001
MVP BM 0.004 0.023 0.023 \ 0.003
RAIL STAR 0.006 0.015 0.016 \ 0.003
RAIL STAR1 0.004 0.005 0.007 \ 0.003
RAILPORT 0.005 0.015 0.016 \ 0.003




STEARN BM 0004 | 0024 | 0024 |  0.003 |

STERN BM 0.003 0.024

COORDINATES

IMU Origin

Right-handed Coordinate System
Name Easting (x) meters | Northing (y) meters | Elevation (z) meters
IMU CENTER 0 0 0
IMU BOW PORT CORNER 0.073 -0.084 -0.006
IMU BOW STAR CORNER 0.071 0.088 -0.004
IMU STERN STAR CORNER -0.068 0.089 -0.003
IMU STERN PORT CORNER -0.065 -0.086 -0.006
GRANITE BOW 0.147 0.48 0.108
GRANITE STAR -0.002 0.574 0.111
GRANITE STERN -0.148 0.478 0.109
GRANITE PORT -0.003 0.382 0.106
GRANITE CENTER -0.002 0.477 0.108
IMU BM 0.034 -0.263 -0.496
STERN BM -40.32 1.927 -2.184
MVP BM -38.721 5.985 -2.018
STEARN BM -40.313 1.921 -2.181
POS GPS ANT STARBOARD -11.917 3.171 -12.936
POS GPS ANT PORT -11.92 1.177 -12.98
A FRAME BOLT -43.019 1.975 -7.142
POS GPS ANT RAIL BM -12.037 2.101 -10.376
POS IMU ANT DECK BM -11.823 2.07 -90.301
C-NAV ANT -10.075 4.131 -11.377
BOW BM 28.346 2.077 -7.853




Granite Block Origin

Right-handed Coordinate System

Name Easting (x) meters | Northing (y) meters | Elevation (z) meters
IMU CENTER 0.002 -0.477 -0.108
IMU BOW PORT CORNER 0.075 -0.561 -0.114
IMU BOW STARBOARD CORNER | 0.073 -0.39 -0.112
IMU STERN STARBOARD CORNER | -0.065 -0.388 -0.111
IMU STERN PORT CORNER -0.063 -0.563 -0.114
GRANITE BOW 0.149 0.003 0
GRANITE STAR 0 0.097 0.003
GRANITE STERN -0.145 0.001 0.001
GRANITE PORT 0 -0.095 -0.002
GRANITE CENTER 0 0 0

IMU BM 0.036 -0.74 -0.604
STERN BM -40.317 1.45 -2.292
MVP BM -38.719 5.508 -2.126
STEARN BM -40.31 1.444 -2.289
POS GPS ANT STARBOARD -11.915 2.694 -13.044
POS GPS ANT PORT -11.918 0.699 -13.088
A FRAME BOLT -43.017 1.498 -1.25
POS GPS ANT RAIL BM -12.034 1.623 -10.484
POS IMU ANT DECK BM -11.821 1.593 -9.409
C-NAV ANT -10.073 3.654 -11.485
BOW BM 28.349 1.6 -7.961




POS GPS RAIL BM AND POS GPS DECK BM



IMU BM
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Certificate of Accuracy

Customer Name: MCMASTER-CARR SUPPLY CO. Customer PO#: TA-28173060

Customer Address: 200 AURORA IND. PARKWAY
AURORA,OH 44202

Date of Calibration: 8/23/02
Product Description: GRANITE SURFACE PLATE
Size; 8"X12"X2"
Serial Number: 36961
Accuracy: Actual: .000075" Allowed: .0002"
Repeatability: Actual: .000055" Allowed: .00010"
Grade: B
Uncertainty of Measurement: 52D
M.O.E.: 7.5x106

Laboratory Conditions: Temperature: 69 °F Humidity: 51%

This product was inspected under environmentally controlled conditions. The electronic and optical gauging
equipment used in inspecting this item has been calibrated and is traceable to the National Institute of Standards and
Technology (NIST). Our calibration system is in compliance with ISO 10012-1.

Calibration Equipment Used in the Inspection of this Product:

Type of Equipment 1D Number Instrument Uncertainty NIST Traceability Cal_Due Date
Number
Autocollimator IP 040 +0.5 arc sec 821/259488-97 6-03

.000020 Mahr Dial | 20990 50 pin 25894-1 6-03

Laboratory Manager Signature:
Donald Schirmers, Lapping Manager
Robert Golla, Accessones Supenisor

REWORK / RECALIBRATION (This section is completed for recertification orders only - accuracies upon receipl)

Date of Receipt:
Accuracy of Incoming Product:
Repeat Measurement of Incoming Product:

" Was unable to read upon receipt due to poor
condition of product

The results on this Certificate of Accuracy apply only to the item described above. This report shall not be
reproduced except in full and with the written authorization of our laboratory.

Measurement Uncertainty is expressed at a confidence level of 95% (coverage factor k=2)

Procedure Number: QP 4.10.1

1101 Prosper Drive « Box 430 - Waite Park, MN 56387+ PH: 320-251-7171 - Fax 320-259-5073




FINAL INSPECTION REPORT
1101 Prosper Drive - Box 430
Waite Par. MN 56387
PH 320-251.7171 - FAX 320-250.5073

ved — WD (6) Customer Name: MM (e
. mumpmuumm 7) Serial Number:  _3/-F ¢/

(5) P.O. Number: - 2013000 (3) Print/Part Number:
(10) Description of Item: _&&Lﬁ(ﬁ (11) Granite Type: G,
(12 Conditions at Time of Inspection: ~ Temperatwre: G oF  Humidey: S/
(13) Test Equipment:
Ixpe of Eguioment Serial Number Caiitration Due Date Uncertainty of IMTE
mimmm

Autocollimator -0 -t LA ¢ Seg
Electronic Level D Height Check [:] ﬂzgc Z‘"' [Tij m
AmoBGaugeHead [ | Surfometer C,]

Perts Prism = Misokator

Other
(1) Grade: ( B’ A AA NJ/A
(15) Overall Accuracy / Flatness (acuat): ss00 75 - P —

(15) Repeat Measurement (sne): _ . 0000SS [ﬂu—ﬂz@
(FIM: Full Indicator Movement)

(17) Final Inspector Signature:

(18) Opinion / Interpretation (if applicable):

(21) Thread Size, Quantity & Location to Print:  Yes No
(22) Insert / Hole / Slot Szze, Quantity & Location to Print:  Yes No

mmumwmwywmmmm Mrmtﬂnﬂhlmmﬂfm mmm:
written 3pproval of our aboratory.  Measurement uncestanty is expn ¢ 8 confidenc :

Shipping
(19) Threaded Inserts:  Yes No (20) Cean: Yes o  No
Packaging Conforms to Company and Customer Requirements:  Yes : No




Save  IMPORTANT DOCUMENT Save

Tru-Stone Technologies
Instructions for Care of Granite Surface Plates

1. Cleaning and Moisture: Plates shall be cleaned thoroughly and given adequate time to dry before
testing for tolerance. Water based cleansers that have not dried will cause iron parts to rust if they are
left in contact with the wet surface for an extended period of time. It is recommended that plates
undergo drying time in a room with less than 50 percent relative humidity. Temperature and dirt have a
direct correlation with measurement accuracy. Personal cleanliness will aid in eliminating one source of
contamination,

2. Temperature Soaking Time: Before granite surface plates are measured for work surface flatness,
the granite should remain in the calibration area until it has reached room temperature, which may
require 2 to 3 days. Large plates require more soak-out time than smaller ones.

3. Scratches and Nicks: Whenever scratches and nicks appear on granite plates, the resulting rough
edges should be removed with a flat granite dressing plate. Any bump that shatters the surface raises
fractured material at the rim of the crater.

4. Rotation of Plates: When a specific work surface area receives prolonged usage, it is suggested
that the plate and stand be rotated 180 degrees on a periodic basis to increase the wear life of the plate.
The production of a contour map during calibration is particularly helpful in locating the parts of the plate
that should be given the most use. This can be accomplished by requesting a long form certification
when ordering the new surface plate or when the plate is being sent in for recalibration.

5. Periodic Recalibration: Periodic recalibration of granite surface plates is recommended to
determine resurfacing or replacement needs. The interval between calibrations will vary with the grade
of plate and the wear resistance of the granite. TRU-STONE CONFORMS TO ISO 9000
CERTIFICATION REQUIREMENTS FOR VENDORS. Frequent monitoring of the work surface by
scanning it with the repeat gage is desirable. When these results differ from those marked on the
replaceable sticker, you should recalibrate the plate. In addition to measuring the overall accuracy of a
surface, smaller areas can be checked for localized variations often missed by the calibrating methods.
Remember precision measurements are only as accurate as the measuring tools used.

6. Torque on THREADED Inserts: Do not exceed the following maximum torque values when using a
torque wrench to limit distorting the work surface and pulling the insert. The following torque values are
the maximum level permissible by the Federal Specification GGG-P-463c.

PERMISSIBLE TORQUE CLAMPING ON THREDED INSERTS

Thread Size Torgue
250 inch 7 ft. Ibs.
3125 inch 15 ft. Ibs.
.375 inch 20 ft. Ibs.
.500 inch 25 ft. Ibs.

7. Clamping Ledges on Grade AA Surface Plates: There is danger of distorting the work surface
flatness beyond tolerance when a heavy item rests on the ledge or an item is clamped to the ledge.
Ledges are not only expensive, but a great cause of inaccuracy. Experimentation and research reveal
that no-ledge plates retain their accuracy better than ledged plates.

8. Supports: There are working and loading conditions where the standard three point supports are not
satisfactory. These cases should be individually engineered. When four or more supports are used,
shims or adjusting screws are necessary for proper support. The supports could be spotted under the
loading points and set to approximately equal the loading. Sometimes the work surface flatness can be
improved by shifting support positions. Fulcrum, air and hydraulic supports are available. Whenever
nonstandard supports are used, the surface plate shall be calibrated at the site for compliance to the
flatness tolerance.

1101 Prosper Drive » P. O. Box 430 « Waite Park, MN 55387 - 1-800-950-0517 + PH: 320-251-7171 = Fax 320-258-5073



Utilize the full surface of a plate so the wear is distributed and not concentrated in one area.
The surface plate should not be overloaded.

Use extreme care in moving the item being measured and the gages being used.

Place on the surface ONLY what is required.

Particularly avoid heavy contact with the edges.

Don't leave metal objects on the surface longer than necessary.

Clean the surface before and after use.

e & & & & 0 @
e

Remember that the condition of this accurate plane
is an integral factor in the measurement being made.

Surface plate cleaner can be purchased through your local Tru-Stone distributor or directly from Tru-
Stone Technologies. Call for pricing and delivery information.

When the need for recalibration or rework of your surface plates and precision granite accessories
arises, contact a Tru-Stone representative or call us directly for more details on restoring your inspection
item to a “like new” condition. This service comes with new certification and plate labels.

One advantage of having your granite inspection equipment recalibrated by a manufacturer is the
manufacturer’s ability to take the time required to ensure the proper repeatability and overall shape of
the inspection surface. Tru-Stone allows the item to normalize ovemight prior to taking the final
readings to indicate whether it is a good enough quality to certify and return to you.

Should you have any questions, please contact our customer service representatives at 320/251-7171
or fax us at"320/259-5073. =

Important Notice

Any streaks of color in the granite are not defects. These are created by the molten lava mixing with
minerals prior to evolving into the granite you see today. Black streaks or spots are the result of a
magnetite (black iron oxide) concentration. White streaks or spots are areas where the granite is lacking
magnetite. The levels of magnetite in granite vary considerably, however the color of the granite in no way

affects the functionality or quality of it.

Our products are UNCONDITIONALLY Guaranteed

Please refer to the Federal Specification GGG-P-463c, which is followed by NIST (National Institute of
Standards & Technology) for Granite Surface Plates.

3.7 Seams or Color Streaks: Seams are cause for rejection. Color streaks have no affect on the
serviceability of the granite.”

“4.5.8 Seams or Color Streaks: Test for a seam is to wet the smooth surface of the granite where
the color streak appears; then dry it off. If the streak remains wet or damp, it is a seam.”

1101 Prosper Drive » P. O. Bax 430 « Waite Park, MN 58387 « 1-800-858-0517 » PH: 320-251-7171 » Fax 320-258-5073
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STABILITY TEST: NOAA Ship FAIRWEATHER (16 Jul 2004 )
SHIP AT TIME OF STABILITY TEST--CONDITION 0
FROM HYDROSTATIC FROM INDEPENDENT
CURVES CALCULATION
Corrected diaplacement tons 1638.79 tons
Mean \.firlual metacentric height obtained from plot of . moment = 5987.252 / 1638.790 it 5 : ik
inclining moments versus tangents of angles of heel  displacement x tangent
Correction for free surface = 374.0 / 1638.790 - 7 feet 0 ;; feet
Mean metacentric height G.M. = - feet 3 .és_ feet
Transverse metacenter above base line corresponding to draft at LCF (corrected for hog or sag) o feet
Transverse metacenter above base line corrected for trim, and hog or sag ) B feet
C.G. above base line S feet 16.37 feet (from figure)
o T 16.36 feet (from GHS)
Longitudinal metacenter above C.G. feet
Moment to alter trim 1 foot, (Long GM x A) / L. ) fi-tons
Trim by stern  feet
Trimming lever = (Trim x moment to trim) / displacement I feet
Longitudinal center of buoyancy (L.CB) from origin A B feet
C.G. from origin - - feet 102.44  feet (from figure)
102.42 feet (from GHS)
FP
Period of complete roll seconds
Apparent radius of gyration of vessel o= _}:I_GO%L feet 3.88 _‘_“_3_“___——— —
12.35 —
) Rolling constant C= lgM— WATERONE & WATERLIE
h

Page 8 of 31



Westlake Consultants, Inc.
9/23/2003

Definitions and Basis for Dimensions/Locations

Northings

Northings (Port - Starboard) are with reference to the IMU Foundation Plate centerline scribe.
Positive values are starboard of the IMU.

Negative values are port of the IMU.

Calculated values are in italics.

Eastings

Eastings (Stern to Bow ) are with reference to the IMU Foundation Plate centerline scribe.
Positive values are forward of the IMU.

Negative values are aft of the IMU.

Calculated values are in italics.

Elevations

Elevations are with reference to the IMU Foundation Plate centerline scribe = 0 elevation.
Positive values are below the IMU (toward the keel).
Negative values are toward the topside.

Dimensions

All dimensions are in feet and decimal feet. All dimensions provided are "offsets" to IMU centerline.

Ship's Centerline Data

At project initiation, control was established to define the ship's centerline
as a plane running from a point on the centerline of the keel at the stern through a
point on the centerline of the keel near the bow, to a point on the bow splitting the bow chock.

IMU Referenced Data - Procedure
All data was originally referenced to the ship's geometry.
Following location of the IMU, data was transformed to the IMU as point of origin for
Northings, Eastings, and Elevation. All dimensions provided with reference to the IMU are "offsets."

Report of Sonar Array

Pace 1 of 11 Installation on
age 10 ages .

Westlake-Survey-Report-NOAA-Fairweather-09-23-03.xls NOAA Fairweather



Ship's Centerline - Control Measurements
(Prior to location of IMU and referencing of data to IMU as point of origin (0,0,0)

Westlake Consultants, Inc.

9/23/2003

Defined by measurements at the keel centerline

longitude transverse elevation
near the bow 1190.674 1000.000 135.8672
at the stern (point of origin) 1000.000 1000.000 100.0000
along the keel (approx 180" forward) 1180.121 1000.000 116.6810
Ship's Baseline
Defined by measurements on the keel

longitude transverse elevation
at the stern (point of origin) 1000.000 1000.000 100.0000
and approx. 129' forward of stern 1129.120 999.985 100.0022

Page 2 of 11 Pages

Westlake-Survey-Report-NOAA-Fairweather-09-23-03.xls

Report of Sonar Array
Installation on
NOAA Fairweather



Westlake Consultants, Inc.
9/23/2003

IMU Foundation Plate

EASTING NORTHING ELEVATION
Horizontal alignment per scribed lines
on IMU foundation plate 0.001
0.000

Scribed lines - intersection/centerline of IMU plate
0.000 0.000 0.000

Elevation checks near four corners of IMU Foundation plate *

* elevation check adjusted for target 0.001
that created 10 mm offset =.03281 -0.001
feet 0.000

-0.001

SUMMARY
¢ IMU foundation plate is level to within +/-0.001 feet.
¢ IMU foundation plate is located 12.856 feet above baseline established at the keel.
¢ IMU is parallel to ship's centerline to within +/- 0.001 feet.

Location of scribed centerline intersection is 6.122 feet port of ship's centerline.
¢ IMU foundation plate centerline is located 11.638' feet forward of bulkhead 52.

Report of Sonar Array

Dace 3 of 11 P Installation on
age 30 ages .
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Westlake Consultants, Inc.

9/23/2003
Granite Block
EASTING NORTHING ELEVATION
Horizontal alignment per scribed lines
1.584
1.583
Scribed lines - intersection/centerline of granite block
-0.003 1.583
Deviation
Elevation checks near four corners of granite block from level
* elevation check adjusted for target that created 10 -0.217 -0.001
mm offset = 0.03281 feet -0.217 -0.001
-0.216 0.001
-0.215 0.001

SUMMARY
¢ Granite block is level to within +/-0.001 foot
of average elevation = -0.21632 feet
¢ Granite block is parallel to ship's centerline to within 0.001 foot
Location is 4.54 feet to port of ship's centerline and 1.583 feet starboard of IMU.
¢ Granite block is aligned with IMU to within 0.003 feet longitudinally.

Report of Sonar Array

Dace 4 of 11 P Installation on
age 40 ages .
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Westlake Consultants, Inc.
9/23/2003

Array Acoustical Centers - Referenced to IMU

EASTING NORTHING ELEVATION
PORT ARRAY (81-60) 25.149 1.619 14.956

Explanation of Calculations
Acoustic center is defined as the center of the transmitter array with the
elevation = 83 mm below mounting face of array.

Easting
Center of array is defined by the foundation plate bolt centerlines (1/2 distance between bolts)
27.008 Forward edge of foundation as measured
- 0.104 Forward edge of foundation to centerline of forward bolt hole
- 1.755 Distance from bolt hole centerline to center of array
25.149 feet forward of IMU

Northing
Center of array is defined as the mid-point between the bolt holes on the foundation.
1.369 Port edge of foundation as measured
+ 0.078 Port edge of foundation to centerline of bolt hole - per Cascade General
+ 0.172 Distance from bolt hole centerline to array center
1.619 feet starboard of IMU

Elevation
Per Reson drawing 2148M011_001 the elevation is 83 mm below array mounting surface
14.679 Array foundation elevation as measured.
0.005 Isolation "shim" added between foundation and array
0.272 83 mm below array mounting surface to acoustical center
14.956 feet below IMU

Report of Sonar Array

Dace 5 of 11 P Installation on
age 50 ages .
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Westlake Consultants, Inc.
9/23/2003

Array Acoustical Centers - Referenced to IMU

EASTING NORTHING ELEVATION
STARBOARD ARRAY (81-11) 27.072 9.41 15.042

Explanation of Calculations
Acoustic center is defined as midpoint of the transmitter array in the longitudinal and transverse axes.
The elevation is defined as the center of the receiving array.

Easting

Center of array is defined as 0.235' aft of the forward bolt centerlines on transmitter array foundation
28.563 Forward edge of foundation fixture plate as measured (receiving plate forward edge)
27.349 Forward edge of transmitter array foundation as calculated
- 0.042 Forward edge of foundation to centerline of forward bolt hole - per design
- 0.235 Distance from bolt hole centerline to center of array - per design
27.072 feet forward of IMU

Northing

Center of array is defined as the mid-point between the bolt holes on the transmitter array foundation.
9.410 Centerline of array foundation as measured on scribe - aft section of fixture plate
9.410 feet starboard of IMU

Elevation
Elevation is 0.401 feet above receiver array mounting surface
16.085 Mounting foundation fixture plate as measured.
15.447 Receiver foundation elevation - as calculated
+ 0.005 Isolation "shim" added between foundation and array
- 0.410 Design distance from mounting surface of array to acoustic center
15.042 feet below IMU

Report of Sonar Array

Dace 6.of 11 P Installation on
age 6 0 ages .
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Westlake Consultants, Inc.
9/23/2003

Longitudinal Array Foundation - Port Side

EASTING NORTHING ELEVATION
Horizontal alignment measured at port edge of array foundation
1.369
1.369

Forward edge of array foundation - measured
27.008

Horizontal alignment - calculated to array centerline

Foundation edge is 0.25 feet port of 1.619
array centerline 1.619
deviation from
Elevation checks near four corners of array foundation level (average)
14.680 0.001
14.681 0.002
14.678 -0.001
14.677 -0.002
SUMMARY

o Port longitudinal array foundation average elevation is 14.679 feet.
Variation in elevation is +0.002 to -0.002 feet.

¢ Port longitudinal array foundation is parallel to ship's centerline and 1.369 feet starboard of IMU.
Calculated array centerline is 1.619 feet starboard of IMU

Report of Sonar Array

Dace 7 of 11 Installation on
age 7 0 ages .
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Westlake Consultants, Inc.

9/23/2003
Longitudinal Array Foundation - Starboard Side
EASTING NORTHING ELEVATION deviation from
Horizontal alignment measured on fixture plate scribe - parallel
Design location is 3.292 feet 9.410 0.002
starboard of ship centerline 9.406 -0.002

Forward edge of array foundation fixture plate - measured

28.563
deviation from
Elevation checks near four corners of array foundation "fixture plate" average
16.085 0.000
16.085 0.000
16.084 0.000
16.085 0.000

Calculated locations of longitudinal and transverse array foundations

Forward edge
Receiver (transverse) 28.563
Transmitter (longitudinal) 27.349

difference = 1.214

NOTE: On Transmitter array foundation - from forward edge to center of forward holes = 0.042'
On Receiver array foundation distance from forward edge to center of forward holes = 0.076'

Calculated elevation of longitudinal and transverse array foundations
Receiver/Transverse Foundation 15.446
Transmitter/Longitudinal Foundation 15.709

difference = 0.263

SUMMARY

o Starboard longitudinal array foundation (measured at fixture plate) average elevation is 16.085 feet.
Deviation from level (average elevation) is less than 0.001 feet.

o Starboard longitudinal array foundation averages 9.408 feet starboard of IMU.
Variation from parallel is from -0.002 feet to +0.002 feet from average.

o Starboard longitudinal array foundation forward edge is 28.563 feet forward of IMU.

Report of Sonar Array

Page 8 of 11 P Installation on
age 8 0 ages .
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Transverse Array Foundation - Port Side

EASTING NORTHING

Forward Edge - Transverse array foundation - measured

28.343

28.338
Port edge - Transverse array - measured

-0.181

Centerline of array - calculated
Foundation forward edge minus 28.093
0.25 feet to array centerline 28.088
Port edge of foundation plus 1.806 feet 1.624

to calculated array centerline

Elevation checks near four corners of array foundation

0.861 feet below baseline with 0.965
foot offset = 98.180 feet average
elevation

SUMMARY

ELEVATION

14.679
14.675
14.675
14.677

e Transverse array foundation average measured elevation is 14.677 feet

below IMU (0.006 feet above design location).

Deviation from level (average elevation) is 0.003 to -0.001 feet

Westlake Consultants, Inc.

9/23/2003

deviation from
level
0.002
-0.001
-0.001
0.001

e Transverse array foundation centerline (calculated) averages 28.090 feet forward of IMU.
Variation from parallel to ship's centerline is from -0.003 to 0.003 feet (from average).
e Transverse array centerline is calculated to be 1.624 feet starboard of IMU.

Page 9 of 11 Pages
Westlake-Survey-Report-NOAA-Fairweather-09-23-03.xls
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Westlake Consultants, Inc.
9/23/2003

Transverse Array Foundation - Starboard Side

NOTE: Direct Measurements were not taken to the transverse array because a single "fixture plate" covered b
transmitter and receiver foundations. The data provided here is primarily “calculated".

EASTING NORTHING ELEVATION
Forward edge - as measured on fixture plate
Receiver - (transverse) 28.563
as measured
Transmitter (longitudinal) 27.349

difference = 1.214

NOTE: On Transmitter array foundation - from forward edge to center of forward holes = 0.042'
On Receiver array foundation distance from forward edge to center of forward holes = 0.076'

Horizontal Alignment 9.406
centerline scribe on fixture plate

as measured - forward portion of plate

(near receiver array)

Average of measurements on fixture plate 9.408

Elevation of longitudinal and transverse array foundations

Receiver/Transducer Transverse Foundation 15.446

Transmitter/Longitudinal Foundation 15.709
difference = 0.263

Based on measured elevations averaging 16.085 feet across fixture plate

SUMMARY

e Transverse array foundation is calculated to be 15.446 feet below IMU - calculated from measured elevation
of 16.085 feet. Deviation in elevation measurements across the array fixture plate is less than 0.001 fe

e Transverse array foundation forward edge (measured) is 28.563 feet forward of IMU.

e Transverse array centerline is measured to be 9.406 feet starboard of IMU.

Variation from parallel of the fixture plate across entire starboard array is + 0.002 feet (from average).

Report of Sonar Array

Pace 10 of 11 P Installation on
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Westlake Consultants, Inc.
9/23/2003

Antennae
EASTING NORTHING ELEVATION

Stbd POS MV Antenna -Location -35.866 12.925 -38.209
Port POS MV Antenna - Location -35.739 -0.409 -38.283
Foundation Plate Stack Antenna Alignment 7.677

Foundation Plate Stack Antenna Alignment 7.677

Port GYRO Foundation Plate Alignment 2.41

Port GYRO Foundation Plate Alignment 2.41

Stbd GYRO Foundation Plate Alignment 3.866

Stbd GYRO Foundation Plate Alignment 3.867

SUMMARY

e Foundation plate stack antenna alignment is parallel to ship's centerline.
e Port GYRO Foundation Plate is aligned parallel to ship's centerline.
e Starboard GYRO Foundation Plate is aligned parallel to ship's centerline.

Report of Sonar Array
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Waterline Measurements Fill in Yellow squares only!

Measuring Party: Rice, Argento, Campbell, Beduhn
Waterline Measurements should be Negative!

1010 Date: 4/7/2009 Dn 097

Benchmark A to Waterline Benchmark B to Waterline Fuel Level: 5+
Measure 1 -86.2 -88.5 Draft Tube:
Measure 2 -86.6 -89.2
Measure 3 -87.6 -96.0 Port-to-Stbd Z-difference
Avg (cm) -86.80 -91.23 Theoretical Actual Error
Avg (m) -0.8680 -0.9123 0.0327 -0.0443  -0.0770
Stdev 0.00721 0.04143
BM Z-value (m) -0.02017 -0.05283 BM C to WL Average (m)
BM C to WL (m) -0.888 -0.965 -0.927||(This value added to 1010_Offsets & Measurements_200X.xIs)
Individual -0.88217 -0.93783
measurement -0.88617 -0.94483
StDev for TPU xIs || 0.04986 -0.89617 -1.01283 |lutilized in Offsets and Measurements and TPU spreadsheet If

(of 6 #'s)



the new POS M/V antenna.

This spreadsheet is designed to compute the z-values of the phase centers of

All offsets are in the Theodolite Coordinate System

BME X 1.665536
y -0.892424
z 1.612667
BM F X 1.668082
y -0.001217
z 1.649000
BM G X 1.668115
y 0.957794
z 1.578000

Measuring Party (fill in yellow spaces only):
Rice, Argento, Campbell, Beduhn

Distances

Port Ant to BM 'E' 0.693 0.693
Port Ant to BM 'F' 1.11 1.11
Port Ant to BM 'G' 1.967 1.97
Stbd Ant to BM 'E' 1.959 1.964
Stbd Ant to BM 'F' 1.166 1.167
Stbd Ant to BM 'G' 0.707 0.705
Antenna Post Diameter Radius

0.0255 0.01275

0.693
1.112
1.97

1.962
1.167
0.705

Port Ant X

y

z

Stbd Ant  x

y

z
Date:
4/7/2009

0.70575
1.1234167
1.98175

1.9744167
1.1794167
0.7184167

added.

The distances from the antenna post to each benchmark was measured
three times and averaged. The post offset to phase center (radius) was then

POS MV V4 Installation and Operation Guide

Drawings |

2.316862
_0886431 Phase Cantra 23T CM
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Figure 79: GPS Antenna Footprint
Serial #- Port Serial #- Stbd |
60162863 60145247
z-Values
Ant. Base Phase Center
1.884369 1.930369
1.888889 1.934889
1.902489 1.948489
1.886629 1.932629 AVERAGE
0.0094 STDEV

1.858381 1.904381
1.874221 1.920221
1.870499 1.916499
1.872360 1.918360 AVERAGE

0.0083 STDEV

The distance is 0.046m (4.60cm) from the bottom of the
antenna to the Phase center, obtained from the POSM/V
v4 guide, see image above.




Offsets from Aft Benchmark to Phase Center of Transducer

|79

|Launch 1010

|Campbel|, Argento, Beduhn

3/20/2009
Date DN Vessel Personnel
2701011

Instructions: The purpose of this measurementis to check for
gross movement of the tranducer. Fill in yellow spaces only.

While the boat is in the cradle, gently lower the transducer and
lock it in place. Using a metric tape measure, plumb bob and
carpenter's level, measure the horizontal and vertical offsets from
the aft benchmark (BM H) to the phase center of the transducer.
The phase center is measured at the forward edge of the black
insulating layer, as shown in the photos. If you have trouble
locating the center, borrow a compass from the navigation

Serial Number of Transducer

department.

Notwithstanding a major accident, BM H will be outboard, aft and
higher than the phase center; as such, enter all offsets as positive

numbers (in cm) and the proper signs will be applied.

Once offsets have been measured, apply a digital level to the IMU
to determine any pitch or roll bias in the orientation of the launch.

For the purposes of this spreadsheet, a positive angle (measured
in degrees) will imply the bow is higher than the stern and the port

side is higher than the starboard side.

All measurements should be done in triplicate to aid in the

calculation of the uncertainty (needed in the HVF). The IMU to
Phase Center values will be calculated automatically.

Offset Measurements (positive cm): Average

Bow-Stern 10.6 10.7 11.0 10.8
Port-Stbd 15.9 15.9 15.8 15.9
Up-Down 35.5 35.4 36.0 35.6

BM H to Phase Center

(Theodolite Coordinate System)
X __#REF! cm
y #REF! cm
z #REF! cm

Measured by NOAA Personnel
inserted into Offset Worksheet,

if to be used in IMU to 8101 calculation

Angle Bias (deg):
Bow Up
Port Up

The measuring crew should
insure there will be no yaw bias.

(CARIS Coordinate System)

X #REF! m
y #REF! m
z #REF!I m

Calculated Value for check purposes

.

I_I

Std Dev:
Bow-Stern| 0.16
Port-Stbd 0.05
Up-Down 0.30

These 2009 values were not used for the hvf
offsets due to the angle bias not being entered.
The 2008 values were used instead and the 2009
values were used as a check that the unit had not
been displaced.



1010 Offsets and Measurements - Summary

Measurement |IMU to RP* Port Ant to 8101
aka Nav to Trans x,y,z
Coord. Sys. Caris Caris Caris Caris Caris
X 0.000 0.250 0.250 1.147 n/a
y 0.000 -0.133 -0.133 1.066 n/a
z 0.000 0.549 0.549 3.665 -0.256
*IMU is RP (Reference Pt)
Vessel Offsets for 1010_8101 are derived from the Horizontal, Vertical & XYZ worksheets in this spreadsheet. 2008 Measured Values
Calculations
coord. Sys. [N [ Port Ant to 8101 |
Theodolite IMU (m) X 3.516 IMU (m) X 3.516 IMU (m) X 3.516
y 0.011 y 0.011 y 0.011
z -1.183 z -1.183 z -1.183
BM H X 3.271447 Port Antenna X 2.317 BMC X 0.000
y 0.425598 y -0.886 y 0.000
z -1.37667 z 1.933 z 0.000
IMU x  -0.244 IMU to X -1.199 BM C to IMU
toBM H y 0.415 Port Antenna y -0.897 X n/a
z -0.194 z 3.116 y n/a
z -1.183
BM H to x 11.10496 IMU to X -0.133
Phase Ctr (cm) y| -16.466 Phase Citr y 0.250 BM C to Waterline
measured z -35.540 z -0.549 measured X n/a
y n/a
BM H to x 0.11105 z -0.927
Phase Ctr (m) y -0.16466
z -0.3554
see
Coord. sys. NN [ PotAnosior ] [ RPioWatedne |
Theodolite IMU to X -0.133 X 1.066 X n/a
Phase Ctr y 0.250 y 1.147 y n/a
z -0.549 z -3.665 z 0.256
Coord. Sys. Coord. Sys. Coord. Sys.
X 0.250 X 1.147 X n/a
y -0.133 y 1.066 y n/a
z 0.549 z 3.665 z -0.256




1010 Offsets and Measurements - Summary

Port Ant to Stbd Ant

Scalar Distance 1.839

2009 Measured Values

IMU to Port Antenna IMU to Heave

Caris Pos/Mv Caris Pos/Mv
-0.897 -1.199 -0.011 -1.176
-1.199 -0.897 -1.176 -0.011
-3.117 -3.117 -0.243 -0.243

Values in the POSMV remained as entered in 2008.

2007 Measured Values

Port Ant to Stbd Ant

Port Ant (m) X 2.317
y -0.886
z 1.933

Stbd Ant (m) X 2.324
0.953
1.918

N <

Port Ant to Stbd Ant

Scalar Distance 1.839

IMU to Port Antenna IMU to Heave

IMU (m) X 3.516 IMU (m) y 0.011
y 0.011 X is nfa z -1.183
z -1.183
Heave Pt (m)
Port Ant (m) X 2.317 (centerline) y 0.000
y -0.886
z 1.934 BM C to Waterline (m) -0.940

measured scalar dist

BM C
Xx&y are n/a z 0.000

BM C to Waterline (m)
(Heave PY) z -0.940

IMU to LCG X -1.176
See IMU to Heave tab

IMU to Port Antenna IMU to Heave

X -1.199 X -1.176

y -0.897 y -0.011

z 3.117 z 0.243
Coord. Sys. Coord. Sys.

X -1.199 X -1.176

y -0.897 y -0.011

z -3.117 z -0.243

See IMU to Heave tab




Description of Offsets for Launch 1010

All Values Shown are in CARIS Coordinates

The Ship Reference Frame (SRF) for Launch 1010 was based from benchmark (BM) C as the 0 point. Physical locations were measured with x,y,z offsets
from this point. These locations were used to calculate offsets of items with respect to each other, as described for each offset.
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X y z
0.250 -0.133 0.549

The physical positions of the IMU
and the phase center of the 8101
with respect to the Ship
Reference Frame were
measured by NOAA personnel.
These physical measurements
were used to calculate the xyz
offsets from the IMU to BM H.
Measurements from BM H to the
Phase Center of the 8101 were
collected by NOAA personnel
while the boat was secured on
the pier and thought to be as
level as possible. The measured
offsets from BM H to the phase
center were then added to the
offset from the IMU to BM H.
The result is the offset from the
IMU to the phase center of the
transducer. The values in the X
and Y fields are transposed and
the inverse of the Z value is used
to give the offsets in CARIS
coordinates.

Port Ant to 8101
X y z
1.147 1.066 3.665

NOAA personnel calculated the
distance between the port
antenna and the phase center of
the port antenna subtracting the
IMU to Port Antenna value from
the IMU to Phase Center value.

RP to Waterline
X y z
N/A N/A -0.256

The average vertical distance
from BM A and B to the waterline
was measured by
FAIRWEATHER personnel using
a steel tape and bubble level.
These values were used to
calculate the BM C to the
waterline value. With the
knowledge of the BM C height
above the IMU, the waterline
height above the IMU could be
calculated. On launch 1010, the
IMU is used as the reference
point.

Port Ant to Stbd Ant
Scalar Distance
1.839

The location of the phase center
of the port and starboard
POS/MV antennas were
measured by NOAA personnel
with respect to the SRF. The
scalar distance between the
phase centers was then
calculated.

IMU to Port Antenna

X y z
-0.897 -1.199 -3.117

The location of the IMU and the
location of the port antenna were
measured by NOAA personnel
with respect to the Ship
Reference Frame (SRF). The
xyz offsets from the IMU to the
port antenna could be calculated
from these physical locations.

IMU to Heave

X y z
-0.011 -1.176 -0.243

The heave point was positioned
differently on each of the axes.
The distance for the longitundinal
axis was determined as
described in the "IMU to Heave"
tab in this workbook. The
athwart ships axis was the vessel
centerline. Lastly, the waterline
was used as the height of the
heave point, which was
calculated earlier in 'RP to
Waterline'.




1010 Vessel Diagram

All Values Shown are in Theodolite Coordinates

945 degree list <3
A
. X: -0.005
l ¥: -1.002 5 —
7:-0.020 X: 1.666
Y- 0892 OED v:-0.886
71613 Z:1.958
¥: 0.000 O x
¥: 0.000
Z:0.000 C X: 1.668 F Jz -1.101
(3 ¥:-0.001 EB
oo LD
C >< 3.765
- G Y 0.429
X: 1.668 X: 2,324 ® 3.271 21373
X: -0.004 ¥:0.958 OED ¥:0.953 Y 0.426
7:1.929 7. -1.377

\mm l\ﬂ i
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Note: Both antenna have been replaced for the POS
V4. While their x-y values are not thought to have
changed, the z-value has been remeasured.
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NOAA POS/MV Calibration Report

Fill out all fields! See previous years as an example.

Yellow areas require screen grabs!

Ship: FAIRWEATHER Vessel: 1010
Date: 4/15/2009 Dn: 105
Personnel: W Renoud, L Morgan, T Beduhn
PCS Serial # 2564 IMU Serial # 294
IP Address: 129.100.1.231
Port Antenna Serial # 60162863 Stbd Antenna Serial # 60145247

POS controller Version (Use Menu Help > About)

POS Version (Use Menu View > Statistics)

GPS Receivers
Primary Receiver Serial #:

Secondary Receiver Serial #:

3.4.0.0

MV-320,VER4,S/N2564,HW2.6-7,SW03.42-May28/07,ICD03.25,
0S425B14,IMU2,PGPS13,SGPS13,RTK-0,THV-0,DPW-0

4624A70264

4622A68956

~POS Version

|MV—320.VER4.S!N2564.HW26—15W03.42—May28#0?.ICD03.25‘OS425E3'I4.IMUZPGF’SW 3,5GPS13 RTK-0,THY-0,DPYW-0

~GPS Receivers
Primary Receiver

Secondary Receiver

|BD950 SN:4624A70264, v.00211, channels:24

|BD950 SN:4622A68956, v.00211, channels:24

~Statistics
Total Hours 1315.0
Total Runs 275
Average Run (hours) 4.8
Longest Run (hours) 41.0
Current Run (hours) 4.2

Calibration area
Location: Lake Washington, N of Sandpoint

Approximate Position:

DGPS Beacon Station: Whidbey

Frequency: 302HZ

Lat
Lon

Close
47 43 41
122 16 30

DGPS Receiver Serial#: 0331-12579-0008




Satellite Constellation

(Use View> GPS Data)

Primary GPS Secondary GPS
Insert screen grabs Note any differences from Primary GPS Receiver
L L
Recaiver Status & Frimary GFS Rcaiver Stats
Madde 3D CIA mode. Moda 3-D CIA mode
HDOP 0829 e HDOP 08E1
VDOF 1481 VDOF 1212
Geoidal Separation (m) AT2N 12 e Gecidal Separation (m) 7231
Tirming L] ié ? Tirming
GPSILITC Wk Nurnber 1627 3 - GPSIUTC Weak Number 1827
GPS Time Offsat (se<) 16.000 & 1.3 GPS Time Offsat (sec) 15.000
Mav Message Latency (sec) 0116 w MNav Massage Latenty (sec) oors
Duffiarential GRS Dufferential GRS
Raoference Station LY Reference Stabon MIA
Comaction Latency (sec) 0.000 Comaction Latency (sec) 0.000
PPS
Tirrwe 17:06:36.000000 UTC
Fulse Count 3242 r-
3 [ a 14 18 19 21 22 24 26 sV 3 8 9 14 5 18 19 21 22 24
LiphikeLiphicLiphicLiphicLiphikcLiphikcLliphicliphikcLiphicLiphicLiphic | Siitus fLiphicLiphicLiphicliphicLiphicLiphicLiphicLiphicllphicllphic
2890 2730 1020 1850 540 3150 1080 2450 1080 500 QIAth| 289 0 2720 1020 1850 450 40 3150 1060 2450 1080
43 0 520 80 160 820 220 520 640 100 320 160 230 820 20 520 64.0 10.0
47 & 48 w0 s 470 455 463 E30 TS5 450 400 418 493 428 473 503 385
360 85 183 25 05 45 65 420 175 A0 00 00 00 00 00 00 00
s | |
PDOP 1.736 (Use View> GAMS Solution)

POS/MV Configuration

Settings

Gams Parameter Setup

Configuration Notes:

GAMS Parameter Setup

(Use Settings > Installation > GAMS Intallation)

x|

Two Antenna Separation [m]

Heading Carection [deg)

Heading Calibration Threshold (deal

=7

[ Baseline Vector

# Camponent [m)
% Companent [m)

Z Camponent [m)

| Apply |




POS/MV Calibration

Calibration Procedure: (Refer to POS MV V4 Installation and Operation Guide, 4-25)
Start time:

End time:

Heading accuracy achieved for calibration: 0.091°

Calibration Results:

Gams Parameter Setup (Use Settings > Installation > GAMS Intallation)
n l
5
Twio Antenna Separation (m) IT 833
Heading Calibration Threshald [deg] IEI 300
Heading Corection [deg] ID 000
[ Baseline Yector
# Companent [m] IEI 0o
Y Companent [m] IT 838
Z Camponent [m] IU 037
= Ok | Claze I Apply | Wiew |
GAMS Status Online X
Save Settings X

Calibration Notes:

Save POS Settings on PC (Use File > Store POS Settings on PC)
File Name: 1010_Dn105_POS_Config_new.nvm

General Notes:
The POS/MV uses a Right-Hand Orthogonal Reference System
The right-hand orthogonal system defines the following:

* The x-axis is in the fore-aft direction in the appropriate reference frame.
* The y-axis is perpendicular to the x-axis and points towards the

right (starboard) side in the appropriate reference frame.
» The z-axis points downwards in the appropriate reference frame.

The POS/MV uses a Tate-Bryant Rotation Sequence

Apply the rotation in the following order to bring the two frames of reference
into complete alignment:

a) Heading rotation - apply a right-hand screw rotation 6z about the
z-axis to align one frame with the other.

b) Pitch rotation - apply a right-hand screw rotation 8y about the
once-rotated y-axis to align one frame with the other.

c) Roll rotation - apply a right-hand screw rotation 6x about the
twice-rotated x-axis to align one frame with the other.




SETTINGS
Input/Output Ports
CcoMm1

com2

COoM3

COom4

COMS5

(Use Settings > Input/Output Ports)




SETTINGS Continued

Heave Filter (Use Settings > Heave)
Heave Filter k x|

Heave Bandwidth (sec) (20.000
Damping Ratio 0.707

=l Ok I Close | Apply |

Events (Use Settings > Events)

x|

I

—Event 1 Ly

i Positive Edge Trigger

" Negative Edge Trigger

—Event

+ Positive Edge Trigger

" MNegative Edge Trigger

Close | Apply |

Time Sync (Use Settings > Time Sync)

|:| User Time Conversion (Units/Sec.)

INSTALLATION (Use Settings > Installation)
Lever Arms and Mounting Angles (Use Settings > Installation > Lever Arms and Offsets)
|
Lever Arms & Mounting Angles I Sensor Mounting I Tags, Multipath & AutnStanl
—Ref. to MU Lever Arm———— IMU Frame w.rt. Ref. Frame—————
A |0.000 # (deg) 0.000
Y [oooo ¥ (deg) 0,000
Ziml oo 7 (ded) oo

—Ref. to Primary GPS Lever Arm- ~Ref. to Vessel Lever Arm

Xfm) 1199 X {rn) 0.000
W) |0897 ¥ (m) 0,000
Zm [3117 Z (m pooo
Motes: —Ref. to Centre of Rotation Lever Arm—
; Ref = R\‘a’:’f:a;;e;ce T % () 1176
wert ="With Respect To .
3. Reference Frame and Yessel ¥ {m) 001
Frame are co-aligned Zi{m) -0.243

Aoply Wiew

In Mavigation Mode . to change parameters go to Standby Mode !

Tags, Multipath and Auto Start (Use Settings > Installation > Tags, Multipath and Auto Start)
x|
Lever Arms & Mounting Angles | Sensar Mounting  Tags, Mulipath & AutoStart I
—Time Tag 1 Multipath
 POS Time Loy
" GPS Time ! Iediurm S
@ UTC Time = High
Time Tag 2
@ POS Time
© GPE Time
© UTC Time
" User Time
—AutoStart
© Disabled
& Enabled
= [k Aoply Wiew

In Mavigation Mode . to change parameters go to Standby Mode !




Sensor Mounting (Use Settings > Installation > Sensor Mounting)

Lever Arms & Mounting Angles x|
Lever Arms & Mounting Angles  Sensor Mounting |Tag5, Multipath & AutnStanl

Ref. to Aux. 2 GPS Lever Arm

Ref. to Aux. 1 GPS Lever Arm—

Wim)  |0.000 % frmi) 0.000
¥ {m) |0.000 ¥ {m) 0.000
Z(m) o000 Z(m) 0.000

Ref. to Sensor 1 Lever Arm —Sensor 1 Frame w.rt. Ref Frame

®{m)  |0.000 ® (deg) i0.000
¥ () |0.000 T (deg) i0.000
Zm  [oooo Z (i) o.000
Ref. to Sensor 2 Lever Arm Sensor 2 Frame wert. Ref. Frame
i) |0.000 X (deg) 0.000
¥  |0.000 W {deg) 0.000
Zim)  [o'ooo Z (deg) 0000
= [k Aoply Wiew

In Mavigation Mode . to change parameters go to Standby Mode !

User Parameter Accuracy (Use Settings > Installation > User Accuracy)

B
RMS Accuracy
Attitude (deg) i0.050
Heading (deg)  |0.050
Pasition () 2.000
“elocity (m/s) IEI.SDD
Close | Apply |
Frame Control (Use Tools > Config)
User Frame Primary GPS Measurement
IMU Frame Auxiliary GPS Measurement

|:|Use GAMS enabled

GPS Receiver Configuration (Use Settings> Installation> GPS Receiver Configuration)

Primary GPS Receiver

Secondary GPS Receiver

i
Primary GPS Receivar |Secundary GPS Hecewerl
—Primary GPS———— GPS 1 Port
GPS Output Rate Baud Rate
1 Hz =] | fesno |
Parity Data Bits Stop Bits
9 (e C 7Bits | | & 16t
rAuta Configuration  Even
& Enabled  Odd 1+ 8 Bits 2 Bits
" Disablad
ak | Apply |
x
Primary GPS Receiver Secondary GPS Receiver |
Secondary GPS 5PS 2 Port
GPS Output Rate Baud Rate
1 Hz =l | fesno =
Parity Data Bits Stop Bits:
& Mone C 7Bits | | & 1Bit
Auto Configuration " Even
@@ Enabled ~ Odd = 8 Bits 2 Bits
© Disabled
Ok Apply




FAIRWEATHER
Multibeam Echosounder Calibration

4/17/2009  ]107

Launch 1010

Vessel

|Lake Washington, Seattle, Washington

Date Dn Local Area

Rice, Beduhn, Forney, Marcum

Calibrating Hydrographer(s)

Reson 8101 Jswing Arm-Hull Mount

Jnot available

MBES System MBES System Location

2701011

Date of most recent EED/Factory Check

|35737

Sonar Serial Number

Swing Arm

Processing Unit Serial Number

|3/20/2009

Sonar Mounting Configuration

DGPS - Woodby Island

Date of current offset measurement/verification

J4/15/2009

Description of Positioning System

Acquisition Log

Date of most recent positioning system calibration

4/17/2009]107 |Lake Washington |5-10kt, >1ft
Date Dn Local Area Wx
J10m-80m

Bottom Type

Marcum, Rice, Forney, Beduhn

Approximate Water Depth

Personnel on board

Beacon: 302 Hz Whidbey, MBES lines 2009__1071850_1 through 2009__1072047_5, 24 lines collected

Comments

TH_1010_107

TrueHeave filename

09107175_4616.5nv Jo:00 J47/39/01.97 |122/16/17.32 |51 |

SV Cast #1 filename UTC Time Lat Lon Depth Ext. Depth
09107202.3nv Jo:00 |47/39/15.82 |122/15/31.53 |51 |

SV Cast #2 filename UTC Time Lat Lon Depth Ext. Depth
09107210.0nv Jo:00 J47/39108.84 |122/14/06.18 Jis Je0

SV Cast #3 filename UTC Time Lat Lon Depth Ext. Depth



view parallel to track, one line with induced roll (outerbeam) or same lines bounded slope (nadir)
NAV TIME LATENCY [same direction, different speed)]

SV Cast# |XTF Line Filename Heading Speed (kts) |Remarks
1]2009_1071923_1 271 5.4
1]2009_1071925_1 093 5.1
1]2009_1071927_1 272 5.0
1]2009_1071929 1 091 5.0
1]2009_1071914_1 272 2.9
1]2009_1071917_1 090 2.7
1]2009_1071931_1 272 2.5
PITCH view parallel to track, same line (at nadir) [opposite direction, same speed)]

SV Cast# |XTF Line Filename Heading Speed (kts) |Remarks
1]2009_1071850_1 272 4
1J2009_ 1071910_1 92 4
1]2009__1071905_1 93 4
1J2009__1071907_1 271 4
1]2009 1071903 1 270 4

HEADING/YAW view parallel to track, offset lines (outerbeams) [opposite direction, same speed]

SV Cast# |XTF Line Filename Heading Speed (kts) |Remarks
1[2009 1071945 _4 272 4]N
1]2009__1071938_4 272 4IN
1[2009 1071935 _4 94 4]N
1J2009_ 1071941 _4 93 4IN
1]2009_1071955_2 092 4]s
1J2009__ 1071959_2 272 41S
1]2009 1071949 2 092 4]s
1J2009__1071952_2 272 41S

ROLL view across track, same line [opposite direction, same speed]

SV Cast# |XTF Line Filename Heading Speed (kts) |Remarks
2]2009__1072043_5 04 3.8
2]2009__1072039_5 183 3.5
2]2009__1072047_5 184 3.5
2]2009__1072035_5 03 3.9




Processing Log

4/18/2009  |108 Jwelton
Date Dn Personnel

Data converted --> HDCS_Data in CARIS

TrueHeave applied

SVP applied

Tide applied

Zone file na

Lines merged

Data cleaned to remove gross fliers [ ]

Compute correctors in this order

1. Precise Timing 2. Pitch bias 3. Heading bias 4. Roll bias

Do not enter/apply correctors until all evaluations are complete and analyzed.

PATCH TEST RESULTS/CORRECTORS

Evaluators Latency (sec) Pitch (deg) Roll (deg) Yaw (deg)
FOO Ringel -0.05 0.20 1.50 0.50
B. Welton 0.02 -0.35 1.50 0.35
G. Rice 0.01 0.43 1.48 0.28
N.Morgan 0.06 1.48
A. Raymond 0.02 0.00 1.46 0.20
CST Morgan 0.00 -0.40 1.48 0.60
Averages 0.01 -0.02 1.48 0.39
Standard Deviation 0.04 0.36 0.04 0.02 0.16 0.08
FINAL VALUES 0.00 -0.02 1.48 0.39
Final Values based on averages with outliers removed

Resulting HVF File Name FA_1010_Reson8101_2009.hvf

Actual values used

MRU Align StdDev
MRU Align StdDev gyro 016 Value from standard deviation of Heading offset values 0.075 gyro

MRU Align StdDev
MRU Align StdDev Roll/Pitch 019 Value from averaged standard deviations of pitch and roll offset values 0.025 Roll/Pitch

NARRATIVE
Lines from Dn108 (2009_1081822_11 through 2009_1082211_2) were also utilized to assess patch test values.
Dn108 did not have True Heave applied as the Pos file was not logged, therefore a full patch write-up was not conducted.

Removed N. Morgan pitch (-1.6 deg) and yaw (1.62) values from the averages as outliers.

Initial MRU values were too high, TPU values reassessed with outliers removed.

HVF Hydrographic Vessel File created or updated with current offsets

Name: CST/FOO/Welton Date: 04/24/09




Ellipsoid Referenced Dynamic Dratft Launch 1010

4/17/2009 107 Lake Washington Rice
Date DN Local Area Processor
SEAI TH_1010_107.000.002 1018 ERDDM.txt
Primary Station POSPac File SBET File
proc_erddm.py, v0.12 4
Processing Method Coefficients
measurements
— best-fit pol
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Speed (m/s) Delta Draft (m)
0.00 0.00
0.50 -0.05
1.00 -0.07
1.50 -0.06
2.00 -0.03
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3.00 0.01
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1.00 0.02
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Dynamic Draft Comparison 2009-ERDDM-Descrete
2008
0.2 —— 2007
0.15 —e— 2006
0.1 vand~
A0.05
£
: 0 \ \ \ \ \
8 0 2 4 5 o 7 8
20.05 \/ > :
-0.1
-0.15
-0.2
Speed (m/s)
2009 HVF Values
|2009-ERDDM-Descrete |
speed (m/s)|draft (m)
0 0
0.5 -0.05
1 -0.07
1.5 -0.06
2 -0.03
2.5 -0.01
3 0.01
3.5 0.02
4 0.02
4.5 -0.01
5 -0.05
55 -0.1
6 -0.17
2008 2006
speed (m/s) |draft (m) speed (m/s) |draft speed (m/s) |draft
0 0 0 0 0 0
2.68 0.08 2.58 -0.041 2.385 -0.07
3.81 0.11 3.1 -0.031 3.205 -0.03
4.68 0.17 3.98 0.023 4.2 -0.02
5.92 0.08 4.6 0.053 5.065 -0.01
5.17 0.102 6.29 -0.03
5.37 0.089




Reference Surface Acquisition Log Launch 1010

Vessel
4/18/2009] 108]Shilshole Reference Surface |<1ft, <Skts
Date Dn Local Area Wx
Andrews, Rice, Beduhn, Raymond
Personnel
Comments
09108172.7nv |1727 |47/40/27.300 |122/25/35.70 |34 |44.2
SV Cast #1 filename UTC Time  Lat Lon Depth Ext. Depth
09108211.0nv J2110 |47/40/30.96 |122/25/31.12 |37.1 J48.2
SV Cast #2 filename UTC Time Lat Lon Depth Ext. Depth
SV Cast#  XTF Line Filename Heading Line Type Remarks
2110 2009 1082123 3 240]ref east-west
2009 1082126 7 061|ref east-west
2009 1082128 8 240]ref east-west
2009 1082130 5 061|ref east-west
2009 1082132 4 240]ref east-west
2009 1082135 9 061|ref east-west
2009 1082137 _9 ref north-south
2009 1082139 10 ref north-south
2009 1082142 11 ref north-south
2009 1082146 12 ref north_south
2009 1082149 13 150|ref north-south
2009 1082151 1 345|ref north-south
2153 155]ref north-south
2155 345|ref north-south
2158 161|ref north-south
2009_1082207_1 132|Heading
2009 1082208 1 312|Heading
2009_1082210_2 132|Heading
2009 1082211 2 312|Heading




Measurement Port Ant to 8125 Port Ant to Sthd Ant IMU to Port Ant
aka Nav to Trans x,y,z

Coord. Sys. Caris Caris Caris

X -0.396 0.502 n/a Scaler Distance 1.834 -0.898

y 0.982 2.082 n/a -1.101

z 0.751 3.919 -0.333 -3.161

-1.101
-0.898
-3.161

Caris

0.015]
-1.114

-0.336

-1.114
0.015
-0.336

Vessel Offsets Horizontal Vertical & XYZ worksheets in this spreadsheet. 2009 Measured Value
Calculations
Coord. Sys. Port Ant to 8125
Theodolite  IMU (m) X 3.54587 IMU (m) x 3.545867
y -0.01516 y -0.01516
z -0.85883 z -0.85883
BMH X 3.30204 Port Ant (m) X 2.445
y 0.43081 y  -0.913
z -1.0485 z 2.309
IMU x  -0.244 IMU to x  -1.101
toBMH y 0.446 Port Antenna y -0.898
z -0.190 z 3.168
BM H to x 122.533 IMU to X 0.982
Phase Ctr (cm) y -84.216 Phase Ctr y -0.396
measured z -56.133 z -0.751
BM H to X 1.225
Phase Ctr (m) vy -0.842
z -0.561
Coord. Sys. Port Ant to 8125
Theodolite  IMU to X 0.982 X 2.082
Phase Ctr y -0.396 y 0.502
z -0.751 z  -3.919
Coord. Sys. Coord. Sys.
x| -0.396 X 0.502
y| 0.982 y 2.082
z 0.751 z 3.919




Description of Offsets for Launch 1018
All Values Shown are in CARIS Coordinates
The Ship Reference Frame (SRF) for Launch 1018 was based from benchmark (BM) C as the 0 point. Physical locations were measured with x,y,z offsets from this point. These locations

were used to calculate offsets of items with respect to each other, as described for each offset.
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X y z
0.282] -0.145]  0.548|

X y z
-0.396]  0.982] 0.751]

The physical positions of the IMU
and the phase center of the 8101
with respect to the Ship
Reference Frame were
measured by NOAA personnel.
These physical measurements
were used to calculate the xyz
offsets from the IMU to BM H.
Measurements from BM H to the
Phase Center of the 8101 were
collected by NOAA personnel
while the boat was secured on
the pier and thought to be as
level as possible. The measured
offsets from BM H to the phase
center were then added to the
offset from the IMU to BM H.
The result is the offset from the
IMU to the phase center of the
transducer. The values in the X
and Y fields are transposed and
the inverse of the Z value is used
to give the offsets in CARIS
coordinates.

| Port Ant to 8101 |
X y z
1.181 0.955 3.717

X y z
0.502 2.082 3.919

NOAA personnel calculated the
distance between the port
antenna and the phase center of
the port antenna subtracting the
IMU to Port Antenna value from
the IMU to Phase Center value.

X

| vy | z
N/A| N/A|  -0.333]

The average vertical distance
from BM A and B to the waterline
was measured by
FAIRWEATHER personnel using
a steel tape and bubble level.
These values were used to
calculate the BM C to the
waterline value. With the
knowledge of the BM C height
above the IMU, the waterline
height above the IMU could be
calculated. On launch 1018, the
IMU is used as the reference
point.

Port Ant to Sthd Ant

Scalar Distance
1.834

The location of the phase center
of the port and starboard
POS/MV antennas were
measured by NOAA personnel
with respect to the SRF. The
scalar distance between the
phase centers was then
calculated.

IMU to Port Antenna
y

IMU to Heave
X y

X Y4
[ -0.898] -1.101] -3.161]

Y4
[ 0015 -1.114] -0.336|

The location of the IMU and the
location of the port antenna were
measured by NOAA personnel
with respect to the Ship
Reference Frame (SRF). The
xyz offsets from the IMU to the
port antenna could be calculated
from these physical locations.

The heave point was positioned
differently on each of the axes.
The distance for the longitundinal
axis was determined as
described in the "IMU to Heave"
tab in this workbook. The
athwart ships axis was the vessel
centerline. Lastly, the waterline
was used as the height of the
heave point, which was
calculated earlier in 'RP to
Waterline'.




1018 Vessel Diagram

All Values Shown are in Theodolite Coordinates
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Measure 1
Measure 2
Measure 3
Avg (cm)
Avg (m)
Stdev

BM Z-value (m)
BM C to WL (m)

Individual
measurement

Waterline Measurements
Measuring Party: Rice, Argento, Campbell, Beduhn
Waterline measurements should be negative!

1018
Benchmark A to Waterline Benchmark B to Waterline
-80.8 -81.0
-81.3 -82.1
-81.1 -81.9
-81.07 -81.67
-0.8107 -0.8167
0.00252 0.00586
0.29933 0.27567
-0.511 -0.541

StDev for TPU xlIs || 0.016742

(of 6 #'s)

Measure 1
Measure 2
Measure 3
Avg (cm)
Avg (m)
Stdev

BM Z-value (m)
BM C to WL (m)

Individual
measurement
StDev for TPU xls
(of 6 #'s)

-0.50867
-0.51367
-0.51167

Measuring Party: Raymond, Welton

-0.53433
-0.54533
-0.54333

1018
Benchmark A to Waterline Benchmark B to Waterline
-82.4 -82.2
-82.3 -82.2
-82.0 -81.1
-82.23 -81.83
-0.8223 -0.8183
0.00208 0.00635
0.29933 0.27567
-0.523 -0.543

0.011572

-0.52467
-0.52367
-0.52067

-0.54633
-0.54633
-0.53533

Fill in Yellow squares only!

Date: 4/7/2009
Fuel Level: 0.75
Draft Tube:

Port-to-Stbd Z-difference
Theoretical Actual Error

0.0237 -0.0060  -0.0297

BM C to WL Average (m)

|| -0.526(|(Add this value to 1018_Offsets & Measurements_200X.xls)

|[utilized in Offsets and Measurements and TPU spreadsheet I

Date: 4/16/2009
Fuel Level: half full
Draft Tube: na

Port-to-Stbd Z-difference
Theoretical Actual Error

0.0237 0.0040 -0.0197

BM C to WL Average (m)
-0.533 (or add this value to 1018_Offsets & Measurements_2008)




centers of the new POS M/V antenna.

This spreadsheet is designed to compute the z-values of the phase

All offsets are in the Theodolite Coordinate System

BME x 1.825761
y -0.861405
z 2.018667

BM F X 1.826865
y -0.002043
z 2.054333

BM G x 1.828354
y 0.918931
z 1.998333

Measuring Party (fill in yellow spaces only):

Rice, Argento, Campbell, Beduhn

Distances

Port Ant to BM 'E' 0.652
Port Ant to BM 'F' 1.109
Port Ant to BM 'G' 1.941
Stbd Ant to BM 'E' 1.884
Stbd Ant to BM 'F' 1.111
Stbd Ant to BM 'G' 0.648
Antenna Post Diameter

0.0255

0.652
111
1.945

1.882
1.112
0.647

Radius
0.01275

0.653
1111
1.943

1.889
1.113
0.647

POS MV V4 Installation and Operation Guide

Drawings

Port Ant  x  2.445325
y -0.913449 Phase Centra ssrem
z  Unknown
Y
Stbd Ant  x  2.444676 N "T"‘ \
y 0.920569 (’f +1“-*\! . ! \J
z Unknown T EIIIL f /
Y A 2
460 CM \\‘_\_'__/

Figure 79: GPS Antenna Footprint

Date: Serial #- Port Serial #- Stbd |
4/7/2009 60145158 60130644
z-Values
Ant. Base Phase Center
0.665083 2.254818 2.300818
1.12275 2.272081 2.318081
1.95575 2.292759 2.338759
2.263449 2.309449 AVERAGE
0.019 STDEV
1.89775 2.225956 2.271956
1.12475 2.233664 2.279664
0.660083 2.234669 2.280669
2.234166 2.280166 AVERAGE
0.005 STDEV

then added.

The distances from the antenna post to each benchmark was measured
three times and averaged. The post offset to phase center (radius) was

The distance is 0.046m (4.60cm) from the bottom of
the antenna to the Phase center, obtained from the
POSM/V v4 guide, see image above.




Offsets from Aft Benchmark to Phase Center of Transducer

3/20/2009 |79 |Iaunch 1018 |Campbell, Argento, Rice, Beduhn

Date DN Vessel Personnel
3102026

Serial Number of Transducer

Instructions: The purpose of this measurement is to check for
gross movement of the tranducer. Fill in yellow spaces only.

While the boat is in the cradle, gently lower the transducer and
lock it in place. Using a metric tape measure, plumb bob and
carpenter's level, measure the horizontal and vertical offsets from
the aft benchmark (BM H) to the phase center of the transducer.
The phase center is measured at the forward edge of the black
insulating layer, as shown in the photos. If you have trouble
locating the center, borrow a compass from the navigation
department.

Notwithstanding a major accident, BM H will be outboard, aft and
higher than the phase center; as such, enter all offsets as positive
numbers (in cm) and the proper signs will be applied.

Once offsets have been measured, apply a digital level to the IMU
to determine any pitch or roll bias in the orientation of the launch.

For the purposes of this spreadsheet, a positive angle (measured
in degrees) will imply the bow is higher than the stern and the port
side is higher than the starboard side.

All measurements should be done in triplicate to aid in the
calculation of the uncertainty (needed in the HVF). The IMU to
Phase Center values will be calculated automatically.

Offset Measurements (positive cm): Average

Bow-Stern 8.7 8.7 8.8 8.7
Port-Stbd 15.9 15.9 15.8 15.9
Up-Down 35.5 35.4 36.0 35.6

BM H to Phase Center

Angle Bias (deg): Std Dev:

Bow Up Bow-Stern 0.06
Port Up Port-Stbd 0.06
The measuring crew should Up-Down 0.32

insure there will be no yaw bias.

(Theodolite Coordinate System) (CARIS Coordinate System)
X 8.733 cm X 0.287 m
y -15.867 cm y -0.156 m
z_ -35.633 cm z 0.546 m
Measured by NOAA Personnel Calculated Value for check purposes
inserted into Offset Worksheet, * see Math Explanation tab

if to be used in IMU to 8101 calculation

These 2009 values were not used for the hvf
offsets due to the angle bias not being
entered. The 2008 values were used instead
and the 2009 values were used as a check
that the unit had not been displaced.



Offsets from Aft Benchmark to Phase Center of Transducer

4/29/2009 |119 |Iaunch 1018 |Argento, Andrews, Foster, Nuckols

Date DN Vessel Personnel
4400007

Serial Number of Transducer

Instructions: The purpose of this measurement is to check for
gross movement of the tranducer. Fill in yellow spaces only.

While the boat is in the cradle, connect the 8125 sled with the
sonar head attached. Using a metric tape measure, plumb bob
and carpenter's level, measure the horizontal and vertical offsets
from the aft benchmark (BM H) to the phase center of the
transducer. The phase center is measured at the center middle of
the black insulating layer below the flat faced transducer, as
shown in the photos. If you have trouble locating the center,
borrow a compass from the navigation department.

Notwithstanding a major accident, BM H will be outboard, aft and
higher than the phase center; as such, enter all offsets as positive
numbers (in cm) and the proper signs will be applied.

Once offsets have been measured, apply a digital level to the IMU
to determine any pitch or roll bias in the orientation of the launch.

For the purposes of this spreadsheet, a positive angle (measured
in degrees) will imply the bow is higher than the stern and the port
side is higher than the starboard side.

All measurements should be done in triplicate to aid in the
calculation of the uncertainty (needed in the HVF). The IMU to
Phase Center values will be calculated automatically.

Offset Measurements (positive cm): Average

Bow-Stern 123.2 122.0 122.4 122.5
Port-Stbd 84.2 84.4 84.1 84.2
Up-Down 55.7 56.2 56.5 56.1

BM H to Phase Center
(Theodolite Coordinate System)

x| 122,533 cm
y._ -84.233 cm
z  -56.133 cm

X

y

z

Figurs 3 - Transducer array outline dimensions

Angle Bias (deg):
Bow Up -0.5
Port Up -2.0

The measuring crew should
insure there will be no yaw bias.

(CARIS Coordinate System)

-0.396 m
0.982 m
0.751 m

Measured by NOAA Personnel
inserted into Offset Worksheet,

Calculated Value for check purposes
* see Math Explanation tab

if to be used in IMU to 8101 calculation

Std Dev:

Bow-Stern 0.61
Port-Sthd 0.15
Up-Down 0.40
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NOAA POS/MV Calibration Report

Fill out all fields! See previous years as an example. Yellow areas require screen grabs!

Ship: FAIRWEATHER Vessel: 1018
Date: 4/15/2009 Dn: 104

Personnel: Andrews, Welton, Forney, Shetler

PCS Serial # 2560 IMU Serial #

007
IP Address: 129.100.1.231
Port Antenna Serial # 60145158 Stbd Antenna Serial # 60130644

POS controller Version (Use Menu Help > About) 3.4.0.0
POS Version (Use Menu View > Statistics) MV-320,Ver 4
GPS Receivers

Primary Receiver Serial #: 4624A70243

Secondary Receiver Serial #: 4624A70263

POS Version
Mv-320 VERS, S/NZE60 HWW2 B-7, SW03 42-May26/07 |C003.25, 05425014 [MU2 PGPS13 SGPS13 RTH-0,THY-0 DFW-0

GRS Receivers
Primary Receiver I
BOY950 SN:4624A470243,v.00211, channels; 24

Secondary Receiver
BD950  SN:4624AT70263, v.00211, channels: 24

Statistics

Total Hours 1383.5
Total Runs 300
Average Run (hours) 46
Longest Run (hours) 93.0
Current Run (hours) 08

Calibration area
Location: Lake Washington, Seattle, WA

Approximate Position: Lat 47 39 35.8
Lon 122 15 35.6
DGPS Beacon Station: Whidbey Island DGPS Receiver Serial#: 0328-12352-0001

Frequency: 302



Satellite Constellation (Use View> GPS Data)

Primary GPS Secondary GPS

PDOP 1.823 (Use View> GAMS Solution)

POS/MV Configuration

Settings
Gams Parameter Setup (Use Settings > Installation > GAMS Intallation)
GAMS Parameter Setup gl
Two &ntenna Separation [m) 1-831
Heading Calibration Thieshold (deg) 0500
Heading Carrection [deg] 0000
Bascling Vector
* Companent (m) 0,004
¥ Companent (m) 1.831
Z Component (m) 0.028
[ a ] e | s | v |

Configuration Notes:

POS/MV Calibration

Calibration Procedure: (Refer to POS MV V4 Installation and Operation Guide, 4-25)

Start time: 1722 UTC
End time: 1723 UTC
Heading accuracy achieved for calibration: 0.324

Calibration Results:

Gams Parameter Setup (Use Settings > Installation > GAMS Intallation)

Two Antenna Separation [m] 1.632
Heading Calibration Threshold (deg) 0.500
Heading Canection [deg) 0.000
Baseline Vector

% Component (] 006
v Component (m] 1.631
Z Component (m) 0.026

& [ h ] Close ‘ dpply | view |

GAMS Status Online Ready Online
Save Settings Yes

Calibration Notes:

Save POS Settings on PC (Use File > Store POS Settings on PC)
File Name: C:\Documents and Settings\1018acq\Desktop\POS-MV Settings\GAMS_Parameter_104_2009.nvm




General Notes:

The POS/MV uses a Right-Hand Orthogonal Reference System
The right-hand orthogonal system defines the following:
« The x-axis is in the fore-aft direction in the appropriate reference frame.
« The y-axis is perpendicular to the x-axis and points towards the
right (starboard) side in the appropriate reference frame.
* The z-axis points downwards in the appropriate reference frame.

The POS/MV uses a Tate-Bryant Rotation Sequence

Apply the rotation in the following order to bring the two frames of reference
into complete alignment:

a) Heading rotation - apply a right-hand screw rotation 8z about the
z-axis to align one frame with the other.

b) Pitch rotation - apply a right-hand screw rotation 8y about the
once-rotated y-axis to align one frame with the other.

c) Roll rotation - apply a right-hand screw rotation 8x about the
twice-rotated x-axis to align one frame with the other.




SETTINGS
Input/Output Ports
COM1

Ccom2

CcOomM3

(Use Settings > Input/Output Ports)

Input/Output Poris Set-up

com1 |comz | com3 | comd | coms |

Parity Data Bits ~Stop Bits- -Flow Contral
Baud Rate & None = & None
EEn] = 7 Bits & 1 Bit
" Even " Hardware
© Odd 8 Bits ¢ 2Bits £ XOM/KOFF
MMWEA Output
Output Select £ Undate R Ruoll Positive Sense
I $INGST e | pdate Rate * Port Up " Starboard Up
S L FINGGA THz =
~ §INHDT Pitch Positive Sense
§INZDA = & Bow Up " Starn Up
Talker ID
FINVTG m Heave Positive Sense
EPASHR . w @ Heave Up " Heawe Down
Input Select
Mone 52
Ciose | Aoty |
Inp itput Ports Set-up R
comi [COMZ | com3 | com4 | coms |
Parity Data Bits ~Stop Bits- -Flow Contral
Baud Rate & Maone - 7 Bit & 1 Bit & Mong
T i ‘
" Even " Hardware
© Odd 8 Bits ¢ 2Bits £ XOM/KOFF
Binary Output
Output Select ) j : FE— Roll Positive Sense
it it .
’m ESEHE Eii2 = & Sensorl * Port Up " Starboard Up
= ] F Sensor? Pitch Positive Sense
& Bow Up " Starn Up
Farmula Select = e
pave Pogitive Sense
|TSSW j @ Heave Up " Heawe Down
Input Select
Mone 52
Close | Apply J
Inp itput Ports Set-up
comi | comz [COME | comd | coms |
Parity Data Bits ~Stop Bits- -Flow Contral
Baud Rate & Maone - 7 Bit & 1 Bit & Mong
EET i ‘
" Even " Hardware
© Odd 8 Bits ¢ 2Bits £ XOM/KOFF

Output Select

Mone o

Input Select

Base 1 GPS  ~

Base GPS Input

Input Type |RTCM 1 or 9 =
Line i
& Serial ¢ Modem o Adlily)

Close | Apply




SETTINGS Continued
Heave Filter

Heave Filter

(Use Settings > Heave)

Heave Bandwidth (sec) [20000

Damping Ratio

| ok]

Close I

0.707

Apply J

Events
Events
“Event 1
& Puositive Edge Trigger

© Negative Edge Trigger
~Event 2

@ Positive Edge Trigger
© Negative Edge Trigger

Close |

(Use Settings > Events)

%]

Apply I

INSTALLATION

Lever Arms and Mounting Angles
Lever Arms & Mounting Anglaks
Lewer Arms & Mounting Angles ] Sensor Mounting

Ref to IMU Lever Arm

IMU Frame wert. Ref Frame

(Use Settings > Installation)

(Use Settings > Installation > Lever Arms and Offsets)
]

] Tage, Multipath & AutUStartl

x(m [oooo X (deg) 0.000

Yim o faood i o000

20 o000 < (deg) oo

Ref. to Primary GPS Lever Arm-| - Ref. to Wessel Lever Arm

() -1.101 X (m) 0.000

¥ (m) 0898 ¥ () 0.000

Zm) L3161 Zim) 0.000

Motes: Ref to Centre of Rotation Lever Arm—
;. REf.I: R;Jﬁ;e;ce i ¥ () L1114

w.rt. = With Respect To e
3. Reference Frame and Wessel L) S
Frarme are co-aligned Zm) -0.336
= Ok Apply I i |

Tags, Multipath and Auto Start

Lever Arms & Mounting Angles

Lewer Arms & Mounting AnglE{«a\\\i Sensor Mounting

Time Tag 1
 POE Time

" GPE Time
& UTC Time

Multipath
o

Fall
r
Time Tag 2

« POS Time

 GPS Time

© UTC Time

" User Time

AutoStart

" Disabled

+ Enabled

(Use Settings > |

3]

nstallation > Tags, Multipath and Auto Start)

Tags. Multipath & AutoStart ]

Apply

Wigw




Sensor Mounting (Use Settings > Installation > Sensor Mounting)

3]

Lever Arms & Mounting Angles

Lewver Arms & Mounting Angles  Sensor Mounting ]Tﬁgs, Multipath & AutnSIan}
Ref. to Aux. 1 GPS Lever Arm Ref. to Aux. 2 GPS Lever Arm
¥igw)  pooo ¥ () oo
Yim o [pooo Y () 0000
Zim)  [oooo Z m) 0000
Ref. to Sensor 1 Lever Arm Sensor 1 Frame wert. Ref Frame
¥ge) oo ¥ (deg) oo
Y [pooo ¥ (deg) 0.000
I [pooo Z (dag) 0.000
Ref. 1o Sensor 2 Lever Arm Sensor 2 Frame we.rt. Ref Frame
¥ge) oo ¥ (deg) oo
Y [oooo Y (deg) o000
I fpooo I (deg) 0.000

o ok ] " Close | Apply I View |

User Parameter Accuracy (Use Settings > Installation > User Accuracy)

User Parameter Accuracy

RMS Accuracy

Attitude (deg) ,EIEIEEI—
Heading (deg) ,ﬁﬂ—
Paosition (m) '2EIEIEI7
Velocity (m/fs) ’EIEDU7

Close J Apply J

GPS Receiver Configuration (Use Settings> Installation> GPS Receiver Configuration)

Primary GPS Receiver

Primary GPS Receiver | Secondary GPS Recetver |

Primary GPS GPS 1 Port

GPS Output Rate Baud Rate

1 Hz =] | | |e600 ~|

Parity- Data Bits Stop Bits

; S 2l C7Bls | ® 1Bt
-Auto Configuration-  Even

& Enabled ~ dd « & Bits 2 Bits
" Disabled

ok ] cose | mpoy |

Secondary GPS Receiver

Primary GPS Receiver Secondary GPS Recever ]

Secondary GPS GPS 2 Port

GPS Output Rate Baud Rate

1 Hz =] | | |e600 ~|

Parity- Data Bits Stop Bits

; S 2l C7Bls | ® 1Bt
-Auto Configuration-  Even

& Enabled ~ dd « & Bits 2 Bits
" Disabled

. Cloze Apply




FAIRWEATHER
Multibeam Echosounder Calibration

4/16/2009]106 JL. washington

Launch 1018

Vessel

Date Dn Local Area

FOO Ringel, CST Morgan, LT Welton, ENS Morgan

Calibrating Hydrographer(s)

8101 Jio18 Jnot available
MBES System MBES System Location Date of most recent EED/Factory Check
3102026 |34497

Sonar Serial Number

JHull mounted swing arm

Processing Unit Serial Number

J03/20/2009

Sonar Mounting Configuration

POSMV v4 GPS (DGPS corrected)

Date of current offset measurement/verification

Jo4/15/2009

Description of Positioning System

Acquisition Log

Date of most recent positioning system calibration

4/16/2009]106 JL. washington Jcalim
Date Dn Local Area Wx
|30-190 feet

Bottom Type

Welton, ENS Morgan, Raymond, Heiner

Approximate Water Depth

Personnel on board

Comments

TH_1018_Patch_Test_Dn105

TrueHeave filename

081060818 Jo:00 | | | |
SV Cast #1 filename UTC Time Lat Lon Depth Ext. Depth
SV Cast #2 filename UTC Time Lat Lon Depth Ext. Depth



ROLL

SV Cast# |XTF Line Filename |Heading  |Speed (kts) |Remarks
005_1832.81X 3 5.9 roll
005_1838.81X 183 6.0]roll
005_1844.81X 03 6.0]roll

PITCH

SV Cast# |XTF Line Filename Heading Speed (kts) |Remarks
001_1730.81X 274 51
001_1741.81X 092 5.1
002_1751.81X 272 5.2
002_1801.81X 092 5.1

HEADING/YAW

SV Cast# |XTF Line Filename Heading Speed (kts) |Remarks
91060818]001_1730.81X 274 5.1]Heading
001_1741.81X 092 5.1|Heading
002_1751.81X 272 5.2]Heading
002_1801.81X 092 5.1|Heading (1805 overtaking boat noise)

NAV TIME LATENCY

SV Cast# |XTF Line Filename Heading Speed (kts) |Remarks
001_1811.81X 272 4.8]timing
001_1823.81X 092 8.0]timing
001_1741.81X 092 5.1|Heading

Processing Log

4/16/2009  |DN106 JENS Morgan

Date Dn Personnel
Data converted --> HDCS_Data in CARIS

TrueHeave applied yes

SVP applied yes

Tide applied  zerotide.tid

Zone file na

Lines merged

Data cleaned to remove gross fliers

Compute correctors in this order

1. Precise Timing 2. Pitch bias 3. Heading bias 4. Roll bias

Do not enter/apply correctors until all evaluations are complete and analyzed.




PATCH TEST RESULTS/CORRECTORS

Evaluators Latency (sec) Pitch (deg) Roll (deg) Yaw (deg)
FOO (in progress) -0.05 -0.80 2.88 -0.40
CST 0.00 0.30 2.86 -0.50
Nick 0.03 -0.94 2.86 -0.35
Bri -0.03 -1.06 2.90 -0.10
Averages -0.01 -0.63 2.88 -0.34
Standard Deviation 0.04 0.63 0.13 0.02 0.17 0.04
FINAL VALUES 0.00 -0.63 2.88 -0.34
Final Values based on CST/FOO Averages Averages Averages

Resulting HVF File Name FA_1018_Reson8101_2009

Actual values used

MRU Align StdDev

MRU Align StdDev gyro 017 Value from standard deviation of Heading offset values 0.035 gyro
MRU Align
MRU Align StdDev Roll/Pitch 0.32 Value from averaged standard deviations of pitch and roll offset values 0.075 StdDev Roll/Pitch

NARRATIVE
Values based on two patch tests- one performed on DN106 in Lake Washington using the bounded slope method and one
performed on DN1070n the Shilshole reference surface using the target method.

Initial MRU values were too high, TPU values reassessed with outliers removed.

HVF Hydrographic Vessel File created or updated with current offsets

Name: Ringel, Welton, Morgan Date: 4/18/09




FAIRWEATHER

Multibeam Echosounder Calibration Launch 1018

6/27/2009]178

Vessel

|Shumagin Islands, Near Northeast Harbor

Date Dn Local Area

Welton, FOO Ringel, CST Morgan

Calibrating Hydrographer(s)

8125 Ji018 Juknown (on loan from RUDE)

MBES System MBES System Location Date of most recent EED/Factory Check

4400007

|31562

Sonar Serial Number

Sled hull mount

Processing Unit Serial Number

|4/29/2009

Sonar Mounting Configuration

POSMV w/ DGPS correctors

Date of current offset measurement/verification

|4/15/2009

Description of Positioning System

Acquisition Log

6/27/2009]178

Date of most recent positioning system calibration

|Shumagin Islands, Near Northeast Harbor |Wind Igt vrb, waves <1ft (Awesome)

Date Dn

rock

Local Area WX

|20-30 meters

Bottom Type

Froelich, Francksen, Walker

Approximate Water Depth

Personnel on board

Comments

2009-178_1018.000

TrueHeave filename

SV Cast #1 filename

UTC Time Lat Lon Depth Ext. Depth

SV Cast #2 filename

UTC Time Lat Lon Depth Ext. Depth



view parallel to track, one line with induced roll (outerbeam) or same lines over bounded slope or

NAV TIME LATENCY feature (nadir) [run same direction, different speed]
SV Cast # Line Filename Heading Speed (kts) |Remarks
H12702_1018_Dn12009L_1781804 022 6.0]roll time bias method

PITCH view parallel to track, same line (nadir) over feature or bounded slope [opposite direction, same speed]
SV Cast # Line Filename Heading Speed (kts) |Remarks
H12702_1018_Dn]2009L_1781750 110 6.0

2009L_1781753 290 6.0

HEADING/YAW

view parallel to track, offset lines from feature

or slope (outerbeams) [opposite direction, same speed]

SV Cast # Line Filename Heading Speed (kts) |Remarks

2009L_1781756 110 6.0

2009L_1781800 290 6.0
ROLL view across track, same line over flat area in [opposite direction, same speed]
SV Cast # Line Filename Heading Speed (kts) |Remarks
H12702_1018_Dn]2009L_1781750 110 6.0

2009L_1781753 290 6.0




Processing Log

6/27/2009 J178 |
Date Dn Personnel
Data converted --> HDCS_Data in CARIS
| TrueHeave applied
SVP applied Previous in Time
Tide applied

Zone file predicted- Sand Point, AK

Lines merged

Data cleaned to remove gross fliers

Compute correctors in this order

1. Precise Timing 2. Pitch bias 3. Heading bias 4. Roll bias
Do not enter/apply correctors until all evaluations are complete and analyzed.
PATCH TEST RESULTS/CORRECTORS
Evaluators Latency (sec) Pitch (deg) Roll (deg) Yaw (deg)

Welton 0.00 -0.90 -1.98 -2.20
FOO 0.00 -0.30 -1.95 -1.70
CST 0.00 -0.40 -1.91 -1.50
Averages 0.00 -0.53 -1.95 -1.80
Standard Deviation 0.00 0.32 0.04 0.36
FINAL VALUES 0.00 -0.53 -1.95 -1.80

Final Values based on Averages

Resulting HVF File Name added to FA 1018 Reson8125 2009

MRU Align StdDev gyro
MRU Align StdDev Roll/Pitch

0.36
0.18

Value from standard deviation of Heading offset values
Value from averaged standard deviations of pitch and roll offset values



Launch DDSSM DATA ACQUISITION FORM

Date 4/16/2009 DN 105 Wind calm
Vessel # 1018 Location L. Wash Seas calm
Average Depth 30m Personnel Welton, Morgan, Raymond, Heiner
RPM Speed Az Hypack Line Name Acquisition Comments
650 4.9 90 007_1923.81X forgot to let truheave settle prior to running into the line
850 5.9 270  ]007_1930.81X forgot to let truheave settle prior to running into the line
650 4.9 90 007_1942.81X
850 5.9 270 007_1952.81X
1050 7 90 007_2001.81X
1250 7.9 270 007_2008.81X
1450 8.7 90 007_2016.81X
Stopl 0 - 007_2023.81X
Stop2 0 - 007_2025.81X

Stop3 0 - 007_2028.81X




DDSSM DATA PROCESSING AND RESULTS FORM

Date 4/18/2009 DN 106 Wind calm
Vessel # 1018 Location Lk Washington Seas calm
Average Depth Personnel
SVP file loaded
Tide file loaded
Speed (m/s) ] Speed (Kts) | Speed (RPM) | Hypack Line Name [ CARIS Line Name [ Depth Loc 1| Diff Loc 1 | Depth Loc 2| Diff Loc 2 | Depth Loc 3| Diff Loc 3 Average
0 0 0 27.6557457 25.9568637 29.8462362
2.52 4.9 650 007_1942.81X 007_1942 27.6090035 | -0.0467422 | o5 ggog032 | -0.0939605 | 59 7750175 | -0-0712187 | g 0624817
3.07 5.9 850 007_1952.81X 007_1952 27.5795859 | -0.0761598 | o5 844337 | -0.1125267 | 59 7651968 | -0-0810394 | 5 0gg2821
3.66 7 1050 007_2001.81X 007_2001 27.5550541 | -0.1006916 | o5 7653247 | -0-191539 | 59 7330816 | -0-1131546 | 130974
4.06 7.9 1250 007_2008.81X 007_2008 27.5219777 | -0.133768 | o5 7774865 | -0-1793773 | 297278022 | -0-118434 | 1489711
4.47 8.7 1450 007_201681)( 007_2016 27.5246716 | -0.1310741 25.7636516 -0.1932122 29.6939714 -0.1522648 -0.1517868
1018 DDSSM Values
Speed (RPM)
0
500 700 900 1100 1300 1500
g -0.05 *~
n
=
T -
g -01 —
g \\_— —&— Location 1
§ — —&— Location 2
g -0.15 - S Location 3
;_;; Average
Ny
a -0.2
[
[a

-0.25




Ellipsoid Referenced Dynamic Draft

Launch 1018

4/16/2009 106 Lake Washington Rice
Date DN Local Area Processor
SEAI TH_1018 patch_test dn105.000.002 1018 _ERDDM.txt
Primary Station POSPac File SBET File
proc_erddm.py, v0.12 4
Processing Method Coefficients
measurements
-18.55 : : . — bestHit poly
—18.60 - 8
—~ —18.65
£
% —18.70
o
2 -18.75
< _18.80
-18.85
—18.90
T
% 0.15
£
2 010
L
<  0.05
<)
E 0.00
7 —0.05
m
£ 010
T -0.15} .
E —-0.20 L L I L I
é 0 1 2 3 4 5 6
Speed (m/s)
-3.50e-003*X° +3.31e-002*Xx2 +.1.04e-001*X
Speed [(mM/s] Delta Draft (m)
0.00 0.00
0.50 0.05
1.00 0.06
1.50 0.07
2.00 0.07
2.50 0.07
3.00 0.09
3.50 0.10
4.00 0.10
4.50 0.07
=) 5.00 -0.00
= 5.50 -0.15
[=] T T
=)
2 oo0s} -
g 0.00 1
E -0.05} .
=
® —0.10} 1
a
T s 1 L 1 L 1
£ %1% 1 2 3 4 5 6
(=]

Speed (m/s)



Dynamic Draft Comparison

—e— 2009-ERDDM-Descrete

0.25 2009 Bottom Referenced
4 | —m-2008
0.15 / 2007
0.1 7/"-* — 2006
E | — ~
< 0.05 \
J i
= 0 1 \ é
-0.05 @ \ &
-0.1 \
-0.15 *
-0.2
Speed (Mm/s)
2009 HVF Values
2009-ERDDM-Descrete 2009 Bottom Referenced
speed (m/s) |draft (m) speed (m/s) |draft (m)
0 0 0 0
0.5 0.05 2.52 0.062
1 0.06 3.07 0.088
15 0.07 3.66 0.131
2 0.07 4.06 0.149
25 0.07 4.47 0.152
3 0.09
3.5 0.1
4 0.1
4.5 0.07
5 0
5.5 -0.15
2008 2007 2006
speed (m/s) |draft (m) speed (m/s) |draft (m) speed (m/s) |draft (m)
0 0 0 0 0 0
3.09 0.09 2.58 0.039 25 0.109
4.12 0.18 3.1 0.061 3 0.079
5.14 0.19 3.82 0.11 4 0.135
6.17 0.21 4.24 0.151 5.1 0.19
4.81 0.133 6 0.01
5.32 0.074




DDSSM DATA PROCESSING AND RESULTS FORM

NOTE: Conducted with Date 4/18/2009 DN 219 Wind calm
sled-mounted 8125. Vessel # 1018 Location Dutch Harbor, AK Seas calm
Average Depth 16 meters Personnel Welton, Rice, Beduhn
SVP file loaded 092192151.svp
Tide file loaded 946-2620 9462620.tid
Speed (m/s)Bpeed (Ktsppeed (RPM| Hypack Line Name | Depth Loc 1 Diff Loc 1 Depth Loc 2 Diff Loc 2 Depth Loc 3 Diff Loc 3 Average
0 0 0 2142 17.5421699 0 16.9987276 0 16.87650376 0
5 650 2050/2055 17.58894816 | 0.046778256 16.99016 |-0.008567602| 16.84873958 | -0.027764188 | 0.003482155
55 774 2123/2128 17.56613327 | 0.023963362 16.96695 |-0.031777602| 16.89124567 | 0.014741905 | 0.002309222
6.3 890 2101/2105 17.56247363 | 0.020303723 16.97538 |-0.023347602| 16.88678976 | 0.010285998 | (0.00241404
7.1/7.2 1060 2133/2136 17.50604808 | -0.036121821 16.9098 -0.088927602 | 16.82672642 | -0.049777349| .0.058275591
7.4/7.5 1120 2109/2112 17.53315974 | -0.009010164 16.951 -0.047727602 | 16.80605949 | -0.070444274 | .0.042394013
8.4/8.5 1425 2116/2119 17.51770889 | -0.07123927 16.916 -0.07416 16.8116773| -0.037062276 | -0.060820515
1018 DDSSM Values
Speed (RPM)
0.2
015
o
S
w01
Z
£ 005 :
5 —— Location 1
= ,/\‘——“\ —&— |ocation 2
@ 0 ’ b Average
S Location 3
g -0.05
Z‘é
Z -01
g
la)

-0.15













Reference Surface Acquisition Log

Launch 1018

Vessel

4/17/2009)| 107|shilshole Bay |Clear, wind up to 10kts
Date Dn Local Area Wx
Argento, Andrews, Renoud, Welton
Personnel
Comments
09107094.4nv Jo944 |47/40/26 |122/25/27 |38.8 |
SV Cast #1 filename UTC Time  Lat Lon Depth Ext. Depth
SV Cast #2 filename UTC Time  Lat Lon Depth Ext. Depth

Project | Vessel | Day Line | Min Time Max Time | Total Time Merged | Outdated |5r Currec‘ted| Line Reject | Line Class Heading | Length (m) | Speed (n
1018_HSRR_2 F&_1018_Res |2009-107 002_1&19 2009-04-17 1 |2009-04-17 1 |01:47 921 Yes Mo Ma Mo P, 330 46637204 | 397 60476253 |3.6642205
1018_HSRR_2 |F&_1018_Res |2009-107 005_1807 2009-04-17 1 |2009-04-17 1 |01:54 640 Yes Mo Ma Mo P, 240 95222111 |422 BSTEEE07 | 36865271
1016_HSRR_2 |F&_1018_Res | 2008-107 007_1632 2009-04-17 1 |2008-04-17 1 |02:07 520 Yes Mo Mo Mo P, 15011034297 |430 75261106 |3.3761586
1018_HSRR_2 |F&_1018_Res | 2009-107 003_1930 2009-04-17 1 |2009-04-17 1 |01:57 241 Yes Mo Ma Mo P, 23090304509 | 391 50376162 |3.3393075
1018_HSRR_2 |F&_1018_Res |2009-107 006_1804 2009-04-17 1 |2009-04-17 1 |02Z:02.361 Yes Mo Ma Mo P, 62.214858907 |433.37597276 |3.5417615
1016_HSRR_2 |F&_1018_Res | 2008-107 007_1801 2009-04-17 1 |2008-04-17 1 |01:46.500 Yes Mo Mo Mo P, 23899611762 | 392 36713316 |3.6736485
1018_HSRR_2 |F&_1018_Res | 2009-107 007_1834 2009-04-17 1 |2009-04-17 1 |04.200 Yes Mo Ma Mo P, 146 34218827 |14 457033554 |3.4421508
1015 _HSRRE_2 FA_ 1018 _Res |2009-107 an9_1514 2009-04-17 1 12009-04-17 1 |01:383.201 e [ [a} Mo {lla} [l o, EBO.E9YSETSA0 | 362 44865852 |3 6908359
1016_HSRR_2 |F&_1018_Res | 2008-107 005_1612 2009-04-17 1 |2008-04-17 1 |01:52.720 Yes Mo Mo Mo P, 241 42554594 | 409 60399673 |3 6336182
1018_HSRR_2 |F&_1018_Res | 2009-107 004_1824 2009-04-17 1 |2009-04-17 1 |01:57 681 Yes Mo Ma Mo P, 33058975106 | 432 27575593 |3.6733099
1015 _HSRRE_2 FA_ 1018 _Res |2009-107 ans_1526 2009-04-17 1 2009-04-17 1 (0212760 es Mo Mo Mo i, 15059129913 447 14063149 | 3.3680372
1016_HSRR_2 |F&_1018_Res | 2008-107 003_1758 2009-04-17 1 |2008-04-17 1 |02:07 721 Yes Mo Mo Mo P, 61538651955 | 437 59002170 |3.4269229
1018_HSRR_2 |F&_1018_Res |2009-107 003_1821 2009-04-17 1 |2009-04-17 1 |01:47 360 Yes Mo Ma Mo R, 149 47514552 | 364.91136722 [3.3989510
105 _HSRR_2 FA_1015_Res |2009-107 an4_1509 2009-04-17 1 (2008-04-17 1 |01:43.561 es Mo Mo Mo i, B0.265994504 (371 117394535 | 3.5833632
1018 HSRR 2|F& 1018 Res|2008-107 006 1629 2009-04-17 1 |2008-04-17 1 |01:56 681 Yes Mo Mo Mo P, 33131978516 | 430 67166877 |3.6910196







Description of Offsets for FAIRWEATHER S-220

All Values Shown are in CARIS Coordinates

IMU to Port Antenna
x:0.797
y: -11,892
z:-13.47

IMU to Heave Point

: x: 1.866 ;
y:-7.028  IMU=Reference Point (RP)
7:-2.086  x:0.000

‘lI y: 0.000
2:0.000

Fer A;te—gn;oﬁ) i IMU to Seabat 8160
y: 19.557 x: 0.493
z:17.766 y: 7.665
2:4.726
Port Antenna to 8TTT IMU to Seabat 8111
x:2.071 X: 2.868
y: 20.144 y: 8.252
z:17.792 z: 4.752

IMU to Port Antenna
x:0.797 § %
y:-11.892 F

z:-13.047




Fairweather Draft - 2009

Immediately prior to the FA field season, the draft measurements were taken prior to fueling when the takes were
very empty after shipyard (Empty) . And again after fueling and once the engineers had transferred the fuel in a
satisfactory manner (Full). The waterline at the IMU was then calculated based on a linear interpolation.

2009  (April) Fwd Aft slope  IMU Depth (ft) IMU Depth (m)
x1 yl x2 y2 Min Max

Empty 5.25 13.83 189 12.83  -0.00544 12.83 14.17
Full 5.25 13.00 189 14.17 0.00635

5.25 189 0.00000 0.00 0.000

5.25 189 0.00000 0.00 0.000

5.25 189 0.00000 0.00 0.000

Draft at IMU (ft) AVG  Value Used in Offsets
The IMU x-value (ft): 79.36 0.009 STDEV  Value used for Waterline Loading Uncertainty
x-value (m): 24.19
Distance Aft Fwd Perpendicular (ft)
0.00 25.00 50.00 75.00 100.00 125.00 150.00 175.00 200.00
12.9

13.1

13.7

13.9

14.1




STABILITY TEST: NOAA Ship FAIRWEATHER (16 Jul 2004 )
SHIP AT TIME OF STABILITY TEST--CONDITION 0
FROM HYDROSTATIC FROM INDEPENDENT
CURVES CALCULATION
Corrected diaplacement tons 1638.79 tons
Mean \.firlual metacentric height obtained from plot of . moment = 5987.252 / 1638.790 it 5 : ik
inclining moments versus tangents of angles of heel  displacement x tangent
Correction for free surface = 374.0 / 1638.790 - 7 feet 0 ;; feet
Mean metacentric height G.M. = - feet 3 .és_ feet
Transverse metacenter above base line corresponding to draft at LCF (corrected for hog or sag) o feet
Transverse metacenter above base line corrected for trim, and hog or sag ) B feet
C.G. above base line S feet 16.37 feet (from figure)
o T 16.36 feet (from GHS)
Longitudinal metacenter above C.G. feet
Moment to alter trim 1 foot, (Long GM x A) / L. ) fi-tons
Trim by stern  feet
Trimming lever = (Trim x moment to trim) / displacement I feet
Longitudinal center of buoyancy (L.CB) from origin A B feet
C.G. from origin - - feet 102.44  feet (from figure)
102.42 feet (from GHS)
FP
Period of complete roll seconds
Apparent radius of gyration of vessel o= _}:I_GO%L feet 3.88 _‘_“_3_“___——— —
12.35 —
) Rolling constant C= lgM— WATERONE & WATERLIE
h

Page 8 of 31



Westlake Consultants, Inc.
9/23/2003

Definitions and Basis for Dimensions/Locations

Northings

Northings (Port - Starboard) are with reference to the IMU Foundation Plate centerline scribe.
Positive values are starboard of the IMU.

Negative values are port of the IMU.

Calculated values are in italics.

Eastings

Eastings (Stern to Bow ) are with reference to the IMU Foundation Plate centerline scribe.
Positive values are forward of the IMU.

Negative values are aft of the IMU.

Calculated values are in italics.

Elevations

Elevations are with reference to the IMU Foundation Plate centerline scribe = 0 elevation.
Positive values are below the IMU (toward the keel).
Negative values are toward the topside.

Dimensions

All dimensions are in feet and decimal feet. All dimensions provided are "offsets" to IMU centerline.

Ship's Centerline Data

At project initiation, control was established to define the ship's centerline
as a plane running from a point on the centerline of the keel at the stern through a
point on the centerline of the keel near the bow, to a point on the bow splitting the bow chock.

IMU Referenced Data - Procedure
All data was originally referenced to the ship's geometry.
Following location of the IMU, data was transformed to the IMU as point of origin for
Northings, Eastings, and Elevation. All dimensions provided with reference to the IMU are "offsets."

Report of Sonar Array

Pace 1 of 11 Installation on
age 10 ages .

Westlake-Survey-Report-NOAA-Fairweather-09-23-03.xls NOAA Fairweather



Ship's Centerline - Control Measurements
(Prior to location of IMU and referencing of data to IMU as point of origin (0,0,0)

Westlake Consultants, Inc.

9/23/2003

Defined by measurements at the keel centerline

longitude transverse elevation
near the bow 1190.674 1000.000 135.8672
at the stern (point of origin) 1000.000 1000.000 100.0000
along the keel (approx 180" forward) 1180.121 1000.000 116.6810
Ship's Baseline
Defined by measurements on the keel

longitude transverse elevation
at the stern (point of origin) 1000.000 1000.000 100.0000
and approx. 129' forward of stern 1129.120 999.985 100.0022
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Westlake Consultants, Inc.
9/23/2003

IMU Foundation Plate

EASTING NORTHING ELEVATION
Horizontal alignment per scribed lines
on IMU foundation plate 0.001
0.000

Scribed lines - intersection/centerline of IMU plate
0.000 0.000 0.000

Elevation checks near four corners of IMU Foundation plate *

* elevation check adjusted for target 0.001
that created 10 mm offset =.03281 -0.001
feet 0.000

-0.001

SUMMARY
¢ IMU foundation plate is level to within +/-0.001 feet.
¢ IMU foundation plate is located 12.856 feet above baseline established at the keel.
¢ IMU is parallel to ship's centerline to within +/- 0.001 feet.

Location of scribed centerline intersection is 6.122 feet port of ship's centerline.
¢ IMU foundation plate centerline is located 11.638' feet forward of bulkhead 52.

Report of Sonar Array
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Westlake Consultants, Inc.

9/23/2003
Granite Block
EASTING NORTHING ELEVATION
Horizontal alignment per scribed lines
1.584
1.583
Scribed lines - intersection/centerline of granite block
-0.003 1.583
Deviation
Elevation checks near four corners of granite block from level
* elevation check adjusted for target that created 10 -0.217 -0.001
mm offset = 0.03281 feet -0.217 -0.001
-0.216 0.001
-0.215 0.001

SUMMARY
¢ Granite block is level to within +/-0.001 foot
of average elevation = -0.21632 feet
¢ Granite block is parallel to ship's centerline to within 0.001 foot
Location is 4.54 feet to port of ship's centerline and 1.583 feet starboard of IMU.
¢ Granite block is aligned with IMU to within 0.003 feet longitudinally.

Report of Sonar Array
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Westlake Consultants, Inc.
9/23/2003

Array Acoustical Centers - Referenced to IMU

EASTING NORTHING ELEVATION
PORT ARRAY (81-60) 25.149 1.619 14.956

Explanation of Calculations
Acoustic center is defined as the center of the transmitter array with the
elevation = 83 mm below mounting face of array.

Easting
Center of array is defined by the foundation plate bolt centerlines (1/2 distance between bolts)
27.008 Forward edge of foundation as measured
- 0.104 Forward edge of foundation to centerline of forward bolt hole
- 1.755 Distance from bolt hole centerline to center of array
25.149 feet forward of IMU

Northing
Center of array is defined as the mid-point between the bolt holes on the foundation.
1.369 Port edge of foundation as measured
+ 0.078 Port edge of foundation to centerline of bolt hole - per Cascade General
+ 0.172 Distance from bolt hole centerline to array center
1.619 feet starboard of IMU

Elevation
Per Reson drawing 2148M011_001 the elevation is 83 mm below array mounting surface
14.679 Array foundation elevation as measured.
0.005 Isolation "shim" added between foundation and array
0.272 83 mm below array mounting surface to acoustical center
14.956 feet below IMU
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Westlake Consultants, Inc.
9/23/2003

Array Acoustical Centers - Referenced to IMU

EASTING NORTHING ELEVATION
STARBOARD ARRAY (81-11) 27.072 9.41 15.042

Explanation of Calculations
Acoustic center is defined as midpoint of the transmitter array in the longitudinal and transverse axes.
The elevation is defined as the center of the receiving array.

Easting

Center of array is defined as 0.235' aft of the forward bolt centerlines on transmitter array foundation
28.563 Forward edge of foundation fixture plate as measured (receiving plate forward edge)
27.349 Forward edge of transmitter array foundation as calculated
- 0.042 Forward edge of foundation to centerline of forward bolt hole - per design
- 0.235 Distance from bolt hole centerline to center of array - per design
27.072 feet forward of IMU

Northing

Center of array is defined as the mid-point between the bolt holes on the transmitter array foundation.
9.410 Centerline of array foundation as measured on scribe - aft section of fixture plate
9.410 feet starboard of IMU

Elevation
Elevation is 0.401 feet above receiver array mounting surface
16.085 Mounting foundation fixture plate as measured.
15.447 Receiver foundation elevation - as calculated
+ 0.005 Isolation "shim" added between foundation and array
- 0.410 Design distance from mounting surface of array to acoustic center
15.042 feet below IMU
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Westlake Consultants, Inc.
9/23/2003

Longitudinal Array Foundation - Port Side

EASTING NORTHING ELEVATION
Horizontal alignment measured at port edge of array foundation
1.369
1.369

Forward edge of array foundation - measured
27.008

Horizontal alignment - calculated to array centerline

Foundation edge is 0.25 feet port of 1.619
array centerline 1.619
deviation from
Elevation checks near four corners of array foundation level (average)
14.680 0.001
14.681 0.002
14.678 -0.001
14.677 -0.002
SUMMARY

o Port longitudinal array foundation average elevation is 14.679 feet.
Variation in elevation is +0.002 to -0.002 feet.

¢ Port longitudinal array foundation is parallel to ship's centerline and 1.369 feet starboard of IMU.
Calculated array centerline is 1.619 feet starboard of IMU
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Westlake Consultants, Inc.

9/23/2003
Longitudinal Array Foundation - Starboard Side
EASTING NORTHING ELEVATION deviation from
Horizontal alignment measured on fixture plate scribe - parallel
Design location is 3.292 feet 9.410 0.002
starboard of ship centerline 9.406 -0.002

Forward edge of array foundation fixture plate - measured

28.563
deviation from
Elevation checks near four corners of array foundation "fixture plate" average
16.085 0.000
16.085 0.000
16.084 0.000
16.085 0.000

Calculated locations of longitudinal and transverse array foundations

Forward edge
Receiver (transverse) 28.563
Transmitter (longitudinal) 27.349

difference = 1.214

NOTE: On Transmitter array foundation - from forward edge to center of forward holes = 0.042'
On Receiver array foundation distance from forward edge to center of forward holes = 0.076'

Calculated elevation of longitudinal and transverse array foundations
Receiver/Transverse Foundation 15.446
Transmitter/Longitudinal Foundation 15.709

difference = 0.263

SUMMARY

o Starboard longitudinal array foundation (measured at fixture plate) average elevation is 16.085 feet.
Deviation from level (average elevation) is less than 0.001 feet.

o Starboard longitudinal array foundation averages 9.408 feet starboard of IMU.
Variation from parallel is from -0.002 feet to +0.002 feet from average.

o Starboard longitudinal array foundation forward edge is 28.563 feet forward of IMU.

Report of Sonar Array

Page 8 of 11 P Installation on
age 8 0 ages .
Westlake-Survey-Report-NOAA-Fairweather-09-23-03.xls NOAA Fairweather



Transverse Array Foundation - Port Side

EASTING NORTHING

Forward Edge - Transverse array foundation - measured

28.343

28.338
Port edge - Transverse array - measured

-0.181

Centerline of array - calculated
Foundation forward edge minus 28.093
0.25 feet to array centerline 28.088
Port edge of foundation plus 1.806 feet 1.624

to calculated array centerline

Elevation checks near four corners of array foundation

0.861 feet below baseline with 0.965
foot offset = 98.180 feet average
elevation

SUMMARY

ELEVATION

14.679
14.675
14.675
14.677

e Transverse array foundation average measured elevation is 14.677 feet

below IMU (0.006 feet above design location).

Deviation from level (average elevation) is 0.003 to -0.001 feet

Westlake Consultants, Inc.

9/23/2003

deviation from
level
0.002
-0.001
-0.001
0.001

e Transverse array foundation centerline (calculated) averages 28.090 feet forward of IMU.
Variation from parallel to ship's centerline is from -0.003 to 0.003 feet (from average).
e Transverse array centerline is calculated to be 1.624 feet starboard of IMU.
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Westlake Consultants, Inc.
9/23/2003

Transverse Array Foundation - Starboard Side

NOTE: Direct Measurements were not taken to the transverse array because a single "fixture plate" covered b
transmitter and receiver foundations. The data provided here is primarily “calculated".

EASTING NORTHING ELEVATION
Forward edge - as measured on fixture plate
Receiver - (transverse) 28.563
as measured
Transmitter (longitudinal) 27.349

difference = 1.214

NOTE: On Transmitter array foundation - from forward edge to center of forward holes = 0.042'
On Receiver array foundation distance from forward edge to center of forward holes = 0.076'

Horizontal Alignment 9.406
centerline scribe on fixture plate

as measured - forward portion of plate

(near receiver array)

Average of measurements on fixture plate 9.408

Elevation of longitudinal and transverse array foundations

Receiver/Transducer Transverse Foundation 15.446

Transmitter/Longitudinal Foundation 15.709
difference = 0.263

Based on measured elevations averaging 16.085 feet across fixture plate

SUMMARY

e Transverse array foundation is calculated to be 15.446 feet below IMU - calculated from measured elevation
of 16.085 feet. Deviation in elevation measurements across the array fixture plate is less than 0.001 fe

e Transverse array foundation forward edge (measured) is 28.563 feet forward of IMU.

e Transverse array centerline is measured to be 9.406 feet starboard of IMU.

Variation from parallel of the fixture plate across entire starboard array is + 0.002 feet (from average).
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Westlake Consultants, Inc.
9/23/2003

Antennae
EASTING NORTHING ELEVATION

Stbd POS MV Antenna -Location -35.866 12.925 -38.209
Port POS MV Antenna - Location -35.739 -0.409 -38.283
Foundation Plate Stack Antenna Alignment 7.677

Foundation Plate Stack Antenna Alignment 7.677

Port GYRO Foundation Plate Alignment 2.41

Port GYRO Foundation Plate Alignment 2.41

Stbd GYRO Foundation Plate Alignment 3.866

Stbd GYRO Foundation Plate Alignment 3.867

SUMMARY

e Foundation plate stack antenna alignment is parallel to ship's centerline.
e Port GYRO Foundation Plate is aligned parallel to ship's centerline.
e Starboard GYRO Foundation Plate is aligned parallel to ship's centerline.
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NOAA SHIP FAIRWEATHER
POS MV COMPONENTS SPATIAL RELATIONSHIP SURVEY

PURPOSE

The primary purpose of the survey was to accurately determine the spatial relationship of various
components of a POS MV navigation system aboard the NOAA ship FAIRWEATHER.
Reference points were also established to determine the spatial location of differential GPS
antennas, Additionally, various reference points (bench marks) were restablished onboard the
vessel to aid in future spatial surveys aboard the boat.

PROJECT DETAILS

This survey was conducted while the ship was docked at the USCG in Seattle, WA . The weather
was cool with a steady breeze.

INSTRUMENTATION

The Topcon 3000LW total station was used to make all measurements.
Technical Data:
Angle Measurement
Smallest unit in display 0.1 seconds

Standard Deviation

Horizontal angle 1.0 seconds
Vertical angle 1.0 seconds
Distance measurement 2mm + 2ppm

A standard “peanut” prism was used as a sighting target. This prism was configured to have a zero
mm offset.

PERSONNEL

Steve Breidenbach  NOAA/NOS/NGS/GSD/I&M BRANCH
(540) 373-1243

Dennis Lokken NOAA/NOS/NGS/GSD/I&M BRANCH
(540) 373-1243



NOAA SHIP FAIRWEATHER
POS MV COMPONENTS SPATIAL RELATIONSHIP SURVEY

ESTABLISHING THE REFERENCE FRAME

To conduct this survey a local coordinate reference frame was established where the X axis runs
along the centerline of the boat and is positive from IMU towards the bow of the boat. The Y axis
is perpendicular to the centerline of the boat (X axis) and is positive from IMU towards the right,
when looking at the boat from the stern. The Z axis is positive in an upward direction from the
IMU. In this reference frame the IMU has the following coordinates;

X =100.000(m)

Y =100.000(m)

Z =100.000(m)

At the end of the survey all the coordinates were rotated to a right-handed coordinate system. The
coordinates were translated to the IMU origin and the Granite Block origin.

DISCUSSION

I recommend conducting the survey again, once the ship is put into dry dock. Conducting a survey
such as this while the boat is in the water requires that the automatic compensators in the survey
instrument be turned off. The survey is therefore conducted with all survey instrumentation set up
relative to the mean movement of the related level vials. While every effort was made to make the
most precise measurements possible, some additional error accumulation cannot be avoided under
these type observing conditions.



The positions given for the IMU GPS antenna are to the bottom of the bolt as depicted on the
photo below.




Position of the C-NAV Antenna
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Point Summary Report
~ Name | StdDevn(m Std Dev e (m Std Dev Hz (m ‘ Std Dev u (m

10FLOOR 0.003 0.003 0.004 ‘ 0.002
11FLOOR 0.003 0.004 0.005 0.002
1CLEAT 0.004 0.018 0.019 ‘ 0.002
1DECK 0.004 0.018 0.018 ‘ 0.002
1FLOOR 0.000 0.000 0.000 ‘ 0.000
1LOCKER 0.004 0.004 0.005 ‘ 0.003
1RAIL 0.004 0.022 0.023 ‘ 0.002
1IWALL 0.003 0.002 0.004 ‘ 0.001
1IWALLS3 0.003 0.003 0.004 ‘ 0.002
2CLEAT 0.003 0.021 0.021 ‘ 0.002
2CLEAT1 0.004 0.022 0.022 ‘ 0.003
2FLOOR 0.001 0.001 0.001 \ 0.001
2RAIL 0.004 0.022 0.022 ‘ 0.002
2WALL 0.002 0.003 0.004 ‘ 0.002
3ANT 0.003 0.006 0.007 ‘ 0.003
3FLOOR 0.002 0.002 0.003 ‘ 0.002
3WALL 0.003 0.003 0.005 ‘ 0.002
4FLOOR 0.001 0.001 0.002 ‘ 0.003
5FLOOR 0.002 0.004 0.005 ‘ 0.001
6FLOOR 0.002 0.002 0.003 ‘ 0.003
7FLOOR 0.005 0.003 0.006 ‘ 0.002
8FLOOR 0.004 0.004 0.005 ‘ 0.002
9FLOOR 0.002 0.013 0.013 ‘ 0.003
ABOLT 0.003 0.026 0.026 ‘ 0.003
ANT DECK 0.003 0.006 0.007 ‘ 0.003




Std Dev Hz (m \
ANT DECK BM 0.004 0.007 0.008 \ 0.003
ANT PORT 0.003 0.007 0.008 \ 0.003
ANT RAIL 0.004 0.006 0.007 \ 0.003
ANT RAIL BM 0.003 0.007 0.007 \ 0.003
ANT STAR 0.004 0.007 0.008 0.003
BOW BM 0.004 0.023 0.024 \ 0.003
BOW BM2 0.004 0.023 0.023 \ 0.003
BRIDGEPORT 0.005 0.011 0.012 \ 0.003
BRIDGESTAR 0.005 0.011 0.012 \ 0.003
BRIDGESTAR2 0.005 0.011 0.012 \ 0.003
DOOR 0.001 0.001 0.002 \ 0.001
GRANITE BOW 0.002 0.001 0.002 \ 0.001
GRANITE CENTER 0.002 0.001 0.002 \ 0.001
GRANITE PORT 0.002 0.001 0.002 \ 0.001
GRANITE STAR 0.003 0.002 0.003 \ 0.001
GRANITE STERN 0.002 0.001 0.002 \ 0.001
IMU BM 0.003 0.001 0.003 0.003
IMU BOW PORT 0.002 0.001 0.002 \ 0.001
IMU BOW STAR 0.002 0.001 0.002 \ 0.001
IMU CENTER 0.000 0.000 0.000 \ 0.000
IMU STERN PORT 0.002 0.001 0.002 \ 0.001
IMU STERN STAR 0.002 0.001 0.002 0.001
LADDER 0.002 0.002 0.002 \ 0.001
MVP BM 0.004 0.023 0.023 \ 0.003
RAIL STAR 0.006 0.015 0.016 \ 0.003
RAIL STAR1 0.004 0.005 0.007 \ 0.003
RAILPORT 0.005 0.015 0.016 \ 0.003




STEARN BM 0004 | 0024 | 0024 |  0.003 |

STERN BM 0.003 0.024

COORDINATES

IMU Origin

Right-handed Coordinate System
Name Easting (x) meters | Northing (y) meters | Elevation (z) meters
IMU CENTER 0 0 0
IMU BOW PORT CORNER 0.073 -0.084 -0.006
IMU BOW STAR CORNER 0.071 0.088 -0.004
IMU STERN STAR CORNER -0.068 0.089 -0.003
IMU STERN PORT CORNER -0.065 -0.086 -0.006
GRANITE BOW 0.147 0.48 0.108
GRANITE STAR -0.002 0.574 0.111
GRANITE STERN -0.148 0.478 0.109
GRANITE PORT -0.003 0.382 0.106
GRANITE CENTER -0.002 0.477 0.108
IMU BM 0.034 -0.263 -0.496
STERN BM -40.32 1.927 -2.184
MVP BM -38.721 5.985 -2.018
STEARN BM -40.313 1.921 -2.181
POS GPS ANT STARBOARD -11.917 3.171 -12.936
POS GPS ANT PORT -11.92 1.177 -12.98
A FRAME BOLT -43.019 1.975 -7.142
POS GPS ANT RAIL BM -12.037 2.101 -10.376
POS IMU ANT DECK BM -11.823 2.07 -90.301
C-NAV ANT -10.075 4.131 -11.377
BOW BM 28.346 2.077 -7.853




Granite Block Origin

Right-handed Coordinate System

Name Easting (x) meters | Northing (y) meters | Elevation (z) meters
IMU CENTER 0.002 -0.477 -0.108
IMU BOW PORT CORNER 0.075 -0.561 -0.114
IMU BOW STARBOARD CORNER | 0.073 -0.39 -0.112
IMU STERN STARBOARD CORNER | -0.065 -0.388 -0.111
IMU STERN PORT CORNER -0.063 -0.563 -0.114
GRANITE BOW 0.149 0.003 0
GRANITE STAR 0 0.097 0.003
GRANITE STERN -0.145 0.001 0.001
GRANITE PORT 0 -0.095 -0.002
GRANITE CENTER 0 0 0

IMU BM 0.036 -0.74 -0.604
STERN BM -40.317 1.45 -2.292
MVP BM -38.719 5.508 -2.126
STEARN BM -40.31 1.444 -2.289
POS GPS ANT STARBOARD -11.915 2.694 -13.044
POS GPS ANT PORT -11.918 0.699 -13.088
A FRAME BOLT -43.017 1.498 -1.25
POS GPS ANT RAIL BM -12.034 1.623 -10.484
POS IMU ANT DECK BM -11.821 1.593 -9.409
C-NAV ANT -10.073 3.654 -11.485
BOW BM 28.349 1.6 -7.961




POS GPS RAIL BM AND POS GPS DECK BM



IMU BM
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NOAA SHIP FAIRWEATHER
POS MV COMPONENTS SPATIAL RELATIONSHIP SURVEY

PURPOSE
The primary purpose of the survey was to precisely determine the spatial relationship of various
components of a POS MV navigation system aboard the NOAA ship FAIRWEATHER.

Additionally, various reference points (bench marks) were re-established onboard the vessel to
aid in future spatial surveys aboard the boat.

PROJECT DETAILS

This survey was conducted while the ship was in dry dock at the Lake Union dry dock in Seattle,
WA. The weather conditions over the two days required to conduct this survey were windy,
cool, with intermittent rain.

INSTRUMENTATION

The Leica TC2003 total station was used to make all measurements.
Technical Data:

Standard Deviation

Horizontal angle 0.5 seconds
Vertical angle 0.5 seconds
Distance measurement 0.2mm + 2ppm

A Leica precision prism was used as a sighting target. This prism was configured to have a zero
mm offset.

PERSONNEL

Kendall Fancher ~ NOAA/NOS/NGS/GSD/I&M BRANCH
(540) 373-1243

Dennis Lokken NOAA/NOS/NGS/GSD/1&M BRANCH
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NOAA SHIP FAIRWEATHER
POS MV COMPONENTS SPATIAL RELATIONSHIP SURVEY

DEFINITION OF THE REFERENCE FRAME

To conduct this survey a local coordinate reference frame was established where the Northing
(YY) axis runs along the centerline of the ship and is positive from the IMU towards the bow of
the ship. The Easting (X) axis is perpendicular to the centerline of the ship and is positive from
the IMU towards the right, when looking at the ship from the stern. The Up (Z) axis is positive
in an upward direction from the IMU.

SURVEY METHODOLOGY

02/15/2009

Coordinates of 100.000N, 100.000E, and 100.000U were assumed for temporary control point 1.
A distance and height difference were measured between temporary control points 1 and 3.
These values were used to determine the coordinates at temporary control point 3. Temporary
control points 1 and 3 were located along the top deck and on the north side of the dry dock
vessel.

Temporary control point 1 was occupied and temporary control point 3 was observed for a
backsight. After initialization, temporary control points 2 and 4(located on the top deck of the
dry dock vessel), H1 (located on the bottom deck of the dry dock vessel), and BOW BM were
observed in both direct and reverse.

Temporary control point 2 was occupied and temporary control point 3 was observed for a
backsight. After initialization, temporary control point W1 (located on the top deck of the dry
dock vessel) and D1 (located inside the ship on the D deck along the port side) were observed in
both direct and reverse. Temporary control point 1 was also observed and yielded an inverse
check of 0.001m horizontally and 0.001m vertically.

Temporary control point 4 was occupied and control point 1 was observed for a backsight. After
initialization, temporary control point 5 (located on the south side and on the top deck of the dry
dock vessel) was observed in both direct and reverse.

Temporary control point 5 was occupied and control point 4 was observed for a backsight. After
initialization, temporary control point D2 (located inside the ship on the D deck along the
starboard side) was observed in both direct and reverse.



Temporary control point H1 was occupied and control point 1 was observed for a backsight.
After initialization, temporary control point H2 (located on the bottom deck of the dry dock
vessel), and USBL BM were observed in both direct and reverse.

Temporary control point H2 was occupied and temporary control point H1 was observed for a
backsight. After initialization, 8111 BM and 8160 BM were observed in both direct and reverse.
Temporary control point W1 was also observed and yielded an inverse check of 0.019m
horizontally and 0.033m vertically.

Temporary control point D1 was occupied and temporary control point D2 was observed for a
backsight. After initialization, temporary control point D3 (located in the doorway leading to the
mess hall on the D deck) was observed in both direct and reverse.

Temporary control point D3 was occupied and temporary control point D1 was observed for a
backsight. After initialization, temporary control point C1 (located on the C deck near the IMU)
was observed in both direct and reverse. Temporary control point D2 was also observed and
yielded an inverse check of 0.026m horizontally and 0.0001m vertically.

Temporary control point C1 was occupied and temporary control point D3 was observed for a
backsight. After initialization, IMU, IMU BOW PORT CORNER, IMU BOW STAR CORNER,
IMU STERN STAR CORNER, and IMU STERN PORT CORNER were observed in both direct
and reverse.

02/16/2009

Temporary control point 4 was occupied and control point 1 was observed for a backsight. After
initialization, temporary control point 6 (located on the south side and on the top deck of the dry
dock vessel) and BOW BM were observed in both direct and reverse. Temporary control point
D2 was also observed and yielded an inverse check of 0.0004m horizontally and 0.083m
vertically.

Temporary control point 6 was occupied and temporary control point 4 was observed for a
backsight. After initialization, TRANSOM PIVOT POINT PORT, STERN BM, POS GPS ANT
RAIL BM, POS IMU ANT DECK BM, POS GPS ANT STARBOARD, and POS GPS ANT
PORT were observed in both direct and reverse.

Temporary control point 3 was occupied and temporary control point 1 was observed for a
backsight. After initialization, TRANSOM PIVOT POINT STARBOARD, STERN BM, POS
GPS ANT STARBOARD, and POS GPS ANT PORT were observed in both direct and reverse.
Temporary control point 6 was also observed and yielded an inverse check of 0.0006m
horizontally and 0.001m vertically.

The reference frame was rotated using STERN BM as the point of rotation. A zero degree
azimuth was used during the rotation from STERN BM to BOW BM. The reference frame was
then translated to relocate the origin of the reference frame to the IMU.



NOAA SHIP FAIRWEATHER
POS MV COMPONENTS SPATIAL RELATIONSHIP SURVEY

INVERSE RESULTS

Inverses were computed between the determined positions of those ship benchmarks and
sensor points which were determined from two separate locations The results of these inverses
are:

ID Horizontal Dist.(m) Elevation Diff(m)
BOW BM 0.0150 0.0240
STERN BM 0.0060 0.0010
POS GPS ANT STARBOARD 0.0100 0.0001
POS GPS ANT PORT 0.0100 0.0000
DISCUSSION

The Fairweather was in dry dock during this survey, however, the dry dock vessel was still
subject to movement due to wave action. Conducting a survey such as this while the ship is
moving requires that the automatic compensators in the survey instrument be turned off. The
survey is therefore conducted with all survey instrumentation set up relative to the mean
movement of the related level vials. While every effort was made to make the most precise
measurements possible, some additional error accumulation cannot be avoided under these type
observing conditions.

The POS GPS antenna coordinates were determined to the top center of the antennas. The Z
value should be corrected to the Antenna Reference Point (ARP). In order to apply this
correction, the mechanical height of the antenna should be determined and subtracted from the Z
value determined during this survey for both of the POS GPS antennas.



NOAA SHIP FAIRWEATHER

POS MV COMPONENTS SPATIAL RELATIONSHIP SURVEY

Coordinate Listing using IMU as the Reference Frame Origin

ID X(NORTHING)m | Y(EASTING)m | Z(UP)m
IMU CENTER 0.000 0.000 0.000
IMU STERN PORT CORNER -0.071 -0.089 -0.001
IMU BOW PORT CORNER 0.070 -0.086 -0.001
IMU BOW STARBOARD CORNER 0.069 0.087 0.000
IMU STERN STARBOARD CORNER -0.073 0.086 0.000
BOW BM 28.378 1.805 7.796
STERN BM -40.306 1.805 2.255
USBL BM -28.354 1.738 -4.204
8160 BM 8.407 0.395 -4.400
8111 BM 8.532 3.002 -4.666
POS GPS ANT RAIL BM -12.011 1.785 10.381
POS IMU ANT DECK BM -11.790 1.780 9.305
POS GPS ANT STARBOARD -11.886 2.794 13.051
POS GPS ANT PORT -11.892 0.797 13.047
TRANSOM PIVOT POINT STARBOARD -39.727 3.366 2.385
TRANSOM PIVOT POINT PORT -39.722 0.240 2.345




NOAA SHIP FAIRWEATHER
POS MV COMPONENTS SPATIAL RELATIONSHIP SURVEY

IMU STERN PORT CORNER ==>

IMU Reference Points



NOAA SHIP FAIRWEATHER
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==GPS Starboard Side - Top PS Port Side==> o
enter of GPS antenna. - Top center of GPS s

antenna.

POS GPS ANTENNAS
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== Punch Mark in top center of bolt welded
to bow deck.

BOW CENTERLINE REFERENCE POINT
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==Centerline Reference Peoint - Punch mark in top of
M Y-olt welded to G deck. *

CENTERLINE REFERENCE POINT ON G DECK
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==Canterline Reference Point - Punch mark in top I
of bolt welded to rail on G deck.
e 3

CENTERLINE REFERENCE POINT ON RAIL AT G DECK



NOAA SHIP FAIRWEATHER
POS MV COMPONENTS SPATIAL RELATIONSHIP SURVEY

on fantail.

CENTERLINE STERN REFERENCE POINT
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TRANSOM REFERENCE POINT ON STARBbARD SIDE
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Certificate of Accuracy

Customer Name: MCMASTER-CARR SUPPLY CO. Customer PO#: TA-28173060

Customer Address: 200 AURORA IND. PARKWAY
AURORA,OH 44202

Date of Calibration: 8/23/02
Product Description: GRANITE SURFACE PLATE
Size; 8"X12"X2"
Serial Number: 36961
Accuracy: Actual: .000075" Allowed: .0002"
Repeatability: Actual: .000055" Allowed: .00010"
Grade: B
Uncertainty of Measurement: 52D
M.O.E.: 7.5x106

Laboratory Conditions: Temperature: 69 °F Humidity: 51%

This product was inspected under environmentally controlled conditions. The electronic and optical gauging
equipment used in inspecting this item has been calibrated and is traceable to the National Institute of Standards and
Technology (NIST). Our calibration system is in compliance with ISO 10012-1.

Calibration Equipment Used in the Inspection of this Product:

Type of Equipment 1D Number Instrument Uncertainty NIST Traceability Cal_Due Date
Number
Autocollimator IP 040 +0.5 arc sec 821/259488-97 6-03

.000020 Mahr Dial | 20990 50 pin 25894-1 6-03

Laboratory Manager Signature:
Donald Schirmers, Lapping Manager
Robert Golla, Accessones Supenisor

REWORK / RECALIBRATION (This section is completed for recertification orders only - accuracies upon receipl)

Date of Receipt:
Accuracy of Incoming Product:
Repeat Measurement of Incoming Product:

" Was unable to read upon receipt due to poor
condition of product

The results on this Certificate of Accuracy apply only to the item described above. This report shall not be
reproduced except in full and with the written authorization of our laboratory.

Measurement Uncertainty is expressed at a confidence level of 95% (coverage factor k=2)

Procedure Number: QP 4.10.1

1101 Prosper Drive « Box 430 - Waite Park, MN 56387+ PH: 320-251-7171 - Fax 320-259-5073




FINAL INSPECTION REPORT
1101 Prosper Drive - Box 430
Waite Par. MN 56387
PH 320-251.7171 - FAX 320-250.5073

ved — WD (6) Customer Name: MM (e
. mumpmuumm 7) Serial Number:  _3/-F ¢/

(5) P.O. Number: - 2013000 (3) Print/Part Number:
(10) Description of Item: _&&Lﬁ(ﬁ (11) Granite Type: G,
(12 Conditions at Time of Inspection: ~ Temperatwre: G oF  Humidey: S/
(13) Test Equipment:
Ixpe of Eguioment Serial Number Caiitration Due Date Uncertainty of IMTE
mimmm

Autocollimator -0 -t LA ¢ Seg
Electronic Level D Height Check [:] ﬂzgc Z‘"' [Tij m
AmoBGaugeHead [ | Surfometer C,]

Perts Prism = Misokator

Other
(1) Grade: ( B’ A AA NJ/A
(15) Overall Accuracy / Flatness (acuat): ss00 75 - P —

(15) Repeat Measurement (sne): _ . 0000SS [ﬂu—ﬂz@
(FIM: Full Indicator Movement)

(17) Final Inspector Signature:

(18) Opinion / Interpretation (if applicable):

(21) Thread Size, Quantity & Location to Print:  Yes No
(22) Insert / Hole / Slot Szze, Quantity & Location to Print:  Yes No

mmumwmwywmmmm Mrmtﬂnﬂhlmmﬂfm mmm:
written 3pproval of our aboratory.  Measurement uncestanty is expn ¢ 8 confidenc :

Shipping
(19) Threaded Inserts:  Yes No (20) Cean: Yes o  No
Packaging Conforms to Company and Customer Requirements:  Yes : No




Save  IMPORTANT DOCUMENT Save

Tru-Stone Technologies
Instructions for Care of Granite Surface Plates

1. Cleaning and Moisture: Plates shall be cleaned thoroughly and given adequate time to dry before
testing for tolerance. Water based cleansers that have not dried will cause iron parts to rust if they are
left in contact with the wet surface for an extended period of time. It is recommended that plates
undergo drying time in a room with less than 50 percent relative humidity. Temperature and dirt have a
direct correlation with measurement accuracy. Personal cleanliness will aid in eliminating one source of
contamination,

2. Temperature Soaking Time: Before granite surface plates are measured for work surface flatness,
the granite should remain in the calibration area until it has reached room temperature, which may
require 2 to 3 days. Large plates require more soak-out time than smaller ones.

3. Scratches and Nicks: Whenever scratches and nicks appear on granite plates, the resulting rough
edges should be removed with a flat granite dressing plate. Any bump that shatters the surface raises
fractured material at the rim of the crater.

4. Rotation of Plates: When a specific work surface area receives prolonged usage, it is suggested
that the plate and stand be rotated 180 degrees on a periodic basis to increase the wear life of the plate.
The production of a contour map during calibration is particularly helpful in locating the parts of the plate
that should be given the most use. This can be accomplished by requesting a long form certification
when ordering the new surface plate or when the plate is being sent in for recalibration.

5. Periodic Recalibration: Periodic recalibration of granite surface plates is recommended to
determine resurfacing or replacement needs. The interval between calibrations will vary with the grade
of plate and the wear resistance of the granite. TRU-STONE CONFORMS TO ISO 9000
CERTIFICATION REQUIREMENTS FOR VENDORS. Frequent monitoring of the work surface by
scanning it with the repeat gage is desirable. When these results differ from those marked on the
replaceable sticker, you should recalibrate the plate. In addition to measuring the overall accuracy of a
surface, smaller areas can be checked for localized variations often missed by the calibrating methods.
Remember precision measurements are only as accurate as the measuring tools used.

6. Torque on THREADED Inserts: Do not exceed the following maximum torque values when using a
torque wrench to limit distorting the work surface and pulling the insert. The following torque values are
the maximum level permissible by the Federal Specification GGG-P-463c.

PERMISSIBLE TORQUE CLAMPING ON THREDED INSERTS

Thread Size Torgue
250 inch 7 ft. Ibs.
3125 inch 15 ft. Ibs.
.375 inch 20 ft. Ibs.
.500 inch 25 ft. Ibs.

7. Clamping Ledges on Grade AA Surface Plates: There is danger of distorting the work surface
flatness beyond tolerance when a heavy item rests on the ledge or an item is clamped to the ledge.
Ledges are not only expensive, but a great cause of inaccuracy. Experimentation and research reveal
that no-ledge plates retain their accuracy better than ledged plates.

8. Supports: There are working and loading conditions where the standard three point supports are not
satisfactory. These cases should be individually engineered. When four or more supports are used,
shims or adjusting screws are necessary for proper support. The supports could be spotted under the
loading points and set to approximately equal the loading. Sometimes the work surface flatness can be
improved by shifting support positions. Fulcrum, air and hydraulic supports are available. Whenever
nonstandard supports are used, the surface plate shall be calibrated at the site for compliance to the
flatness tolerance.

1101 Prosper Drive » P. O. Box 430 « Waite Park, MN 55387 - 1-800-950-0517 + PH: 320-251-7171 = Fax 320-258-5073



Utilize the full surface of a plate so the wear is distributed and not concentrated in one area.
The surface plate should not be overloaded.

Use extreme care in moving the item being measured and the gages being used.

Place on the surface ONLY what is required.

Particularly avoid heavy contact with the edges.

Don't leave metal objects on the surface longer than necessary.

Clean the surface before and after use.

e & & & & 0 @
e

Remember that the condition of this accurate plane
is an integral factor in the measurement being made.

Surface plate cleaner can be purchased through your local Tru-Stone distributor or directly from Tru-
Stone Technologies. Call for pricing and delivery information.

When the need for recalibration or rework of your surface plates and precision granite accessories
arises, contact a Tru-Stone representative or call us directly for more details on restoring your inspection
item to a “like new” condition. This service comes with new certification and plate labels.

One advantage of having your granite inspection equipment recalibrated by a manufacturer is the
manufacturer’s ability to take the time required to ensure the proper repeatability and overall shape of
the inspection surface. Tru-Stone allows the item to normalize ovemight prior to taking the final
readings to indicate whether it is a good enough quality to certify and return to you.

Should you have any questions, please contact our customer service representatives at 320/251-7171
or fax us at"320/259-5073. =

Important Notice

Any streaks of color in the granite are not defects. These are created by the molten lava mixing with
minerals prior to evolving into the granite you see today. Black streaks or spots are the result of a
magnetite (black iron oxide) concentration. White streaks or spots are areas where the granite is lacking
magnetite. The levels of magnetite in granite vary considerably, however the color of the granite in no way

affects the functionality or quality of it.

Our products are UNCONDITIONALLY Guaranteed

Please refer to the Federal Specification GGG-P-463c, which is followed by NIST (National Institute of
Standards & Technology) for Granite Surface Plates.

3.7 Seams or Color Streaks: Seams are cause for rejection. Color streaks have no affect on the
serviceability of the granite.”

“4.5.8 Seams or Color Streaks: Test for a seam is to wet the smooth surface of the granite where
the color streak appears; then dry it off. If the streak remains wet or damp, it is a seam.”

1101 Prosper Drive » P. O. Bax 430 « Waite Park, MN 58387 « 1-800-858-0517 » PH: 320-251-7171 » Fax 320-258-5073
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Measurement

Port Ant to 8111 (Nav to Trans)

Coord. Sys. Caris Caris

X 2.868 2.071
y 8.252 20.144
z 4.752 17.792

*Top of IMU is RP (Reference Pt)

Vessel Offsets for S220_8111 are derived from Westlake-Survey-Report-NOAA-Fairweather-09-23-03.pdf

and Fairweather NGS Report Feb gOO?.doc

Waterline to RP*

| caris

n/a
n/a

0.014

Scaler Distance | 1.997

2009 Measured Value

Calculations

Coord. Sys.  Westlake
IMU easting 0.000
Base northing 0.000
(ft/m) elevation 0.000
Westlake
8111 easting 27.072
(ft) northing 9.410
elevation 15.042
Westlake
8111 easting 8.252
(m) northing 2.868
elevation 4.585
Westlake
Base of IMU to Top of IMU
(m) elevation -0.168
These rows
Westlake (m) easting 8.252
unless noted Top of IMU northing 2.868
otherwise to 8111  elevation 4.752
Coord Sys.
X 2.868
y 8.252
z 4.752

Port Ant to 8111

Waterline to RP*

NGS 2009 IMU Base to baseline at Keel
Top of Port x  -11.892 (ft) elevation 12.856
Ant y 0.797 IMU Base to baseline at Keel
(m) z 13.047 (m) elevation 3.919
Top of Ant to Phase Center
(m) z 0.007 Waterline to Keel
Phase Cntr x -11.892 (ft) elevation 13.45
Port Ant y 0.797 Waterline to Keel
(m) z 13.040 (m) elevation 4.100
See Ship's Draft Tab
Port X 0.797
Ant y -11.892 Top of IMU to Base of IMU
(m) z -13.040 (m) elevation 0.168
Westlake Top of IMU to Keel
(m) easting 8.252 (m) 4.086
Top of IMU northing 2.868
to 8111  elevation 4.752
(m) X 2.868
Top of IMU y 8.252
to 8111 z 4,752
[ Port Ant to 8111 Waterline to RP*
X 2.071 (m) easting N/A
y 20.144 Waterline northing N/A
(m) z 17.792 to IMU elevation 0.014
Coord Sys. Coord. Sys.
X 2.071 x|N/A
y  20.144 y N/A
z 17.792 _—7 z 0.014

See Description Tab

NGS 2009

Top of x  -11.892

Port Ant y 0.797
(m) z 13.047

Top of Ant to Phase Center

(m) z 0.007
NGS 2009
Top of x -11.886
Sthd Ant y 2.794
(m) z 13.051

Scalar Distance (m) 1.997




Caris
0.797 -11.892
-11.892 0.797
13.047 -13.047

Caris

1.866 -7.028
-7.028 1.866
-2.086 -2.086

Value in POSMV is top of
antenna rather than the phase
center to IMU.

NGS 2009
IMU Top (m) X 0.000
y 0.000
z 0.000
NGS 2009
Top of Port x  -11.892
Ant y 0.797
(m) z 13.047
Top of Ant to Phase Center
(m) z 0.007
NGS 2009
Phase Cntr x  -11.892
Port Ant y 0.797
(m) z 13.047

NGS 2009 (m) x  -11.892
Top of IMU y 0.797
to Port Ant z 13.047
Coord Sys. Pos/Mv
x| -11.892
y 0.797
z| -13.047

IMU to Bulkhd (Frame) 52
(ft) easting  -11.638
(m) easting -3.547

Frame 0 (FP) to Frame 52
(m) easting  -27.737
IMU to Frame 0 (FP)
(m) easting 24.190

Heave Pt* to Frame O (FP)
(ft) easting 102.42
(m) easting 31.218

IMU to Centerline
(ft)  northing 6.122
(m)  northing 1.866

Heave Pt* to Centerline

(m)  northing 0

(m) easting -7.028
Top of IMU northing 1.866
to Heave Pt* elevation -2.086

Coord. Sys. Pos/Mv

x| -7.028
y 1.866
z| -2.086

see Description Tab

IMU Base to baseline at Keel
(ft) elevation 12.856
(m) elevation 3.919

Top of IMU to Base of IMU

(m) elevation 0.168
Top of IMU to Keel
(m) elevation 4.086

Center of Gravity above baseline

(ft) elevation 16.37
Mean Metacentric height
(ft) elevation 3.88

Heave Pt* to baseline at Keel
(ft) elevation 20.25
(m) elevation 6.172

(*Heave Pt is Metacenter)
(FP is Forward Perpendicular)




[Measurement| IMU to 8160 (MRUto Trans) |  [PortAntto 8160 (Navto Trans)[ | Waterline to RP*
Coord. Sys. Caris Caris |

X 0.493 -0.304

y 7.665 19.557,

z 4.726 17.766,

*Top of IMU is RP (Reference Pt)

Caris |
n/a

n/a
0.014

Caris Caris
|Scaler Distance | 1.997| 0.797 -11.892 1.866
-11.892 0.797 -7.028
13.047 -13.047 -2.086

-7.028]
1.866
-2.086]

Vessel Offsets for S220_8111 are derived from Westlake-Survey-Report-NOAA-Fairweather-09-23-03.pdf,

Fairweather NGS_Report_02-07.pdf_and  FairweatherCenterlineSurvey 03-09.pdf,

Derivations

Coord. Sys.

Westlake
IMU easting 0.000
Base northing 0.000

(ft/m) elevation 0.000

Westlake
8160 easting 25.149
(ft) northing 1.619
elevation 14.956

Westlake
8160 easting 7.665
(m) northing 0.493
elevation 4.559

Base of IMU to Top of IMU
(m) elevation -0.168

Westlake easting 7.665
Top of IMU  northing 0.493
to 8160 (m) elevation 4.726

Coord Sys

X 0493
y 7.665
z 4.726

NGS 2009
Top of Port X -11.892
Ant y 0.797
(m) z 13.047
Top of Ant to Phase Center
(m) z 0.007
Phase Cntr X -11.892
Port Ant y 0.797
(m) z 13.040
Port X 0.797
Ant y -11.892
(m) z -13.040
Westlake
(m) easting 7.665
Top of IMU northing 0.493
t0 8160  elevation 4.726
(m) X 0.493
Top of IMU y 7.665
to 8111 z 4.726
X -0.304
y 19.557
(m) z 17.766
Coord Sys
X -0.304]
Y| 19.557
z 17.766




Description of Offsets for FAIRWEATHER S-220

All Values Shown are in CARIS Coordinates

IMU to Port Antenna
x:0.797
y: -11,892
z:-13.47

IMU to Heave Point

: x: 1.866 ;
y:-7.028  IMU=Reference Point (RP)
7:-2.086  x:0.000

‘lI y: 0.000
2:0.000

Fer A;te—gn;oﬁ) i IMU to Seabat 8160
y: 19.557 x: 0.493
z:17.766 y: 7.665
2:4.726
Port Antenna to 8TTT IMU to Seabat 8111
x:2.071 X: 2.868
y: 20.144 y: 8.252
z:17.792 z: 4.752

IMU to Port Antenna
x:0.797 § %
y:-11.892 F

z:-13.047




[ MUto 8111 (MRU to Trans) |
X y z

2.868 8.252 4.752
The lever arms between the IMU
and phase center of the 8160
transducer are taken from the
Westlake report with the addition of
the 0.168 m offset included for the
height of the IMU.

Port Ant to 8111 (Nav to Trans)
X y z
2.071 20.144 17.792
This information comes from a
combination of the Westlake and
NGS surveys. Subtraction of the
distance between Top of Antenna
and the Phase Center were
included in final value
determination. Relative positions
obtained from Port Ant to 8111 via
IMU.

Scaler Distance 1.997
Using the NGS 2009 survey values
for the antennas, a calculated
vector for antenna separation was
determined. The distance from Top
of Antenna to Phase Center does
not affect this calculation and
therefore was not included.

Waterline to RP*
X y z

n/a n/a 0.014]
The height of the IMU above the
keel comes from the Westlake
survey value of 3.919 m plus the
measured value of the top of the
IMU to the base plate, to get an
IMU height above the keel. The
draft (waterline to keel) used for the
FAIRWEATHER is based on
observations, Ship's Draft
spreadsheet. Differencing the
value of IMU to keel and waterline
to keel gives the waterline to RP
distance.

[ MUto 8160 (MRU to Trans) |
X y z

0.493 7.665 4.726)
The lever arms between the IMU
and phase center of the 8111
transducer are taken from the
Westlake report with the addition
of the 0.168 m offset included for
the height of the IMU.

[ PortAnt to 8160 (Nav to Trans)|
X y z

-0.304 19.557 17.766
This information comes from a
combination of the Westlake and
NGS surveys. Subtraction of the
distance between Top of Antenna
and the Phase Center were
included in final value
determination. Relative positions
obtained from Port Ant to 8160 via
IMU.

[ ™UwPortAnt |
X y z

0.797 -11.892 13.047
This information comes directly
from the NGS 2009 survey.
Subtraction of the distance
between Top of Antenna and the
Phase Center were included in
final value determination.

X y z

From pg 3 of the Westlake Survey

1.866 -7.028 -2.086|
Key points on the IMU, from the
Westlake survey, are its location
with respect to the ship’s reference]
frame. Itis 4.087 m (3.919 m to
base line + 0.168 m for IMU height|
above base plate) above the keel,

SUMMARY

IMU foundation plate is level to within +/-0.001 feet
IMU foundation plate is located 12.856 feet above baseline established at the keel
IMU is parallel to ship's centerline to within +/- 0.001 feet

Location of scribed centerline intersection is 6.122 feet port of ship's centerline.
IMU foundation plate centerline is located 11.638' feet forward of bulkhead 52.

1.866 m port of centerline and
3.547 m forward of frame 52. This
information is needed to reference
the IMU to the ship’s Heave
Measurement Location (Heave
Point). *

the metacenter.

Lynn - read through and check

* From the Art Anderson inclination experiment the position of the metacenter was used as the position of the ship’s Heave Point. (There ma
be a better way to determine the Heave Point, but this decision was based upon available information). The metacenter is defined by the
center of buoyancy. As a vessel inclines through small angles, the center of buoyancy moves through the arc of a circle whose center is at

Important numbers and information determined from the Art Anderson report are the location of the metacenter and how it is positioned with
respect to the vessel. The longitudinal location of the metacenter is defined as 102.42 feet (31.217 m) aft of the forward perpendicular. The
height of the metacenter is 20.25 feet (6.172 m) above the keel. There is an assumption of the metacenter being on the centerline of the
vessel. Similar values for the RAINIER’s metacenter are 32.52 m aft of the forward perpendicular and 5.2 m above the keel. The difference
in the height of the metacenter can be attributed to the difference between the FA’'s and RA’s average draft which is 13.12 feet as opposed tg
approximately 14.5 feet respectively.

Referencing the metacenter (Heave Point, HP) to the IMU information requires information about the frame spacing of the vessel. From the
Westlake survey, the IMU is located 3.547 m forward of frame 52. From Inclination document, the HP is 31.217 m aft of the forward
perpendicular. From engineering drawings of the ship frame spacing is approximately 21 inches. The calculation for the longitudinal location|
of the HP with respect to frame zero, the Forward Perpendicular (FP) is as follows:

52 (frame) * 21 (inches/frame)/12(inches/ft)*.3048(m/ft)-3.547 m = 24.190 m from frame 0.
31.217 m (HP aft of FP) — 24.190 m (IMU aft of FP) = 7.027 m (HP aft of IMU)

The calculation for the vertical separation between the IMU and the HP is based on the height of the metacenter being 6.172m and the heigh
of the IMU being 4.087 m above the keel. Differencing yields the metacenter being 2.085 m above the IMU.

The calculation for the athwartship separation is based upon the assumption that the HP is on the centerline and the knowledge that the IMU
is 1.866 m to port of the centerline.




Sources

Offset values for the ship were derived from three sources. Two static offset surveys, an inclination experiment, and values measured or
approximated by ship’s personnel.

On September 23, 2003 an offset survey of the NOAA Ship FAIRWEATHER was conducted by:

Westlake Consultants, Incorporated

15115 SW Sequoia Parkway, Suite 150

Tigard, Oregon 97224

Phone (503) 684-0652

...and the relocation of the POS M/V antenna forced a partial resurvey in Feb. 2007 by Steven Breidenbach of NGS.

These values relate the physical positions of one sensor to the next with the base plate of the IMU being the point of origin. All
dimensions in the document are given in feet and decimal feet.

On July 16, 2004 an inclination experiment was conducted at MOC-P by:

Art Anderson Associates
202 Pacific Avenue
Bremerton, WA 98337-1932

Calculations

The values for the required lever arms are listed in the S220_Offsets and Measurements spreadsheet. The reference point and the
IMU are identical. Difference in documentation between Westlake and FA calculations are based off of measuring up from the
IMU base (Westlake’s origin) and the top of the IMU. The top center of the IMU for the POS/MV is the defined origin for the
POS/MV and the origin that is being used on all FAIRWEATHER vessels. The distance from the base plate to the top of the
IMU is 0.168 m, a value measured by ship’s complement. Conversions factor from feet to meters is 0.3048 m/ft.

As a requirement for the TPE, the standard deviation for each position is 3 mm. This value is based upon a conversation with
Elaine McDonald of Westlake and is followed up by an Email documenting that fact. The email is located at the end of this
document.



POS MV V4 Installation and Operation Guide

Drawings

Phasa Cantre a.37CM

460 CM

Figure 79: GPS Antenna Footprint

POS MV V4 Installation and Operation Guide

Drawings

Appendix E

Drawings

167.5

Figure 77: IMU Footprint




WESTLAKE Coordinate System
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NGS Coordinate System
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POSIMV Coordinate System
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CARIS Coordinate System
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[ MUto 8111 (MRU to Trans) |
X y z

2.868 8.252 4.752
The lever arms between the IMU
and phase center of the 8160
transducer are taken from the
Westlake report with the addition of
the 0.168 m offset included for the
height of the IMU.

Port Ant to 8111 (Nav to Trans)
X y z
2.071 20.144 17.792
This information comes from a
combination of the Westlake and
NGS surveys. Subtraction of the
distance between Top of Antenna
and the Phase Center were
included in final value
determination. Relative positions
obtained from Port Ant to 8111 via
IMU.

Scaler Distance 1.997
Using the NGS 2009 survey values
for the antennas, a calculated
vector for antenna separation was
determined. The distance from Top
of Antenna to Phase Center does
not affect this calculation and
therefore was not included.

Waterline to RP*
X y z

n/a n/a 0.014]
The height of the IMU above the
keel comes from the Westlake
survey value of 3.919 m plus the
measured value of the top of the
IMU to the base plate, to get an
IMU height above the keel. The
draft (waterline to keel) used for the
FAIRWEATHER is based on
observations, Ship's Draft
spreadsheet. Differencing the
value of IMU to keel and waterline
to keel gives the waterline to RP
distance.

[ MUto 8160 (MRU to Trans) |
X y z

0.493 7.665 4.726)
The lever arms between the IMU
and phase center of the 8111
transducer are taken from the
Westlake report with the addition
of the 0.168 m offset included for
the height of the IMU.

[ PortAnt to 8160 (Nav to Trans)|
X y z

-0.304 19.557 17.766
This information comes from a
combination of the Westlake and
NGS surveys. Subtraction of the
distance between Top of Antenna
and the Phase Center were
included in final value
determination. Relative positions
obtained from Port Ant to 8160 via
IMU.

[ ™UwPortAnt |
X y z

0.797 -11.892 13.047
This information comes directly
from the NGS 2009 survey.
Subtraction of the distance
between Top of Antenna and the
Phase Center were included in
final value determination.

X y z

From pg 3 of the Westlake Survey

1.866 -7.028 -2.086|
Key points on the IMU, from the
Westlake survey, are its location
with respect to the ship’s reference]
frame. Itis 4.087 m (3.919 m to
base line + 0.168 m for IMU height|
above base plate) above the keel,

SUMMARY

IMU foundation plate is level to within +/-0.001 feet
IMU foundation plate is located 12.856 feet above baseline established at the keel
IMU is parallel to ship's centerline to within +/- 0.001 feet

Location of scribed centerline intersection is 6.122 feet port of ship's centerline.
IMU foundation plate centerline is located 11.638' feet forward of bulkhead 52.

1.866 m port of centerline and
3.547 m forward of frame 52. This
information is needed to reference
the IMU to the ship’s Heave
Measurement Location (Heave
Point). *

the metacenter.

Lynn - read through and check

* From the Art Anderson inclination experiment the position of the metacenter was used as the position of the ship’s Heave Point. (There ma
be a better way to determine the Heave Point, but this decision was based upon available information). The metacenter is defined by the
center of buoyancy. As a vessel inclines through small angles, the center of buoyancy moves through the arc of a circle whose center is at

Important numbers and information determined from the Art Anderson report are the location of the metacenter and how it is positioned with
respect to the vessel. The longitudinal location of the metacenter is defined as 102.42 feet (31.217 m) aft of the forward perpendicular. The
height of the metacenter is 20.25 feet (6.172 m) above the keel. There is an assumption of the metacenter being on the centerline of the
vessel. Similar values for the RAINIER’s metacenter are 32.52 m aft of the forward perpendicular and 5.2 m above the keel. The difference
in the height of the metacenter can be attributed to the difference between the FA’'s and RA’s average draft which is 13.12 feet as opposed tg
approximately 14.5 feet respectively.

Referencing the metacenter (Heave Point, HP) to the IMU information requires information about the frame spacing of the vessel. From the
Westlake survey, the IMU is located 3.547 m forward of frame 52. From Inclination document, the HP is 31.217 m aft of the forward
perpendicular. From engineering drawings of the ship frame spacing is approximately 21 inches. The calculation for the longitudinal location|
of the HP with respect to frame zero, the Forward Perpendicular (FP) is as follows:

52 (frame) * 21 (inches/frame)/12(inches/ft)*.3048(m/ft)-3.547 m = 24.190 m from frame 0.
31.217 m (HP aft of FP) — 24.190 m (IMU aft of FP) = 7.027 m (HP aft of IMU)

The calculation for the vertical separation between the IMU and the HP is based on the height of the metacenter being 6.172m and the heigh
of the IMU being 4.087 m above the keel. Differencing yields the metacenter being 2.085 m above the IMU.

The calculation for the athwartship separation is based upon the assumption that the HP is on the centerline and the knowledge that the IMU
is 1.866 m to port of the centerline.




Sources

Offset values for the ship were derived from three sources. Two static offset surveys, an inclination experiment, and values measured or
approximated by ship’s personnel.

On September 23, 2003 an offset survey of the NOAA Ship FAIRWEATHER was conducted by:

Westlake Consultants, Incorporated

15115 SW Sequoia Parkway, Suite 150

Tigard, Oregon 97224

Phone (503) 684-0652

...and the relocation of the POS M/V antenna forced a partial resurvey in Feb. 2007 by Steven Breidenbach of NGS.

These values relate the physical positions of one sensor to the next with the base plate of the IMU being the point of origin. All
dimensions in the document are given in feet and decimal feet.

On July 16, 2004 an inclination experiment was conducted at MOC-P by:

Art Anderson Associates
202 Pacific Avenue
Bremerton, WA 98337-1932

Calculations

The values for the required lever arms are listed in the S220_Offsets and Measurements spreadsheet. The reference point and the
IMU are identical. Difference in documentation between Westlake and FA calculations are based off of measuring up from the
IMU base (Westlake’s origin) and the top of the IMU. The top center of the IMU for the POS/MV is the defined origin for the
POS/MV and the origin that is being used on all FAIRWEATHER vessels. The distance from the base plate to the top of the
IMU is 0.168 m, a value measured by ship’s complement. Conversions factor from feet to meters is 0.3048 m/ft.

As a requirement for the TPE, the standard deviation for each position is 3 mm. This value is based upon a conversation with
Elaine McDonald of Westlake and is followed up by an Email documenting that fact. The email is located at the end of this
document.
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NOAA POS/MV Calibration Report

Ship: FAIRWEATHER Vessel:  S220
Date: 4/27/2009 Dn: 117
Personnel: Campbell, Rice
PCS Serial # 2411 IMU Serial # 292
IP Address: 129.100.1.231
Port Antenna Serial # 60103854 Stbd Antenna Serial # 60125191
POS controller Version (Use Menu Help > About) 4.0.2.0
POS Version (Use Menu View > Statistics) 320 Version 4

GPS Receivers

Primary Receiver BD950 SN:4611A66708 v.00211
Secondary Receiver BD950 SN:4602A62806 v.00211

. Statistics k
POS Version R —— S —
hv-320 VERS, S/N2411 HW2 5-7 SWO3.42-May28/07 |CD03.25 05425814 IMU2 PGPS13 SGPS13 RTK-D THY-0 DPW- |
GPS Receivers

Primary Receiver : : .

BDOS0 SN4G611AB6708, v 00211, channels: 24

Secondary Receiver

BD950 SN4G0ZAG2E806,v.00211, channels: 24

Statistics-

Total Hours 7080.1
Total Runs 331
Average Run (hours) 214
Longest Run (hours) 549.0
Current Run thours) 40.0

Calibration area
Location:  Central Fitz Hugh Sound, BC, Canada
Approximate Position: Lat

Lon

DGPS Beacon Station: Alert Bay
Frequency: 309




Satellite Constellation

Primary GPS
Sketch general SV configuration or insert screen grabs
N
T—
HDOP

HDOP

(Use View> GPS Data)

Secondary GPS
Note any differences from Primary GPS Receiver

lﬁ—.—u—m

[ ————————

vy B v | o crvtory Hoiroms | dasmbary 1| dsmtioy 2
B

0.807|

% Troe st o 00
I 3

VDOP ]

VDOP

1.169)

o= |
Sattelites in use: 10
L1 SNR > 30 35 40
PDOP (Use View> GAMS Solution)
POS/MV Configuration
Settings Gams Parameter Setup

=
Sattelites in use: 10
L1SNR: 30 35 40

(Use Settings>Installation>GAMS Installation)

Twa Antenna Separation (m)
Heading Calibration Threshold (dea)

Heading Conection (deg)

[ Bassline Wectar

% Component (]
¥ Component (m)

2Z Component (m)

= Ok

Configuration Notes:

Antenna separation based on 2007 survey.

POS/MV Calibration
Calibration Procedure:

Start time:
End time:

19:59:38
20:34:44
Heading accuracy achieved for calibration:

Calibration Results:

Gams Parameter Setup

AMS Parameter Setup

0.253

(Refer to POS MV V3 Installation and Operation Guide, 4-25)

(Use Settings>Installation>GAMS Installation)

T

Twa Antenna Separation (m)
Heading Caiibration Thieshold deg)

Heading Carrectian (deg)

1.997
0.500
0.000

Baseline Vector

* Component (m)
¥ Component (m)

Z Companent (m)

0.001
1.996
0015

= Ok

|: Ciose I

Apply | View

GAMS Status Online
Save Settings

Yes

Calibration Notes:

Save POS Settings on PC
File Name:

(Use File > Store POS Settings on PC)



General Notes:

The POS/MV uses a Right-Hand Orthogonal Reference System

The right-hand orthogonal system defines the following:

« The x-axis is in the fore-aft direction in the appropriate reference frame.

« The y-axis is perpendicular to the x-axis and points towards the
right (starboard) side in the appropriate reference frame.
« The z-axis points downwards in the appropriate reference frame.

The POS/MV uses a Tate-Bryant Rotation Sequence

Apply the rotation in the following order to bring the two frames of reference
into complete alignment:

a) Heading rotation - apply a right-hand screw rotation 6z about the
z-axis to align one frame with the other.

b) Pitch rotation - apply a right-hand screw rotation 8y about the
once-rotated y-axis to align one frame with the other.

c) Roll rotation - apply a right-hand screw rotation 6x about the
twice-rotated x-axis to align one frame with the other.

SETTINGS
Input/Output Ports (Use Settings > Input/Output Ports)
com1i
comt |conz | coms | come | coms |
| Parity | Dats Bas | - Stop Bits | Flow Contral
o L = & Nana 7B | F 1Bt = None
 Evin  Hurdwars
Cos | |F8Bm | C2BIs || uomorr
Output Select | "MEA Dutpt s | [ Fest Postive Sense
n Dals = Pori Up " Starboard Up
[FMEA - H |
TH: 2l || Pich Positive Senee
- F Bowlp  C StemUp
E o s] || Heawe Poste Sense
[ $INPRS = Haave Up " Heave Down
Input Select
iNuun -
Ccom2
comt [COME |cont | coms | coms |
[ Pty - Data Bty -~ Stop Bite | - Fliow Control
iz et |[c7om | 1o || = Nom
~ Ewn " Hardware.
row | ©EBt || C2805 ||~ youscer |
Output Select | =04 Sulput — 1 [ Rl Posithve Senas T
ey 5 % # Sengor | F Pelp  © Starboard Up
25 Hz = | - spenarz | Pitch Fostie Sansn |
U] # BowpC Stemup
Faumiils St x e
T3St = | Hawew Up T Haew Dier |
Input Select
Hone -

G | A |

Ccom3

com | cong [COME |coma | coms |

| Parity [ Dats Bes ‘Stop Bite | Flow Cantred
Basd Rate
| & Nan C7Be || 18 = (Nonw
00 = © Evn  Hardwars
© Odd FEBs || C 208 ||~ wownoRr
Qutput Select
=0 =

Input Select Base GFS lagut

Base 1 GPS ¥] Input Typa [RTCH 1o -]

| Ling 1
| % Sarial " Modem |

Closa Aty

Com4

comt | comz | coms [COMA |coms |

| Parity [ Dats Bes ‘Stop Bite | Flow Cantred
Ml,L_‘ Ll R P & Nong
00 = © Evn  Hardwars
© Odd FEBs || C 208 ||~ wownoRr
Output Select  'MEACuR [ Rl Postim S
Feaza -] | = Port Up Starboard Up
- Pitch Paitivy Sunse
© Bowlp  C StamUs
Hewe Positive Sonse
~ HeweUp  © Hoave Down
Input Select
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SETTINGS Continued COM5

Heave Filter (Use Settings > Heave)
Heave Filter
Events
INSTALLATION (Use Settings > Installation)
Lever Arms and Mounting Angles (Use Settings > Installation > Lever Arms and Offsets)

Lever Arms & Mounting Angles.

ﬁ

-11.892 |’

INSTALLATION Continued
Tags, Multipath and Auto Start (Use Settings > Installation > Tags, Multipath and Auto Start)

L.

£ Highy




Sensor Mounting (Use Settings > Installation > Sensor Mounting)

Lewver Arms & hMounting Angles

Tags. kMultipath & AutoStar I
—Ref to Aux. 1 GPS Lever Arm— ~Ref to Aux. 2 GPS Lever Amm—————

¥ (m) |0.000 ® (rm) 0.000
¥ (m)  [0.000 ¥ () 0.000
£ [o.ooo Z(m) 0.000

—Ref to Sensar 1 Lever Arm —Sensor 1 Frame wrt Ref Frame

X {m)  [0.000 W (deg) 0.000
¥ () 0.000 ¥ (deg) 0.000
Zim)  [o.ooo Z (deg) 0.000
Ref. to Sensor 2 Lever Arrm Sensor 2 Frame w.r.t. Ref Frame
X {m)  [0.000 W (deg) 0.000
¥ () 0.000 ¥ (deg) 0.000
z 1%3 0.000 Z (deg) 0.000
User Parameter Accuracy (Use Settings > Installation > User Accuracy)
User Parameter Accuracy x|

RMS Accuracy
Attitude (deg) 0.050

Heading (deg) 0.050
Pasition {m) 2.000

“Welocity (mfs) ID.SDD

Close | Apply |
Frame Control (Use Tools > Config)
Mavigator ﬂ
—Frame Control——————— ~Auxiliary GPS Position
£ U Frame Sl

€ Use regardless of status

& User Frarme Do not use

rPrimary GPS Measurement GAN
& [ormal ’Vr Disable GAME Solution ‘

€ Use regardless of status

€ Dojnot use

Close | Apply |

(Use Settings> Installation> GPS Receiver Configuration)
GPS Receiver Configuration

Primary GPS Receiver Gps Receiver Configuration x|

Primary GPS Receiver | Secondary GPS R’ecewerl

Primary GRS | GPS 1 Port
GPS Output Rate Baud Rate

1 Hz =l | | Joe0n =l

Parity Data Bits Stop Bits
= Mone 7 Bits & 1 Bit
—Auto Configuration ~ Even
& Enabled © Odd @ B Bits 2 Bits
 Disabled
Close Apply
Secondary GPS Receiver Gps Receiver Configuration x|

Primary GPS Receiver Secondary GPS Recewer |

—Secondary GPS——— GPS 2 Port
GPS Output Rate Baud Rate

1 Hz | |9500 =

Parity Data Bits Stop Bits
& None 7 Bits & 1 Bit
—Auto Configuration  Ewen
& Enabled ~ Odd * & Bits " 2 Bits

° Disabled

Close Apply




FAIRWEATHER

Multibeam Echosounder Calibration S220 8111
Vessel

4/28/2009 118 |Moira Rock

Date Dn Local Area

Morgan, Welton, Raymond, Stuart, Ringel

Calibrating Hydrographer(s)

Reson 8111 |Fairweather |Mar-2009

MBES System MBES System Location Date of most recent EED/Factory Check
Unknown |35652

Sonar Serial Number Processing Unit Serial Number

Hull, curved transducer |2/15/2009

Sonar Mounting Configuration Date of current offset measurement/verification
Applanix Pos MV |4/27/2009

Description of Positioning System Date of most recent positioning system calibration

Acquisition Log

4/29/2009]119 |Moira Rock |Ptly cloudy, cool,
Date Dn Local Area Wx
Bottom Type Approximate Water Depth

Personnel on board

Back time cast number BOT_005

Comments

TrueHeave filename

BOT_0004 | | | | |
SV Cast #1 filename UTC Time Lat Lon Depth Ext. Depth
BOT_0005 | |55\04\48.48 |131\58\23.30 | |

SV Cast #2 filename UTC Time Lat Lon Depth Ext. Depth



NAV TIME LATENCY

view parallel to track, one line with induced roll (outerbeam) or same lines target or slope (nadir)
[same direction, different speed]

SV Cast# |XTF Line Filename Heading |Speed (kts) |Remarks

BOT_0005 |2009_ 1190714 206 3.7]10m port over target

BOT_0005 2009 1190732 033 3.8]8m starboard over target

BOT_0005 2009 1190749 207 9.0]30m port over target redo:do not use for patch
BOT_0005 ]2009 1190800 034 8.7]7m stb over tgt

BOT_0005 2009 1190811 207 9.0]30m stb over target redo:do not use for patch
BOT_0006 |2009_1190857 206 9.1]5m port over target

PITCH view parallel to track, same line (at nadir) [opposite direction, same speed)]

SV Cast# |XTF Line Filename Heading |Speed (kts) |Remarks

BOT_0005 []2009 1190608 207 6.5|back time cast 0605

BOT_0005 []2009 1190633 033 6.5]good line held true

BOT_0005 2009 1190645 210 6.2]started to starboard, straightened smartly
BOT_0005 2009 1190658 033 7.2]15m starboard over target

HEADING/YAW

view parallel to

track, offset i

nes (outerbeams) [opposite direction, same speed]

SV Cast# |XTF Line Filename Heading |Speed (kts) |Remarks

BOT_0005 2009 1190827 031 6.5]Line 3:good line held true

BOT_0006 2009 1190911 031 6.5]Line4: good line held true

BOT_0006 2009 1190937 208 6.5]Line 3:good line held true

BOT_0006 2009 1191002 207 6.6]Line 4: good line held true

ROLL view across track, same line [opposite direction, same speed]

SV Cast# |XTF Line Filename Heading |Speed (kts) |Remarks

BOT_0004 ]2009 1190503 270 5.3]good line
2009 1190519 086 5.4]Off line to Starboard 20ish meters at start
2009 1190534 268 5.4]mostly good line, 10m off at start
2009 1190548 091 5.7]mostly good line, 20m off Starboard at start




Processing Log

4/29/2009 119 |stuart
Date Dn Personnel

Data converted --> HDCS_Data in CARIS

TrueHeave applied PosPac_S220 118.005

SVP applied Moira_Rock _S220 SV.svp

Tide applied  zerotide.tid

Zone file

Lines merged

Data cleaned to remove gross fliers [ ]

Compute correctors in this order
1. Precise Timing 2. Pitch bias 3. Heading bias 4. Roll bias

Do not enter/apply correctors until all evaluations are complete and analyzed.

PATCH TEST RESULTS/CORRECTORS

Evaluators Latency (sec) Pitch (deg) Roll (deg) Yaw (deg)
B. Welton -0.05 0.30 0.00 -0.30
A. Raymond 0.04 -0.40 0.00 -0.40
L. Stuart -0.07 0.25 0.02 -0.70
CST Morgan 0.00 -0.20 -0.02 -0.30
FOO 0.04 -0.30 0.00 -0.20
Averages -0.01 -0.07 0.00 -0.38
Standard Deviation 0.05 0.32 0.10 0.01 0.19 0.08
FINAL VALUES 0.00 -0.07 0.00 -0.38
Final Values based on CST/FOO Average of all results

Resulting HVF File Name FA_S220 Reson8111 2009.hvf

Actual values used

MRU Align StdDev

MRU Align StdDev gyro 019 Value from standard deviation of Heading offset values 0.082 gyro
MRU Align
MRU Align StdDev Roll/Pitch 0-17 Value from averaged standard deviations of pitch and roll offset values 0.057 StdDev Roll/Pitch

NARRATIVE

Initial MRU values were too high, TPU values reassessed with outliers removed.

HVF Hydrographic Vessel File created or updated with current offsets

Name: CST Morgan Date: 05/06/09




FAIRWEATHER

Multibeam Echosounder Calibration $220 8160
Vessel

4/28/2009  |118 |Moira Rock

Date Dn Local Area

Morgan, Welton, Raymond, Campbell, Ringel

Calibrating Hydrographer(s)

Reson 8160 |Fairweather - $220

J2004

MBES System MBES System Location

Unknown

Date of most recent EED/Factory Check

|35385

Sonar Serial Number

Hull, flat faced

Processing Unit Serial Number

J2/15/2009

Sonar Mounting Configuration

Applanix Pos MV

Date of current offset measurement/verification

|4/2712009

Description of Positioning System

Acquisition Log

4/28-29/2009]01 |Moira Rock

Date of most recent positioning system calibration

|Clear, cool, 2 foot chop, 10-12 kts NNW

Date Dn Local Area

Wx

Bottom Type

Approximate Water Depth

Personnel on board

NMEA Output was not run during SV Cast resulting in no positions, an approximate position for Cast #3 is entered below

Comments

PosPac_S220_118

TrueHeave filename

BOT_0001 | | | | |
SV Cast #1 filename UTC Time Lat Lon Depth Ext. Depth
BOT_0002 | | | | |
SV Cast #2 filename UTC Time Lat Lon Depth Ext. Depth
BOT_0003 | |55/05.9346 |131/56.5637 | |
SV Cast #3 filename UTC Time Lat Lon Depth Ext. Depth



NAV TIME LATENCY

view parallel to track, one line with induced roll (outerbeam) or same lines bounded slope (nadir)

[same direction, different speed]

SV Cast# |XTF Line Filename Heading Speed (kts) JRemarks
BOT_0001 [2009 1182317 032 6.6]Also good Pitch line
2009 1182347 033 4.4
2009 1182332 207 7.0]Good pitch line
2009 1190007 207 4.3|Latency
20091190023 032 9.6]Latency
2009 1190034 207 9.2]Latency
PITCH view parallel to track, same line (at nadir) [opposite direction, same speed)]
SV Cast# |HSX Line Filename Heading Speed (kts) |Remarks
BOT_0001 [2009_1182240 033 6.5]First line!!
2009 1182305 207 6.4|Pretty good line.
2009 1182317 032 6.6]good line
2009 1182332 207 7.0]good line

HEADING/YAW

view parallel to track, offset lines (outerbeams) [opposite direction, same speed]

SV Cast# |XTF Line Filename Heading Speed (kts) |Remarks

BOT_0002 ]2009_1190112 024 5.5INW line, good outer beam overlap with feature.
2009 1190131 213 5.5]SE Good line
2009_1190147 027 5.5INW inboard and better overlap
2009 1190203 213 5.6]SE

ROLL view across track, same line [opposite direction, same speed]

SV Cast# |XTF Line Filename Heading Speed (kts) JRemarks

BOT_0003 2009 1190307 270 6.2|80m to port at beginning of line
2009_ 1190323 090 6.3]lost bottom track mid line
2009 1190338 270 5.0]poor line tracking
2009_ 1190353 090 6.8]good line
2009_ 1190408 270 6.3]good line
2009_ 1190426 090 6.0]good line




Processing Log

4/29/2009 119 |stuart

Date Dn Personnel
Data converted --> HDCS_Data in CARIS

TrueHeave applied PosPac_S220_118.000

SVP applied Moira_Rock_S220 SV.svp

Tide applied  zerotide.tid

Zone file

Lines merged

Data cleaned to remove gross fliers [

Compute correctors in this order

1. Precise Timing 2. Pitch bias 3. Heading bias 4. Roll bias
Do not enter/apply correctors until all evaluations are complete and analyzed.
PATCH TEST RESULTS/CORRECTORS
Evaluators Latency (sec) Pitch (deg) Roll (deg) Yaw (deg)
CST Morgan 0.04 -0.40 -0.04 -0.40
B. Welton 0.00 -0.35 -0.07 0.60
A. Raymond 0.05 -0.16 -0.04 0.55
B. Campbell 0.01 -0.35 -0.04 0.60
FOO 0.00 -0.10 -0.05 0.50
Averages 0.02 -0.27 -0.05 0.37
Standard Deviation 0.02 0.13 0.029 0.01 0.43 0.05
FINAL VALUES 0.00 -0.27 -0.50 0.37
Final Values based on
Resulting HVF File Name
Actual values used
MRU Align StdDev
MRU Align StdDev gyro 043 Value from standard deviation of Heading offset values 0.048 gyro
MRU Align
MRU Align StdDev Roll/Pitch 0.07 Value from averaged standard deviations of pitch and roll offset values 0.021 stdDev Roll/Pitch

NARRATIVE
Data analyzed was collected on Dn 118 and 119.

Initial MRU values were too high, TPU values reassessed with outliers removed.

HVF Hydrographic Vessel File created or updated with current offsets

Name: CST Morgan

Date: 5/6/2009



G.Rice
2/26/09

Fairweather Elipsoidally Referenced Dynamic Draft
Measurement

Lake Washington, February 23" 2009

On Feb 23" 2009 the NOAA Ship Fairweather conducted a dynamic draft measurement
(DDM) on Lake Washington using post processed kinematics (PPK). A standard
operating procedure was defined before the test and is included as Appendix A. The plan
was to determine the how much, at different speeds, the vessel’s draft changes with
reference to ellipsoidal height. During the test, Fairweather stopped between speeds to
allow for a static height measurement. Due to time constraints this test was only run with

approximate speeds of 4 knots, 6 knots, 8 knots, and 10 knots.

Because this DDM was conducted on Lake Washington, any change in water level was
assumed to be negligible. Since it was further assumed there was no current, speed
through the water was determined using over-ground speed (GPS). Wind was from the
North at approximately 10 knots. The ship was light on fuel, without launches, and
drawing two feet less in the stern than would normally be expected during survey
operations.

POSPac file recording from the POS/MV began before getting underway, approximately
an hour before the DDM was performed. After the test, the data were imported into
POSPac processing software and reference stations were uploaded using the “smart
select” option. Six stations were selected, three from CORS and three from SOPAC. The
Smart Base Quality Check was run and it identified one position to be adjusted and two
that could be set to control; these changes were accepted. Applanix Smart Base was run
to generate a local virtual reference station. Processors then ran the GNSS-Inertial
Processor, using the SmartBase GNSS Mode with a zero initialization for Roll, Pitch and

Heading. Lever Arms and Mounting Arms were set to be in the 10cm uncertainty range.



A coordinate system of UTM zone 10 with the GEOIDO03 (Conus) was used while
processing the data. Figure 1 is a screen grab of the network. Reference station distance

from the working area ranged from 1500 meters to 35 kilometers.

e PP

10000 m

Figure 1 — The network used consisting of six reference stations.

Once processed in POSPac the Display Plots were reviewed. No problems were found.
The X, Y and Z Reference-Primary GPS Lever Arms varied by as much as 0.2 meters
over the course of the exercise, although the Z Lever Arm agreed to within 3cm with the
typical values found during the Ernest Sound Project. The Altitude SBET and the

associated RMS values can be found in Figure 2 and Figure 3 respectively.
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Figure 3 — The estimated vertical error time series from POSPac.
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Because the noise associated with altitude readings (Figure 2) is within the uncertainty
shown in Figure 3, this noise is not considered significant. Two approaches were
considered for determining authentic draft measurement from within the noise. The first
approach selects specific sections of data that have relatively small changes in speed and
average them for both speed and ellipsoidal height. The draft, then, is the result of
subtracting the average ellipsoidal height recorded at rest from the averaged ellipsoidal
height at speed. The second method plots a best-fit polynomial curve to the distribution
of all data on a speed vs ellipsoidal height axis (Figure 4). This is more robust and just as
accurate as the first approach. Consider that survey vessels are often making changes to
speed or course during operations, changes for which typical DDM tests do not account.

The second method described was used here.
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Figure 4 — Ellipsoidal Height data as a function of the Speed with the best-fit curve.

Figure 4 shows the data clusters at each of the target speeds. These clusters of data
weight the best-fit curve to the correct shape. Data points from speed changes
demonstrate the variation likely during survey operations and are an indicator of the



uncertainty for DDM. While the best-fit curve does not pass through each cluster, its

proximity is within the vertical uncertainty for these measurements.

The equation for the best-fit curve can be used to give the delta draft table needed by
Caris. By simply plugging in different speeds the change in draft is given when the
ellipsoidal offset at rest is subtracted from the equation, resulting in a zero y intercept.
This is accomplished here by using the y intercept derived by the polynomial fit. If
insufficient data from at rest is supplied to the best-fit process or the fit is poor this can
result in a vertical offset. Since the table in Caris assumes down is positive the equation
will also need to be multiplied by (-1). Equation 1 was derived using the described

process and was used to populate Table 1.

ADraft = (-2.15* Speed ® + 46.93* Speed * + 69.41* Speed) *10~* 1)

Table 1 The computed Dynamic Draft Table for Caris

Speed (m/s) | Delta Draft (m)
0 0
0.5 0.005
1.0 0.011
1.5 0.020
2.0 0.031
25 0.043
3.0 0.057
3.5 0.072
4.0 0.089
4.5 0.107
5.0 0.125
9.5 0.144
6.0 0.164




While the number of terms in Equation 1 might be excessive it was deemed prudent to
have too many rather than too few coefficients.

Past dynamic draft values for Fairweather have varied and have had mixed success. The
values used from the 2006 season have generally been accepted to work best and were
used for 2008 when the 2008 values proved to be insufficient. Figure 5 allows for a visual

comparison of these values.
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Figure 5 — A comparison of the 2009 ellipsoidally referenced measurements to those from previous
years.

The best-fit polynomial curve can be evaluated by subtracting its values from all test
data. Calculating the standard deviation for these residual values give an estimate of the

uncertainty in the estimate from the best-fit curve (Figure 6).
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Figure 6 — The residual difference between the measurement data and the best-ft curve.

Two standard deviations for the residual difference was calculated to be 4.7cm. While
this is accurate for this test it is not accurate to say this depicts the uncertainty for
dynamic draft in general. The changes in draft while changing speed was captured by this
method but the further uncertainty caused by currents is not. It is standard for the vessel
speed through the water to be approximated by the speed over ground on many NOAA
vessels. Since this impacts how Caris implements the dynamic draft table it also impacts
the delta draft used.

In conclusion, this method for estimating the dynamic draft appears reliable from the
comparison with previous year’s results as well as robust because of its inclusion of many
measurements. Due to time constraints this test was limited to four speeds at 10 minutes
each. More time at each speed and at more speeds would add to the reliability of the
estimates. Differences between the best-fit curves for the geoid verse the ellipsoid varied

by as much as 4 mm and was not considered significant.



Appendix A
G. Rice
2/3/08

Dynamic Draft Measurements Using POSPac

1. Scope:
This document is for the initial attempt to use POSPac to measure dynamic draft relative
to the ellipsoid aboard the NOAA Ship FAIRWEATHER. This process is only a

preliminary and should be updated with lessons learned after the initial attempt.

2. Background:

This process is for a body of water with a static water level over short time periods, such
as a lake. Tides will not be taken into account and it is assumed that currents are
negligible. The ellipsoid is assumed to be relatively parallel to the water level over the
area of this test. Time periods of static vessel settlement at the end of each line will help
to confirm this assumption. VV-datum does exist for the area of Lake Washington (where
this test will be performed) so if needed the navigation information can be converted to
the geoid. Since vertical data will only be referenced internally (at rest compared to
underway) the datum does not matter as long as it is parallel to the water level plane.
Because of the availability of reference stations for an established network the data will

be processed to the ITRF ellipsoid.

3. Data Collection:

The POS/MV should be turned on and logging POSPac for 30 minutes before the
beginning of the evolution. If time allows log the status of water and fuel tanks, which
small boats are aboard and what the draft marks read. Once on location for the test sit
static for 2 minutes and then again in between every line and again at the end of the test.
Each line should be driven at speed for 5 minutes in each direction. The two minute rest
can occur before or after turning around to begin the next line. Speed estimates are to



ensure proper space is available for each line only. Maintaining the same shaft RPM and
propeller pitch for both directions is more important than having the same speed. Line

speeds are as follows:

Line 1 Line 2 Approximate Shaft Propeller Comments
Start/End | Start/End speed (kts) RPM Pitch
2 120 30
4 130 40
6 140 50
8 150 60
10 160 70
12 170 80

Record the start and end time for each line according to the time in the POS Controller.

4. Data Processing:
The data will be processed through POSPac using either a Virtual Reference Station in a
network or a single station. Output will likely be examined in either Python or Matlab to

estimate actual Dynamic Draft Measurements.
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SeaBat 8160 Noise Analysis
1.0 Overview

For mid and deep water sonar systems, noise emanating from the vessel on which the sonar is
mounted is a major determinant in the performance of the sonar. In addition to sources such as
echosounders and other acoustic devices, such as doppler logs, mechanical noise from the
engines and drive trains, and flow noise will also affect performance, with the magnitude of the
noise varying with vessel speed.

This document describes the noise analysis test done on the RESON SeaBat 8160 installed on
the NOAA S/V Fairweather, on 10 October 2004.

2.0 Test Conduct

The following is a description of the system setup and test protocol used to test the SeaBat 8160
multibeam sonar.

2.1 Sonar Setup

To determine the amount of in-band noise seen by the sonar, the system was configured as
follows:

Setting Value

Power Off

Gain Manual Fixed 20
Range 100 meters

Data collection was done using a RESON engineering utility, which collects the full amplitude
and phase time series data from the sonar. Figure 1 shows a sample screen capture, in this case
one of the data sets taken at six knots, with a shaft speed of 140 RPM. At least ten (10)
collections were done for each test case, and the results for first 10 measurements each test case
were averaged for the report.

2.2 Vessel Operation

Normal survey speed for the vessel is approximately 10 knots. To bracket this range, and to
check at possible lower survey speeds, the test was defined to cover the range of 2 to 12 knots, in
2 knot steps. The initial tests were at a shaft speed of 130 RPM, with the speed adjusted by
changing the pitch on the propellers. Additional tests were run at shaft speeds of 140 and 150
RPM, with the pitch adjusted to achieve speeds of 6, 8 and 10 knots. A log of data collections
for the tests is provided in Appendix A.

Fairweather 8160 Noise Analysis Report Page 1 of 5



All the underway data collections were done in water depths of 200 to 300 meters. The zero
speed data collections were done at anchor, in water depths of about 30 meters.

# Untitled - Snapshot i g [ =

Eile Setup Wiew Help

*mY i

FL60-D8KE-0001
) 8160-06k-0002
. B160-D6k-0002 D001 5HS
- B160-D6k-0002 D002, 5HS
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160-06k4-0002 0004, 5HS

SHS
- BLED-064-0002 D008 SNS
- BLE0-064-0002 D002.5HS
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- BLED-064-0002 0011.5H5
© BLE0-064-0002 D012.5N5
B $160-06kE-0003

160-06k-0004

) 8160-08k-0001

L B160-08K-0001 0001.5HS
| B1E0-Dakk-0001 0002.5N5

Parameter Value

Latitude: 0.000000
Longitude 0.000000
Height 000
Heading 0o
Roll 0o
Pitch 0.0o
Heave 0.00
SBES depth 0.00
Depth sensor 0.00
| — [
Range sefting: ~ [100.0 j Sonar Param | Value | [Gupport Dot [ Valie I
= Range 1o0.0 Datetime: 10/10/04 11:32:48.9..
Power setting 0 = Power 1) Latitude 0.000000 deg
=] Gain 20 Fixed Longi!ude 0.000000 deg
e lzn— :ll Wedge Avg .. 59675 :jdmg g gndzgg
- Fitch 0.00 deg
Display gain: 2 j Heave 0.00 meters
Manual - Fired 4
Ready [ ]

Figure 1 - Snapshot Utility Screen Capture

2.3 Data Analysis

The data from each of the test cases were collated in an Excel spreadsheet, shown in Appendix
B. A graph of the measured noise levels, as a function of vessel speed and shaft RPM is shown
in Figure 2. The noise level is a unitless value that represents the average of all the amplitude
samples, from all the beams for the sampled sonar ping. This value represents a combination of
the electrical noise in the sonar, and the response to all acoustic energy, within the bandwidth of
the sonar, impinging on the receive array.

For each the 130, 140 and 150 RPM tests, the plot shows the noise level as a function of vessel
speed. Only one sample was taken at 160 RPM, since to achieve the 12 knot speed, it was
necessary to run at that RPM, with the pitch set to maximum test value of 10 feet.

Fairweather 8160 Noise Analysis Report Page 2 of 5



8160 Noise vs. Speed
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Figure 2 - Noise Plot

3.0 Conclusions

a. It appears that the best survey speed, from a noise perspective, is at approximately 10
knots. Both lower and higher speeds correlate with higher noise levels.

b. For lower survey speeds, it would be desirable to use a lower shaft RPM, combined with
a higher pitch setting, to minimize the noise level seen by the sonar.

c. The reason for the higher noise levels seen in the zero speed, at anchor collections is
undetermined, by may be a result of the much shallower operating depth, and increased
reverberation of vessel mechanical noise reflected off the bottom.

Fairweather 8160 Noise Analysis Report Page 3 of 5
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Appendix A — Test Log

RESON Inc.

Date: 10/10/2004 Survey Area: Rudyerd Bay, Ak Page / Pages:
Survey Name: 3160 MNoise Test Surveyors: B Bridge TimeZone: -9
Survey Vessel: NOAA Fainweather Client: NOAA

Offset Information |

X hi F Latency Roll Pitch “Yaw SVP File

Sounder | | | Tide Filg

DGPS

Motion Sensor Taotal Pole

Other Date of Patch Test | | minus Dry Pole

Draft (£}
Start | Stop Line Dir. |Speed COMMENTS

8160-00kt-0002 0| At anchor, engines off - Gain Fixed 20, Pwr Off Rng100
8160-00kt-eng_ond001 0|Engines turned on
§160-02k-0001 21500 2.5 stw 1.7 rpm 1301 .5 feet pitch
§160-04k-0001 Al5004 .0 stw 3.0 rpm 130@4 0 feet pitch
§160-06k-0001 Blsog 6.0 stw 5.0 rpm 13066 .0 feet pitch
3160-08kt-0001 Z|s0g 8.0 stw 7.0 rpm 13080 feet pitch
8160-10k-0001 10|s0g 10.0 stw 8.5 rpm 130610.0 fest pitch
8160-12k-0001 12509 12.0 stw 10.5 rpm 160@E210.0 feet pitch
8160-06k-0002 6.5]509 6.0 stw 5.0 rpm 140@5.0 feet pitch
8160-08k-0002 8509 8.0 stw 7.0 rpm 140@7 .0 feet pitch
§160-10k-0002 10509 10.0 stw 8.5 rpm 140609 .5 feet pitch
§160-10k-0003 10500 10.0 stw 8.5 rpm 150609 .0 feet pitch
§160-08k-0003 gls0g 8.0 stw 7.0 rpm 15066 .5 feet pitch
8160-06k-0003 Blsog 6.0 shw 5.0 rpm 150 5 feet pitch

Survey Manager: Client Representative:

Signature: Signature:

Fairweather 8160 Noise Analysis Report Page 4 of 5




Appendix B — Noise Analysis Spreadsheet
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SeaBat 8111 Noise Analysis
1.0 Overview

For mid and deep water sonar systems, noise emanating from the vessel on which the sonar is
mounted is a major determinant in the performance of the sonar. In addition to sources such as
echosounders and other acoustic devices, such as doppler logs, mechanical noise from the
engines and drive trains, and flow noise will also affect performance, with the magnitude of the
noise varying with vessel speed.

This document describes the noise analysis test done on the RESON SeaBat 8111 installed on
the NOAA S/V Fairweather, on 11 October 2004.

2.0 Test Conduct

The following is a description of the system setup and test protocol used to test the SeaBat 8111
multibeam sonar.

2.1 Sonar Setup

To determine the amount of in-band noise seen by the sonar, the system was configured as
follows:

Setting Value

Power Off

Gain Manual Fixed 20
Range 100 meters

Data collection was done using a RESON engineering utility, which collects the full amplitude
and phase time series data from the sonar. Figure 1 shows a sample screen capture, in this case
one of the data sets taken at six knots, with a shaft speed of 140 RPM. At least ten (10)
collections were done for each test case, and the results for first 10 measurements each test case
were averaged for the report.

2.2 Vessel Operation

Normal survey speed for the vessel is approximately 10 knots. To bracket this range, and to
check at possible lower survey speeds, the test protocol was defined to cover the range of 2 to 12
knots, in 2 knot steps. The tests were conducted at shaft speeds of 120 to 170 RPM, in 10 RPM
steps, with the speed adjusted by changing the pitch on the propellers. For each RPM value, the
speeds that could be achieved at that shaft speed were tested. A log of data collections for the
tests is provided in Appendix A.

Fairweather 8111 Noise Analysis Report Page 1 of 6



All the underway data collections were done in water depths of 120 to 160 fathoms. The zero
speed data collections, with the engines on, were done at anchor in about 30 meters of water, and
out in the bay, at water depths of about 130 fathoms.
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Figure 1 - Snapshot Utility Screen Capture

2.3 Data Analysis

The data from each of the test cases were collated in an Excel spreadsheet, shown in Appendix
B. A graph of the measured noise levels, as a function of vessel speed and shaft RPM is shown
in Figure 2. The noise level is a unitless value that represents the average of all the amplitude
samples, from all the beams for the sampled sonar ping. This value represents a combination of
the electrical noise in the sonar, and the response to all acoustic energy, within the bandwidth of
the sonar, impinging on the receive array.

For each the tests, the plot shows the noise level as a function of vessel speed. Again, the tests
were run at the speeds that could be achieved at the selected shaft RPM.

In an effort to resolve the cause of the high noise levels at anchor seen in the 8160 tests, noise
tests with the engines at idle (110 shaft RPM, 0 pitch) in both shallow and deep water. In deeper
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water, much lower noise levels were observed, apparently due to the greater attenuation of the
noise from the various acoustic sources on the ship over the greater range.

8111 Noise Analysis
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Figure 2 - Noise Plot

3.0 Conclusions

a. It appears that the best survey speed for the 8111, from a noise perspective, is in the
range of 8 to 10 knots. Both lower and higher speeds correlate with higher noise levels.

b. It would be desirable to use shaft speeds of 140 RPM, or lower, to minimize the noise
level seen by the sonar.

c. Significantly increased levels of reverberation from acoustic sources on the vessel are
seen in shallower water. If this causes any degradation in the quality of the soundings in
the 8111, increased power levels, higher than those recommended in the sonar settings
guide, should be used to compensate.

Fairweather 8111 Noise Analysis Report Page 3 of 6
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Appendix A — Test Logs

101 x]
2 O 0 v = 0= | O i =
1 RESON Inc. I
2 | Date: 1081172004 Survey Area: Rudyerd Bay, Ak Page i Pages: | 10of2
| 3 |Survey Name: 8111 Moise Test Surveyors: E Eridge TimeZone: -9
4 | Survey Vessel: MNOAA Fairweather Client: MNOAA
5 Offset Information |
E50 X Y F4 Latency Roll Pitch Maw SVYP File
| 7 |Sounder | | | Tide File
| 8 |DGPS
| 9 |Motion Sensor Total Pole
|10 | Other Date of Patch Test |:| minus Ory Pole
11 Draft (Z)
47| Start | Stop Line Dir. |Speed COMMENTS
13 5111-00kt-EngOn-0001 0] Gain MF20, Power 0, Range 100, at anchaor, 110 RPM
14 8111-00k-0001 0]110 RPM 0 Pitch
15 §111-02kt-120-0001 2120 RPM 1.0 Pitch 0.4 Doppler
16 5111-04kt-120-0001 41120 RPN 3.0 Pitch 2.8 Doppler
17 5111-06kt-120-0001 5|120 RPM 6.0 Pitch 4.6 Doppler
18 8111-08kt-120-0001 8|120 RPM &.5 Pitch 8.7 Doppler
19 §111-10kt-120-0001 9|120 RPM 10.0 Pitch 7.2 Doppler
20 5111-10kt130-0001 101130 RPM 10.0 Pitch 8.2 Doppler
21 5111-08kt-130-0001 5|130 RPM 7.0 Pitch 6.2 Doppler
22 5111-06kt-130-0001 5|130 RPM 5.0 Pitch 4.5 Doppler
23 §111-04kt-130-0001 41130 RPM 3.0 Pitch 2.2 Doppler
24 5111-02t-130-0001 2|130 RPM 1.5 Pitch 0.5 Doppler
25 5111-04kt-140-0001 41140 RPM 2.5 Pitch 2.5 Doppler
26 8111-06kt-140-0001 5140 RPM 4.75 Pitch 4.3 Doppler Too Shallow
27 §111-06kt-140-0002 5140 RPM 5.3 Pitch 5.2 Doppler
28 5111-08kt-140-0001 5140 RPM 7.4 Pitch 6.5 Doppler
29 5111-10kt-140-0001 10140 RPM 9.0 Pitch 8.5 Doppler
30
31
32 | Survey Manager: Client Representative:
|33 | Signature: Signature:
34
35
M [4]» [pi['Sheet1 {Sheetz £ sheeta / |4]
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E} survey Log - 8111 Noise Test Pg2.xls A o ] 4

A B C D E F G H I 0 | K | L [ m =

1 RESON Inc. (i
2 | Date: 1001172004 Survey Area: Rudyerd Bay, Ak Page I Pages: |2 of 2
| 3 |Survey Name: 8111 Moise Test Surveyors: E Eridge TimeZone: -9
4 | Survey Vessel: NOAA Fairweather Client: NOAA

5 Offset Information |
|5 | X Y Z Latency Roll Pitch  vaw SVYP File
| 7 |Sounder | | | Tide Fild
|8 |DGPS
| 9 |Motion Sensor Total Pole
|10 |Other Date of Patch Test I:l minus Ory Pole

11 Draft (Z)

1o Start | Stop Line Dir. |Speed COMMENTS

13 8111-10kt-150-0001 10| Gain MF20, Power 0, Range 100, 150,82, 7.4

14 8111-08kt-150-0002 5|150 RPM 6.1 Pitch 6.3 Doppler

15 §111-06kt-150-0001 5|150 RPM 4.3 Pitch 4.4 Doppler

16 5111-04kt-150-0001 41150 RPM 3.0 Pitch 2.8 Doppler

17 5111-06kt-160-0001 5160 RPM 4.0 Pitch 5.2 Doppler

18 5111-08kt-160-0001 5|160 RPM 6.1 Pitch 6.5 Doppler

19 5111-10kt-160-0001 101160 RPM 8.2 Pitch 8.8 Doppler

20 5111-12kt-160-0001 11.7]160 RPM 10. Pitch 9.9 Doppler

21 8111-12k-170-0001 12]170 RPM 9.0 Pitch 10.4 Doppler

22 5111-06kt-170-0001 5170 RPM 4.0 Pitch 4.8 Doppler

23 §111-08kt-170-0001 8|170 RPM 5.9 Pitch 6.8 Doppler

24 8111-10kt-170-0001 101170 BEPM 7.0 Pitch 8.3 Doppler

25

76

27

28

29

30

31
| 32 | Survey Manager. Client Representative:;
| 33 | Signature: Signature:

34

=

4[4[k [HSheet1 £ cheetz f sheets / 4]
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Appendix B — Noise Analysis Spreadsheet
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Appendix IV

Total Propagated Error (TPE)

e Fairweather TPE Values
e Tide TPE Values



FAIRWEATHER SURVEY . Process Owner
Appendix IV Survey
Documents Title Last update Version Approval Date
FA_TPE_ Values_2009 July 18, 2009 2009.3 July 18, 2009
Offsets
Vessel FAIRWEATHER-S220|FAIRWEATHER-S220 1010 1018 1018
Sonar System Reson 8111 Reson 8160 Reson 8101 Reson 8101 Reson 8125
Positioning System POS/MV POS/MV POS/MV POS/MV POS/MV
Model 320 Model 320 Model 320 Model 320 Model 320
MRU to Trans X 2.868 0.493 0.250 0.282 -0.396
MRU to Trans Y 8.252 7.665 -0.133 -0.145 0.982
MRU to Trans Z 4.752 4.726 0.549 0.548 0.751
Offsets |Nav to Trans X 2.071 -0.304 1.147 1.181 0.502
Nav to Trans Y 20.144 19.557 1.066 0.955 2.082
Nav to Trans Z 17.792 17.766 3.665 3.717 3.919
Trans Roll 0.00 0.00 0.000 0.00 0.00
Standard Deviation
Vessel FAIRWEATHER-S220|FAIRWEATHER-S220| 1010 1018 1018
Sonar System Reson 8111 Reson 8160 Reson 8101 Reson 8101 Reson 8101
Positioning System POS/MV POS/MV POS/MV POS/MV POS/MV
Model 320 V4 Model 320 V4 Model 320 V3 Model 320 V3 Model 320 V3 Status
Motion Gyro (deg) 0.02 0.02 0.02 0.02 0.02 Finalized
Heave% Amp 5 5 5 5 5 Finalized
Motion Heave (m) 0.05 0.05 0.05 0.05 0.05 F?nal?zed
Sensor Roll (deg) 0.02 0.02 0.02 0.02 0.02 Finalized
Pitch (deg) 0.02 0.02 0.02 0.02 0.02 Finalized
Position Nav (m) 0.5* 0.5 0.5 0.5 0.5 - Finalized
Vessel Speed (m/s) 0.03 0.03 0.03 0.03 003 T Finalized
Timing Trans (s) 0.005 0.005 0.005 0.005 0.005] c Finalized
Nav Timing (s) 0.005 0.005 0.005 0.005 0.005| -% Finalized
Latency Gyro Timing (s) 0.005 0.005 0.005 0.005 0.005] 5 Finalized
Heave Timing (s) 0.005 0.005 0.005 0.005 0.005) 2 Finalized
Pitch Timing (s) 0.005 0.005 0.005 0.005 0.005) & Finalized
Roll Timing (s) 0.005 0.005 0.005 0.005 0.005} © Finalized
Vessel Offset X (m) 0.007 0.007 0.007 0.007 0.007 § F!nal@zed
Offsets Offset Y (m) 0.007 0.007 0.007 0.007 0.007 o Finalized
Offset Z (m) 0.008 0.008 0.007 0.007 0.007 Finalized
Loading 0.01 0.01 0.050 0.017 0.017| Finalized
Waterline [Draft (m) 0.014 0.014 0.035 0.035 0.035 Finalized
DeltaDraft (m) 0.050 0.050 0.060 0.060 0.060 Finalized
MRU 0.082 0.048 0.075 0.035 0.036 Finalized, 8125-P183"
Alignment 0.057 0.021 0.025 0.075 0.180 Finalized, 8125-P183"
Tides Tide Meas (m) 0.01 0.01 0.01 0.01 0.01p > Project Dependent**
Tide Zoning (m) Project Dependent |Project Dependent |Project Dependent [Project DependentProject Dependen W o 3 Project Dependent**
Sound [SV Meas (m/s) 0.5 0.5 1.0 1.0 1.0E - -g of Defaults, Project Dependent**
Velocity |Surface SV (m/s) 0.5 0.5 1.0 1.0 1.0pP Defaults, Project Dependent**

*Position Nav adjusted in the HVF to 5m when acquiring in Coarse Acquisition mode, additional information will be submitted in the DAPR and/or the DR.
**Default values listed, descriptive report will list actual values applied if supplied with Project Instructions or calculated with the Sound speed estimator.
AMRU values for 1018 8125 may change as new patch test values are used.




Tide Measurement [Tide Zoning 95% Tide Zoning 1-sigma SV Msrd (m/s) [Surface SV (m/s)

Project H# (Use in Caris) (Provided by CO-OPS) [(Use in Caris) (Use in Caris) [(Use in Caris)
OPR-0119-FA-09 8101 1.00 1.00
Ernest Sound 0.00 0.14 0.07 8125 1.00 0.50
8111/8160 0.50 0.50
OPR-P183-FA-09 8101 1.00 1.00
Shumagin Islands 0.00 0.00 0.00 8125 1.00 0.50
and Vicinity (TCARI is a special case, see FOO for more info) 8111/8160 0.50 0.50
OPR-P357-FA-09 8101 1.00 1.00
Kachemak bay 0.00 0.00 0.00 8125 1.00 0.50

(TCARI is a special case, see FOO for more info) 8111/8160 0.50 0.50




Appendix V

Additional Calibration Reports

Control

Diver Least Depth Gauge
Laser Level

Leadlines

Sound Velocity

Total Stations



Vertical Control Equipment Test
April 2009

The 2009 test of the Fairweathers’ vertical control equipment included testing five 8210 Sutron
“bubbler” Tide Gauges that were provided by the Center for Operational Oceanographic
Products and Services (CO-OPS). The gauges are equipped with Paros Scientific Sensors (SDI-
12) for measuring pressure. Each year, the gauges are checked by the CO-OPS Field Operations
Center to ensure their accuracy.

CO-OPS does not provide calibration or quality assurance documentation to the
FAIRWEATHER. FAIRWEATHER personnel are responsible for installation and removal of
the water level gauges. CO-OPS is responsible for delivering final approved vertical correctors
to the FAIRWEATHER for application to the hydrographic data set. As FAIRWEATHER
receives new gauges, data quality assurance checks will be conducted in a similar manner as the
procedures listed below to ensure full functionality prior to deployment.

Five tide gauges: #10 (3344973C), #12 (3344B1D0), #13 (3344C740), #14 (3344D436) and #17
(3351E1F2) were set up and tested by ship personnel at the Sand Point Pier in Seattle, WA from
April 1st through April 17", 2009. Each gauge was tested for at least 48 hours to insure proper
data collection. The orifice was placed just off the pier by the gauge in approximately 10 meters
of water. The GPS antenna was facing open sky to the South-Southwest. The set-up was
periodically checked to insure proper transmission and to check for any leaks in the system.
Table #1 below lists pertinent information for the five gauges tested at Sand Point.

CO-OPS was able to verify that all the above gauges had strong transmissions to the GOES
satellite, and were collecting accurate tide curves.

Gauge # PAROS Ser# GOES Channel Plat ID Tx Time
10 97043 116 3344973C 0:37:32
12 85173 116 3344B1D0 0:17:02
13 85220 116 3344C740 0:20:02
14 86002 116 3344D436 0:23:32
17 79049 116 3351E1F2 0:18:02

Table 1: 2009 Gauge information




Kukkamake February 26, 2009 (Dn 057)

On February 26, 2009 (Dn 057) SST Campbell, ENS Forney, AST Renoud and AST Beduhn
performed a Kukkamaki on both Carl Zeiss N12 (Stadia:333) levels (S/N 100056 and S/N
103267). The Kukkamaki were performed in conjunction with the Tides Training portion of
Hydroschool 2009 at Sand Point.

The Kukkamaki course was set up in the parking lot on Lake Washington behind the Dive
Building. The weather was sunny and cold with moderate wind. A 40 meter straight line was
measured on level ground and divided into 10 meter intervals. The level was then set on the
30 meter mark and a backsight and forsight were shot to the 20 and 40 meter marks
respectively. Next the level was set up at the 0 meter mark, and a backsight and foresight
were shot to the 20 and 40 meter marks, respectively. (See Fig. 1)

The Carl Zeiss level, S/N 100056 had a collimation error of 0.026, and Zeiss level S/N
103267 also had a collimation error of 0.026. Error values for both Zeiss levels fall within the
+/- 0.05 tolerance requirements of the Field Procedures Manual, May 2008.

Rod 1 Rod 2

SETUP TWO E SETUF ONE
/ BackSight : / \\ FcreSighté
I | | |
Om 20m 30m 40m

Fig 1. Diagram of Kukkamaki setup



NOAS FORM 75-29 U.5. DEFARTMENT OF
COMMERCE
[12-75] NATIONAL QCEANIC AND

ATMOSFHERIC ADMIMISTRATION

PRECISE LEVELING

THITEE- biRE

FORWARD RUN [See reverse ior SO0 YAA0 S0V

HSRR

103267 SHEET OF

FROMEM.

TOBM.

Kukkamaki

WEATHER Sunn, ool

230 DATE: Dn 057, Feb. 26, 2003

BACKSIGHTS FORESIGHTS _ 3 DRDER,CLASS _ 1_
THREAD THREAD | SUMOF | ROD | THREAD
P | peaome| B | wrerval | mreRvals | Teme|mEeomz| MEAM REMARKS
1543| BS1 1459 FS1 C=(Ah1-A?) -0.2mm
1 1532 1532.33 1484] 1483 67 20m
1617 1468 where BS1-FS1=Ahi
4597 4451 BS2 - FS2 = Ah?
1411(20mS 1353 |40mS Ah1- 4867
2 1381] 1380 67 1331 1331 67 Ah2 49
1360 1271 Ahl-AR2=] 033
4142 3955 -0.2 (CR) 153

320m -0.02RBREET

C=_ [D.02666667

Fillin YELLOW shaded cel

"C" must be < + 0.05mm/m

Instrument SN: 103267

Rod SN: B

Party Chief. Baird

Ohserver: SST Campbhell

Recorder: ENS Forney

Rod Person: AST Renoud




Jr0LA FORM 75.23 W.5. DEPARTMENT OF |HSRR 100056 SHEET oF
COMMERCE

[12-75) NATIOMAL OCEARNIC AND
ATMOSPHERIC ADMIMIE TRATION

FROMER. TOEM.
PRECISE LEVELING

THIEEE. WiGE Kukkamaki 10:45 DATE: Dn 057, Feb. 26, 2009

WEATHER Sunny, cool

FORWARD RUN /5 reserse for SACHWAGT G

BACKSIGHTS FORESIGHTS __3 __ ORDER,CLASS __1___
THREAD THREAD SUM OF ROD [ THREAD THREAD | SUMOF
Setup READING MEAN INTERVAL | INTERYALS | TEMF | READING MEAN INTERVAL | INTERVALS FEMARKS
1528] BS1 1471]_FS1 C= {Ah1 - A?) - 02mm
1| 1s13] 1813 1456] 1456.33 20 m
1438 1442 where  BST-FS1=Aht
4539 4369 BS2 - FS2 = Ah2
1567 [20mS 1540(40mS Ahf- 5667
I 1480] 1480 Ah2 57
1507 1420 Ah1-AR2 = 033
4511 4440 -0.2(CR) [ 043

+20m -0.02666RR/

C=_ [0.02666667

Fill in YELLOW shaded cells.

"C" must be < + 0.05mm/m

Instrument SN: 100056

Rod SN: B

Party Chief: Baird

Observer: ENS Forney

Recorder: SST Camphell

Rod Person: AST Beduhn




NOAA Ship FAIRWEATHER

Trimble Backpack Data Quality
Assurance Testing

April 2009 e

Trimble 2 ‘E}
Offset Method

A
kN

Distance from
Control Mark (m) B

Trimble 1 Direct 0.33
Trimble 1 Offset 0.56
Trimble 2 Direct 0.10

Trimble 2 Offset 0.13

Trimble 1
Direct Method

Control Mark
"AVIATION 2"

©

Direct Method

®

" Tiimble:d

ffset Method



SURVEY DATASHEET ( Version1.0)

1ofl

http://beta.ngs.noaa.gov/CORS-Proxy/oraOpusDbWeb/getDatasheet.jsp?...

SURVEY DATASHEET (Version 1.0)

PID: BBBK46
Designation: VIXEN HBR 2009
Stamping: VIXEN HBR 2009
Stability:
Setting: In rock outcrop or ledge
Description: A modified 3.5 inch bronze NOS disk is cemented into a rock
outcrop on the West Side of Magnetic Point on the eastern side of
Ernest Sound. The mark is approximately 10 feet above the high
water mark on the south side of the westward of two humps, and it
protrudes south out of a wooded area and is nearly surrounded at
high water. This mark was leveled as part of a series of NOS
benchmarks for a tide station originally designated as Vixen Harbor.
Observed: 2009-05-20T 08:00:00Z
Source: OPUS - page5 0810.20 Close-up View
REF_FRAME: EPOCH: SOURCE: NAVDS88 (Computed using UNITS: SET DETAILS
NAD_83(CORS96) 2003.0000 GEOIDO06) m PROFILE
LAT: 55° 47' 18.23740" + 0.005 m
UTM 8 SPC 5001(AK 1)
LON: -132° 11' 27.06511" £+ 0.010 m
NORTHING: 6186101.208m 441196.443m
ELL HT: 1.331 + 0.015 m
EASTING: 676130.571m 911250.506m
X: -2413974.145 + 0.004 m
CONVERGENCE: 2.32366467° 1.22996338°
Y: -2663096.964 + 0.015 m
POINT SCALE: 0.99998052  0.99990050
Z:5251232.937 + 0.011 m
COMBINED FACTOR: 0.99998032  0.00000000
ORTHO HT: 5.768 + 0121 m

CONTRIBUTED BY

glen.rice

National Oceanic and Atmospheric

Administration

Horizon View

i

Map data ©2009 Tele Atlas - Terms of Use

The numerical values for this position solution have satisfied the quality control criteria of the National Geodetic Survey. The contributor has
verified that the information submitted is accurate and complete.

8/5/2009 2:56 AM



FILE: VIXE1201.090 000038260

NGS OPUS SOLUTION REPORT

All computed coordinate accuracies are listed as peak-to-peak values.

For additional

USER:
RINEX FILE:

SOFTWARE:
EPHEMERIS:
NAV FILE:
ANT NAME:
ARP HEIGHT:

REF FRAME:
X:
Y:
Z

LAT:

E LON:

W LON:

EL HGT:
ORTHO HGT:

Northing (Y) [meters]
Easting (X) [meters]
Convergence
Point Scale
Combined Factor

US NATIONAL GRID DESIGNATOR:

PID

Uv5996

weston. renoud@noaa.gov
vixel20s.090

page5 0810.20 masterll.

igrl5294._eph [rapid]
brdc1200.09n
ASH701975.01AGP NONE
1.3

NAD_83(CORS96) (EPOCH:2003.0000)

-2413974.164(m)
-2663096.982(m)
5251232.967(m)

eNeoNe)

55 47 18.23725
227 48 32.93477

1.371(m)
5.808(m)

0
0]
132 11 27.06523 0.
0
0

UTM COORDINATES
UTM (Zone 08)

information: www.ngs.

noaa.gov/0PUS/Using_OPUS.html#accuracy

DATE:
TIME:

May 06, 2009
06:03:36 UTC

pl 081023 START:
STOP:

OBS USED:

# FIXED AMB:

OVERALL RMS:

2009/04/30 18:28:00
2009/05/01 02:35:00
14778 / 16367 90%

97 / 102 95%
0.016(m)

ITRFOO (EPOCH:2009.3286)

.036(m) -2413975.012(m)  0.036(m)
.041(m) -2663095.882(m)  0.041(m)
.060(m) 5251233.143(m)  0.060(m)
.011(m) 55 47 18.24701 0.011(m)
.009(m) 227 48 32.85632 0.009(m)
009(m) 132 11 27.14368 0.009(m)
.080(m) 1.378(m)  0.080(m)

.144(m) [NAVD88 (Computed using GEOIDO06)]

STATE PLANE COORDINATES
SPC (5001 AK 1)

6186101.204 441196.438
676130.569 911250.504
[degrees] 2.32366465 1.22996336
0.99998052 0.99990050
0.99998031 0.00000000

8UPG7613186101(NAD 83)

BASE STATIONS USED

DESIGNATION
DK6423 BISS BIORKA
DJ3035 LEV6 LEVEL

DK6482 AISS ANNETTE

ISLAND 6 CORS ARP

ISLAND 5 CORS ARP

ISLAND 5 CORS ARP

LATITUDE LONGITUDE DISTANCE(m)
N565116.162 W1353221.387 238727.4

NEAREST NGS PUBLISHED CONTROL POINT

LOOK 1916

N562756.364 W1330532.511 93963.3
N550408.647 W1313558.255  88401.3
N554728.961 W1321123.951 336.0



STATION NAME:
MONUMENT : NO

XYZ
XYZ
NEU
NEU
NEU
XYZ
XYZ
XYZ
XYZ
XYZ
XYZ
XYZ
XYZ
LLH
LLH
LLH

-2494921
-0.
0.
-0.
-0.
-0.
0.
-0.
-2494921.
0.
-2494921.
-2494921.
-2494921.
56 51 16.
56 51 16.
56 51 16.

STATION NAME:
MONUMENT : NO

XYZ
XYZ
NEU
NEU
NEU
XYZ
XYZ
XYZ
XYZ
XYZ
XYZ
XYZ
XYZ
LLH
LLH
LLH

-2412812
-0.
0.
-0.
-0.
-0.
0.
-0.
-2412812.
-0.
-2412812.
-2412812.
-2412812.
56 27 56.
56 27 56.
56 27 56.

STATION NAME:
MONUMENT : NO

XYZ
XYZ
NEU
NEU
NEU
XYZ
XYZ
XYZ
XYZ
XYZ
XYZ
XYZ
XYZ
LLH
LLH
LLH

-2430153.
-0.
0.
-0.
-0.
-0.
0.
-0.
-2430154.
0.
-2430154.
-2430154.
-2430154.
55 4 8.
55 4 8.
55 4 8.

BASE STATIO

bis5 a

DOMES NUMBER

.0833 -2448390.9914
0164 0.0037
0000 0.0000
0034 -0.0019
0037 -0.0015
2022 0.0456
0000 0.0000
0351 -0.0318
3206 -2448390.9776
0000 0.0001
3205 -2448390.9775
2855 -2448390.9457
2855 -2448390.9457
17152 224 27 38.53076
17163 224 27 38.53088
17163 224 27 38.53088
lev6 a 2 (Level lIs
DOMES NUMBER

.0457 -2579074.2577
0190 0.0003
0000 0.0000
0034 -0.0019
0037 -0.0015
2342 0.0037
0000 0.0000
0340 -0.0336
3140 -2579074.2876
0000 0.0000
3140 -2579074.2875
2799 -2579074.2540
2799 -2579074.2540
37385 226 54 27.40784
37396 226 54 27.40796
37396 226 54 27.40796
aisb a

DOMES NUMBER

8469 -2737192.9494
0147 -0.0013
0000 0.0000
0034 -0.0019
0037 -0.0015
1812 -0.0160
0000 0.0000
0342 -0.0356
0623 -2737193.0011
0000 -0.0000
0623 -2737193.0011
0281 -2737192.9654
0281 -2737192.9654

65794 228 24 1.66886
65805 228 24 1.66897
65805 228 24 1.66897

N INFORMATION

5317113.

eNoNoNoNoNeoNe)

5317113.
0.
5317113.
5317113.
5317113.
66.

66.

66.

land 6;

5293282.
-0.

0.

0.

0.

-0.

0.

0.
5293282.
0.
5293282.
5293282.
5293282.
25.

25.

25.

5205816.
-0.

0.

0.

0.

-0.

0.

0.
5205816.
-0.
5205816.
5205816.
5205816.
32

32.

32.

6533

-0005
-0000
.0813
-0689
.0062
-0000
.0662

7257
0001
7257
6595
6595
8349
7536
7536

Level

2476
0044
0000
0813
0689
0542
0000
0659
2592
0000
2593
1934
1934
4801
3988
3988

2 (Annette Island 5; Annette

7670
0087
0000
0813
0689
1073
0000
0647
7244
0000
7244
6597
6597

-4119

3306
3306

2 (Biorka Island 5; Biorka Island, Alaska USA)

MON
VEL
MON
ARP
ARP
VEL

@ 1997.0000 (M)

(M/YR)

TO ARP (M)

TO L1 PHASE CENTER (M)
TO L2 PHASE CENTER (M)
TIMES 12.3286 YRS

MON TO ARP

ARP TO L1 PHASE CENTER

L1 PHS CEN @ 2009.3286

+ XYZ ADJUSTMENTS

NEW L1 PHS CEN @ 2009.3286
NEW ARP @ 2009.3286

NEW MON @ 2009.3286

NEW L1 PHS CEN @ 2009.3286
NEW ARP @ 2009.3286

NEW MON @ 2009.3286

Island, Alaska USA)

MON
VEL
MON
ARP
ARP
VEL

@ 1997.0000 (M)

(M/YR)

TO ARP (M)

TO L1 PHASE CENTER (M)
TO L2 PHASE CENTER (M)
TIMES 12.3286 YRS

MON TO ARP

ARP TO L1 PHASE CENTER

L1 PHS CEN @ 2009.3286

+ XYZ ADJUSTMENTS

NEW L1 PHS CEN @ 2009.3286
NEW ARP @ 2009.3286

NEW MON @ 2009.3286

NEW L1 PHS CEN @ 2009.3286
NEW ARP @ 2009.3286

NEW MON @ 2009.3286

Island, Alaska USA)

MON
VEL
MON
ARP
ARP
VEL

@ 1997.0000 (M)

(M/YR)

TO ARP (M)

TO L1 PHASE CENTER (M)
TO L2 PHASE CENTER (M)
TIMES 12.3286 YRS

MON TO ARP

ARP TO L1 PHASE CENTER

L1 PHS CEN @ 2009.3286

+ XYZ ADJUSTMENTS

NEW L1 PHS CEN @ 2009.3286
NEW ARP @ 2009.3286

NEW MON @ 2009.3286

NEW L1 PHS CEN @ 2009.3286
NEW ARP @ 2009.3286

NEW MON @ 2009.3286



REMOTE STATION INFORMATION

STATION NAME: vixe 1
MONUMENT : NO DOMES NUMBER
XYZ -2413975.4955 -2663095.9246 5251234.3436 MON @ 2009.3281 (M)

NEU 0.0025 0.0026 1.3000 MON TO ARP (M)

NEU -0.0025 -0.0026 0.0637 ARP TO L1 PHASE CENTER (M)
NEU -0.0012 0.0008 0.0440 ARP TO L2 PHASE CENTER (M)
XYZ -0.4876 -0.5418 1.0765 MON TO ARP

XYZ -0.0274 -0.0263 0.0513 ARP TO L1 PHASE CENTER
XYZ -2413976.0104 -2663096.4927 5251235.4713 L1 PHS CEN @ 2009.3286

BASELINE NAME: bis5 vixe

XYZ 0.4944 0.0601 -1.2254 + XYZ ADJUSTMENTS

XYZ -2413975.5160 -2663096.4326 5251234.2459 NEW L1 PHS CEN @ 2009.3286
XYZ -2413975.4887 -2663096.4063 5251234.1947 NEW ARP @ 2009.3286

XYZ -2413975.0011 -2663095.8645 5251233.1182 NEW MON @ 2009.3286

LLH 55 47 18.24711 227 48 32.85611 2.7099 NEW L1 PHS CEN @ 2009.3286
LLH 55 47 18.24719 227 48 32.85626 2.6462 NEW ARP @ 2009.3286
LLH 55 47 18.24711 227 48 32.85611 1.3462 NEW MON @ 2009.3286

BASEL INE NAME: lev6 vixe

XYz 0.4956 0.0484 -1.2118 + XYZ ADJUSTMENTS

XYZ -2413975.5149 -2663096.4443 5251234.2595 NEW L1 PHS CEN @ 2009.3286
XYZ -2413975.4875 -2663096.4180 5251234.2082 NEW ARP @ 2009.3286

XYZ -2413974.9999 -2663095.8762 5251233.1318 NEW MON @ 2009.3286

LLH 55 47 18.24714 227 48 32.85661 2.7255 NEW L1 PHS CEN @ 2009.3286
LLH 55 47 18.24722 227 48 32.85676 2.6618 NEW ARP @ 2009.3286
LLH 55 47 18.24714 227 48 32.85661 1.3618 NEW MON @ 2009.3286

BASEL INE NAME: aisb vixe

XYz 0.4596 0.0195 -1.1652 + XYZ ADJUSTMENTS

XYZ -2413975.5509 -2663096.4732 5251234.3062 NEW L1 PHS CEN @ 2009.3286
XYZ -2413975.5235 -2663096.4468 5251234.2549 NEW ARP @ 2009.3286

XYZ -2413975.0359 -2663095.9051 5251233.1784 NEW MON @ 2009.3286

LLH 55 47 18.24677 227 48 32.85619 2.7897 NEW L1 PHS CEN @ 2009.3286
LLH 55 47 18.24685 227 48 32.85634 2.7260 NEW ARP @ 2009.3286
LLH 55 47 18.24677 227 48 32.85619 1.4260 NEW MON @ 2009.3286
G-FILES
Axx2009 430 951
B2009 4301828 9 51 235 1 page5 v0810.201GS 226 1 2 27NGS 2009 5 6IFDDFX
lant_info.003 NGS 20090501

C00090001 -809462844 24 2147049188 30 658805413 33 X1209AVIXEX1209ABIS5
D 1 2 4808077 1 3 -9110619 2 3 -5412684

Axx2009 430 951
B2009 4301828 9 51 235 1 page5 v0810.201GS 226 1 2 27NGS 2009 5 G6IFDDFX
lant_info.003 NGS 20090501

C00090002 11627200 25 840216222 34 420490616 38 X1209AVIXEX1209ALEV6
D 1 2 6906117 1 3 -8609405 2 3 -3610684

Axx2009 430 951
B2009 4301828 9 5 1 235 1 page5 v0810.201GS 226 1 2 27NGS 2009 5 G6IFDDFX
lant_info.003 NGS 20090501

C00090003 -161789922 38 -740970604 54 -454165187 57 X1209AVIXEX1209AA1S5
D 1 2 7937919 1 3 -6704252 2 3 -1704411



bis5-vixe]|
bis5-vixe]|

bis5-vixe]

leve-vixe]
lev6-vixe]|

lev6-vixe]|

aisb-vixe|
ais5-vixe]

ais5-vixe]

bis5-vixe]
bis5-vixe]|
bis5-vixe]|
levbe-vixe]
levbe-vixe]
levb-vixe]
aisb-vixe]
aisb-vixe|

aisb-vixe|

Covariance Matrix for

POST-FIT RMS BY SATELLITE VS. BASELINE

OVERALL 02 03 04
0.015 0.022 0.059 0.016
11 12 13 14
0.011 ... 0.017 0.014
22 23 24 25
0.018 0.013 ... 0.015
OVERALL 01 02 03
0.015 .. 0.018 0.001
10 11 12 13
0.018 0.012 ... 0.016
20 22 23 24
0.014 0.019 0.014 A
OVERALL 02 03 04
0.017 0.025 0.008 0.021
11 12 13 14
0.013 ... 0.021 0.015
22 23 24 25
0.021 0.016 0.015
OBS BY SATELLITE
OVERALL 02 03 04
5152 289 1 375
11 12 13 14

389 .- 191 220

22 23 24 25

110 642 - 531
OVERALL 01 02 03
4998 .- 252 1
10 11 12 13

234 399 .- 196

20 22 23 24

584 110 612 -
OVERALL 02 03 04
4628 151 1 314
11 12 13 14

384 .- 163 221

22 23 24 25

112 616 523

0.0000058778
0.0000005693
-0.0000006648

Covariance Matrix for

0.0000076436
-0.0000022269
0.0000012035

Horizontal network accuracy
Vertical network accuracy

-0.0000003393

-0.0000022269

the xyz OPUS
-0000005693
-0000110489

the enu OPUS

-0000097701
-0000014095

I
o

06 07 08
.. 0.015 0.014
16 17 18
0.018 0.017 .-
28 30 31
0.022 .018
04 06 07
0.016 - .015
14 16 17
0.014 0.013 .018
25 28 30
0.015
06 07 08
.. 0.014 .016
16 17 18
0.012 0.022 .-
28 30 31
0.022 .017
VS. BASELINE
06 07 08
.- 421 269
16 17 18
9 247 .-
28 30 31
61 - 385
04 06 07
380 .- 427
14 16 17
221 8 262
25 28 30
523 - -
06 o7 08
- 411 234
16 17 18
8 151 -
28 30 31
48 390

Position (meters2).
-0.0000006648
-0.0000003393

0.0000128489

Position (meters2).
0.0000012035
0.0000014095
0.0000123618

0.00730 meters.
.00689 meters.

09

19

.017

32

.020

08

.014

18

31

-019

09

19

-019

32

-019

09
19
139
32
19

08
254
18
31
398

09
19
108

32
18

10

-018

20

.014

09

19

-019

32

10

.020

20

.022

10
246
20
608

09
19
137
32
10
209

20
566



Derivation of NAD 83 vector components

Position of reference station ARP in NAD_83(CORS96) (EPOCH:2003.0000) .
Xa(m) Ya(m) Za(m)

BIS5 -2494920.44060 -2448392.05858 5317113.38841 2003.00

LEV6 -2412811.42529 -2579075.35282  5293281.97185 2003.00

AIS5 -2430153.20716 -2737194.06415 5205816.48535 2003.00

Position of reference station monument in NAD_83(CORS96) (EPOCH:2003.0000).
Xr(m) Yr(m) Zr(m)
BIS5 -2494920.44060 -2448392.05858 5317113.38841 2003.00
LEV6 -2412811.42529 -2579075.35282 5293281.97185 2003.00
AIS5 -2430153.20716 -2737194.06415 5205816.48535 2003.00

Velocity of reference station monument in NAD_83(CORS96) (EPOCH:2003.0000).

Vx (m/yr) Vy (m/yr) Vz (m/yr)
BIS5 0.00490 0.00450 0.00990
LEV6 0.00220 0.00120 0.00480
AIS5 0.00620 -0.00040 0.00060

Vectors from unknown station monument to reference station monument
in NAD_83(CORS96) (EPOCH: 2003 .0000) .

Xr-X= DX(m) Yr-Y= DY(m) Zr-Z= Dz(m)
BIS5 -80946.27660 214704.92342 65880.42141 2003.00
LEV6 1162.73871 84021.62918 42049.00485 2003.00
AIS5 -16179.04316 -74097.08215 -45416.48165 2003.00

This position and the above vector components were computed without any
knowledge by the National Geodetic Survey regarding the equipment or
field operating procedures used.



DATASHEETS http://www.ngs.noaa.gov/cgi-bin/ds_mark.prl?PidBox=Al4914

The NGS Data Sheet

See file dsdata.txt for more information about the datasheet.

DATABASE = ,PROGRAM = datasheet, VERSION = 7.67

1 National Geodetic Survey, Retrieval Date = AUGUST 4, 2009

Al14914 DESIGNATION - BM NO 37

Al4914 PID - Al4914

Al14914 STATE/COUNTY- AK/KETCHIKAN GATEWAY BOROUGH

Al4914 USGS QUAD - KETCHIKAN B-5

Al4914

Al4914 *CURRENT SURVEY CONTROL

Al4914

Al4914* NAD 83(2007)- 55 19 58.66141(N) 131 37 31.81957(W) ADJUSTED
A14914* LOCAL TIDAL - 8.25 (meters) 27.1 (feet) LEVELING
Al4914

Al14914 EPOCH DATE - 2007.00

Al4914 X - -2,415,358.879 (meters) COMP
Al4914 Y - -2,718,046.174 (meters) COMP
Al4914 7 - 5,222,559.311 (meters) COMP
A14914 LAPLACE CORR- -0.13 (seconds) DEFLEC99
A14914 ELLIP HEIGHT- 3.778 (meters) (02/10/07) ADJUSTED
Al14914 GEOID HEIGHT- -5.88 (meters) GEOI1DO6
Al4914

Al4914 ——————- Accuracy Estimates (at 95% Confidence Level in cm) -—--—--—-
Al14914 Type PID Designation North East Ellip
Al4914 —— o
Al14914 NETWORK Al14914 BM NO 37 0.63 0.45 1.57
Al4914 e
Al14914 VERT ORDER - THIRD ?

Al4914

A14914 _The horizontal coordinates were established by GPS observations
Al14914 _and adjusted by the National Geodetic Survey in February 2007.
Al4914

Al14914_.The datum tag of NAD 83(2007) is equivalent to NAD 83(NSRS2007).
Al14914 _See National Readjustment for more information.

Al14914 _The horizontal coordinates are valid at the epoch date displayed above.
Al14914 _The epoch date for horizontal control is a decimal equivalence

Al14914 _of Year/Month/Day.

Al4914

Al14914_.The orthometric height was determined by differential leveling.

Al14914 _The vertical network tie was performed by a horz. field party for horz.
Al14914 _obs reductions. Reset procedures were used to establish the elevation.

10of2

Al14914

A14914 _Photographs are available for this station.

Al4914

Al14914_.The X, Y, and Z were computed from the position and the ellipsoidal ht.
Al4914

Al14914 _The Laplace correction was computed from DEFLEC99 derived deflections.
Al4914

A14914 _The ellipsoidal height was determined by GPS observations

Al14914 _and is referenced to NAD 83.

Al4914

Al14914_.The geoid height was determined by GEOIDO6.

Al4914

Al14914; North East Units Scale Factor Converg.
Al14914;SPC AK 1 - 391,423.859 948,202.671 MT 0.99990058 +1 41 48.4
Al14914;UTM 09 - 6,134,983.224  333,464.473 MT 0.99994023 -2 09 35.6

8/5/2009 12:55 AM



DATASHEETS http://www.ngs.noaa.gov/cgi-bin/ds_mark.prl?PidBox=Al4914

2 of 2

Al4914

Al149141 - Elev Factor x Scale Factor = Combined Factor
Al49141SPC AK 1 - 0.99999941 x 0.99990058 = 0.99989999

A149141UTM 09 - 0.99999941 x 0.99994023 = 0.99993964

Al4914

Al14914 SUPERSEDED SURVEY CONTROL

Al4914

Al14914 NAD 83(1992)- 55 19 58.65991(N) 131 37 31.82053(W) AD( ) B
Al4914 ELLIP H (04/28/00) 3.819 (m) GP( ) 41
Al14914

Al14914 _Superseded values are not recommended for survey control.
Al14914 _NGS no longer adjusts projects to the NAD 27 or NGVD 29 datums.
Al14914 _See file dsdata.txt to determine how the superseded data were derived.
Al4914

Al4914 U.S. NATIONAL GRID SPATIAL ADDRESS: 9UUB3346434983(NAD 83)
Al14914 MARKER: DB = BENCH MARK DISK

Al4914 SETTING: 32 = SET IN A RETAINING WALL OR CONCRETE LEDGE

Al4914 SP_SET: RETAINING WALL

Al4914 STAMPING: NO 37 1956

Al14914 MARK LOGO: CGS

Al4914 MAGNETIC: O = OTHER; SEE DESCRIPTION

Al4914 STABILITY: B = PROBABLY HOLD POSITION/ELEVATION WELL

Al4914 SATELLITE: THE SITE LOCATION WAS REPORTED AS SUITABLE FOR
Al4914+SATELLITE: SATELLITE OBSERVATIONS - January 04, 2007

Al4914

Al14914 HISTORY - Date Condition Report By
Al4914 HISTORY - 1956 MONUMENTED CGS
Al4914 HISTORY - 20050420 GOOD NGS
Al4914 HISTORY - 20070104 GOOD INDIV
Al4914

Al4914 STATION DESCRIPTION
Al4914

A14914"DESCRIBED BY COAST AND GEODETIC SURVEY 1956

A14914"DESCRIBED BY R+M CONSULTANTS 1999 (RHB) . THE STATION IS LOCATED
A14914° APPROXIMATELY 1.6 KM (1.00 MI) SOUTHEASTERLY OF DOWNTOWN KETCHIKAN
A14914°ALASKA AT THE KETCHIKAN COAST GUARD BASE. OWNERSHIP-- UNITED STATES
Al4914°COAST GUARD, C/0 PCC CHUCK SHAFFER I1.S.C. KETCHIKAN, 1300 STEDMAN
A14914"STREET, KETCHIKAN ALASKA 99901, PHONE NUMBER 907-228-0380, FAX NUMBER
A149147907-228-0314, ACCESS IS RESTRICTED. CONTACT THE CHIEF PETTY OFFICER
A14914"AT LEAST 48 HOURS PRIOR TO ENTRY.

A14914"TO REACH THE STATION FROM THE INTERSECTION OF STEDMAN STREET AND
A14914"DEERMOUNT STREET, AT THE SOUTHEASTERLY END OF KETCHIKAN, PROCEED
A14914"SOUTHEAST 1.0 KM (0.60 MI) ALONG STEDMAN STREET TO THE COAST GUARD
Al14914"BASE AND THE STATION ON THE RIGHT.

A14914"THE STATION 1S A STANDARD USCGS BRASS BENCH MARK DISK STAMPED --NO 37
A1491471956-- AND SET FLUSH WITH A CONCRETE RETAINING WALL IN FRONT OF THE
A14914"COAST GUARD ADMINISTRATION BUILDING. THE STATION IS LOCATED 26.5 M
Al4914°(86.9 FT) 351 DEGREES MAGNETIC AZIMUTH FROM THE NORTHEAST CORNER OF
Al14914°THE COAST GUARD ADMINISTRATION BUILDING, 3.0 M (9.8 FT) 134 DEGREES
Al14914"MAGNETIC AZIMUTH FROM THE NORTH END OF A GUARD RAIL, AND 42.2 M (138.5
Al14914°FT) 95 DEGREES MAGNETIC AZIMUTH FROM A FIRE HYDRANT.

Al14914

A14914 STATION RECOVERY (2005)

Al14914

Al14914"RECOVERY NOTE BY NATIONAL GEODETIC SURVEY 2005 (RA)

A14914"RECOVERED IN GOOD CONDITION.

A14914

Al14914 STATION RECOVERY (2007)

A14914

Al14914"RECOVERY NOTE BY INDIVIDUAL CONTRIBUTORS 2007 (JPP)

A14914"RECOVERED AS DESCRIBED

*** retrieval complete.
Elapsed Time = 00:00:00

8/5/2009 12:55 AM



FILE: USCG1212.090 000038225

NGS OPUS SOLUTION REPORT

All computed coordinate accuracies are listed as peak-to-peak values.

For additional

USER:
RINEX FILE:

SOFTWARE:
EPHEMERIS:
NAV FILE:
ANT NAME:
ARP HEIGHT:

REF FRAME:
X:
Y:
Z

LAT:

E LON:

W LON:

EL HGT:
ORTHO HGT:

Northing (Y) [meters]
Easting (X) [meters]
Convergence
Point Scale
Combined Factor

US NATIONAL GRID DESIGNATOR:

PID

A14914

weston. renoud@noaa.gov
uscgl21lu.090

page5 0810.20 master30.

igrl5295.eph [rapid]
brdc1210.09n
ASH701975.01AGP NONE
1.5

NAD_83(CORS96) (EPOCH:2003.0000)

-2415358.948(m)
-2718046.293(m)
5222559.332(m)

eNeoNe)

55 19 58.65822
228 22 28.18196

3.872(m)
9.747(m)

0
0]
131 37 31.81804 0.
0
0

UTM COORDINATES
UTM (Zone 09)

information: www.ngs.

noaa.gov/0PUS/Using_OPUS.html#accuracy

DATE:
TIME:

May 06, 2009
01:51:09 UTC

pl 081023 START:
STOP:

OBS USED:

# FIXED AMB:

OVERALL RMS:

2009/05/01 20:56:00
2009/05/01 23:05:00
4299 / 4471 96%

25 / 28 89%
0.016(m)

ITRFOO (EPOCH:2009.3313)

.060(m) -2415359.797(m)  0.060(m)
.089(m) -2718045.189(m)  0.089(m)
.048(m) 5222559.513(m)  0.048(m)
.078(m) 55 19 58.66849 0.078(m)
.066(m) 228 22 28.10437 0.066(m)
066(m) 131 37 31.89563 0.066(m)
.058(m) 3.872(m)  0.058(m)

-133(m) [NAVD88 (Computed using GEOIDO06)]

STATE PLANE COORDINATES
SPC (5001 AK 1)

6134983.124 391423.761
333464 .496 948202.701
[degrees] -2.15989498 1.69678539
0.99994023 0.99990058
0.99993962 0.00000000

9UUB3346434983(NAD 83)

BASE STATIONS USED

DESIGNATION
DK6423 BISS BIORKA
DJ3035 LEV6 LEVEL

DK6482 AISS ANNETTE

ISLAND 6 CORS ARP

ISLAND 5 CORS ARP

ISLAND 5 CORS ARP

LATITUDE LONGITUDE DISTANCE(m)
N565116.162 W1353221.387 296620.9
N562756.364 W1330532.511 155952.3
N550408.647 W1313558.255 29425.0

NEAREST NGS PUBLISHED CONTROL POINT

BM NO 37

N551958.661 W1313731.819 0.0



STATION NAME:
MONUMENT : NO

XYZ
XYZ
NEU
NEU
NEU
XYZ
XYZ
XYZ
XYZ
XYZ
XYZ
XYZ
XYZ
LLH
LLH
LLH

-2494921
-0.
0.
-0.
-0.
-0.
0.
-0.
-2494921.
-0.
-2494921.
-2494921.
-2494921.
56 51 16.
56 51 16.
56 51 16.

STATION NAME:
MONUMENT : NO

XYZ
XYZ
NEU
NEU
NEU
XYZ
XYZ
XYZ
XYZ
XYZ
XYZ
XYZ
XYZ
LLH
LLH
LLH

-2412812
-0.
0.
-0.
-0.
-0.
0.
-0.
-2412812.
-0.
-2412812.
-2412812.
-2412812.
56 27 56.
56 27 56.
56 27 56.

STATION NAME:
MONUMENT : NO

XYZ
XYZ
NEU
NEU
NEU
XYZ
XYZ
XYZ
XYZ
XYZ
XYZ
XYZ
XYZ
LLH
LLH
LLH

-2430153.
-0.
0.
-0.
-0.
-0.
0.
-0.
-2430154.
-0.
-2430154.
-2430154.
-2430154.
55 4 8.
55 4 8.
55 4 8.

BASE STATIO

bis5 a

DOMES NUMBER

.0833 -2448390.9914
0164 0.0037
0000 0.0000
0034 -0.0019
0037 -0.0015
2022 0.0456
0000 0.0000
0351 -0.0318
3206 -2448390.9775
0000 -0.0000
3206 -2448390.9776
2855 -2448390.9458
2855 -2448390.9458
17151 224 27 38.53076
17162 224 27 38.53087
17162 224 27 38.53087
lev6 a 2 (Level lIs
DOMES NUMBER

.0457 -2579074.2577
0190 0.0003
0000 0.0000
0034 -0.0019
0037 -0.0015
2343 0.0037
0000 0.0000
0340 -0.0336
3140 -2579074.2876
0000 0.0000
3140 -2579074.2876
2800 -2579074.2540
2800 -2579074.2540
37384 226 54 27.40784
37395 226 54 27.40796
37395 226 54 27.40796
aisb a

DOMES NUMBER

8469 -2737192.9494
0147 -0.0013
0000 0.0000
0034 -0.0019
0037 -0.0015
1813 -0.0160
0000 0.0000
0342 -0.0356
0623 -2737193.0011
0000 0.0000
0623 -2737193.0011
0282 -2737192.9654
0282 -2737192.9654

65794 228 24 1.66886
65805 228 24 1.66897
65805 228 24 1.66897

N INFORMATION

5317113.

eNoNoNoNoNeoNe)

5317113.
-0.
5317113.
5317113.
5317113.
66.
66.
66.

land 6;

5293282.
-0.

0.

0.

0.

-0.

0.

0.
5293282.
-0.
5293282.
5293282.
5293282.
25.

25.

25.

5205816.
-0.

0.

0.

0.

-0.

0.

0.
5205816.
-0.
5205816.
5205816.
5205816.
32

32.

32.

6533

-0005
-0000
.0813
-0689
.0062
-0000
.0662

7257
0000
7257
6595
6595
8349
7536
7536

Level

2476
0044
0000
0813
0689
0543
0000
0659
2592
0000
2592
1933
1933
4801
3988
3988

2 (Annette Island 5; Annette

7670
0087
0000
0813
0689
1073
0000
0647
7244
0000
7244
6597
6597

-4119

3306
3306

2 (Biorka Island 5; Biorka Island, Alaska USA)

MON
VEL
MON
ARP
ARP
VEL

@ 1997.0000 (M)

(M/YR)

TO ARP (M)

TO L1 PHASE CENTER (M)
TO L2 PHASE CENTER (M)
TIMES 12.3313 YRS

MON TO ARP

ARP TO L1 PHASE CENTER

L1 PHS CEN @ 2009.3313

+ XYZ ADJUSTMENTS

NEW L1 PHS CEN @ 2009.3313
NEW ARP @ 2009.3313

NEW MON @ 2009.3313

NEW L1 PHS CEN @ 2009.3313
NEW ARP @ 2009.3313

NEW MON @ 2009.3313

Island, Alaska USA)

MON
VEL
MON
ARP
ARP
VEL

@ 1997.0000 (M)

(M/YR)

TO ARP (M)

TO L1 PHASE CENTER (M)
TO L2 PHASE CENTER (M)
TIMES 12.3313 YRS

MON TO ARP

ARP TO L1 PHASE CENTER

L1 PHS CEN @ 2009.3313

+ XYZ ADJUSTMENTS

NEW L1 PHS CEN @ 2009.3313
NEW ARP @ 2009.3313

NEW MON @ 2009.3313

NEW L1 PHS CEN @ 2009.3313
NEW ARP @ 2009.3313

NEW MON @ 2009.3313

Island, Alaska USA)

MON
VEL
MON
ARP
ARP
VEL

@ 1997.0000 (M)

(M/YR)

TO ARP (M)

TO L1 PHASE CENTER (M)
TO L2 PHASE CENTER (M)
TIMES 12.3313 YRS

MON TO ARP

ARP TO L1 PHASE CENTER

L1 PHS CEN @ 2009.3313

+ XYZ ADJUSTMENTS

NEW L1 PHS CEN @ 2009.3313
NEW ARP @ 2009.3313

NEW MON @ 2009.3313

NEW L1 PHS CEN @ 2009.3313
NEW ARP @ 2009.3313

NEW MON @ 2009.3313



REMOTE STATION INFORMATION

STATION NAME: uscg 1
MONUMENT : NO DOMES NUMBER
XYZ -2415360.6791 -2718045.9236  5222561.0525 MON @ 2009.3312 (M)

NEU 0.0025 0.0026 1.5000 MON TO ARP (M)

NEU -0.0025 -0.0026 0.0637 ARP TO L1 PHASE CENTER (M)
NEU -0.0012 0.0008 0.0440 ARP TO L2 PHASE CENTER (M)
XYZ -0.5634 -0.6380 1.2351 MON TO ARP

XYZ -0.0274 -0.0269 0.0510 ARP TO L1 PHASE CENTER
XYZ -2415361.2699 -2718046.5885  5222562.3386 L1 PHS CEN @ 2009.3313

BASELINE NAME: bis5 uscg

XYZ 0.9053 0.7027 -1.5713 + XYZ ADJUSTMENTS

XYZ -2415360.3646 -2718045.8858 5222560.7673 NEW L1 PHS CEN @ 2009.3313
XYZ -2415360.3372 -2718045.8589 5222560.7163 NEW ARP @ 2009.3313

XYZ -2415359.7738 -2718045.2209 5222559.4812 NEW MON @ 2009.3313

LLH 55 19 58.66769 228 22 28.10655 5.4148 NEW L1 PHS CEN @ 2009.3313
LLH 55 19 58.66777 228 22 28.10670 5.3511 NEW ARP @ 2009.3313
LLH 55 19 58.66769 228 22 28.10655 3.8511 NEW MON @ 2009.3313

BASELINE NAME: lev6 uscg

XYZ 0.8455 0.7092 -1.5248 + XYZ ADJUSTMENTS

XYZ -2415360.4245 -2718045.8793 5222560.8138 NEW L1 PHS CEN @ 2009.3313
XYZ -2415360.3971 -2718045.8524  5222560.7628 NEW ARP @ 2009.3313

XYZ -2415359.8336 -2718045.2144  5222559.5277 NEW MON @ 2009.3313

LLH 55 19 58.66761 228 22 28.10377 5.4730 NEW L1 PHS CEN @ 2009.3313
LLH 55 19 58.66769 228 22 28.10392 5.4093 NEW ARP @ 2009.3313
LLH 55 19 58.66761 228 22 28.10377 3.9093 NEW MON @ 2009.3313

BASELINE NAME: aisb uscg

XYZ 0.8950 0.7912 -1.5237 + XYZ ADJUSTMENTS

XYZ -2415360.3749 -2718045.7973 5222560.8149 NEW L1 PHS CEN @ 2009.3313
XYZ -2415360.3476 -2718045.7704  5222560.7639 NEW ARP @ 2009.3313

XYZ -2415359.7841 -2718045.1324  5222559.5288 NEW MON @ 2009.3313

LLH 55 19 58.67014 228 22 28.10278 5.4202 NEW L1 PHS CEN @ 2009.3313
LLH 55 19 58.67022 228 22 28.10293 5.3565 NEW ARP @ 2009.3313
LLH 55 19 58.67014 228 22 28.10278 3.8565 NEW MON @ 2009.3313
G-FILES
Axx2009 5 1 951
B2009 5 12056 9 5 123 5 1 page5 v0810.201GS 226 1 2 27NGS 2009 5 S5I1FDDFX
lant_info.003 NGS 20090501

C00090001 -795615118 66 2696542751 78 945541782 67 X1219AUSCGX1219ABIS5
D 1 2 2500896 1 3 -8353636 2 3 -3886207

Axx2009 5 1 951
B2009 5 12056 9 5 123 5 1 page5 v0810.20I1GS 226 1 2 27NGS 2009 5 51FDDFX
lant_info.003 NGS 20090501

C00090002 25475536 48 1389709604 61 707226656 63 X1219AUSCGX1219ALEV6
D 1 2 4114541 1 3 -8151359 2 3 -1359443

Axx2009 5 1 951
B2009 5 12056 9 5 123 5 1 page5 v0810.20I1GS 226 1 2 27NGS 2009 5 51FDDFX
lant_info.003 NGS 20090501

CO0090003 -147942441 83 -191478330 77 -167428691 87 X1219AUSCGX1219AAI1S5
D 1 2 9292636 1 3 -1168614 2 3 -2618



bis5-uscg]

bis5-uscg]

lev6-uscg]

lev6-uscg]

aisb-uscg]

aisb-uscg]

bis5-uscg]
bis5-uscg]
lev6-uscg]
lev6-uscg]
aisb5-uscg]

aisb-uscg]

Covariance Matrix for
0.0000301089
0.0000018736

-0.0000015562

Covariance Matrix for
0.0000303908
-0.0000022471
0.0000006067

Horizontal network accuracy
Vertical network accuracy

POST-FIT RMS BY SATELLITE VS. BASELINE

OVERALL
0.020 O.
20

0

OVERALL
0.012 O.
20

0]

OVERALL
0.015 O.
20

0]

OVERALL
1428
20

OVERALL
1441
20

OVERALL
1430
20

0.
0.
-0.0000005678

07

30

07

30

07

30

11 13
.017 0.025
31 32
.016 0.018

11 13
.014 0.012
31 32
.010 0.010

11 13
.016 0.020
31 32
.012 0.012

OBS BY SATELLITE VS. BASELINE

02 04
025 0.019
23 25
.019 0.028
02 04
022 0.015
23 25
.011 0.013
02 04
026 0.019
23 25
.012 0.018
02 04
40 217
23 25
256 91
02 04
27 221
23 25
252 91
02 04
40 198
23 25
256 89

the xyz OPUS Position (meters2).

0000018736
0000349644

the enu OPUS Position (meters2).
-0.0000022471
0.
-0.0000000685

0000336197

07

30
07

30
07

30

11 13
85 166
31 32

211 256

11 13
85 166
31 32

212 256

11 13
79 159
31 32

212 256

-0.0000015562
-0.0000005678
0.0000356156

0.0000006067
-0.0000000685
0.0000366785

0.01384 meters.
0.01188 meters.

14

14

14

14

14

16
0.028

16
0.029

16
0.024

16
106

16
131

16
141

17

17

17

17

17

17



Derivation of NAD 83 vector components

Position of reference station ARP in NAD_83(CORS96) (EPOCH:2003.0000) .
Xa(m) Ya(m) Za(m)

BIS5 -2494920.44060 -2448392.05858 5317113.38841 2003.00

LEV6 -2412811.42529 -2579075.35282  5293281.97185 2003.00

AIS5 -2430153.20716 -2737194.06415 5205816.48535 2003.00

Position of reference station monument in NAD_83(CORS96) (EPOCH:2003.0000).
Xr(m) Yr(m) Zr(m)
BIS5 -2494920.44060 -2448392.05858 5317113.38841 2003.00
LEV6 -2412811.42529 -2579075.35282 5293281.97185 2003.00
AIS5 -2430153.20716 -2737194.06415 5205816.48535 2003.00

Velocity of reference station monument in NAD_83(CORS96) (EPOCH:2003.0000).

Vx (m/yr) Vy (m/yr) Vz (m/yr)
BIS5 0.00490 0.00450 0.00990
LEV6 0.00220 0.00120 0.00480
AIS5 0.00620 -0.00040 0.00060

Vectors from unknown station monument to reference station monument
in NAD_83(CORS96) (EPOCH: 2003 .0000) .

Xr-X= DX(m) Yr-Y= DY(m) Zr-Z= Dz(m)
BIS5 -79561.49260 269654 .23442 94554 .05641 2003.00
LEV6 2547 .52271 138970.94018 70722 .63985 2003.00
AIS5 -14794 .25916 -19147.77115 -16742.84665 2003.00

This position and the above vector components were computed without any
knowledge by the National Geodetic Survey regarding the equipment or
field operating procedures used.



FILE: 10541220.090 000038259

NGS OPUS SOLUTION REPORT

All computed coordinate accuracies are listed as peak-to-peak values.

For additional

information: www.ngs.noaa.gov/0PUS/Using_OPUS.html#accuracy

USER: weston.renoud@noaa.gov DATE: May 06, 2009
RINEX FILE: 1054122b.090 TIME: 05:56:23 UTC
SOFTWARE: page5 0810.20 masterll.pl 081023 START: 2009/05/02 01:31:00
EPHEMERIS: igr15296.eph [rapid] STOP: 2009/05/02 03:27:30
NAV FILE: brdc1220.09n OBS USED: 4571 / 4715 97%
ANT NAME: TRM55971.00 NONE # FIXED AMB: 28 / 29 97%
ARP HEIGHT: 1.5 OVERALL RMS: 0.012(m)
REF FRAME: NAD_83(CORS96) (EPOCH:2003.0000) ITRFOO (EPOCH:2009.3318)

X: -2415358.872(m)
Y: -2718046.148(m)
y 5222559.317(m)

LAT: 55 19 58.66217

E LON: 228 22 28.17972

W LON: 131 37 31.82028
EL HGT: 3.770(m)
ORTHO HGT: 9.645(m)

UTM COORDINATES
UTM (Zone 09)

eNeoNe)

0
0]
0.
0
0

.005(m) -2415359.721(m)  0.005(m)
.053(m) -2718045.044(m)  0.053(m)
.036(m) 5222559.498(m)  0.036(m)
.038(m) 55 19 58.67244 0.038(m)
.033(m) 228 22 28.10212 0.033(m)
033(m) 131 37 31.89788 0.033(m)
.037(m) 3.770(m)  0.037(m)

.125(m) [NAVD88 (Computed using GEOIDO06)]

STATE PLANE COORDINATES
SPC (5001 AK 1)

Northing (Y) [meters] 6134983.248 391423.882
Easting (X) [meters] 333464 .461 948202 .658
Convergence [degrees] -2.15989552 1.69678487
Point Scale 0.99994023 0.99990058
Combined Factor 0.99993964 0.00000000

US NATIONAL GRID DESIGNATOR:

9UUB3346434983(NAD 83)

BASE STATIONS USED

PID DESIGNATION
DK6423 BISS BIORKA
DJ3035 LEV6 LEVEL

DK6482 AISS ANNETTE

ISLAND 5 CORS ARP
ISLAND 6 CORS ARP
ISLAND 5 CORS ARP

LATITUDE LONGITUDE DISTANCE(m)
N565116.162 W1353221.387 296620.7
N562756.364 W1330532.511 155952.1
N550408.647 W1313558.255 29425.1

NEAREST NGS PUBLISHED CONTROL POINT

A14914 BM NO 37

N551958.661 W1313731.819 0.0



STATION NAME:
MONUMENT : NO

XYZ
XYZ
NEU
NEU
NEU
XYZ
XYZ
XYZ
XYZ
XYZ
XYZ
XYZ
XYZ
LLH
LLH
LLH

-2494921
-0.
0.
-0.
-0.
-0.
0.
-0.
-2494921.
-0.
-2494921.
-2494921.
-2494921.
56 51 16.
56 51 16.
56 51 16.

STATION NAME:
MONUMENT : NO

XYZ
XYZ
NEU
NEU
NEU
XYZ
XYZ
XYZ
XYZ
XYZ
XYZ
XYZ
XYZ
LLH
LLH
LLH

-2412812
-0.
0.
-0.
-0.
-0.
0.
-0.
-2412812.
-0.
-2412812.
-2412812.
-2412812.
56 27 56.
56 27 56.
56 27 56.

STATION NAME:
MONUMENT : NO

XYZ
XYZ
NEU
NEU
NEU
XYZ
XYZ
XYZ
XYZ
XYZ
XYZ
XYZ
XYZ
LLH
LLH
LLH

-2430153.
-0.
0.
-0.
-0.
-0.
0.
-0.
-2430154.
0.
-2430154.
-2430154.
-2430154.
55 4 8.
55 4 8.
55 4 8.

BASE STATIO

bis5 a

DOMES NUMBER

.0833 -2448390.9914
0164 0.0037
0000 0.0000
0034 -0.0019
0037 -0.0015
2022 0.0456
0000 0.0000
0351 -0.0318
3206 -2448390.9775
0000 -0.0000
3206 -2448390.9775
2855 -2448390.9458
2855 -2448390.9458
17151 224 27 38.53076
17162 224 27 38.53087
17162 224 27 38.53087
lev6 a 2 (Level lIs
DOMES NUMBER

.0457 -2579074.2577
0190 0.0003
0000 0.0000
0034 -0.0019
0037 -0.0015
2343 0.0037
0000 0.0000
0340 -0.0336
3140 -2579074.2876
0000 0.0000
3140 -2579074.2876
2800 -2579074.2540
2800 -2579074.2540
37384 226 54 27.40784
37395 226 54 27.40796
37395 226 54 27.40796
aisb a

DOMES NUMBER

8469 -2737192.9494
0147 -0.0013
0000 0.0000
0034 -0.0019
0037 -0.0015
1813 -0.0160
0000 0.0000
0342 -0.0356
0624 -2737193.0011
0000 0.0000
0624 -2737193.0011
0282 -2737192.9654
0282 -2737192.9654

65794 228 24 1.66886
65805 228 24 1.66897
65805 228 24 1.66897

N INFORMATION

5317113.

eNoNoNoNoNeoNe)

5317113.
0.
5317113.
5317113.
5317113.
66.

66.

66.

land 6;

5293282.
-0.

0.

0.

0.

-0.

0.

0.
5293282.
0.
5293282.
5293282.
5293282.
25.

25.

25.

5205816.
-0.

0.

0.

0.

-0.

0.

0.
5205816.
0.
5205816.
5205816.
5205816.
32.

32.

32.

6533

-0005
-0000
.0813
-0689
.0062
-0000
.0662

7257
0000
7257
6595
6595
8349
7536
7536

Level

2476
0044
0000
0813
0689
0543
0000
0659
2592
0000
2592
1933
1933
4801
3988
3988

2 (Annette Island 5; Annette

7670
0087
0000
0813
0689
1073
0000
0647
7244
0000
7244
6597
6597
4119
3306
3306

2 (Biorka Island 5; Biorka Island, Alaska USA)

MON
VEL
MON
ARP
ARP
VEL

@ 1997.0000 (M)

(M/YR)

TO ARP (M)

TO L1 PHASE CENTER (M)
TO L2 PHASE CENTER (M)
TIMES 12.3318 YRS

MON TO ARP

ARP TO L1 PHASE CENTER

L1 PHS CEN @ 2009.3318

+ XYZ ADJUSTMENTS

NEW L1 PHS CEN @ 2009.3318
NEW ARP @ 2009.3318

NEW MON @ 2009.3318

NEW L1 PHS CEN @ 2009.3318
NEW ARP @ 2009.3318

NEW MON @ 2009.3318

Island, Alaska USA)

MON
VEL
MON
ARP
ARP
VEL

@ 1997.0000 (M)

(M/YR)

TO ARP (M)

TO L1 PHASE CENTER (M)
TO L2 PHASE CENTER (M)
TIMES 12.3318 YRS

MON TO ARP

ARP TO L1 PHASE CENTER

L1 PHS CEN @ 2009.3318

+ XYZ ADJUSTMENTS

NEW L1 PHS CEN @ 2009.3318
NEW ARP @ 2009.3318

NEW MON @ 2009.3318

NEW L1 PHS CEN @ 2009.3318
NEW ARP @ 2009.3318

NEW MON @ 2009.3318

Island, Alaska USA)

MON
VEL
MON
ARP
ARP
VEL

@ 1997.0000 (M)

(M/YR)

TO ARP (M)

TO L1 PHASE CENTER (M)
TO L2 PHASE CENTER (M)
TIMES 12.3318 YRS

MON TO ARP

ARP TO L1 PHASE CENTER

L1 PHS CEN @ 2009.3318

+ XYZ ADJUSTMENTS

NEW L1 PHS CEN @ 2009.3318
NEW ARP @ 2009.3318

NEW MON @ 2009.3318

NEW L1 PHS CEN @ 2009.3318
NEW ARP @ 2009.3318

NEW MON @ 2009.3318



REMOTE STATION INFORMATION

STATION NAME: 1054 1
MONUMENT : NO DOMES NUMBER
XYZ -2415360.1829 -2718045.5883 5222560.7616 MON @ 2009.3317 (M)

NEU -0.0016 -0.0007 1.5000 MON TO ARP (M)

NEU 0.0016 0.0007 0.0850 ARP TO L1 PHASE CENTER (M)
NEU 0.0008 0.0012 0.0701 ARP TO L2 PHASE CENTER (M)
XYZ -0.5681 -0.6383 1.2328 MON TO ARP

XYZ -0.0307 -0.0356 0.0708 ARP TO L1 PHASE CENTER
XYZ -2415360.7818 -2718046.2622  5222562.0652 L1 PHS CEN @ 2009.3318

BASELINE NAME: bis5 1054

XYZ 0.4618 0.5681 -1.2792 + XYZ ADJUSTMENTS

XYZ -2415360.3200 -2718045.6941 5222560.7861 NEW L1 PHS CEN @ 2009.3318
XYZ -2415360.2893 -2718045.6585 5222560.7152 NEW ARP @ 2009.3318

XYZ -2415359.7211 -2718045.0202 5222559.4824 NEW MON @ 2009.3318

LLH 55 19 58.67263 228 22 28.10122 5.3319 NEW L1 PHS CEN @ 2009.3318
LLH 55 19 58.67258 228 22 28.10118 5.2469 NEW ARP @ 2009.3318
LLH 55 19 58.67263 228 22 28.10122 3.7469 NEW MON @ 2009.3318

BASELINE NAME: lev6 1054

XYZ 0.4650 0.5483 -1.2431 + XYZ ADJUSTMENTS

XYZ -2415360.3167 -2718045.7139  5222560.8221 NEW L1 PHS CEN @ 2009.3318
XYZ -2415360.2860 -2718045.6783  5222560.7513 NEW ARP @ 2009.3318

XYZ -2415359.7179 -2718045.0400 5222559.5185 NEW MON @ 2009.3318

LLH 55 19 58.67296 228 22 28.10211 5.3687 NEW L1 PHS CEN @ 2009.3318
LLH 55 19 58.67290 228 22 28.10207 5.2837 NEW ARP @ 2009.3318
LLH 55 19 58.67296 228 22 28.10211 3.7837 NEW MON @ 2009.3318

BASELINE NAME: aisb 1054

XYZ 0.4596 0.5153 -1.2692 + XYZ ADJUSTMENTS

XYZ -2415360.3222 -2718045.7469  5222560.7960 NEW L1 PHS CEN @ 2009.3318
XYZ -2415360.2915 -2718045.7113  5222560.7252 NEW ARP @ 2009.3318

XYZ -2415359.7233 -2718045.0730 5222559.4924 NEW MON @ 2009.3318

LLH 55 19 58.67172 228 22 28.10312 5.3634 NEW L1 PHS CEN @ 2009.3318
LLH 55 19 58.67167 228 22 28.10308 5.2784 NEW ARP @ 2009.3318
LLH 55 19 58.67172 228 22 28.10312 3.7784 NEW MON @ 2009.3318
G-FILES
Axx2009 5 2 952
B2009 5 2 130 9 5 2 327 1 page5 v0810.201GS 226 1 2 27NGS 2009 5 6IFDDFX
lant_info.003 NGS 20090501

CO0090001 -795615644 35 2696540744 64 945541770 54 X1229A1054X1229ABI1S5
D 1 2 5925660 1 3 -7873734 2 3 -3932368

Axx2009 5 2 952
B2009 5 2 130 9 5 2 327 1 page5 v0810.201GS 226 1 2 27NGS 2009 5 G6IFDDFX
lant_info.003 NGS 20090501

C00090002 25474379 48 1389707860 105 707226749 74 X1229A1054X1229ALEV6
D 1 2 8548113 1 3 -6918825 2 3 -5342543

Axx2009 5 2 952
B2009 5 2 130 9 5 2 327 1 page5 v0810.20I1GS 226 1 2 27NGS 2009 5 61FDDFX
lant_info.003 NGS 20090501

C00090003 -147943048 35 -191478924 46 -167428327 63 X1229A1054X1229AA1S5
D 1 2 8769931 1 3 -7728950 2 3 -8819178



bis5-1054]

bis5-1054]

lev6-1054|

lev6-1054|

aisb5-1054]

ais5-1054]

bis5-1054]|
bis5-1054]|
lev6-1054|
lev6-1054|
ais5-1054]

ais5-1054]

Covariance Matrix for
0.0000105644
0.0000015661

-0.0000012555

Covariance Matrix for
0.0000212492
-0.0000110088
0.0000079720

Horizontal network accuracy

POST-FIT RMS BY SATELLITE VS. BASELINE

OVERALL
0.012 O.
19
0.014 O.

OVERALL
0.012 O.
19
0.016 O.

OVERALL
0.012 O.
19
0.015 O.

OVERALL
1534
19
204
OVERALL
1486
19
202
OVERALL
1551
19
221

0.
0.
-0.

-0.
0.
-0.

03
012
23
013

03
014
23
011

03
013
23

06
24

06
24

06

25

07

25

0.010
07

25
0.010

07

28

013 0.010 0.012

OBS BY SATELLITE

03
165
23
50

03
165
23
50

03
164
23
51

the xyz OPUS
0000015661
0000383044
0000017924

the enu OPUS
0000110088
0000255317
0000008251

Vertical network accuracy

06
24
" 06
24
" 06
25
233

07
25
233

07

25
233
07
28
168

08 10
0.007 0.012
28

0.011
08 10
0.007 0.011
28
0.010
08 10

0.008 0.012

VS. BASELINE

08 10
233 224
28
173

08 10
233 215
28
133

08 10
233 217

Position (meters2).

-0.0000012555
-0.0000017924
0.0000274689

Position (meters2).

0.0000079720
-0.0000008251
0.0000295569

0.01224 meters.
0.01066 meters.

13
0.011

13
0.012

13
0.013

13
190

13
193

13
202

15
0.013

15
0.017

15
0.015

15
62

15
62

15
62

16

16

16

16

16

16



Derivation of NAD 83 vector components

Position of reference station ARP in NAD_83(CORS96) (EPOCH:2003.0000) .
Xa(m) Ya(m) Za(m)

BIS5 -2494920.44060 -2448392.05858 5317113.38841 2003.00

LEV6 -2412811.42529 -2579075.35282  5293281.97185 2003.00

AIS5 -2430153.20716 -2737194.06415 5205816.48535 2003.00

Position of reference station monument in NAD_83(CORS96) (EPOCH:2003.0000).
Xr(m) Yr(m) Zr(m)
BIS5 -2494920.44060 -2448392.05858 5317113.38841 2003.00
LEV6 -2412811.42529 -2579075.35282 5293281.97185 2003.00
AIS5 -2430153.20716 -2737194.06415 5205816.48535 2003.00

Velocity of reference station monument in NAD_83(CORS96) (EPOCH:2003.0000).

Vx (m/yr) Vy (m/yr) Vz (m/yr)
BIS5 0.00490 0.00450 0.00990
LEV6 0.00220 0.00120 0.00480
AIS5 0.00620 -0.00040 0.00060

Vectors from unknown station monument to reference station monument
in NAD_83(CORS96) (EPOCH: 2003 .0000) .

Xr-X= DX(m) Yr-Y= DY(m) Zr-Z= Dz(m)
BIS5 -79561.56860 269654 .08942 94554 .07141 2003.00
LEV6 2547 .44671 138970.79518 70722.65485 2003.00
AIS5 -14794 33516 -19147.91615 -16742.83165 2003.00

This position and the above vector components were computed without any
knowledge by the National Geodetic Survey regarding the equipment or
field operating procedures used.



FILE: 10661210.090 000038258

NGS OPUS SOLUTION REPORT

All computed coordinate accuracies are listed as peak-to-peak values.

For additional

USER:
RINEX FILE:

SOFTWARE:
EPHEMERIS:
NAV FILE:
ANT NAME:
ARP HEIGHT:

REF FRAME:
X:
Y:
Z

LAT:

E LON:

W LON:

EL HGT:
ORTHO HGT:

Northing (Y) [meters]
Easting (X) [meters]
Convergence
Point Scale
Combined Factor

US NATIONAL GRID DESIGNATOR:

PID

A14914

weston. renoud@noaa.gov
1066121x.090

page5 0810.20 master29.

igrl5295.eph [rapid]
brdc1210.09n
TRM55971.00
1.5

NONE

NAD_83(CORS96) (EPOCH:2003.0000)

-2415358.876(m)
-2718046.200(m)
5222559.312(m)

eNeoNe)

55 19 58.66097
228 22 28.18151

3.789(m)
9.664(m)

0
0]
131 37 31.81849 0.
0
0

UTM COORDINATES
UTM (Zone 09)

information: www.ngs.

noaa.gov/0PUS/Using_OPUS.html#accuracy

DATE:
TIME:

May 06, 2009
05:55:21 UTC

pl 081023 START:
STOP:

OBS USED:

# FIXED AMB:

OVERALL RMS:

2009/05/01 23:15:00
2009/05/02 01:23:00
4958 / 5204 95%

31/ 37 84%
0.013(m)

ITRFOO (EPOCH:2009.3315)

.004(m) -2415359.725(m)  0.004(m)
.072(m) -2718045.096(m)  0.072(m)
.019(m) 5222559.493(m)  0.019(m)
.058(m) 55 19 58.67125 0.058(m)
.045(m) 228 22 28.10391 0.045(m)
045(m) 131 37 31.89609 0.045(m)
.017(m) 3.789(m)  0.017(m)

.121(m) [NAVD88 (Computed using GEOIDO6)]

STATE PLANE COORDINATES
SPC (5001 AK 1)

6134983.210 391423.846
333464 .491 948202.691
[degrees] -2.15989510 1.69678528
0.99994023 0.99990058
0.99993963 0.00000000

9UUB3346434983(NAD 83)

BASE STATIONS USED

DESIGNATION
DK6423 BISS BIORKA
DJ3035 LEV6 LEVEL

DK6482 AISS ANNETTE

ISLAND 6 CORS ARP

ISLAND 5 CORS ARP

ISLAND 5 CORS ARP

LATITUDE LONGITUDE DISTANCE(m)
N565116.162 W1353221.387 296620.8
N562756.364 W1330532.511 155952.2
N550408.647 W1313558.255 29425.1

NEAREST NGS PUBLISHED CONTROL POINT

BM NO 37

N551958.661 W1313731.819 0.0



STATION NAME:
MONUMENT : NO

XYZ
XYZ
NEU
NEU
NEU
XYZ
XYZ
XYZ
XYZ
XYZ
XYZ
XYZ
XYZ
LLH
LLH
LLH

-2494921
-0.
0.
-0.
-0.
-0.
0.
-0.
-2494921.
0.
-2494921.
-2494921.
-2494921.
56 51 16.
56 51 16.
56 51 16.

STATION NAME:
MONUMENT : NO

XYZ
XYZ
NEU
NEU
NEU
XYZ
XYZ
XYZ
XYZ
XYZ
XYZ
XYZ
XYZ
LLH
LLH
LLH

-2412812
-0.
0.
-0.
-0.
-0.
0.
-0.
-2412812.
0.
-2412812.
-2412812.
-2412812.
56 27 56.
56 27 56.
56 27 56.

STATION NAME:
MONUMENT : NO

XYZ
XYZ
NEU
NEU
NEU
XYZ
XYZ
XYZ
XYZ
XYZ
XYZ
XYZ
XYZ
LLH
LLH
LLH

-2430153.
-0.
0.
-0.
-0.
-0.
0.
-0.
-2430154.
0.
-2430154.
-2430154.
-2430154.
55 4 8.
55 4 8.
55 4 8.

BASE STATIO

bis5 a

DOMES NUMBER

.0833 -2448390.9914
0164 0.0037
0000 0.0000
0034 -0.0019
0037 -0.0015
2022 0.0456
0000 0.0000
0351 -0.0318
3206 -2448390.9775
0000 -0.0000
3206 -2448390.9776
2855 -2448390.9458
2855 -2448390.9458
17151 224 27 38.53076
17162 224 27 38.53087
17162 224 27 38.53087
lev6 a 2 (Level lIs
DOMES NUMBER

.0457 -2579074.2577
0190 0.0003
0000 0.0000
0034 -0.0019
0037 -0.0015
2343 0.0037
0000 0.0000
0340 -0.0336
3140 -2579074.2876
0000 -0.0000
3140 -2579074.2876
2800 -2579074.2540
2800 -2579074.2540
37384 226 54 27.40784
37395 226 54 27.40796
37395 226 54 27.40796
aisb a

DOMES NUMBER

8469 -2737192.9494
0147 -0.0013
0000 0.0000
0034 -0.0019
0037 -0.0015
1813 -0.0160
0000 0.0000
0342 -0.0356
0624 -2737193.0011
0000 -0.0000
0624 -2737193.0011
0282 -2737192.9654
0282 -2737192.9654

65794 228 24 1.66886
65805 228 24 1.66897
65805 228 24 1.66897

N INFORMATION

5317113.

eNoNoNoNoNeoNe)

5317113.
-0.
5317113.
5317113.
5317113.
66.
66.
66.

land 6;

5293282.
-0.

0.

0.

0.

-0.

0.

0.
5293282.
-0.
5293282.
5293282.
5293282.
25.

25.

25.

5205816.
-0.

0.

0.

0.

-0.

0.

0.
5205816.
0.
5205816.
5205816.
5205816.
32.

32.

32.

6533

-0005
-0000
.0813
-0689
.0062
-0000
.0662

7257
0000
7257
6595
6595
8349
7536
7536

Level

2476
0044
0000
0813
0689
0543
0000
0659
2592
0000
2592
1933
1933
4801
3988
3988

2 (Annette Island 5; Annette

7670
0087
0000
0813
0689
1073
0000
0647
7244
0000
7244
6597
6597
4119
3306
3306

2 (Biorka Island 5; Biorka Island, Alaska USA)

MON
VEL
MON
ARP
ARP
VEL

@ 1997.0000 (M)

(M/YR)

TO ARP (M)

TO L1 PHASE CENTER (M)
TO L2 PHASE CENTER (M)
TIMES 12.3316 YRS

MON TO ARP

ARP TO L1 PHASE CENTER

L1 PHS CEN @ 2009.3315

+ XYZ ADJUSTMENTS

NEW L1 PHS CEN @ 2009.3315
NEW ARP @ 2009.3315

NEW MON @ 2009.3315

NEW L1 PHS CEN @ 2009.3315
NEW ARP @ 2009.3315

NEW MON @ 2009.3315

Island, Alaska USA)

MON
VEL
MON
ARP
ARP
VEL

@ 1997.0000 (M)

(M/YR)

TO ARP (M)

TO L1 PHASE CENTER (M)
TO L2 PHASE CENTER (M)
TIMES 12.3316 YRS

MON TO ARP

ARP TO L1 PHASE CENTER

L1 PHS CEN @ 2009.3315

+ XYZ ADJUSTMENTS

NEW L1 PHS CEN @ 2009.3315
NEW ARP @ 2009.3315

NEW MON @ 2009.3315

NEW L1 PHS CEN @ 2009.3315
NEW ARP @ 2009.3315

NEW MON @ 2009.3315

Island, Alaska USA)

MON
VEL
MON
ARP
ARP
VEL

@ 1997.0000 (M)

(M/YR)

TO ARP (M)

TO L1 PHASE CENTER (M)
TO L2 PHASE CENTER (M)
TIMES 12.3316 YRS

MON TO ARP

ARP TO L1 PHASE CENTER

L1 PHS CEN @ 2009.3315

+ XYZ ADJUSTMENTS

NEW L1 PHS CEN @ 2009.3315
NEW ARP @ 2009.3315

NEW MON @ 2009.3315

NEW L1 PHS CEN @ 2009.3315
NEW ARP @ 2009.3315

NEW MON @ 2009.3315



REMOTE STATION INFORMATION

STATION NAME: 1066 1
MONUMENT : NO DOMES NUMBER
XYZ -2415360.3732 -2718045.6145 5222560.7825 MON @ 2009.3314 (M)

NEU -0.0016 -0.0007 1.5000 MON TO ARP (M)

NEU 0.0016 0.0007 0.0850 ARP TO L1 PHASE CENTER (M)
NEU 0.0008 0.0012 0.0701 ARP TO L2 PHASE CENTER (M)
XYZ -0.5681 -0.6383 1.2328 MON TO ARP

XYZ -0.0307 -0.0356 0.0708 ARP TO L1 PHASE CENTER
XYZ -2415360.9721 -2718046.2884  5222562.0861 L1 PHS CEN @ 2009.3315

BASELINE NAME: bis5 1066

XYZ 0.6505 0.5484 -1.2812 + XYZ ADJUSTMENTS

XYZ -2415360.3216 -2718045.7400 5222560.8049 NEW L1 PHS CEN @ 2009.3315
XYZ -2415360.2908 -2718045.7043 5222560.7341 NEW ARP @ 2009.3315

XYZ -2415359.7227 -2718045.0661 5222559.5013 NEW MON @ 2009.3315

LLH 55 19 58.67204 228 22 28.10288 5.3675 NEW L1 PHS CEN @ 2009.3315
LLH 55 19 58.67198 228 22 28.10284 5.2825 NEW ARP @ 2009.3315
LLH 55 19 58.67204 228 22 28.10288 3.7825 NEW MON @ 2009.3315

BASELINE NAME: lev6é 1066

XYZ 0.6466 0.4762 -1.3003 + XYZ ADJUSTMENTS

XYZ -2415360.3255 -2718045.8122  5222560.7858 NEW L1 PHS CEN @ 2009.3315
XYZ -2415360.2948 -2718045.7766  5222560.7150 NEW ARP @ 2009.3315

XYZ -2415359.7266 -2718045.1383  5222559.4822 NEW MON @ 2009.3315

LLH 55 19 58.67018 228 22 28.10544 5.3840 NEW L1 PHS CEN @ 2009.3315
LLH 55 19 58.67013 228 22 28.10540 5.2990 NEW ARP @ 2009.3315
LLH 55 19 58.67018 228 22 28.10544 3.7990 NEW MON @ 2009.3315

BASELINE NAME: ais5 1066

XYZ 0.6477 0.5316 -1.2860 + XYZ ADJUSTMENTS

XYZ -2415360.3244 -2718045.7568  5222560.8001 NEW L1 PHS CEN @ 2009.3315
XYZ -2415360.2937 -2718045.7212  5222560.7293 NEW ARP @ 2009.3315

XYZ -2415359.7255 -2718045.0829  5222559.4965 NEW MON @ 2009.3315

LLH 55 19 58.67156 228 22 28.10340 5.3718 NEW L1 PHS CEN @ 2009.3315
LLH 55 19 58.67151 228 22 28.10336 5.2868 NEW ARP @ 2009.3315
LLH 55 19 58.67156 228 22 28.10340 3.7868 NEW MON @ 2009.3315
G-FILES
Axx2009 5 1 952
B2009 5 12315 9 5 2 123 1 page5 v0810.201GS 226 1 2 27NGS 2009 5 61FDDFX
lant_info.003 NGS 20090501

C00090001 -795615628 39 2696541203 52 945541582 57 X1219A1066X1219ABIS5
D 1 2 5936586 1 3 -9007484 2 3 -5245597

Axx2009 5 1 952
B2009 5 12315 9 5 2 123 1 page5 v0810.201GS 226 1 2 27NGS 2009 5 G6IFDDFX
lant_info.003 NGS 20090501

C00090002 25474467 53 1389708843 69 707227111 69 X1219A1066X1219ALEV6
D 1 2 7879129 1 3 -8769746 2 3 -5475035

Axx2009 5 1 952
B2009 5 12315 9 5 2 123 1 page5 v0810.20I1GS 226 1 2 27NGS 2009 5 61FDDFX
lant_info.003 NGS 20090501

CO0090003 -147943027 41 -191478825 47 -167428368 50 X1219A1066X1219AAI1S5
D 1 2 9402615 1 3 -8031189 2 3 -8318564



POST-FIT RMS BY SATELLITE VS. BASELINE

OVERALL 02 03 04 06 07 08 10
bis5-1066] 0.013 0.017 0.022 0.012 ... 0.011 0.018 0.015
16 20 23 24 25 31 32
bis5-1066] 0.013 0.011 0.010 ... 0.007 ... 0.026
OVERALL 02 03 04 06 07 08 10
lev6-1066] 0.012 0.016 0.021 0.012 ... 0.010 0.015 0.015
16 20 23 24 25 31 32
lev6-1066] 0.014 0.013 0.009 ... 0.007 ... 0.027
OVERALL 02 03 04 06 o7 08 10
ais5-1066] 0.012 0.018 0.019 0.015 ... 0.009 0.017 0.017
16 20 23 25 31 32

ais5-1066] 0.013 0.014 0.009 0.008

OBS BY SATELLITE VS. BASELINE

OVERALL 02 03 04 06 o7 08 10
bis5-1066] 1700 197 54 111 - 254 105 92
16 20 23 24 25 31 32
bis5-1066] 244 118 254 - 254 - 17
OVERALL 02 03 04 06 07 08 10
lev6-1066| 1702 197 35 111 .- 254 105 95
16 20 23 24 25 31 32
lev6-1066| 245 129 251 - 254 - 26
OVERALL 02 03 04 06 07 08 10
ais5-1066| 1556 70 67 98 - 254 104 77
16 20 23 25 31 32

ais5-1066| 245 133 254 254

Covariance Matrix for the xyz OPUS Position (meters2).

0.0000133578 0.0000013105 -0.0000015235
0.0000013105 0.0000214978 -0.0000013592
-0.0000015235 -0.0000013592 0.0000233556
Covariance Matrix for the enu OPUS Position (mneters2).
0.0000156481 -0.0000033255 0.0000020278
-0.0000033255 0.0000186598 0.0000012414
0.0000020278 0.0000012414 0.0000239032

0.01018 meters.
0.00959 meters.

Horizontal network accuracy
Vertical network accuracy



Derivation of NAD 83 vector components

Position of reference station ARP in NAD_83(CORS96) (EPOCH:2003.0000) .
Xa(m) Ya(m) Za(m)

BIS5 -2494920.44060 -2448392.05858 5317113.38841 2003.00

LEV6 -2412811.42529 -2579075.35282  5293281.97185 2003.00

AIS5 -2430153.20716 -2737194.06415 5205816.48535 2003.00

Position of reference station monument in NAD_83(CORS96) (EPOCH:2003.0000).
Xr(m) Yr(m) Zr(m)
BIS5 -2494920.44060 -2448392.05858 5317113.38841 2003.00
LEV6 -2412811.42529 -2579075.35282 5293281.97185 2003.00
AIS5 -2430153.20716 -2737194.06415 5205816.48535 2003.00

Velocity of reference station monument in NAD_83(CORS96) (EPOCH:2003.0000).

Vx (m/yr) Vy (m/yr) Vz (m/yr)
BIS5 0.00490 0.00450 0.00990
LEV6 0.00220 0.00120 0.00480
AIS5 0.00620 -0.00040 0.00060

Vectors from unknown station monument to reference station monument
in NAD_83(CORS96) (EPOCH: 2003 .0000) .

Xr-X= DX(m) Yr-Y= DY(m) Zr-Z= Dz(m)
BIS5 -79561.56460 269654 .14142 94554 .07641 2003.00
LEV6 2547 .45071 138970.84718 70722 .65985 2003.00
AIS5 -14794 33116 -19147.86415 -16742.82665 2003.00

This position and the above vector components were computed without any
knowledge by the National Geodetic Survey regarding the equipment or
field operating procedures used.



Divers Least Depth Gauge Report

Dive Completed: April 22,2009 (DN112)
Location: Lake Washington, Seattle, Washington
Latitude - 47/39/01.97N Longitude - 22/16/17.32W
Divers: ENS Glen Rice, ENS Mark Andrews, SST Adam Argento & LTjg Caryn Arnold
DLDG S/N: 68337
CTD S/N: 4616
Surface Pressure (mb): 1021
Surface Gauge Reading (psia): 14.78

Lead Line 1st DLDG 2nd DLDG | Average | Computed
(M) reading (psia) | reading (psia) | (psia) Depth (M)

1 16.04 16.23 16.14 1.03

2 17.57 17.64 17.61 2.06

3 19.02 19.08 19.05 3.07

4 20.43 20.48 20.46 4.07

5 21.86 21.90 21.88 5.06

6 23.25 - 23.25 6.02

Notes:
The dive was completed on DN112 and the cast used for this report was from DN107. (SVP file 09107175)

Report Prepared by: LTjg Arnold



PTC Electronics Incorporated

PO Box 72, Wyckoff, NJ 07481 Phone: (201) 847-0500  Fax: (201) 847-1394 « URL: www.PTCElectronics.com

DATE 04/02/2008

TRANSDUCER TYPE Digital Pressure Gage-D2000
SERIAL NUMBER 68337

PRESSURE RANGE/Acc'y  0-100psia 0.1% fs.
EXCITATION VOLTAGE NA

PRESSURE STANDARD usep DRUCK DPI 600

SPECIFIED ACCURACY 0.03%

CALIBRATION PERIOD Bi-annual

LAST CALIBRATED 06/01/06

READOUT Digital

DATA TAKEN BY John C. Kicks

CALIBRATION CONDITIONS:

BAROMETRIC PRESSURE 14.64 psia
AMBIENT TEMPERATURE 72°F
PRESSURE MEDIA Air

PRESSURE REFERENGE  OQUTPUT (UNITS) psia

el Increasing Decreasing
-1.00 13.64 13.47 13.47
0.00 14.64 14.48 14.47
1.00 15.64 15.48 15.48
2.00 16.64 16.48 16.48
3.00 17.64 17.48 17.48
4.00 18.64 18.48 18.49
5.00 19.64 19.48 19.48
6.00 20.64 20.48 20.49
7.00 21.64 21.48 21.48
12.00 26.64 26.49 26.49
17.00 31.64 31.48 31.48
2200  36.64 36.49 36.50
27.00 41.64 41.47 41.47
32.00 46.64 46.48

APPROVED by 1 = .~/

Alan F. Kicks, QA. Manager




NOAA Ship FAIRWEATHER
LASER RANGEFINDER Accuracy test

Testing date: 04/13/2009, 04/22/2009
Testing personnel: Mark Andrews, Matthew Andring, Annie Raymond, Patricia Raymond, Glen Rice

LR LR
Actual LR 001481 000676 Actual LR 001481 000676
Trial Distance Distance  Distance Height Height Height
1 10 10.1 10.1 2.0 2.1 2.0
2 10 10.0 10.0 2.0 2.0 2.0
3 10 10.0 10.0 2.0 2.0 2.0
4 20 20.1 20.2 2.0 21 21
5 20 20.1 20.1 2.0 2.0 2.0
6 20 20.1 20.1 2.0 21 21
7 50 50.0 50.1 2.0 2.0 1.8
8 50 50.1 50.1 2.0 21 1.9
9 50 50.1 50.0 2.0 1.8 1.9
10 100 100.1 100.2 2.0 2.0 21
11 100 100.0 100.1 2.0 2.0 2.0
12 100 100.2 100.1 2.0 1.8 1.7
Actual LR i0929 Actual LR i0929
Trial Distance Distance Height Height
1 10 9.94 1.0 1.10
2 10 9.93 1.0 0.98
3 10 9.95 1.0 1.06
4 20 19.91 1.0 1.07
5 20 19.90 1.0 1.11
6 20 19.88 1.0 0.96
7 50 49.92 1.0 0.94
8 50 49.90 1.0 0.93
9 50 49.88 1.0 1.04
10 100 99.90 1.0 1.19
11 100 99.89 1.0 1.06
12 100 99.89 1.0 1.08

LR = Laser Rangefinder
All distances are measured in meters.






Lead Line & Sounding Pole Calibration Report

Field unit;:

FA

Lead Line / Sounding Pole Identification Number:

Line 10-01-05 w/ lead 20-05

Date of Calibration: 4/20/09

Method of Calibration:
Other

X Steel tape

O Permanent graduation marks O

Location: Seattle, WA

Chief of Party: CDR Baird

Lead Line / Sounding Pole Unit of Measure: Meters (measured from bottom of lead to bottom of mark)

Measured by: AR/LS

Recorded by: AR

Checked by: AR

Graduated Marking

Calibration Measurement

Lead Line Corrector

@) (b) (c=b-a
1 0.992 -0.008
2 1.992 -0.008
3 2.992 -0.008
4 3.99 -0.01
5 4.987 -0.013
6 5.985 -0.015
7 6.984 -0.016
8 7.983 -0.017
9 8.982 -0.018
10 9.98 -0.02

Average Correction

-0.0133

Standard Deviation

0.004547282




Lead Line & Sounding Pole Calibration Report

Field unit: FA

Lead Line / Sounding Pole Identification Number: 10 5 09

Date of Calibration: 4/27/09

Method of Calibration:
Other

x Steel tape

0 Permanent graduation marks O

Location: Seattle, WA

Chief of Party: CDR Baird

Lead Line / Sounding Pole Unit of Measure: Meters (measured from bottom of lead to bottom of mark)

Measured by:DF/BN

Recorded by: DF

Checked by: DF

Graduated Marking

Calibration Measurement

Lead Line Corrector

(@) (b) (c=b-4a)
1 1 0

2 1.995 -0.005
3 2.99 -0.01
4 3.885 -0.115
5 4.882 -0.118
6 5.74 -0.26
7 6.967 -0.033
8 7.962 -0.038
9 8.955 -0.045
10 9.946 -0.054

Average Correction

-0.0678

Standard Deviation

0.079147963




Lead Line & Sounding Pole Calibration Report

Field unit:

FA

Lead Line / Sounding Pole Identification Number:
Line 10-02-05 w/ lead 10-02-04

Date of Calibration: 4/20/09

Method of Calibration:
Other

x Steel tape

O Permanent graduation marks O

Location: Seattle, WA

Chief of Party: CDR Baird

Lead Line / Sounding Pole Unit of Measure: Meters (measured from bottom of lead to bottom of mark)

Measured by: AR/LS

Recorded by: AR

Checked by: AR

Graduated Marking

Calibration Measurement

Lead Line Corrector

() (b) (c=b-a)

1 1 0

2 1.99 -0.01

3 2.89 -0.11

4 3.976 -0.024

5 4.97 -0.03

6 5.965 -0.035

7 6.955 -0.045

8 7.95 -0.05

9 8.945 -0.055

10 9.94 -0.06
Average Correction -0.0419
Standard Deviation 0.030722594




Lead Line & Sounding Pole Calibration Report

Field unit: FA

Lead Line / Sounding Pole Identification Number:
20 01 _05 (Lead 10_02_04)

Date of Calibration: 4/28/2009

Method of Calibration: x Steel tape 0 Permanent graduation marks O Other

Location: Seattle, WA

Chief of Party: CDR Baird

Lead Line / Sounding Pole Unit of Measure: Meters (measured from bottom of lead to bottom of mark)

Measured by: DF/BN Recorded by: DF Checked by:
Graduated Marking Calibration Measurement Lead Line Corrector
(a) (b) (c=b-a)
1 1.021 0.021
2 2.002 0.002
3 2.993 -0.007
4 3.988 -0.012
5 4.991 -0.009
6 5.998 -0.002
7 6.994 -0.006
8 7.995 -0.005
9 8.994 -0.006
10 9.991 -0.009
11 10.993 -0.007
12 11.992 -0.008
13 12.988 -0.012
14 13.986 -0.014
15 14.984 -0.016
16 15.983 -0.017
17 16.982 -0.018
18 17.986 -0.014
19 18.981 -0.019
20 19.986 -0.014
Average Correction -0.0086
Standard Deviation 0.008875751




Lead Line & Sounding Pole Calibration Report

Field unit: FA

Lead Line / Sounding Pole Identification Number: 20_02_05

Date of Calibration:04/28/2009

Method of Calibration: x Steel tape 0 Permanent graduation marks O
Other

Location: Seattle, WA

Chief of Party: CDR Baird

Lead Line / Sounding Pole Unit of Measure: Meters (measured from bottom of lead to bottom of mark)

Measured by: DF/BN/JL Recorded by: DF Checked by:
Graduated Marking Calibration Measurement Lead Line Corrector

(a) (b) (c=b-a)

1 1.004 0.004

2 1.998 -0.002

3 2.992 -0.008

4 3.988 -0.012

5 4.98 -0.02

6 5.974 -0.026

7 6.97 -0.03

8 7.967 -0.033

9 8.962 -0.038

10 9.955 -0.045

11 10.9887 -0.0113

12 11.989 -0.011

13 12.985 -0.015

14 13.985 -0.015

15 14.987 -0.013

16 15.985 -0.015

17 16.985 -0.015

18 17.987 -0.013

19 18.99 -0.01

20 19.99 -0.01

Average Correction -0.016915
Standard Deviation 0.011978809




Lead Line & Sounding Pole Calibration Report

Field unit: FA

Lead Line / Sounding Pole Identification Number:

30_01_03 (Lead 10_02_04)

Date of Calibration: 04/28/2009

Method of Calibration:
Other

x Steel tape

O Permanent graduation marks O

Location: Seattle, WA

Chief of Party: CDR Baird

Lead Line / Sounding Pole Unit of Measure: Meters (measured from bottom of lead to bottom of mark)

Measured by: DF/BN/MA Recorded by: DF Checked by:
Graduated Marking Calibration Measurement Lead Line Corrector
(@) (b) (c=b-a)
1 0.998 -0.002
2 1.975 -0.025
3 2.973 -0.027
4 3.996 -0.004
5 4.965 -0.035
6 5.961 -0.039
7 6.966 -0.034
8 7.959 -0.041
9 8.955 -0.045
10 9.952 -0.048
11 10.958 -0.042
12 11.953 -0.047
13 12.954 -0.046
14 13.949 -0.051
15 14.949 -0.051
16 15.95 -0.05
17 16.948 -0.052
18 17.951 -0.049
19 18.968 -0.032
20 19.974 -0.026
21 20.976 -0.024
22 21.953 -0.047
23 22.956 -0.044
24 23.965 -0.035
25 24.955 -0.045
26 25.953 -0.047
27 26.95 -0.05
28 27.956 -0.044
29 28.951 -0.049
30 29.957 -0.043
Average Correction -0.03
Standard Deviation 0.015937377




Residual, (Degrees C)

SEA-BIRD ELECTRONICS, INC.

Phone: (425) 643 - 9866 Fax (425) 643 - 9954 Email: seabird@seabird.com

SENSOR SERIAL NUMBER: 4585
CALIBRATION DATE: 24-Dec-08

ITS-90 COEFFICIENTS
1.152958e-003
2.769577e-004

-1.238595e-006
1.923712e-007

a0 =
al =
a2 =
a3

BATH TEMP

(ITS-90)

1.

4

18

24.
29.
.5000

32

0000

.5000
15.
.5000

0000

0000
0001

INSTRUMENT
OUTPUT(n)

686671.
613990.
430449.
380356.
311746.
259029.
226970.

MV = (n- 524288) / 1.6e+007
R =MV *2.900e+009 + 1.024e+008) / (2.048e+004 - MV * 2.0e+005)

Temperature ITS-90 = 1/{a0 + al[/n(R)] + a2[/n"(R)] + a3[ln (R)]} - 273.15 (°C)

898
153
356
864
237
610
136

Residual = instrument temperature - bath temperature

1808 136th Place N.E., Bellevue, Washington, 98005 USA

SBE19plus TEMPERATURE CALIBRATION DATA
ITS-90 TEMPERATURE SCALE

INST TEMP

(ITS-90)

1

32

.0001

4.
15.
18.
24.
29.
.5001

4999
0002
4999
0000
0000

RESIDUAL
(ITS-90)
0001
0001
0002
0001
0000
0001
0001

0.
-0.
0.
-0.
-0.
-0.
0.

0.02

0.01

0.00 A A —a A

-0.01

_0_02IIIIIIIIIIIIIIIIIIIIIIIIIIIIIIII
5 5 10 15 20 25 30 35

Temperature, Degrees C

>|®

Date, Delta T (mdeg C)

12-Dec-07 -0.41
24-Dec-08 0.00



Residual, (S/m)

SEA-BIRD ELECTRONICS, INC.

SENSOR SERIAL NUMBER: 4585
CALIBRATION DATE: 24-Dec-08

COEFFICIENTS:

g =

h
i =
J

BATH TEMP

-1.030096e+000
1.490529e-001
-1.755436e-004
3.495131e-005

(ITS-90)

22.
1.

4

15.

18
24

29.
32.

0000
0000
.5000
0000
.5000
.0000
0001
5000

(PSU)

0.
34.
34.
34.
34.
34.
34.
34.

0000
9056
8856
8424
8329
8221
8149
8105

f = INST FREQ / 1000.0
Conductivity = (g + hf +if > +jf ") / (1 + 8t + ep) Siemens/meter

t = temperature[°C)]; p = pressure[decibars]; = CTcor; € = CPcor;

O U U D W IN

BATH SAL BATH COND
(Siemens/m)

0.
.98287
.29062
.27448
.62033
.17939
.70213
.07509

00000

1808 136th Place N.E., Bellevue, Washington, 98005 USA
Phone: (425) 643 - 9866 Fax (425) 643 - 9954 Email: seabird@seabird.com

SBE19plus CONDUCTIVITY CALIBRATION DATA
PSS 1978: C(35,15,0) = 4.2914 Siemens/meter

CPcor
CTcor

INST FREO
(Hz)

2630.

5188

5382.
5961.
6152.
6447.
6711.
6894.

Residual = instrument conductivity - bath conductivity

81
.24
83
81
16
70
97
15

= -9.5700e-008

= 3.2500e-006

INST COND RESIDUAL

(Siemens/m) (Siemens/m)
0.0000 0.00000
2.9829 0.00001
3.2906 -0.00001
4.2745 -0.00002
4.6203 0.00000
5.1794 0.00002
5.7021 0.00001
6.0751 -0.00001

Date, Slope Correction

12-Dec-07 0.9999008
24-Dec-08 1.0000000

> ®

0.002
0.001
/0/./.
0.000 //’Ei?;:_;.;._‘_
-0.001
-0.002- L L1 I I A
0 2 3 4 5 6

Conductivity (Siemens/m)



Residual, (% FSR)

SEA-BIRD ELECTRONICS, INC.

1808 136th Place N.E., Bellevue, Washington, 98005 USA
Phone: (425) 643 - 9866 Fax (425) 643 - 9954 Email: seabird@seabird.com

SENSOR SERIAL NUMBER: 4585 SBE19plus PRESSURE CALIBRATION DATA
CALIBRATION DATE: 29-Dec-08 5076 psia S/N 5433
COEFFICIENTS:
PAO = 5.029148e-001 PTCAO = 5.087931e+005
PAl = 1.546002e-002 PTCAl = -1.387413e+000
PA2 = -6.698233e-010 PTCA2 = 1.147553e-001
PTEMPAO = -6.561551e+001 PTCBO = 2.398063e+001
PTEMPAl = 5.126876e+001 PTCB1 = -2.075000e-003
PTEMPA2 = -2.271790e-001 PTCB2 = 0.000000e+000
PRESSURE SPAN CALIBRATION THERMAL CORRECTION
PRESSURE INST THERMISTOR COMPUTED ERROR TEMP THERMISTOR  INST
PSIA  OUTPUT OUTPUT PRESSURE  %FSR ITS90 OUTPUT OUTPUT
14.43 509698.5 1.6 14.38 -0.00 32.50 1.93 509770.31
1026.03 575213.9 1.6 1025.77 -0.01 29.00 1.86 509746.37
2037.81 641125.8 1.6 2037.49 -0.01 24.00 1.76 509720.20
3049.21 707405.4 1.6 3049.00 -0.00 18.50 1.65 509705.55
4061.89 774171.3 1.6 4061.98 0.00 15.00 1.58 509700.64
5073.45 841224.4 1.6 5073.30 -0.00 4.50 1.38 509686 .80
4060.64 774087.2 1.6 4060.79 0.00 1.00 1.31 509690.08
3049.89 707478.4 1.6 3050.21 0.01
2037.97 641159.4 1.6 2038.09 0.00 TEMP (ITS90) SPAN (mV)
1026.00 575237.5 1.6 1026.17 0.00 -5.00 23.99
14.44 509714.6 1.6 14.59 0.00 35.00 23.91

y = thermistor output; t = PTEMPAO + PTEMPA1 * y + PTEMPA2 * y2
x = pressure output - PTCAO - PTCA1 * t - PTCA2 * ¢

n=x * PTCBO/(PTCBO + PTCB1 * t + PTCB2 * t2)

pressure (psia) = PAO + PAIl * n+ PA2 * n’

Date, Avg Delta P %FS
0.50

(@] 29-Dec-08  0.00

0.25

-0.25

_0_50\\\\\\\\\\\\\\\\\\\\\\\\\\\\\\\\\\\\\\\\\\\\

0 500 1000 1500 2000 2500 3000 3500 4000 4500 5000 5500
Pressure (PSIA)




SB SEA-BIRD ELECTRONICS, INC.

1808 - 136th Place Northeast, Bellevue, Washington 98005 USA
RRRRRELELC) Phone: (425) 643-9866 Fax: (425) 643-9954 www.seabird.com

Conductivity Calibration Report

|Customer:  |[Pacific Marine Center / NOAA |
[Job Number: || 53036 | [Date of Report: || 12/29/2008 |
[Model Number || SBE 19Plus | [Serial Number: || 19P36026-4585 |

Conductivity sensors are normally calibrated 'as received', without cleaning or adjustments, allowing a determination of
sensor drift. If the calibration identifies a problem or indicates cell cleaning is necessary, then a second calibration is
performed after work is completed. The 'as received' calibration is not performed if the sensor is damaged or non-
functional, or by customer request.

An 'as received' calibration certificate is provided, listing the coefficients used to convert sensor frequency to conductivity.
Users must choose whether the 'as received' calibration or the previous calibration better represents the sensor condition
during deployment. In SEASOFT enter the chosen coefficients using the program SEACON. The coefficient 'slope’
allows small corrections for drift between calibrations (consult the SEASOFT manual). Calibration coefficients obtained
after a repair or cleaning apply only to subsequent data.

'AS RECEIVED CALIBRATION' Performed [ ] Not Performed
Date: |12/24/2008 Drift since last cal: |  -0.00020 | PSU/month*
Comments:

'CALIBRATION AFTER CLEANING & REPLATINIZING' ] Performed Not Performed
Date: :l Drift since Last cal: | | PSU/month*

Comments:

*Measured at 3.0 S/m

Cell cleaning and electrode replatinizing tend to 'reset’ the conductivity sensor to its original condition. Lack of drift in
post-cleaning-calibration indicates geometric stability of the cell and electrical stability of the sensor circuit.



SB SEA-BIRD ELECTRONICS, INC.

1808 - 136th Place Northeast, Bellevue, Washington 98005 USA
RRARRRELEL) Phone: (425) 643-9866 Fax: (425) 643-9954 www.seabird.com

Temperature Calibration Report

|Customer: |[Pacific Marine Center / NOAA |
[Job Number: || 53036 | [Date of Report: | 12/29/2008 |
[Model Number || SBE 19Plus | [Serial Number: || 19P36026-4585 |

Temperature sensors are normally calibrated 'as received', without adjustments, allowing a determination sensor drift. If
the calibration identifies a problem, then a second calibration is performed after work is completed. The 'as received’
calibration is not performed if the sensor is damaged or non-functional, or by customer request.

An 'as received' calibration certificate is provided, listing coefficients to convert sensor frequency to temperature. Users
must choose whether the 'as received' calibration or the previous calibration better represents the sensor condition
during deployment. In SEASOFT enter the chosen coefficients using the program SEACON. The coefficient 'offset’
allows a small correction for drift between calibrations (consult the SEASOFT manual). Calibration coefficients
obtained after a repair apply only to subsequent data.

'AS RECEIVED CALIBRATION' Performed L] Not Performed
Date: |12/24/2008 Drift since last cal: +0.00040 Degrees Celsius/year
Comments:

'CALIBRATION AFTER REPAIR' ] Performed Not Performed

Date: |:| Drift since Last cal: |:| Degrees Celsius/year

Comments:



Residual, (Degrees C)

SEA-BIRD ELECTRONICS, INC.

1808 136th Place N.E., Bellevue, Washington, 98005 USA

Phone: (425) 643 - 9866 Fax (425) 643 - 9954 Email: seabird@seabird.com

SENSOR SERIAL NUMBER: 4616
CALIBRATION DATE: 30-Dec-08

ITS-90 COEFFICIENTS
1.281404e-003
2.533926e-004
1.063479e-006
1.058343e-007

a0 =
al =
a2 =
a3 =

BATH TEMP

(ITS-90)

1.

4
15
18

24.
29.
.5001

32

0000

.5000
.0000
.5000

0000
0000

INSTRUMENT
OUTPUT(n)

622339.
552555.
379373.
332879.
269786.
221773.
192769.

MV = (n- 524288) / 1.6e+007
R =MV *2.900e+009 + 1.024e+008) / (2.048e+004 - MV * 2.0e+005)

Temperature ITS-90 = 1/{a0 + al[/n(R)] + a2[ln (R)] + a3[ln (R)]} - 273.15 (°C)

390
458
339
949
136
322
169

SBE19plus TEMPERATURE CALIBRATION DATA
ITS-90 TEMPERATURE SCALE

Residual = instrument temperature - bath temperature

INST TEMP
(ITS-90)

1

18

24.
28.
.5004

32

.0001
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4998
9999
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0000
9995
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Date, Delta T (mdeg C)

13-Dec-07 -0.80

30-Dec-08 0.00

>|®




Residual, (S/m)

SEA-BIRD ELECTRONICS, INC.

1808 136th Place N.E., Bellevue, Washington, 98005 USA
Phone: (425) 643 - 9866 Fax (425) 643 - 9954 Email: seabird@seabird.com

SENSOR SERIAL NUMBER: 4616

CALIBRATION DATE: 30-Dec-08

COEFFICIENTS:

SBE19plus CONDUCTIVITY CALIBRATION DATA
PSS 1978: C(35,15,0) = 4.2914 Siemens/meter

g = —-1.045676e+000 CPcor = -9.5700e-008
h = 1.453624e-001 CTcor = 3.2500e-006
i = -2.792262e-004
j = 4.047864e-005
BATHTEMP BATHSAL BATHCOND INSTFREO INST COND RESIDUAL
(ITS-90) (PSU) (Siemens/m) (Hz) (Siemens/m) (Siemens/m)
22.0000 0.0000 0.00000 2686.32 0.0000 0.00000
1.0000 34.6635 2.96415 5258.47 2.9642 0.00001
4.5000 34.6435 3.27002 5454.79 3.2700 -0.00001
15.0000 34.6004 4.24792 6039.09 4.2479 -0.00000
18.5000 34.5912 4.59172 6231.25 4.5917 -0.00001
24.0000 34.5806 5.14743 6529.62 5.1474 0.00001
29.0000 34.5733 5.66698 6796.43 5.6670 0.00001
32.5001 34.5689 6.03772 6980.38 6.0377 -0.00001
f = INST FREQ / 1000.0
Conductivity = (g + hf +if > +jf ") / (1 + 8t + ep) Siemens/meter
t = temperature[°C)]; p = pressure[decibars]; = CTcor; € = CPcor;
Residual = instrument conductivity - bath conductivity
Date, Slope Correction
0.002 ® | 13-Dec-07 0.9999446
A | 30-Dec-08 1.0000000
0.001
’././‘.
I o0& |
0.000 m— i N DU N
-0.001
-0.002 L 111 | | L1 1 | | L 111 L |1 [ 111
0 1 2 3 4 5 6 7

Conductivity (Siemens/m)



SEA-BIRD ELECTRONICS, INC.

1808 136th Place N.E., Bellevue, Washington, 98005 USA
Phone: (425) 643 - 9866 Fax (425) 643 - 9954 Email: seabird@seabird.com

SENSOR SERIAL NUMBER: 4616 SBE19plus PRESSURE CALIBRATION DATA

Residual, (% FSR)

CALIBRATION DATE: 23-Dec-08 1450 psia S/N 5512
COEFFICIENTS:
PAO = 8.151393e-001 PTCAO = 5.204151e+005
PAl = 4.427036e-003 PTCAl = 1.499910e+001
PA2 = -1.489407e-011 PTCA2 = -2.797969%9e-001
PTEMPAO = -7.628063e+001 PTCBO = 2.473825e+001
PTEMPAl = 4.917975e+001 PTCB1 = 5.000000e-005
PTEMPA2 = -2.452670e-001 PTCB2 = 0.000000e+000
PRESSURE SPAN CALIBRATION THERMAL CORRECTION
PRESSURE INST THERMISTOR COMPUTED ERROR TEMP THERMISTOR  INST
PSIA OUTPUT OUTPUT PRESSURE  %FSR ITS90 OUTPUT  OUTPUT
14.56 523716.6 2.0 14.62 0.00 32.50 2.24 523831.27
300.91 588379.6 2.0 300.80 -0.01 29.00 2.16 523832.41
587.28 653125.0 2.0 587.23 -0.00 24.00 2.06 523825.60
873.71 717921.0 2.0 873.75 0.00 18.50 1.95 523815.10
1160.12 782709.1 2.0 1160.11 -0.00 15.00 1.87 523797.80
1446.59 847531.7 2.0 1446.51 -0.01 4.50 1.66 523711.29
1160.83 782900.4 2.0 1160.96 0.01 1.00 1.58 523637.33
587.26 653145.1 2.0 587.32 0.00
300.86 588375.3 2.0 300.78 -0.01 TEMP (ITS90) SPAN (mV)
14.56 523715.6 2.0 14.61 0.00 -5.00 24.74
35.00 24.74
y = thermistor output; t = PTEMPAO + PTEMPA1 * y + PTEMPA2 * y2
x = pressure output - PTCAO - PTCA1 * t - PTCA2 * ¢
n=x * PTCBO/(PTCBO + PTCB1 * t + PTCB2 * t2)
pressure (psia) = PAO + PAIl * n+ PA2 * n’
Date, Avg Delta P %FS
0.50 [ @] 23-Dec-08 -0.00
0.25
0.00-10— —— —o
-0.25
0504—L—L 1 1 | I || [ Y T Y T O
0 250 500 750 1000 1250 1500

Pressure (PSIA)




SB SEA-BIRD ELECTRONICS, INC.

1808 - 136th Place Northeast, Bellevue, Washington 98005 USA
RRARRRELEL) Phone: (425) 643-9866 Fax: (425) 643-9954 www.seabird.com

Temperature Calibration Report

|Customer: |[Pacific Marine Center / NOAA |
[Job Number: || 53036 | [Date of Report: | 12/30/2008 |
[Model Number || SBE 19Plus | [Serial Number: || 19P36026-4616 |

Temperature sensors are normally calibrated 'as received', without adjustments, allowing a determination sensor drift. If
the calibration identifies a problem, then a second calibration is performed after work is completed. The 'as received’
calibration is not performed if the sensor is damaged or non-functional, or by customer request.

An 'as received' calibration certificate is provided, listing coefficients to convert sensor frequency to temperature. Users
must choose whether the 'as received' calibration or the previous calibration better represents the sensor condition
during deployment. In SEASOFT enter the chosen coefficients using the program SEACON. The coefficient 'offset’
allows a small correction for drift between calibrations (consult the SEASOFT manual). Calibration coefficients
obtained after a repair apply only to subsequent data.

'AS RECEIVED CALIBRATION' Performed [ ] Not Performed
Date: |12/30/2008 Drift since last cal: +0.00077 Degrees Celsius/year
Comments:

'CALIBRATION AFTER REPAIR' [ Performed Not Performed

Date: |:| Drift since Last cal: |:| Degrees Celsius/year

Comments:



SB SEA-BIRD ELECTRONICS, INC.

1808 - 136th Place Northeast, Bellevue, Washington 98005 USA
RRRRRELELC) Phone: (425) 643-9866 Fax: (425) 643-9954 www.seabird.com

Conductivity Calibration Report

|Customer:  |[Pacific Marine Center / NOAA |
[Job Number: || 53036 | [Date of Report: || 12/30/2008 |
[Model Number || SBE 19Plus | [Serial Number: || 19P36026-4616 |

Conductivity sensors are normally calibrated 'as received', without cleaning or adjustments, allowing a determination of
sensor drift. If the calibration identifies a problem or indicates cell cleaning is necessary, then a second calibration is
performed after work is completed. The 'as received' calibration is not performed if the sensor is damaged or non-
functional, or by customer request.

An 'as received' calibration certificate is provided, listing the coefficients used to convert sensor frequency to conductivity.
Users must choose whether the 'as received' calibration or the previous calibration better represents the sensor condition
during deployment. In SEASOFT enter the chosen coefficients using the program SEACON. The coefficient 'slope’
allows small corrections for drift between calibrations (consult the SEASOFT manual). Calibration coefficients obtained
after a repair or cleaning apply only to subsequent data.

'AS RECEIVED CALIBRATION' Performed [ ] Not Performed
Date: 12/30/2008 Drift since last cal: |  +0.00010 | PSU/month*
Comments:

'CALIBRATION AFTER CLEANING & REPLATINIZING' ] Performed Not Performed
Date: :l Drift since Last cal: | | PSU/month*

Comments:

*Measured at 3.0 S/m

Cell cleaning and electrode replatinizing tend to 'reset’ the conductivity sensor to its original condition. Lack of drift in
post-cleaning-calibration indicates geometric stability of the cell and electrical stability of the sensor circuit.



Residual, (Degrees C)

SEA-BIRD ELECTRONICS, INC.

Phone: (425) 643 - 9866 Fax (425) 643 - 9954 Email: seabird@seabird.com

SENSOR SERIAL NUMBER: 4617
CALIBRATION DATE: 20-Dec-08

ITS-90 COEFFICIENTS
1.246846e-003
2.697109e-004

-7.052860e-007
1.823959e-007

a0
al
az2
a3

BATH TEMP

(ITS-90)

1.
.5000
.0000
.5000

4
15
18

24.
29.
.5000

32

0000

0000
0000

INSTRUMENT
OUTPUT(n)

585630.
518793.
354138.
310211.
250739.
205606.
178394.

MV = (n- 524288) / 1.6e+007
R =MV *2.900e+009 + 1.024e+008) / (2.048e+004 - MV * 2.0e+005)

Temperature ITS-90 = 1/{a0 + al[/n(R)] + a2[ln (R)] + a3[ln (R)]} - 273.15 (°C)

424
136
373
898
695
492
119

Residual = instrument temperature - bath temperature

1808 136th Place N.E., Bellevue, Washington, 98005 USA

SBE19plus TEMPERATURE CALIBRATION DATA
ITS-90 TEMPERATURE SCALE

INST TEMP
(ITS-90)

0.
.5001
15.
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24.
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.5000
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32

9999
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Date, Delta T (mdeg C)

13-Dec-07 -0.90
20-Dec-08 -0.00



Residual, (S/m)

SEA-BIRD ELECTRONICS, INC.

SENSOR SERIAL NUMBER: 4617

CALIBRATION DATE: 20-Dec-08

COEFFICIENTS:
-1.000141e+000

g

h
i
]

BATH TEMP

1.279500e-001

-2.981125e-004

3.615456e-005

(ITS-90)

22.
1.

4

18
24

32

0000
0000

.5000
15.
.5000
.0000
29.
.5000

0000

0000

(PSU)

0.
34.
34.
34.
34.
34.
34.
34.

0000
8741
8541
8109
8011
7896
7810
7748

f = INST FREQ / 1000.0
Conductivity = (g + hf +if > +jf ") / (1 + 8t + ep) Siemens/meter

t = temperature[°C)]; p = pressure[decibars]; = CTcor; € = CPcor

O U U D W IN

BATH SAL BATH COND
(Siemens/m)
0.
.98043
.28794
.27102
.61657
.17509
.69719
.06957

00000

1808 136th Place N.E., Bellevue, Washington, 98005 USA
Phone: (425) 643 - 9866 Fax (425) 643 - 9954 Email: seabird@seabird.com

SBE19plus CONDUCTIVITY CALIBRATION DATA
PSS 1978: C(35,15,0) = 4.2914 Siemens/meter

CPcor
CTcor

INST FREO
(Hz)

2801.
5589.
5800.

6429

6635.
6956.

7242

7439.

Residual = instrument conductivity - bath conductivity

87
41
77
.24
72
19
.59
93

= -9.5700e-008

= 3.2500e-006

INST COND RESIDUAL

(Siemens/m) (Siemens/m)
0.0000 0.00000
2.9804 -0.00000
3.2879 0.00000
4.2710 0.00000
4.6166 0.00000
5.1751 -0.00000
5.6972 -0.00001
6.0696 0.00001

Date, Slope Correction

13-Dec-07 0.9999005
20-Dec-08 1.0000000

> ®

0.002
0.001
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Conductivity (Siemens/m)



SEA-BIRD ELECTRONICS, INC.

1808 136th Place N.E., Bellevue, Washington, 98005 USA
Phone: (425) 643 - 9866 Fax (425) 643 - 9954 Email: seabird@seabird.com

SENSOR SERIAL NUMBER: 4617 SBE19plus PRESSURE CALIBRATION DATA

Residual, (% FSR)

CALIBRATION DATE: 23-Dec-08 1450 psia S/N 5513
COEFFICIENTS:
PAQ = -6.055955e-001 PTCAO = 5.192474e+005
PAl = 4.445261e-003 PTCAl = -1.257329e+001
PA2 = -1.492962e-011 PTCA2 = 2.871586e-001
PTEMPAO = -7.890859e+001 PTCBO = 2.460838e+001
PTEMPAL = 4.909915e+001 PTCBl = 6.750000e-004
PTEMPA2 = -3.861224e-001 PTCB2 = 0.000000e+000
PRESSURE SPAN CALIBRATION THERMAL CORRECTION
PRESSURE INST THERMISTOR COMPUTED ERROR TEMP THERMISTOR  INST
PSIA OUTPUT OUTPUT PRESSURE  %FSR ITS90 OUTPUT  OUTPUT
14.56 522528.9 2.0 14.57 0.00 32.50 2.31 522669.88
300.91 586983.0 2.0 300.87 -0.00 29.00 2.24 522666.19
587.28 651477.4 2.0 587.23 -0.00 24.00 2.13 522662.57
873.71 716034.6 2.0 873.74 0.00 18.50 2.02 522651.21
1160.12 780599.0 2.0 1160.16 0.00 15.00 1.94 522650.29
1446.59 845193.3 2.0 1446.58 -0.00 4.50 1.72 522724.31
1160.83 780743.0 2.0 1160.80 -0.00 1.00 1.65 522781.82
587.26 651494.2 2.0 587.30 0.00
300.86 586980.7 2.0 300.86 0.00 TEMP (ITS90) SPAN (mV)
14.56 522528.9 2.0 14.57 0.00 -5.00 24.61
35.00 24.63
y = thermistor output; t = PTEMPAO + PTEMPA1 * y + PTEMPA2 * y2
x = pressure output - PTCAO - PTCA1 * t - PTCA2 * ¢
n=x * PTCBO/(PTCBO + PTCB1 * t + PTCB2 * t2)
pressure (psia) = PAO + PAIl * n+ PA2 * n’
Date, Avg Delta P %FS
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SB SEA-BIRD ELECTRONICS, INC.

1808 - 136th Place Northeast, Bellevue, Washington 98005 USA
RRARRRELEL) Phone: (425) 643-9866 Fax: (425) 643-9954 www.seabird.com

Temperature Calibration Report

|Customer: |[Pacific Marine Center / NOAA |
[Job Number: || 53036 | [Date of Report: | 12/22/2008 |
[Model Number || SBE 19Plus | [Serial Number: || 19P36026-4617 |

Temperature sensors are normally calibrated 'as received', without adjustments, allowing a determination sensor drift. If
the calibration identifies a problem, then a second calibration is performed after work is completed. The 'as received’
calibration is not performed if the sensor is damaged or non-functional, or by customer request.

An 'as received' calibration certificate is provided, listing coefficients to convert sensor frequency to temperature. Users
must choose whether the 'as received' calibration or the previous calibration better represents the sensor condition
during deployment. In SEASOFT enter the chosen coefficients using the program SEACON. The coefficient 'offset’
allows a small correction for drift between calibrations (consult the SEASOFT manual). Calibration coefficients
obtained after a repair apply only to subsequent data.

'AS RECEIVED CALIBRATION' Performed [ ] Not Performed
Date: |12/20/2008 Drift since last cal: +0.00088 Degrees Celsius/year
Comments:

'CALIBRATION AFTER REPAIR' [ Performed Not Performed

Date: |:| Drift since Last cal: |:| Degrees Celsius/year

Comments:



SB SEA-BIRD ELECTRONICS, INC.

1808 - 136th Place Northeast, Bellevue, Washington 98005 USA
RRRRRELELC) Phone: (425) 643-9866 Fax: (425) 643-9954 www.seabird.com

Conductivity Calibration Report

|Customer:  |[Pacific Marine Center / NOAA |
[Job Number: || 53036 | [Date of Report: || 12/22/2008 |
[Model Number || SBE 19Plus | [Serial Number: || 19P36026-4617 |

Conductivity sensors are normally calibrated 'as received', without cleaning or adjustments, allowing a determination of
sensor drift. If the calibration identifies a problem or indicates cell cleaning is necessary, then a second calibration is
performed after work is completed. The 'as received' calibration is not performed if the sensor is damaged or non-
functional, or by customer request.

An 'as received' calibration certificate is provided, listing the coefficients used to convert sensor frequency to conductivity.
Users must choose whether the 'as received' calibration or the previous calibration better represents the sensor condition
during deployment. In SEASOFT enter the chosen coefficients using the program SEACON. The coefficient 'slope’
allows small corrections for drift between calibrations (consult the SEASOFT manual). Calibration coefficients obtained
after a repair or cleaning apply only to subsequent data.

'AS RECEIVED CALIBRATION' Performed [ ] Not Performed
Date: 12/20/2008 Drift since last cal: |  -0.00020 | PSU/month*
Comments:

'CALIBRATION AFTER CLEANING & REPLATINIZING' ] Performed Not Performed
Date: :l Drift since Last cal: | | PSU/month*

Comments:

*Measured at 3.0 S/m

Cell cleaning and electrode replatinizing tend to 'reset’ the conductivity sensor to its original condition. Lack of drift in
post-cleaning-calibration indicates geometric stability of the cell and electrical stability of the sensor circuit.



SEA-BIRD ELECTRONICS, INC.

1808 136th Place N.E., Bellevue, Washington, 98005 USA
Phone: (425) 643 - 9866 Fax (425) 643 - 9954 Email: seabird@seabird.com

SENSOR SERIAL NUMBER: 6121
CALIBRATION DATE: 28-Aug-08

ITS-90 COEFFICIENTS

a0 = 1.289081e-003

al = 2.567873e-004

a2 = 1.103918e-007

a3 = 1.347008e-007

BATH TEMP INSTRUMENT
(ITS-90) OUTPUT(n)
1.0000 648503.186
4.5000 575581.220
15.0000 394150.390
18.5000 345412.610
24.0000 279302.814
29.0001 229064.831
32.5000 198774.661

MV = (n- 524288) / 1.6e+007
R =MV *2.900e+009 + 1.024e+008) / (2.048e+004 - MV * 2.0e+005)

Temperature ITS-90 = 1/{a0 + al[/n(R)] + a2[ln (R)] + a3[ln (R)]} - 273.15 (°C)

Residual = instrument temperature - bath temperature

0.02

0.01

o
o
)

Residual, (Degrees C)
o
S

-0.02

SBE19plus TEMPERATURE CALIBRATION DATA
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Residual, (S/m)

SEA-BIRD ELECTRONICS, INC.

1808 136th Place N.E., Bellevue, Washington, 98005 USA
Phone: (425) 643 - 9866 Fax (425) 643 - 9954 Email: seabird@seabird.com

SENSOR SERIAL NUMBER: 6121 SBE19plus CONDUCTIVITY CALIBRATION DATA
CALIBRATION DATE: 28-Aug-08 PSS 1978: C(35,15,0) = 4.2914 Siemens/meter
COEFFICIENTS:
g = -1.002097e+000 CPcor = -9.5700e-008
h = 1.438184e-001 CTcor = 3.2500e-006
i = -5.214257e-004
j = 5.901932e-005
BATHTEMP BATHSAL BATHCOND INSTFREO INST COND RESIDUAL
(ITS-90) (PSU) (Siemens/m) (Hz) (Siemens/m) (Siemens/m)
22.0000 0.0000 0.00000 2648.58 0.0000 0.00000
1.0000 34.8850 2.98128 5283.22 2.9813 0.00003
4.5000 34.8648 3.28885 5482.95 3.2888 -0.00002
15.0000 34.8213 4.27216 6076.87 4.2721 -0.00002
18.5000 34.8119 4.61785 6272.01 4.6178 -0.00000
24.0000 34.8011 5.17661 6574.84 5.1766 0.00002
29.0001 34.7946 5.69917 6845.52 5.6992 0.00002
32.5000 34.7904 6.07198 7032.01 6.0720 -0.00002
f = INST FREQ / 1000.0
Conductivity = (g + hf +if > +jf ") / (1 + 8t + ep) Siemens/meter
t = temperature[°C)]; p = pressure[decibars]; = CTcor; € = CPcor;
Residual = instrument conductivity - bath conductivity
Date, Slope Correction
0.002 [ @ ] 28-Aug-08 1.0000000
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PRESSURE SPAN CALIBRATION THERMAL CORRECTION
PRESSURE INST THERMISTOR COMPUTED ERROR TEMP THERMISTOR  INST
PSIA OUTPUT OUTPUT PRESSURE  %FSR ITS90 OUTPUT  OUTPUT
14.68 530344.0 1.5 14.69 0.00 32.50 1.75 530426.41
179.95 592865.0 1.5 179.94 -0.00 29.00 1.68 530439.09
359.94 660894.0 1.5 359.90 -0.00 24.00 1.59 530454.71
539.94 728875.0 1.5 539.90 -0.00 18.50 1.48 530483.73
719.93 796800.0 1.5 719.91 -0.00 15.00 1.42 530518.13
874.90 855228.0 1.5 874.89 -0.00 4.50 1.22 530644.39
719.95 796828.0 1.5 719.99 0.00 1.00 1.15 530705.47
539.97 728912.0 1.5 540.00 0.00
359.97 660927.0 1.5 359.99 0.00 TEMP (ITS90) SPAN (mV)
179.96 592874.0 1.5 179.97 0.00 -5.00 25.12
14.69 530337.0 1.5 14.68 -0.00 35.00 25.08
y = thermistor output; t = PTEMPAO + PTEMPA1 * y + PTEMPA2 * y2
x = pressure output - PTCAO - PTCA1 * t - PTCA2 * ¢
n=x * PTCBO/(PTCBO + PTCB1 * t + PTCB2 * t2)
pressure (psia) = PAO + PAIl * n+ PA2 * n’
0.50 [ @ | 26-Aug-08
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SEA-BIRD ELECTRONICS, INC.

1808 136th Place N.E., Bellevue, Washington, 98005 USA
Phone: (425) 643 - 9866 Fax (425) 643 - 9954 Email: seabird@seabird.com

SENSOR SERIAL NUMBER: 6121
CALIBRATION DATE: 26-Aug-08

COEFFICIENTS:
-6.478769%9e-001
2.639452e-003
1.757831e-011

PAQ =
PAl =
PA2 =
PTEMPA
PTEMPA
PTEMPA

0
1
2

-6.128910e+001

= 5.471751e+001

-5.689142e-001

SBE19plus PRESSURE CALIBRATION DATA

870 psia S/N 2752079

PTCAO0 = 5.247839e+005
PTCAl = -1.748425e+001
PTCA2 = 2.632259e-001
PTCBO = 2.511463e+001
PTCB1 = -1.075000e-003
PTCB2 = 0.000000e+000

Date, Avg Delta P %FS

Pressure (PSIA)
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SEA-BIRD ELECTRONICS, INC.

1808 136th Place N.E., Bellevue, Washington, 98005 USA
Phone: (425) 643 - 9866 Fax (425) 643 - 9954 Email: seabird@seabird.com

SENSOR SERIAL NUMBER: 6122
CALIBRATION DATE: 28-Aug-08

ITS-90 COEFFICIENTS

a0 = 1.310924e-003

al = 2.514962e-004

a2 = 7.231185e-007

a3 = 1.086082e-007

BATH TEMP INSTRUMENT
(ITS-90) OUTPUT(n)
1.0000 640421.220
4.5000 567849.949
15.0000 387722.085
18.5000 339446.305
24.0000 274051.763
29.0001 224421.051
32.5000 194523.508

MV = (n- 524288) / 1.6e+007
R =MV *2.900e+009 + 1.024e+008) / (2.048e+004 - MV * 2.0e+005)

Temperature ITS-90 = 1/{a0 + al[/n(R)] + a2[ln (R)] + a3[ln (R)]} - 273.15 (°C)

Residual = instrument temperature - bath temperature
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SBE19plus TEMPERATURE CALIBRATION DATA
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130

Residual, (S/m)

SEA-BIRD ELECTRONICS, INC.

1808 136th Place N.E., Bellevue, Washington, 98005 USA
Phone: (425) 643 - 9866 Fax (425) 643 - 9954 Email: seabird@seabird.com

SENSOR SERIAL NUMBER: 6122
CALIBRATION DATE: 28-Aug-08

COEFFICIENTS:

SBE19plus CONDUCTIVITY CALIBRATION DATA
PSS 1978: C(35,15,0) = 4.2914 Siemens/meter

g = -9.949806e-001 CPcor = -9.5700e-008
h = 1.571158e-001 CTcor = 3.2500e-006
i = -4.874166e-004
j = 6.173091e-005
BATHTEMP  BATHSAL BATHCOND INSTFREO  INST COND RESIDUAL
(ITS-90) (PSU) (Siemens/m) (Hz) (Siemens/m) (Siemens/m)
22.0000 0.0000 0.00000 2523.23 0.0000 0.00000
1.0000 34.8850 2.98128 5044.97 2.9813 -0.00000
4.5000 34.8648 3.28885 5236.00 3.2888 -0.00000
15.0000 34.8213 4.27216 5803.96 4.2722 0.00001
18.5000 34.8119 4.61785 5990.56 4.6178 -0.00000
24.0000 34.8011 5.17661 6280.15 5.1766 0.00000
29.0001 34.7946 5.69917 6539.03 5.6992 -0.00000
32.5000 34.7904 6.07198 6717.42 6.0720 0.00000
f = INST FREQ / 1000.0
Conductivity = (g + hf +if > +jf ") / (1 + 8t + ep) Siemens/meter
t = temperature[°C)]; p = pressure[decibars]; = CTcor; € = CPcor;
Residual = instrument conductivity - bath conductivity
Date, Slope Correction
0.002 [ @ ] 28-Aug-08 1.0000000
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CALIBRATION DATE: 26-Aug-08 870 psia S/N 2752080
COEFFICIENTS:
PAO = -1.047938e-001 PTCAO = 5.243776e+005
PAl = 2.635617e-003 PTCAl = 1.680541e-001
PA2 = 2.031440e-011 PTCA2 = -1.070257e-001
PTEMPAO = -6.085315e+001 PTCBO = 2.507825e+001
PTEMPAl = 5.350080e+001 PTCBl = -5.500000e-004
PTEMPA2 = -1.784269e-001 PTCB2 = 0.000000e+000
PRESSURE SPAN CALIBRATION THERMAL CORRECTION
PRESSURE INST THERMISTOR COMPUTED ERROR TEMP THERMISTOR  INST
PSIA OUTPUT OUTPUT PRESSURE  %FSR ITS90 OUTPUT  OUTPUT
14.68 529945.0 1.5 14.68 0.00 32.50 1.75 530023.07
179.95 592575.0 1.5 179.92 -0.00 29.00 1.69 530041.09
359.94 660723.0 1.5 359.90 -0.00 24.00 1.60 530065.44
539.94 728813.0 1.5 539.91 -0.00 18.50 1.49 530093.22
719.93 796824.0 1.5 719.90 -0.00 15.00 1.43 530105.65
874.90 855331.0 1.5 874.89 -0.00 4.50 1.23 530137.68
719.95 796862.0 1.5 720.00 0.01 1.00 1.16 530118.67
539.97 728851.0 1.5 540.01 0.00
359.97 660760.0 1.5 359.99 0.00 TEMP (ITS90) SPAN (mV)
179.96 592598.0 1.5 179.98 0.00 -5.00 25.08
14.69 529948.0 1.5 14.69 0.00 35.00 25.06
y = thermistor output; t = PTEMPAO + PTEMPA1 * y + PTEMPA2 * y2
x = pressure output - PTCAO - PTCA1 * t - PTCA2 * ¢
n=x * PTCBO/(PTCBO + PTCB1 * t + PTCB2 * t2)
pressure (psia) = PAO + PAIl * n+ PA2 * n’
Date, Avg Delta P %FS
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SENSOR SERIAL NUMBER: 6122

SEA-BIRD ELECTRONICS, INC.

1808 136th Place N.E., Bellevue, Washington, 98005 USA
Phone: (425) 643 - 9866 Fax (425) 643 - 9954 Email: seabird@seabird.com

SBE19plus PRESSURE CALIBRATION DATA

Pressure (PSIA)
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APPLIED
MICROSYSTEMS

004986 Certificate of Calibration

Customer: NOAA - Pacific Marine Center
Asset Serial Number: 004986
Asset Type: 004986 (Smart SV&P)

Calibrated Pressure Range: 1000 dBar

Certification Date: 02/10/2008

Certified By:

f
/ y | #
Robert Haydock,

President
Applied Microsystems

Applied Microsystems certifies that the equipment described above has been calibrated with
equipment referenced to traceable standards. Any repairs / calibrations completed on this
instrument were approved by the instrument owner under purchase order.

This instrument has been recalibrated. Please be sure to update your records. Please also ensure
that you update the instrument’s coefficient values in any post-processing software (ie. Smart Talk)
that you use. Instrument configuration files are available at our Client Service & Support Portal
(see web address below).

For a complete service history of this instrument, please consult our on-line Client Service &
Support Portal at http://www.appliedmicrosystems.com/customers/index.htm

Applied Microsystems
2071 Malaview Avenue
Sidney, B.C. V8L 5X6 CANADA
Tel: +1-250-656-0771 Fax: +1-250-655-3655



Sound Velocity Calibration

Date: 9/23/2008
Instrument SN: 004986
Calibrator: Les Woodland

RMS Error: 0.018
Range: 1400 to 1550 m/s

Error Plot
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Sound ¥elocity { m/s )

m/s=A+B*((NH-N)/(NH-NL))+C*((NH-N)/(NH-NL))"2+D*((NH-N)/(NH-NL))*3

Coefficients

A=1.521719E+3
B=-1.065195E+2
C=8.413916E+0
D=-7.328216E-1

APPLIED wou st P,
MICROSYSTEMS

2071 Malaview Ave West, Sidney, British Columbia, Canada V8L 5X6
Phone: (250) 656-0771 Fax: (250) 655-3655

Canada & USA: 800-663-8721

Email: info@AppliedMicrosystems.com Web: http://www.aml.bc.ca



Pressure Calibration

Date ( mm/dd/yy ):  09/30/08
Instrument SN: 004986
Calibrator: Les Woodland

RMS Error: 0.086
Range: 1000 dBar

Error Plot
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Pressure {(dBar)

dBar=A+B*T+C*T"2+D*T"3+(E+F* T+G*T"2+H*T"3)*Raw+(l+J*T+K*T"2+L*T"3)*Raw"2

Coefficients

A=-1.774596E+3 G=-3.214595E-7
B=9.062190E-2 H=9.150362E-9
C=2.005744E-2 1=-1.404551E-8
D=-3.298937E-4 J=3.282178E-10
E=5.909598E-2 K=-4.517941E-12
=-7.414152E-6 L=-5.695738E-14

APPLIED wou st P,
MICROSYSTEMS

2071 Malaview Ave West, Sidney, British Columbia, Canada V8L 5X6
Phone: (250) 656-0771 Fax: (250) 655-3655

Canada & USA: 800-663-8721

Email: info@AppliedMicrosystems.com Web: http://www.aml.bc.ca



APPLIED e H,'D
M IEREISYSTEMS

5229 Certificate of Calibration

Customer: NOAA - Pacific Marine Center

Instrument Serial Number: INS-05229

Instrument Type: Smart SV&P

Instrument Description: Real-time instrument with sound velocity (invar) and pressure

Calibrated Pressure Range: 1000 dBar

Certification Date: 08/02/2008 (dd/mm/

Certified By:

Robert Haydock,
General Manager
Applied Microsystems

Applied Microsystems certifies that the equipment described above has been calibrated with
equipment referenced to traceable standards. Any repairs / calibrations completed on this
instrument were approved by the instrument owner under purchase order.

This instrument has been recalibrated. Please be sure to update your records. Please also ensure
that you update the instrument's coefficient values in any post-processing software (ie. Smart Talk)
that you use. Instrument configuration files are available at our Client Service & Support Portal
(see web address below).

For a complete service history of this instrument, please consult our on-line Client Service &
Support Portal at http://www.appliedmicrosystems.com/customers/index.htm

Applied Microsystems
2071 Malaview Avenue
Sidney, B.C. V8L 5X6 CANADA
Tel: +1-250-656-0771 Fax: +1-250-655-3655



Sound Velocity Calibration

Date: 2/8/2008 J
Instrument SN: 005229 i i L b
Calibrator: Matt Tradewell ge:

Error Plok
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‘Sound ¥elocity { m/s )

m/s=A+B*((NH-N)/(NH-NL))+C*((NH-N)/(NH-NL))A24+ D*((NH-N)/(NH-NL))*3

Coefficients

A=1.521988E+3
B=-1.067986E+2
C=8.820610E+0
D=-9.938356E-1

MICROSYSTEM '

2071 Malaview Ave West, Sidney, British Columbia, Canada V8L 5X6
Phone: (250) 656-0771 Fax: (250) 655-3655

Canada & USA: 800-663-8721

Email: info@AppliedMicrosystems.com Web: http://www.aml.bc.ca




Pressure Calibration

Date: 2/6/2008
Instrument SN: 005229
Calibrator: Matt Tradewell

RMS Error: 0.1141
Range: 1000 dBar

Error Plot
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Pressure (dBar)

dBar=A+B* T+C* T2+D*T"3+(E+F*T+G*TA2+H*TA3)* Raw+({1+J* T+K*T 2+L*TA3)*Raw”2

Coefficients

A=-1.468823E+3 G=2.642032E-7
B=-4.145866E-1 H=-1.446059E-8
C=-1.325764E-3 1=-1.195644E-9
D=2.944354E-4 J=-5.100709E-13
E=4.653640E-2 K=-5.746673E-12
F=1.484535E-5 L=1.502744E-13

APPLIED ¢ st D,
MICROSYSTEMS

2071 Malaview Ave West, Sidney, British Columbia, Canada V8L 5X6
Phone: (250) 656-0771 Fax: (250) 655-3655

Canada & USA: 800-663-8721

Email: info@AppliedMicrosystems.com Web: hitp://www.aml.bc.ca



APPLIED
MICRDOSYSTEMS

005466 Certificate of Conformity

Customer: NOAA Ship Fairweather

Our Reference: Project 14065 NOAA Ship Fairweather; Smart SV&P-MVP (Sept-
08)

Customer Purchase Order: Phone Order

Asset Serial Number: 005466

Asset Type: 005466 (Smart SV&P for Brooke MVP)

Calibrated Pressure Range: 1000 dBar

Additional Description: RS 485 communication at 19200 baud
Certification Date: 30/10/2008 (dd/mm/yyyy)
Certified By:

f
/ ; I r
Robert Haydock,

President
Applied Microsystems

Applied Microsystems certifies that the above described equipment has been tested in accordance
with the product’s technical specifications, brochures, and / or relevant drawings. Applied
Microsystems certifies that calibrations on this instrument have been completed with equipment
reference to traceable standards.

Instrument configuration files and soft copy certificates are available at Applied Microsystems
Client Service and Support Portal at http://www.appliedmicrosystems.com/customers/index.htm

Applied Microsystems
2071 Malaview Avenue
Sidney, B.C. V8L 5X6 CANADA
Tel: +1-250-656-0771 Fax: +1-250-655-3655



Sound Velocity Calibration

Date (mm/dd/yy): 30/10/08
Instrument SN: 005466
Calibrator: Matt Tradewell

RMS Error: 0.020
Range: 1400 to 1550 m/s

Error Plot
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-0.z0-t . . : : : . p
1412 1440 1460 1450 1500 1520 15359

Sound ¥elocity { m/s )

m/s=A+B*((NH-N)/(NH-NL))+C*((NH-N)/(NH-NL))"2+D*((NH-N)/(NH-NL))*3

Coefficients

A=1.533131E+3
B=-1.137455E+2
C=1.040759E+1
D=-1.332106E+0

APPLIED wou st P,
MICROSYSTEMS

2071 Malaview Ave West, Sidney, British Columbia, Canada V8L 5X6
Phone: (250) 656-0771 Fax: (250) 655-3655

Canada & USA: 800-663-8721

Email: info@AppliedMicrosystems.com Web: http://www.aml.bc.ca



Pressure Calibration

Date: 10/23/2008 .
Instrument SN: 005466 ggnns E.rror. ?bOOGOOgBar
Calibrator: Matt Tradewell ge:

Error Plot
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Pressure {dBar)

dBar=A+B*T+C*T"2+D*T"3+(E+F* T+G*T"2+H*T"3)*Raw+(l+J*T+K*T"2+L*T"3)*Raw"2

Coefficients

A=-1.238729E+3 G=-1.128182E-6
B=-3.145002E-1 H=1.415759E-8
C=3.012141E-2 1=-4.262089E-9
D=-3.571170E-4 J=-1.925685E-10
E=4.398952E-2 K=1.080000E-11
F=2.278661E-5 L=-1.832266E-13

APPLIED wou st P,
MICROSYSTEMS

2071 Malaview Ave West, Sidney, British Columbia, Canada V8L 5X6
Phone: (250) 656-0771 Fax: (250) 655-3655

Canada & USA: 800-663-8721

Email: info@AppliedMicrosystems.com Web: http://www.aml.bc.ca



AML Calibration Equipment
Temperature Calibrations

Performed using either of two Hart Scientific "Black Stack” Model 1560 Power Bases with attached
Hart Scientific Model 2563 Thermistor Modules connected to a Thermometrics AS125 4 Wire
Thermistor Standard

1: Hart Scientfic Power Base 1560 S/N 79263 / Thermistor Module 2563 S/N 79039 /
Thermometrics AS125 4 Wire Thermistor Standard S/N 2131
2: Hart Scientfic power Base 1560 S/N A05690 / Thermistor Module 2563 S/N A05693 /
Thermometrics AS125 4 Wire Thermistor Standard S/N 2128

Temperature calibration equipment is calibrated yearly and verified bi-monthly as per Applied
Microsystems Ltd. Calibration Schedule T11.2 utilizing a Hart Scientific Model 5901 Triple Point of
Water Cell. All temperature calibrations and verifications are ITS-90 and NIST traceable

Pressure Calibrations

Performed using a Budenburg Model 380D S/N 18564 Range 0-8000 psi Deadweight Tester.
Calibrations and verifications are implemented as per Applied Microsystems Ltd. Calibration
Schedule T11.2. All pressure calibrations and verifications are NIST traceable.

Conductivity Calibrations

Performed using either of two Guildline 8400B S/N 59251 or Guildline 8400 S/N 43385 Autosals.
Both Conductivity Calibrators are calibrated and verified using Ocean Scientific International IAPSO
Standard Seawater as per Applied Microsystems Itd. Calibration Schedule T11.2. All Conductivity
Calibrations and verifications are NIST traceable

Battery Channel Calibrations

Performed using a Precision Fluke Model 45 Multimeter S/N 4720162. Calibrations and verifications
are implemented as per Applied Microsystems Ltd. Calibration Schedule T11.2 All calibrations and
verifications are NIST traceable.

Sound Velocity Calibrations

Performed using an Applied Microsystems Ltd Temperature Standard S/N 9998 in distilled water,
<5 ppm TDS, and sound velocity reference is Del Grosso and Mader's Pure Water Equation.
Calibrations and verifications are implemented as per Applied Microsystems Ltd. Calibration
Schedule T11.2 All temperature calibrations and verifications are ITS-90 and NIST traceable.
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SVP Test and Calibration certificate
SVP70
4008077

Functionality Test: ~ Sign :

Hart 1504 s/n A6B554 & Thermistor s/n 3014
4.6 °C
16.5 °C
25.5 °C
Custom Built Tank (TestUnit ASF150 Ser# 41-10-0007-R03)

0 Bar

301.7 Bar

603.6 Bar

RMS Speed of Sound Errors
0.0033 m/s

0.0845 m/s




Residual, (S/m)

SEA-BIRD ELECTRONICS, INC.

1808 136th Place N.E., Bellevue, Washington, 98005 USA
Phone: (425) 643 - 9866 Fax (425) 643 - 9954 Email: seabird@seabird.com

SENSOR SERIAL NUMBER: 0117 SBE 45 CONDUCTIVITY CALIBRATION DATA
CALIBRATION DATE: 08-Jan-08 PSS 1978: C(35,15,0) = 4.2914 Siemens/meter
COEFFICIENTS:

g = —-1.031942e+000 CPcor = -9.5700e-008

h = 1.269033e-001 CTcor = 3.2500e-006

i = -2.218276e-004 WBOTC = -3.1803e-006

j = 3.318496e-005

BATHTEMP  BATHSAL BATHCOND INSTFREO  INST COND RESIDUAL

(ITS-90) (PSU) (Siemens/m) (Hz) (Siemens/m) (Siemens/m)
22.0000 0.0000 0.00000 2855.80 0.00000 0.00000
1.0000 34.7807 2.97321 5622.31 2.97324 0.00003
4.4999 34.7610 3.28001 5832.94 3.27999 -0.00003
14.9999 34.7176 4.26078 6459.57 4.26076 -0.00001
18.5000 34.7080 4.60555 6665.57 4.60555 -0.00000
24.0000 34.6969 5.16282 6985.35 5.16285 0.00002
29.0000 34.6902 5.68399 7271.30 5.68399 0.00001
32.4999 34.6851 6.05568 7468.33 6.05567 -0.00001
f=INST FREQ * sqrt(1.0 + WBOTC * t) / 1000.0
Conductivity = (g + hf +if > +jf ") / (1 + 8t + ep) Siemens/meter
t = temperature[°C)]; p = pressure[decibars]; = CTcor; € = CPcor;
Residual = instrument conductivity - bath conductivity
Date, Slope Correction
0.002 [ @ ] 08-Jan-08 1.0000000
0.001
0.000 Q—o— o—0o—0—90 9o |
-0.001
-0.002 I | L 111 I | I | L 111 I | [
0 1 2 3 4 5 6 7

Conductivity (Siemens/m)



Residual, (S/m)

SEA-BIRD ELECTRONICS, INC.

1808 136th Place N.E., Bellevue, Washington, 98005 USA
Phone: (425) 643 - 9866 Fax (425) 643 - 9954 Email: seabird@seabird.com

SENSOR SERIAL NUMBER: 0117 SBE 45 CONDUCTIVITY CALIBRATION DATA
CALIBRATION DATE: 11-Dec-07 PSS 1978: C(35,15,0) = 4.2914 Siemens/meter
COEFFICIENTS:

g = -1.029836e+000 CPcor = -9.5700e-008

h = 1.264890e-001 CTcor = 3.2500e-006

i = -1.244736e-004 WBOTC = —-3.1803e-006

j = 2.698268e-005

BATHTEMP  BATHSAL BATHCOND INSTFREO  INST COND RESIDUAL

(ITS-90) (PSU) (Siemens/m) (Hz) (Siemens/m) (Siemens/m)
22.0000 0.0000 0.00000 2854.99 0.00000 0.00000
1.0000 35.7009 3.04425 5671.69 3.04426 0.00001
4.5000 35.6792 3.35798 5885.14 3.35797 -0.00001
15.0000 35.6327 4.36100 6519.96 4.36099 -0.00001
18.5000 35.6226 4.71361 6728.60 4.71359 -0.00002
23.9999 35.6111 5.28357 7052.48 5.28361 0.00003
29.0000 35.6023 5.81635 7341.91 5.81634 -0.00001
32.5001 35.5947 6.19615 7541.26 6.19615 -0.00000
f=INST FREQ * sqrt(1.0 + WBOTC * t) / 1000.0
Conductivity = (g + hf +if > +jf ") / (1 + 8t + ep) Siemens/meter
t = temperature[°C)]; p = pressure[decibars]; = CTcor; € = CPcor;
Residual = instrument conductivity - bath conductivity
Date, Slope Correction
0.004 ® | 23-Dec-06 1.0005616
A | 11-Dec-07 1.0000000
0.002
0.000 A A—h A A A ———
-0.002 \‘\.\
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Conductivity (Siemens/m)



Residual, (Degrees C)

SEA-BIRD ELECTRONICS, INC.

1808 136th Place N.E., Bellevue, Washington, 98005 USA

Phone: (425) 643 - 9866 Fax (425) 643 - 9954 Email: seabird@seabird.com

SENSOR SERIAL NUMBER: 0117
CALIBRATION DATE: 08-Jan-08

ITS-90 COEFFICIENTS

a0 =
al
az2
a3

BATH TEMP

-2.444687e-004
3.101067e-004
-4.608202e-006
2.066460e-007

(ITS-90)

1.
4.
.9999
.5000

14
18

24.
29.
32.

0000
4999

0000
0000
4999

INSTRUMENT
OUTPUT

825687.
708009.
455003.
395051.
318250.
263033.
230938.

O 01Oy P B OO

SBE 45 TEMPERATURE CALIBRATION DATA
ITS-90 TEMPERATURE SCALE

INST TEMP
(ITS-90)
1.0001
4.4998

15.0000

18.5000

23.9999

29.0000

32.4999

Temperature ITS-90 = 1/{a0 + al[ln(n)] + a2[ln"(n)] + a3[ln ()]} - 273.15 (°C)

Residual = instrument temperature - bath temperature

RESIDUAL
(ITS-90)

0.02

0.01
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Temperature, Degrees C

.0001
.0001
.0001
.0000
.0001
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Date, Delta T (mdeg C)

(@] 08-Jan-08 0.00



Residual, (Degrees C)

SEA-BIRD ELECTRONICS, INC.
1808 136th Place N.E., Bellevue, Washington, 98005 USA

Phone: (425) 643 - 9866 Fax (425) 643 - 9954 Email: seabird@seabird.com

SENSOR SERIAL NUMBER: 0117
CALIBRATION DATE: 11-Dec-07

ITS-90 COEFFICIENTS

a0 = -1.865866e-004

al = 2.970047e-004

a2 = -3.621420e-006

a3 = 1.819198e-007

BATH TEMP INSTRUMENT
(ITS-90) OUTPUT
1.0000 825650.8
4.5000 707981.6
15.0000 455000.0
18.5000 395058.3
23.9999 318252.4
29.0000 263036.0
32.5001 230933.8

SBE 45 TEMPERATURE CALIBRATION DATA

ITS-90 TEMPERATURE SCALE

INST TEMP

RESIDUAL

(ITS-90)
1.0001
4.4999

15.0002
18.4998
24.0001
28.9998
32.5002

(ITS-90)
.0001
.0001
.0002
.0002
.0002
.0002
.0001

Temperature ITS-90 = 1/{a0 + al[ln(n)] + a2[ln"(n)] + a3[ln ()]} - 273.15 (°C)

Residual = instrument temperature - bath temperature

Date, Delta T (mdeg C)

0.08 @ | 23-Dec-06 -33.75
A ] 11-Dec-07 0.00
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Temperature, Degrees C



SB SEA-BIRD ELECTRONICS, INC.

1808 - 136th Place Northeast, Bellevue, Washington 98005 USA
RRRRRELELC) Phone: (425) 643-9866 Fax: (425) 643-9954 www.seabird.com

Conductivity Calibration Report

|Customer:  |[Pacific Marine Center / NOAA |
[Job Number: || 48749 | [Date of Report: || 1/8/2008 |
[Model Number || SBE45 | [Serial Number: || 4536628-0117 |

Conductivity sensors are normally calibrated 'as received', without cleaning or adjustments, allowing a determination of
sensor drift. If the calibration identifies a problem or indicates cell cleaning is necessary, then a second calibration is
performed after work is completed. The 'as received' calibration is not performed if the sensor is damaged or non-
functional, or by customer request.

An 'as received' calibration certificate is provided, listing the coefficients used to convert sensor frequency to
conductivity. Users must choose whether the 'as received' calibration or the previous calibration better represents the
sensor condition during deployment. In SEASOFT enter the chosen coefficients using the program SEACON. The
coefficient 'slope’ allows small corrections for drift between calibrations (consult the SEASOFT manual). Calibration
coefficients obtained after a repair or cleaning apply only to subsequent data.

'AS RECEIVED CALIBRATION' Performed [] Not Performed

Date: 12/11/2007 Drift since last cal: |  +0.00150 | PSU/month*

Comments:

'CALIBRATION AFTER REPAIR' Performed ] Not Performed

Date: | 1/8/2008 Drift since Last cal: | N/A | PSU/month*

Comments:

*Measured at 3.0 S/m

Cell cleaning and electrode replatinizing tend to 'reset’ the conductivity sensor to its original condition. Lack of drift in
post-cleaning-calibration indicates geometric stability of the cell and electrical stability of the sensor circuit.



SB SEA-BIRD ELECTRONICS, INC.

1808 - 136th Place Northeast, Bellevue, Washington 98005 USA
RRARRRELEL) Phone: (425) 643-9866 Fax: (425) 643-9954 www.seabird.com

Temperature Calibration Report

|Customer: |[Pacific Marine Center / NOAA |
[Job Number: || 48749 | [Date of Report: | 1/8/2008 |
[Model Number || SBE45 | [Serial Number: || 4536628-0117 |

Temperature sensors are normally calibrated 'as received', without adjustments, allowing a determination sensor drift. If
the calibration identifies a problem, then a second calibration is performed after work is completed. The 'as received’
calibration is not performed if the sensor is damaged or non-functional, or by customer request.

An 'as received' calibration certificate is provided, listing coefficients to convert sensor frequency to temperature. Users
must choose whether the 'as received' calibration or the previous calibration better represents the sensor condition
during deployment. In SEASOFT enter the chosen coefficients using the program SEACON. The coefficient 'offset’
allows a small correction for drift between calibrations (consult the SEASOFT manual). Calibration coefficients
obtained after a repair apply only to subsequent data.

'AS RECEIVED CALIBRATION' Performed L] Not Performed
Date: [12/11/2007 Drift since last cal: +0.03490 Degrees Celsius/year
Comments:

'CALIBRATION AFTER REPAIR' Performed ] Not Performed

Date: | 1/8/2008 Drift since Last cal: N/A Degrees Celsius/year

Comments:



Aor 16, 2009 ] DIGIBAR CALIBRATION REPORT O
version 1.0 (c) 2004

Serial #: ] ODOM HYDROGRAPHIC SYSTEMS, Inc. .

98013-041609

L% C— = N -

STANDARD DEL GROSSO H?0

TEMP VELOCITY MEASURED RES_VEL OBS-CAL TEMP VELOCITY MEASURED RES_VEL OBS-CAL

FREQUENCY FREQUENCY

4.00 1421.62 5555.38 1421.72 0.10 17.50 1474.38 5754.23 1474.39 0.01
450 1423.90 5563.65 1423.91 0.01 18.00 1476.01 5760.25 1475.98 -0.03
5.00 1426.15 5572.06 1426.14 -0.01 18.50 1477.62 5766.61 1477.67 0.05
5.50 1428.38 5580.63 1428.41 0.03 18.00 1479.21 5772.53 1479.24 0.03
6.00 1430.58 5588.91 143060 0.02 19.50 1480.77 5778.59 1480.84 0.07
6.50 1432.75 5597.16 1432.79 0.04 20.00 1482.32 5784.53 1482.42 0.10
7.00 1434.90 5605.25 1434.93 0.03 20.50 1483.84 5790.02 1483.87 0.03
7.50 1437.02 5612.62 1436.88 -0.14 21.00 1485.35 5795.92 1485.43 0.09
8.00 1439.12 5621.12 1439.13 0.02 21.50 1486.83 5801.44 1486.89 0.07
8.50 1441.19 5629.22 1441.28 0.09 22.00 1488.29 5806.96 1488.36 0.08
9.00 1443.23 5636.66 1443.25 0.02 22.50 1489.74 5812.30 1489.77 0.03
9.50 1445.25 5643.93 1445.18 -0.08 23.00 1491.16 5817.59 1491.17 0.01
10.00 1447.25 5651.96 1447.30 0.05 23.50 1492.56 5822.88 1492.57 0.01
10.50 1449.22 5659.15 1449.21 -0.02 24,00 1493.95 5828.51 1494.06 0.1
11.00 1451.17 5666.35 1451.11 -0.06 24 50 1495.32 5833.69 1495.44 0.12
11.50 1453.09 5673.82 1453.09 0.00 25.00 1496.66 5838.75 1496.78 0.11
12.00 1454.89 5681.13 1455.03 0.03 25.50 1497.99 5843.82 1498.12 0.13
12.50 1456.87 5688.13 1456.88 0.01 26.00 1499.30 5848.69 1498.41 0.11
13.00 1458.72 5695.22 1458.76 0.04 28.50 1500.59 5853.57 1500.70 0.11
13.50 1460.55 5702.13 1460.59 0.04 27.00 1501.86 5858.39 1501.88 0.12
14.00 1462.36 5708.74 1462.34 -0.02 27.50 1503.11 5862.89 150317 0.08
14.50 1464.14 5715.63 146417 0.02 28.00 1504.35 5867.72 1504.45 0.10
15.00 1465.91 5722.21 1465.91 0.00 28.50 1505.56 5872.44 1505.70 0.14
15.50 1467.65 5728.99 1467.70 0.06 29.00 1506.76 5876.95 1506.89 0.13
16.00 1469.36 5735.28 1469.37 0.01 29.50 1507.94 5881.41 1508.08 0.13
16.50 1471.06 5741.78 1471.09 0.04 30.00 1509.10 5885.67 1508,20 0.10
17.00 1472.73 5748.03 1472.75 0.02
0.20
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Odom Hydrographic Systems, Inc.
1450 SeaBoard Avenue, Baton Rouge, Louisiana 70810-6261, USA
Telephcne: (225)-768-3051, Facsimile: (225)-766-5122
E-mail: email@odomhydrographic.com, HTTP: www.odomhydrographic.com
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e J DIGIBAR CALIBRATION REPORT (N
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(Sadaf #: ] ODOM HYDROGRAPHIC SYSTEMS, Inc. 2
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The instruments used in this calibration have been calibrated to the published manufacturer specifications using standards traceable to

NIST, to consensus standards, to ratio methods, or to acceptable values of natural physical constants that meets the requirements of

ANSI/NCSL Z540-1, ISO 9001, ISO 10012 and 1SO 17025. Certificate/traceability numbers: 0002-2655.00-23491-001, 0002-2655.00-

23491-002. 1D#s:294,295,762,172,56

Odom Hydrographic Systems, Inc.
1450 SeaBoard Avenue, Baton Rouge, Louisiana 70810-6261, USA
Telephone: (225)-768-3051, Facsimile: (225)-766-5122
& E-mail: email@odomhydrographic.com, HTTP: www.odomhydrographic.com




I'~\TELEDYNE Digibar
0DOM HYDROGRAPHIC
A Teledyne Technologies Company
Date 4/17/2009
Serial # 98013
SW Version 1294
Cable Length 20 meters
Board Identification Serial #
Press Transduce 79842 Power Supply
Zero Voltage .18 Control PCB
Span Volage 2.68 LCD
Mid-Scale Voltagg 1.43 Probe Sensor
R5 3.9K Probe Controller
R9 10K Airmar Transducer 853906
Gradient 3391
Intercept 497
Max psi: 200 psi
Velocity Check: v
Depth Check: N
Communications: V
External Power: NA
Pressure Transducer Linearity
100 Transducer Linearity
PSI DVM@L1
0 0.18
80 1 0.192
3 0.217
5 0.242
10 0.304
o 15 | 0.367
& 25 0.491
40 50 0.804
75 1.116
100 1.43
20
0 L] 1
0 0.5 1 1.5

DVM @ L1




@/C;eoLine.

POSITIONING SYSTEMS

Certificate of Calibration

Model: Nikon DTM310

Serial Number: 842575

This certifies that the above instrument has been inspected and calibrated
by the Geoline Positioning Systems Inc. Service Department. At the time of
completion of this service, Geoline Positioning Systems, Inc. certifies that
the above stated product meets all factory specifications and tolerances for
product parameters and performance of this product model.

All product calibration and specification parameters were tested and/or
adjusted using applicable factory calibration jigs, precision optical
collimation systems and electronic test equipment. All collimation systems
have been properly checked and calibrated according to industry standard
practices. All electronic test equipment used have had current calibration.

Date of Calibration:_6/28/04

Next Recommended Calibration Date: 12/28/04

- _
Signed: /«Sﬂ" %/M/‘ Date: 6/28/04

Title: Service Technician

GeolLine Positioning Systems, Inc.
1331 118th Avenue SE, Suite 400
Bellevue, WA 98005

425.452.2711 « 425.452.2703 fax



@/geoLine.

POSITIONING SYSTEMS

Certificate of Calibration

Model: Sokkia SET 5F

Serial Number;_16288

This certifies that the above instrument has been inspected and calibrated
by the GeoLine Positioning Systems Inc. Service Department. At the time of
completion of this service, GeoLine Positioning Systems, Inc. certifies that
the above stated product meets all factory specifications and tolerances for
product parameters and performance of this product model.

All product calibration and specification parameters were tested and/or
adjusted using applicable factory calibration jigs, precision optical
collimation systems and electronic test equipment. All collimation systems
have been properly checked and calibrated according to industry standard
practices. All electronic test equipment used have had current calibration.

Date of Calibration: 7/19/04

Next Recommended Calibration Date: 7/19/05

Signed: _~ . Date: 7/19/04

Title: Service Technician

GeolLine Positioning Systems, Inc.
1331 118th Avenue SE, Suite 400
Bellevue, WA 98005

425.452.2711 » 425.452.2703 fax



Appendix VI

Correspondence

« PPK DDSSM Permission
e« FA Hydrographic Resolution Waiver Request
« FA Hydrographic Resolution Waiver Acceptance



----- Original Message -----

From Briana.Welton@noaa.gov

Date Thu, 23 Apr 2009 17:06:02 -0700

To CO.Fairweather@noaa.gov, XO.Fairweather@noaa.gov
Subject Fwd: Re: Dynamic draft using PPK

————— Original Message -----

From Olivia.Hauser@noaa.gov

Date Thu, 23 Apr 2009 09:14:31 -0700

To Olivia Hauser <Olivia.Hauser@noaa.gov>

Cc Edward.J.Vandenameele@noaa.gov, '"Jack L. Riley"

<Jack.Riley@noaa.gov>, Glen Rice <Glen.Rice@noaa.gov>, Grant Froelich
<Grant.Froelich@noaa.gov>, Steve Brodet <Steve.Brodet@noaa.gov>,
FOO.Thomas.Jefferson@noaa.gov, FOO Rainier <FOO.Rainier@noaa.gov>,
FOO.Fairweather@noaa.gov, Briana Welton <Briana.Welton@noaa.gov>, "Corey
Allen® <Corey.Allen@noaa.gov>

Subject Re: Dynamic draft using PPK

Hello All,

1 spoke with EJ who conferred with Jeff Ferguson and they both agreed
that if you decide to use the PPK method to determine dynamic draft on
your vessel, include it in the HSRRs with the following information and
they will be approved. Please include a statement that it is a deviation
from the FPM, what you did to get your values and a comparison to either
previous dynamic draft tables or one obtained concurrently using an
approved method. (Basically the write-ups you already have). The HSRRs
will be approved with the deviation, and we"ll work on getting the FPM
updated for next year.

V/R, Olivia

————— Original Message -----

From: Olivia Hauser <olivia.hauser@noaa.gov>

Date: Tuesday, April 21, 2009 12:08 pm

Subject: Dynamic draft using PPK

To: edward.j.vandenameele@noaa.gov, ""Jack L. Riley"”
<Jack.Riley@noaa.gov>, Glen Rice <Glen.Rice@noaa.gov>, Grant Froelich
<Grant.Froelich@noaa.gov>, Steve Brodet <Steve.Brodet@noaa.gov>,
foo.thomas. jefferson@noaa.gov, FOO Rainier <FOO.Rainier@noaa.gov>,
foo.fairweather@noaa.gov, Briana Welton <Briana.Welton@noaa.gov>,
"Corey Allen® <Corey.Allen@noaa.gov>

LCDR van den Ameele,

This is a follow-up to our phone conversation the other day. Both FA
agg_have tested the use of PPK to determine the dynamic draft for
tcg;;els with positive results. Currently the FPM states that this is
ngtvalid method to determine dynamic draft. Can we change that? 1 have

attached the two write ups/reports that were created from these
tests.

The only major item of concern here is the removal of tide. Both of
the

test cases were conducted in areas where tide is negligible which
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made

the use of this data easy. It may noe be as simple in areas with
large

tidal fluctuations. Is there a way we can remove tide from the SBET
(Jack or Steve)? Also, ENS Rice wrote the python script that created
the

final curves and graphs in both reports. It might be in our best
interest to include these in pydro or provide them in another form to

all the field units if they decide to use this method.

I recommend that we change the FPM to include this method as an
acceptable method to calculate dynamic draft.

V/R, Olivia

LTJG Olivia Hauser

NOAA HSTP Field Support Liaison, East
439 W. York Street, Norfolk, VA 23510
Voice: 757-441-6319 x 105

Fax: 757-441-6601

Cell: 302-229-3368
olivia.hauser@noaa.gov
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—=e=__ ™ | National Oceanic and Atmospheric Administration
< | NOAA Marine and Aviation Operations
=) & | NOAA ship Fairweather S-220
K Pt 1010 Stedman Street
Ketchikan, AK 99901

May 8, 2009

MEMORANDUM FOR: Jeffery Ferguson
Chief, Hydrographic Surveys Division

FROM: CDR Douglas D. Baird, Jr., NOAA
Commanding Officer, NOAA Ship Fairweather

SUBJECT: Waiver from HTD 2009-02 specifications

Fairweather personnel have examined 2009 reference surface and project related data with the
Hydrographic Technical Directive 2009-02 CUBE criteria and specifications in mind, and
have determined that adhering to those specifications would be an onerous task.

In order to meet the HTD 2009-02 criteria for complete coverage surveys for the 2, 4, & 8
meter grid resolutions the survey launches would have to clutch-in and clutch-out of gear to
move slowly enough and the ship would be reduced to bare steerage and significantly reduced
swath coverages.

I am willing to slow the platforms down to six knots speed over ground — this is just a touch
over clutch-in speed on Fairweather’s two survey launches, and allows the ship to maintain
positive control for most conditions. And we will reduce the swath coverage to 50° off nadir
to both port and starboard.

I propose the following grid resolutions for the 2009 calendar year projects, using at least 5
soundings per node, at 6 knots, displaying 50° off nadir:

0 to 23 meters ............. 1 meter grid resolution
18 to 40 meters .............. 2 meter grid resolution
3510 80 meters ............ 4 meter grid resolution
75 to 160 meters .......... 8 meter grid resolution
155+ meters ............ 16 meter grid resolution

Since it is very rare for Fairweather to be required to conduct object detection surveys, this
waiver request is strictly for complete coverage multibeam surveys.




63'@ N "&%p UNITED STATES DEPARTMENT OF COMMERCE
« TR National Oceanic and Atmospheric Administration
= :-/j = NATIONAL OCEAN SERVICE
%)?o T Office of Coast Survey
Silver Spring, Maryland 20910-3282

19 May 2009
MEMORANDUM FOR: Commander Douglas D. Baird Jr., NOAA
Commanding Officer, NOAA Ship Fairweather

FROM: Jeffrey Ferguson
Chief, Hydrographic Surveys Division

SUBJECT: Waiver from HTD 2009-02 Specifications

The NOAA Ship Fairweather’s waiver, dated May 8, 2009, requesting a departure from the grid
resolution requirements specified in Hydrographic Technical Directive 2009-02 is approved.

The NOAA Ship Fairweather will use the following grid resolutions for complete coverage
multibeam on 2009 calendar year surveys, obtaining at least 5 soundings per node:

Oto23meters..........coeeennnns 1 meter grid resolution
18to 40 meters............c.ue.... 2 meter grid resolution
35t080 meters...........cceunenn. 4 meter grid resolution
75 to 160 meters..................8 meter grid resolution
155+ meters.......c.ooveiinenes 16 meter grid resolution

cc Chiefs; OPS, PHB, AHB
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